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Getting Started

This section is intended to provide users with an introduction to the STEP system and concepts. Additionally, it
provides detailed information needed to perform basic data maintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around STEP Workbench, but the concepts and functionality presented are often
applicable to both the workbench and Web Ul interfaces. Because of this, it is helpful for users of either interface to
be familiar with the material in this guide. For documentation specific to the Web Ul, see the Web User Interfaces
guide.

The Getting Started guide contains the following sections.

« Introduction: This section includes a terminology table and an overview of some basic STEP concepts.
This material should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.

« STEP Workbench Ul: This section introduces the user to the workbench interface, as well as providing
detailed reference information for the various functions, including toolbar actions and menu options.

« Object Maintenance in Tree: This section provides an overview of creating, editing, and deleting objects in
the workbench, as well as providing detailed information for working with particular types of objects.

« Navigation and Searches: This section introduces the user to basic search and navigation functionality in
STEP Workbench, as well as providing detailed descriptions of the search criteria available on the Search
tab.

« Keyboard Shortcuts: This topic provides a list of keyboard shortcuts that can be used in the workbench.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 7
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Introduction

This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.
o STEP Terminology: A table defining basic STEP terms, including links to topics with additional information.

« Basic STEP Concepts:Introduces some core concepts in STEP to facilitate understanding of the Getting
Started and System Setup guides.

« Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 8
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STEP Terminology

This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the online
help. Links to additional material on related topics are also provided, when appropriate. This should not be
considered a complete list of all STEP terms as it is intended to cover only the more commonly used terms that
users are likely to encounter throughout the online help.

A
Definition Further
Reading
Action Type of business rule that can be executed to manipulate data or perform an See the
action. Actions can be executed by various processes and events within the Business
system. For example, at approval of an object, within a workflow (on entry to a Actions topicin
state, exit from a state, on the transition between tasks, or when a deadline has the Business
been met), as part of an import process, or from a bulk update process. Rules
documentation.
API see Public API Seethe STEP
API
Documentation
link on the Start
Page.
Approval | The process of pushing data from the Maintenance workspace to the Approved | Seethe
workspace in STEP. Approval can be associated with business logic that may Approval of
prevent approval or may perform automated data updates during approval. Objects topicin
Approvals are often the triggers for sending data to downstream systems. the Getting
Started / User
Guide
documentation.
Asset Any type of digital media, such as an image, Word document, PDF, Excel file, See the Assets
PowerPoint, JPG, GIF, etc. topicin the
Getting Started
/ User Guide
documentation.
Asset A process that exports assets from STEP to a file system. Conversion templates | See the Asset
Push can be applied to transform images, for example from high res to low res, Push topicin

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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Definition Further

Reading

resizing, applying color scales, etc, though assets can also be sent as-is simply the Digital
to make them available on the file system. Assets guide.

Assignee | The user or group to which a task is assigned for work to be performed within a See the
workflow. User states can be assigned directly to a named user or to a user Assignees in
group. When a state is assigned to a user group the task is "offered" to all Workflows
members of that group. To perform the task associated with the state, a member | topicin the

of the group has to claim the task. Once a task is claimed it is no longer visible in | Workflows

the group task list; only the person who claimed the task is able to see it. A user documentation.
may subsequently release a task back to the group.

Attribute | A characteristic or detailed piece of information related to a particular object. See the
Attributes can be one of two types, description or specification. Description Attributes topic
attributes are available on most object types in STEP, while specification in the System
attributes are only available on objects in the Primary Product Hierarchy. Setup / Super

User Guide
documentation.

Attribute | Groups attributes, reference types, and/or link types. Attribute groups can have | Seethe

Group sub-groups. Attributes
Groups topic in
the System
Setup / Super
User Guide
documentation.

Attribute | The value stored in a particular attribute on a particular object. See the

Value Attributes topic
in the System
Setup / Super
User Guide
documentation.

Definition Further Reading

Bookmark | A placeholder created by the user that serves as a shortcutto a See the Bookmarks topic

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 10
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Term Definition Further Reading
previously viewed location. in the Getting Started /
User Guide
documentation.
Business | Automated piece of programming logic that may implement See the Business Rules
Rule customer-defined rules, such as validations, automatic updates, topicin the Business
notifications, data-driven workflow routing, etc. Also see Condition Rules documentation.
and Action.
C
Term Definition Further Reading
Calculated An attribute where the value is calculated according to a specific formula | See the
Attribute defined for this attribute. The formula may include static text, other Calculated
attribute values, information from references on the object, and a Attributes topicin
number of other options. the System Setup
/ Super User
Guide
documentation.
Category View in STEP that helps product managers and data analyststo getan | Seethe Data
Profile overview of an entire section of the Product Hierarchy through various Profiles topicin the
metrics that are displayed in dashboard format. Data Profiling
documentation.
Character Tag | An entry that begins with “<” and ends with “/>” such as <check/>. See the Tags topic
These tags represent characters that may not be found in the special in the System
character map in Unicode, or may be used instead of the Unicode Setup / Super
character. User Guide
documentation.
Claim The action that a user performs to take a task in a workflow out of a See the Claiming
group queue and assign to himself / herself. and Releasing
Tasksin
Workflows topic in
the Workflows
documentation.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 11



Term

Classification

Definition

A particular type of hierarchy that organizes groups of objects or assets.
Objects are linked to classifications via references, and may have
references to multiple classifications. Also referred to as "yellow

StiboSystems

MASTER DATA MANAGEMENT

Further Reading

See the
Classifications
topic in the Getting

folders." Started / User
Guide
documentation.
Collection An object that holds a static set of objects, or a dynamic search criteria See the
that can be refreshed as needed to find the latest matching objects. Collections topicin
Using collections, the resulting data can be displayed, bulk actions can the Getting
be performed, or the objects can be exported. Started / User
Guide
documentation.
Completeness | A measurement within STEP, expressed as a percentage, to indicate See the Object
Score the proportion of key data that has been completed for a particular Completeness
object. This key data is configurable, as is the weighting of importance. topicin the Data
Profiling User
Guide
documentation.
Condition A condition is a type of business rule that evaluates to either true or See the Business
false, and does not change data. In relation with approval, a condition Conditions topicin
can act as validation for whether an approval action can be carried out. the Business
In relation to workflows, conditions can be used to prevent a transition Rules
from being taken if certain conditions are not met. documentation.
Context A specific filter placed on the system data. Each contextis a See the Contexts

combination of different dimensions such as language, country, and so
forth, for example, English US, French CA, or German DE. Data may
vary based on context.

topicin the System
Setup / Super
User Guide
documentation.

Definition Further Reading
Data Model | Basic system configuration defining the allowable structures and See the System Setup /
make up of data within STEP. Consists of system setup data, Super User Guide.
© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 12
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Term Definition Further Reading
including: dimensions, contexts, object types, reference types, keys,
component models, attribute groups, attributes, lists of values, units,
and tags.
Dimension- | An attribute that can have different values for different dimension See the Dimension
Dependent | points, where the actual value is determined by the context in which Dependent Attributes
Attribute the attribute is presented. topicin the System
Setup / Super User
Guide documentation.

Definition Further
Reading
Entity A group of master data that has a specific business meaning. Entities typically | Seethe
store product-neutral data in STEP according to client-specific groupings of Entities topicin
information, such as customers, employees, suppliers, and addresses. Entities | the Getting
are also often used to store reference data that is utilized within the system. Started / User
Entities can be grouped into a hierarchy using reference types that are only Guide

valid from an entity object to an entity object. A source object can be displayed | documentation.
as a child of the target object or the target as a child of the source.

Externally | A characteristic of an attribute or reference that can be setto 'Yes’ or’'No’. A See the
Maintained | 'Yes’ selection indicates that the data point is maintained externally, and a Externally
Attribute change in it does not trigger a change in approval status and/or a new revision | Maintained
on the STEP object on which the data was changed. A ’No’ selection indicates | Attributes topic
that the data point is maintained internally and a change in it has the potential in the System
to trigger a change in the approval status and/or a new revision on the STEP Setup / Super
object on which the data was changed. User Guide
documentation.

Definition Further Reading

Function | A type of business rule that allows for input parameters to See the Business Functions
produce an output. These operations are side-effect free, and it topic in the Business Rules
do not change STEP data. documentation.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 13
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Further Reading

Golden | Collection of data from a variety of sources, based on matching, See the Golden Records Match
Record | linking, and survivorship rules. The Golden Record is considered | Action topic in the Matching,
the trusted data record, compiled from the various source objects. | Linking, and Merging

documentation.

H

Term

Definition

Further Reading

Hierarchy | A data structure composed of parents and children. See the Object Type Hierarchy topicin the
Object Types and Structures of the
System Setup / Super User Guide
documentation.

Hotfolder | File system of folders where data can be dropped for | See the IIEP Receiver Methods in the

automatic loading into STEP, based on the
particular configurations and/or code applied to the
hotfolder.

Data Exchange documentation, or Asset
Importer in the Digital Assets
documentation.

Definition

Further

Reading

ID The unique identifier for all objects within STEP. It cannot be translated or
edited once created, and cannot contain special characters.

Image A series of parameters defining the way in which an image is transformed See the Image

Conversion | from the standard high resolution asset that exists in STEP to the required Conversion
downstream format. Several conversion options are available by default, and | Configuration
additional conversions can be added via configuration and/or extensions. topicin the
Note that conversions change assets as they are pushed from STEP, leaving | Digital Assets
the originating file unchanged in STEP. documentation.

Inbound Communication channel defining how data is received by STEP. Each See the

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 14
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Link Types topic in the

Definition Further
Reading
Integration | endpoint defines how data is received from an external system, specifying Inbound
Endpoint location, transport protocol, data to be exchanged and other configuration Integration
(HEP) parameters. Endpoints topic
in the Data
Exchange
documentation.
Integration | Communication channel between STEP and external systems. See Inbound | See the Data
Endpoint Integration Endpoint and Outbound Integration Endpoint. Exchange
(IEP) documentation.
Inheritance | The ability to make data available in the product or classification hierarchy to See the
lower nodes by linking it to a higher node in the hierarchical structure. Inherited
Attributes topic
in the System
Setup / Super
User Guide
documentation.
K
Term Definition Further Reading
Library Set of functions that can be reused in multiple business rules or other | See the Business
libraries. Libraries cannot be called independently and must be Libraries topic in the
referenced from other actions, conditions, or functions. Business Rules
documentation.
Link A parent/child relationship between objects within the STEP system. | See the Reference and

System Setup / Super
User Guide
documentation.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 15
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Term Definition Further Reading
List of A validation base type for an attribute that only allows a value to be See the List of Values
Values considered valid if it belongs to a respective list of pre-configured (LOVs) topic in the
(LOV) values assigned to the attribute. Also used to refer to the value list System Setup / Super
itself. LOVs are also referred to as 'Domains' at times. User Guide
documentation.

Localized | An attribute value that is set directly on an object and is not inherited See the Inherited

Value from any level above in the hierarchy. Attributes topic in the
System Setup / Super
User Guide
documentation.
M
Term Definition Further Reading
Mandatory | Indicates that the product and all its sub-products See the Mandatory Attributes topicin the
Attribute must have a value for the specified attribute in order System Setup / Super User Guide
for the object to be approved. documentation.
Multi- An attribute that can contain more than one value for | See the Editing Multi-Valued Attributes
Valued a specific object. topicin the System Setup / Super User
Attribute Guide documentation.
N

Definition Further

Reading

Object An element within the system, for example, a product, image, classification, See the Basic
attribute, workflow, business rule, etc. STEP
Concepts topic
in the Getting
Started / User
Guide.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 16
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Definition Further
Reading
Object A specific label for levels within a taxonomy, given to different elements within See the Basic
Type the system. Nearly every object in STEP is labeled with an object type to help STEP
identify what it is (i.e. a product or entity rather than an image, a TIF rather than | Concepts topic
a PDF, etc.). This includes entities, products, product categories, alternate in the Getting
hierarchies, images and other assets, attributes, and LOVs. Through the use of | Started/ User
object types, system administrators can control how rigid or loosely defined the | Guide.
database will be in terms of object creation and where objects are allowed to
‘live’ and/or be used. This labeling also becomes very important when working
with exported data so that each type of object in STEP can be identified for
special handling in web applications or other uses outside of STEP.
Orphan A specification attribute that has a value, which has been deleted from / not See the
Attribute linked to a product node or classification and is denoted by italics. Orphan
Attributes topic
in the System
Setup / Super
User Guide
documentation.
Outbound | Communication channel defining how data is sent by STEP. Each endpoint See the
Integration | defines how data is sent to an external system, specifying location, transport Outbound
Endpoint protocol, data to be exchanged and other configuration parameters. Integration
(OIEP) Endpoints topic
in the Data
Exchange
documentation.
P
Term Definition Further Reading
Postprocessor | A plugin component within the IEP framework that allows See the IIEP Configuration
STEP to act on the result of the import / export such as Flipper and the OIEP Output
starting workflows, sending notifications, etc. Templates Flipper topics in
the Data Exchange
documentation.
Preprocessor | A plugin component within the integration endpoint See the IIEP Configuration

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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Term Definition Further Reading
framework that allows STEP to modify the message prior to Flipper and the OIEP Output
import / export. It can be used for various functionality such as | Templates Flipper topics in
pre-validation, format conversion, filtering, etc. the Data Exchange

documentation.

Primary Hierarchy that allows for different types of objects to be stored | See the Object Type

Product once in the database; each object within this hierarchy has a Hierarchy topic in the

Classification
(PPC)

unique ID / identifier and may have only one location within
the hierarchy. Also referred to as the 'blue hierarchy'.

System Setup / Super User
Guide documentation.

Product One of the object super types, referring to any object within See the Products topicin the
the Primary Product Classification (blue hierarchy). Getting Started / User Guide
documentation.
Product InDesign templates that determine what type of data will See the Product Templates
Template appear on a printed page, including the positioning and topicin the Publisher /
styling. STEP'n'design
documentation.
Product Data type used to model multiple variants of a similar object. See the Product Variants
Variant For example, T-shirts in various sizes and colors could all be topicin the System Setup /
variants of a single product. Super User Guide
documentation.
Proof View A tab in STEP Workbench which displays a product template | See the Generating Proof
view of the current STEP data without the user needing to Views topicin the
use InDesign. STEP'n'design
documentation.
Publication One of the super types, referring to objects in the publication See the Publication
(green) hierarchy. Hierarchy section of the
STEP Publisher
documentation.
Public API The set of server-side functions that have been exposed to be | See the STEP API

used in the business logic. This includes many functions to
create, get, and set data, such as values and references. It
also includes various methods for logging as well as sending
emails.

Documentation link on the
Start Page.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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Further Reading

Purge

Removal of an object from the database. Following purge, an
object cannot be revived.

See the Revisions topic in
the System Setup / Super
User Guide documentation.

Queue

Definition Further
Reading
The mechanism within the IIEP framework that allows messages to be Seethe
processed in an asynchronous way. The queuing concept allows separating Background
processes from different integration endpoints as well as controlling the degree Processes and
of parallel imports (a queue size of one guarantees sequential import, while a Queues topicin
queue size larger than one allows parallel processing of multiple messages for the System
increased throughput where sequential execution is not required). Setup / Super
User Guide
documentation.

Reference | An association between objects

Definition Further Reading

See the Reference and Link Types topic in the System

within the STEP system. Setup / Super User Guide documentation.
S
Term Definition Further Reading
Special A character that cannot be found on a standard keyboard but See the Tags topicin the
Character can usually be found in the Windows character map. Example: System Setup / Super
Trademark Symbol - ™ User Guide
documentation.
State A step within a workflow to which a specific user, user group, or | See the Creating a

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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Further Reading

system can be assigned to complete the task(s) associated with

Workflow topicin the

the state. Workflows
documentation.

STEP Stibo Enterprise Platform master data software application that
provides business managers a single source database to store,
manage, and re-purpose product information for publication or
syndication.

STEP’n’design | STEP’s plugins for InDesign that allow data from the STEP See the STEP Publisher/
database to be pulled onto pages. STEP’n’design

documentation.

STEPXML The native XML language for STEP, which can be used for See the STEPXML
importing / exporting STEP data, as well as transferring Format topic in the Data
configurations between STEP systems. Exchange

documentation.

Super type A major category of data within STEP including: Asset, See the Object super
Classification, Entity, Product, and Publication. See the specific | types topic within the
definition for each super type for additional information. Getting Started / User

Guide.
Super User A user that is given administrative privileges within the STEP See the Actions Sets
system. topicin the System Setup
/ Super User Guide
documentation.
T
Term Definition Further Reading
Task The work and/or action that must be completed withina | See the Working with Tasks in
specific workflow state (whether by a user or via Workflows topic in the Workflows
automation). documentation.

Transition | The change of tasks from one state to another within a See Creating a Workflow in the

workflow. Workflows documentation.
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Definition Further
Reading
Unique Key | A unique key is a system entity that represents a specific objectinthe STEP | See the Unique
system. The entity is composed of one or more data points, whether utilized | Keys topicin the
as-is or in a combined and/or transformed format using a specified formula. System Setup/
There can be exactly one record for each object for each defined key. No Super User
two objects with the same unique key for an active key can exist. Guide
documentation.
User Rules that allow or restrict users from performing certain functions withinthe | See the
Permissions | system. Privilege Rules
topicin the
System Setup/
Super User
Guide
documentation.

Definition Further Reading
Validation | A characteristic of attributes that identifies the format of the See the Validation Rules topic in
Base accepted data for the attribute value, such as whether the the System Setup / Super User
Type value is a date, integer, fraction, text, LOV, etc. Guide documentation.

Definition Further
Reading
Web Ul A web-based interface to access the STEP database in order to read, edit, or | See the Web
download data and assets. Multiple Web Uls can be configured for each User Interfaces
STEP installation. topicin the
Web Ul
documentation.
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Definition Further

Reading

Workbench | An interface for managing data in STEP, as well as carrying out administrative | See the STEP
functions. Workbench Ul
topicin the
Getting Started
/ User Guide
documentation.

Workflow Business process(es) modeled as a series of states and tasks that can be Seethe
executed by users and/or automatic processes within the STEP system. Workflows
Workflows prompt the next step of a process to be started, by either creatinga | documentation.
task for a user, or sending an alert. Workflows may contain a number of
process steps or tasks, as well as business logic.

Workspace | A set of independent ‘copies’ of the database objects that provides a revision- | Seethe

specific view of objects. Workspaces are organized into separate areas Workspaces
including Main and Approved. The Main workspace is where data topicin the
maintenance takes place. The approved workspace is a non-editable System Setup /
snapshot of data that has been determined to have been acceptable for Super User
publishing to downstream systems. Guide
documentation.
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Basic STEP Concepts

This topic introduces the reader to some fundamental STEP concepts that provide a foundation for the rest of the
material in the Getting Started / User guide, as well as the System Setup / Super User guide. The focus of this
topic is on data structures and data management, and is not intended to be an introduction to the full capabilities of
a STEP system.

Object Types Overview

Technically, nearly everything in STEP is an object, and object types must be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different elements
within the system. Nearly every object in STEP is labeled with an object type to help identify whatitis (i.e., a
product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products, product
categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of object types,
system administrators can control how rigid or loosely defined the database will be in terms of object creation and
where objects are allowed to "live" and/or be used. This labeling also becomes very important when working with
exported data so that each type of objectin STEP can be identified for special handling in web applications or
other uses outside of STEP. Object types in STEP can largely be divided into two categories:

« Tree Object Types: Object types that make up the standard STEP hierarchies accessible on the Tree tab in
workbench. Many of these object types can be further grouped into five categories of object types, referred
to as the super types. Tree object types are defined in System Setup, but instances of the object types are
accessed within the Tree.

« System Setup Object Types: Also referred to as Basic Object Types. This category encompasses all of the
remaining object types that make up a STEP system. Among many other things, this includes attributes,
users, integration endpoints, workflows, and business rules. System Setup object types are defined in
System Setup, and instances of the object types are also accessed within System Setup.

More information on object types in general, including how to create and maintain object types, can be found in the
Object Types and Structures section of the System Setup / Super User documentation.

Object Super Types

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon' object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:
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Assets
Classifications
Entities

Products

ok 0N =

Publications

More information on the characteristics of the various super types can be found in the Object Super Types topic
within this guide.

Object Types Versus Object Instances

Two core capabilities for managing data in STEP are the Tree tab and the System Setup tab. In order to
successfully use STEP, itis critical to understand the differences between the functions available in these two
areas, specifically in relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and import
configurations, products, classifications, images, etc. However, the term "objects" is more generally used to mean
assets, classifications, entities, products, and publications. In other words, the super types are also all things that
you can find on the Tree tab in STEP. This section focuses on the differences between object types and object
instances for Tree objects, specifically those that fall into the super types.

For example:
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[ STEP Workflow ” Bookmarks " System Setup " BG Processes ” Search ]

#-{ 7] Assets

r_=| Configurations

-] Web Sites

=1 ] Acme Retail Web Site

=] Apparel

E
E

S|l 18207-012

-] 18214-012

|l 18215-012

|l 18217-012
Lol 18217-054

~[C] Women's Apparel

- 7] Automotive

[-{_~] Building and Electrical Products

vl {Ji] Entity Root

-5 Publications

[I-{IT] Primary Product Hierarchy
E}r_:l Products

+-{I5) Apparel
r_=| Footwear
-5 Safety
r_=| Hardware
r_=| Displays
r_=| Furniture
r_=| Automative
r_=| Building Products
1= Electrical & Electranics
|j Electronic Accessaries
E}Fj Wire & Cable
: E|r_=| Cable
E}- Cable Ttems
- [ 050-42151
El|__=| Cable Sales Items
E-J 7832-200

StiboSystems

MASTER DATA MANAGEMENT

The objects and structures available in the Tree will vary based on your particular data model, but the concepts
described can be applied across any data model. Regardless of the specific names or structures, each node on
the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user can right-click on
many of these objects and have a 'New...' option, such as 'New Product' or 'New Classification’, allowing them to
create a new node in the hierarchy. For example, when right-clicking on the 'Apparel' object and selecting 'New

Product', a dialog appears with an option to create a 'Level 2' object.
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Elr_=| Primary Product Hierarchy Mame
=[5 Products > Iattribute N
[+-{IT) Apparel =
r_=| Footwear % Create Product
i) Safety
[ Hardware | —— _
r_=| Displays ® level 2
r_=| Furniture
r_=| Autometive | ID 114509
r_=| Building Prody
E]r_=| Electrical & Ele
: rj Electronic Create Cancel
=03 Wire &C

Chbject Type

Marne

Typing a Name and clicking Create would create a new object as a child to the Apparel node. But what defines
that a 'Level 2' object can be created on this node? And that it is a Product (blue) object rather than an Entity (gray)
or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in System Setup. To
continue with the above example, we can see that the defined object types and structures include a Primary
Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which can in turn, can
only have a Level 3 child. However, a Level 3 object type can have a number of child object types, including an
Item Folder, Level 4, and a Sales Item Folder. A Sales Item Folder is a child of a Level 3 object type, as mentioned,
but can also be a child to a Level 4. Similarly, a Sales Item can be child to multiple things, including a Sales ltem
Folder and a Sales Item Family.
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System Setup
= Object Types & Structures
rj Alternate Classifications
-- Assets
-3 Basic Object Types
&35 Commerdal Types
[ﬂ‘ Entity uzer-type root
[ Event Queus Object Types
E||__=| Primary Product Classification
i Discontinued Products
iﬁ‘ External Products
i Packaging Hierarchy
r_=| Primary Product Classification
E Product Overrides
E|r_=| Products
EIFj Level 1
E||__=| Level 2
E}Fj Level 3
B Il Item Folder
E} a Item
P Ml Open Item
=N Il [tem Family
= E Ttem
..... . Open Ttem
= r_=| Level 4
- Item Folder
E| ﬁ Ttem
S Wl Open Item
B -Jill Ttem Family

Iélaltem

[ STEP Workflow ” Bookmarks ]m[ BG Processes ” Search ” Tree

E} |__=| Sales Ttem Folder
El ll Sales Item

B I_ Sales Item

[=-[[7] Sales Item Folder
E} l_ Sales Item

I'i'_} 7] SalesItemFamily
= Il Sales Item

..... . Dpen Item

P b | Cpen sales Item
-] SalesItemFamily
..... | Open Sales Item

----- “|_| Open Sales Item

----- I_ Open Sales Item
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The object types defined in System Setup provide the "skeleton" for the allowable instances of objects that can be
created in the Tree. Itis important to understand that it is only the structure and types of objects that are defined in
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System Setup, but any number of instances of the defined types can be created in Tree. This is best illustrated by
viewing System Setup and Tree side by side, as shown below. Object instances are displayed in Tree, with red
text indicating the corresponding object type designations from System Setup.

System Setup

=& Object Types & Structures
[#-[ 7] Alternate Classifications
-- Assets
[+ (¥ Basic Object Types
45 Commercial Types
[ﬁ’ Entity user-type root
@‘ Event Queue Object Types
E}Fj Primary Product Classification
i Discontinued Products
- External Products
i Packaaging Hierarchy
r_=| Primary Product Classification
ﬁ Product Overrides
E|r_=| Products
E}Fj Level 1
E|r_=| Level 2

E}rj Level 3
=- ‘ Item Folder
E E Item
P . Open Ttem
= ‘ Ttem Family

-] Level 4

E} ‘ Item Folder

E Er ﬁ Ttem
P Wl COpen Item
EI ‘ Ttem Family

E} rj Sales Item Folder
EI Il Sales Item
Pobe || Open 5ales Item
Iél 2] SalesTtemFamily
& I_ Sales Item
----- \_ Open Sales Item
[=-771 Sales Item Folder

E|r_=| Primary Product Hierarchy| Primary Product Classification

= Products Products
=T Apparel  Level 1

[ Upper Body Wear Level 2
E1-T T-shirts Level 3
=il T-shirts Items Ttem Folder
. - 88723-12 Item Family
. [#-{ifll Cotton T-Shirts Ttem Family
= |j T-Shirts Sales Items Sales Item Folder
----- Yl 198623 Sales Item
----- w|ll 188409 Sales Item
=[] Head Wear Level 2
(-5 Hats and Caps Level 3
=il Hats and Caps Items Item Folder
-|{® (120170) Ttem
ﬁ (120656)
- | (179653)
- ™ (179864)
- |{# (179866)
E 109308
E Blue Hat
E Blue Hat
ﬁ Gray Hat
ﬁ Industrial Hard Hat
| ski Hat
= E Ski Helmet
..... . (181625) Open Item
[#-[T] Hats and Caps Sales Items - Sales Item Folder

-I-{{7] Footwear Level 1

Elj Shoes Level 2
[T Pumps Level 3

E}- Pumps Items Level 4
=E ‘Heels High: 3" or higher Item Family

----- - 207144 Item
- 207148

Notice in the above screenshots that a Level 2 object exists in System Setup only once, but we see multiple

instances of itin Tree.
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The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For
example, an entity hierarchy could have a Customer object type with allowable children of Address and Contact
object types. The object types and structures are defined in System Setup, and instances of these objects can then

be created in Tree.

System Setup

=13 Object Types & Structures
[+ ] Alternate Classifications
-- Assets
-z Basic Object Types
- $5) Commerdal Types
E}IE‘ Entity user-type root
. =i Entity Root

E}% All Customers
. B8 customer

-4} Address

{8 Contact

=I-{jiil Entity Root

L—__}% lestorner I-ierard’11,r|

= 8 Customer A

'ﬁ Axel Kiers Vej 11

Jesper Jensen

=~ 2 Customer B

-4} 3550 George Busbee Plwy

Johin Smith

----- 8 Customer C

Note that object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy
(blue hierarchy) can only contain object types of the product super type, while an entity hierarchy (gray hierarchy)
can only contain objects of the entity super type. It is possible to have the visual appearance of mixed hierarchies,
but this is accomplished via references rather than actual data structures. For example, products may appear in
the Tree to be within a classification hierarchy, but this is due to references on the object, as shown below.

Tree
[=-[ 5] Merchandising Hierarchy
=+ 7] Apparel
E|r_=| Sportswear
=[] T-shirts
= Tshirts
| 18217054
| 18214012
|l 18215012
| 18217012
[#-[ 7] Automative
[+-[ ] Beverages
(&[] Footwear
[+ 7] Suppliers
[=-{7] Web Sites
=[] Acme Retail Web Site
E|r_=| Apparel

|| 18207012
il 18214012

18207-012 rev.0.2 - References

Commercial [m Category Prafile
| Product ” Sub Products
Cr Discontinued Product Maintenance
- Image References
Cr Item References, Classification
§ Sales Item References, Classification
Reference Type v| » [Target ¥
Merchandising Link  + ',lﬁ [ ~| Merchandising Hierarchy /Apparel/Sportswear T-shirts r
Website Link + [ 7] Web Sites/Acme Retail Web Site /Apparel/Mens Casual/T-shirts and Sweatshirts ™
2 Sales Item References, Product
& Ungrouped Classification Links
r Index Words
&~ Publications
- Linked Attributes from Product Hierarchy
r Linked Attributes from Classification Hierarchy

Tasks

Referenced By ”

Images & C

e

e
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Notice that the corresponding System Setup structure for the above does not include the product object types.

System Setup

E]r_= Merchandising Hierarchy Foot
: E}r_: Department

|':“|1'_= SubDepartment
|': MerchandisingClass
|';“|1'_= Web Hierarchy Root
=[] Website Root

=-{T] Web Level 1

E}r: Web Level 2

The true residence of the product objects is within the Primary Product Classification, with a visual display of the
product references into various classification hierarchies being just that: a visual display of references. However,
assets are an exception to this concept. Assets are not part of the Classification structure in System Setup, but do
in fact exist within this structure in Tree. Each asset must be linked in to one or more classifications, and this is the
only location in which they "live" in STEP. Each asset automatically has a reference applied to each classification
in whichitis linked. More information on references can be found in the Reference and Link Types topicin the
System Setup / Super User guide. More information on the various object super types and their characteristics
can be found in the Object Super Types topic within this guide.

Using the above information, the questions posed earlier in this topic can now be answered:

Why can we only create a Level 2 object under the Apparel node? Because in this particular data model
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be created
under a Level 1 object type.

Why can't we create an Entity or Classification under the Apparel node? Because only object types within the
same super type can exist within the same hierarchy. And even if this wasn't the case, the structure defined in
System Setup in this particular hierarchy only allows a Level 2 object type (of the product super type) under a Level
1 object type.
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Object Super Types

This topic provides an introduction to the STEP object super types. It will be helpful to have read and understood
the Basic STEP Concepts topic in this guide prior to reading this material.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in workbench are referred to
as Tree Object Types. Many of these object types can be further grouped into five categories of object types,
referred to as the super types. This topic introduces the five primary object super types in STEP. Understanding
the differences between the various object super types is important when making decisions about how to model
datain STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon' object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:

Assets
Classifications
Entities

Products

o 0D =

Publications

Each is described below, along with links to more detailed information for working with the various super types.

Assets

The Asset super type is used to hold any type of digital media, including images, videos, documents, and text files.
Assets are organized within classifications, and can be linked to other objects in STEP using references.
Specifically, assets can be linked to objects of the Classification, Entity, or Product object super types. Upon
import, STEP populates some basic information about each asset, which can be viewed under the System
Properties flipper on each asset, but cannot be edited. Default asset icons vary by file type, and can be updated by
admin users.
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NEW! rev.1.1 - Images & Documents

(GO [ | References || Referenced By || Status || State Log || Tasks

7] Assets
E EE Name Value »
i 'j ProductFolderIcon
1] ruck ID 111684
[T Tlustrations Mame MEW!
[+ 7] Installation Manuals > Dbject Type Product Image
G"Ij Logos * Hevisi 1.1 Last edited by USER4 on Fri Aug 19 14:42: 18 EOT 2016
F-[] MSDS Sheets evision .1Last edited by on Fri Aug 142
[+-[ 7] Owners Manual Approved x Mever Been Approved
[+ 7] Product Images » Translation Mot Translated
= Product Yid
[Pro u. oees » Path Classification 1 root/Assets,Tcons/NEW!
[#-[ 7] Configurations
-~ ETIM Hierarchy § System Properties:
-7 Index Words Mame Value »
[+-{ 7] Merchandising Hierarchy s Gamma 0.45
[+-[ 7] Suppliers 5 Class Indexed color
[+-[ 7] Web Sites > Colors 16
[]i Er'ltlt!f Root 3 Calnrspace RGB
[]ﬁ Publications ¥ Ccmpressjcn ap
[#)-{[5) Primary Product Hierarchy |5 pengy 1 (bits/sample)
-(;5 Collecti
g g E;l ons > Extension png
5 ﬁ; @ dug; * Filename MEW!.png
ECyde Bin » Format ¢ PNG (Portable Metwork Graphics image)
> Height 231.47 (mm)
> MIME Type mage/pna
* Pinel Height 1 B56 (pixels)
» Pinel Width 11 657 (pixels)
» Gamples 4 3 (samples/pixel)

For more information on working with assets, see the Assets topic within this guide.

Classifications

The Classification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these icons may be updated by
an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored in
appropriate subfolders under the 'Assets' classification folder. Product objects could also be linked into
classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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Tlustrations

..... | Pens
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----- i STEPReferencesTab
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H-[—] MSDS Sheets

H-[—] Owners Manual
H-[—] Product Images
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-7 Classifications

[#-[7] Configurations

r_=| Index Words

E|r_=| Merchandising Hierarchy

|'_‘=| Apparel
E}Fj Automotive
=) Tires

Classification

Assets rev.0.4 - Classification

Referenced By || Images & Documents || Tables || Status || State Log || Tasks
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” References

» D

* Mame

» Object Type

* Revision

0.4 Last edited by USER on Fri Dec 04 17:40:33 EST 2015

* |Approved

f Approved on Fri Dec 04 17:40:33 EST 2015

» [Translation

Mot Translated

» Path

Classification 1 root/Assets

> Misibility

> Purpose

abo

(=[] Tire Accessories

P N F4on ne En

For more information on working with classifications, see the Classifications topic in this guide.

Entities

The Entity super type is used to create hierarchies and objects that do not require inheritance of data through
categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to store
reference data. In addition, entities are used to store source data for golden records. Entities are represented by
gray folders and white and gray cubes by default, but these can be updated by an admin user, as is evident in the
screenshot below.
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E-{ 7] Assets

r_=| Configurations
r_=| ETIM Hierarchy
r_=| Index Words

r_=| Merchandising Hierarchy

r_=| Suppliers

Web Sites

=i Entity Root

E}% Customer Hierarchy

E]g Customer A

£ Axel Kiers Vej 11

Jesper Jensen

=l g Customer B

>’:} 3550 George Busbee Plwy
John Smith

----- 2 Customer C
~oh Key Accounts

For more information on working with entities, see the Entities section of this guide.

Products

StiboSystems

MASTER DATA MANAGEMENT

The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy are
often categories and subcategories, with leaf nodes being actual objects. Whether an organizational folder,
sellable object, or something else, each node in the hierarchy is of the product super type, and all child objects are

able to inherit attributes and values from parental objects.
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For more information on working with products, see the Products section of this guide.

#-[ 7] Assets

r_=| Configurations
r_=| ETIM Hierarchy
r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

- 7] Web Sites

- i Entity Root

-8 Publications

[=I-[IT] Primary Product Hierarchy

E}|‘_=| Products

[+-{I5) Apparel

r_=| Footwear

r_=| Safety

r_=| Hardware

r_=| Displays

|_—‘_|r_=| Furniture

=11 Bedroom
E|r_=| Beds

=}l Beds Items

--|'=| Beds Sales Items

-a Comfy Footboard
----- a Comfy Headboard
a Comfy Side Rail

Publications

The Publication super type is used to create hierarchies and objects used for print publishing solutions, including
STEP'n'design, Flatplanner, and AutoPage. Publication objects are used to create templates used in print
solutions, as well as publications such as catalogs or pamphlets. Product objects can be linked into publication
hierarchies, meaning data from the product(s) will be reflected in the publication. Publication objects use green

icons by default, though these can be updated by an admin user.
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T T——

Eﬁ Publications A ||| AukoPage Publication Planner || Pagination Rules || Page Inspector || Status || State Log || Tasks
ﬁ Templates Publication Section l Plan ” Publication Planner " Plan Mokes " Financial Summary l
E}--ﬁ Autopage Publications ® —

=@ Acme Wholesale Clathing I
. > > -
% Commerdial Data Hame Value
--i Caps and Hats » D 111845
"i Shirts * Name Shirts
- [E5) Shoes ) :
: * Object T Section
- 20714 R
..... ﬁ 20695 * Revision 0.2 Last edited by USER4 on Mon Aug 29 11:40:21 EDT 2016
l EJ OTP Documents » Path Fublications/Autopage Publications/Acme Wholesale Clothing/Shirts
- @ Jewelry » Start section on page 2
[+ ER Accessories . —
&5 Gloves > Fffective Date
- [l Beta Tools » Expiration Date
% Commerdial Data » Section Theme abe Shirts
[+ &5 Power Tools
: » Circulati 123
[+ &5 Hand Tools reviation
- [l Toolboxes » Cover Photo Shot Due
[+ @ Garden Tools » FirstPageNumber £
E}-ﬁ Standard Publications > LastPageNumber &0
f+- & Flatplanner Publications o

For more information on working with publication objects, see the Publication Hierarchy section of the STEP
Publisher (InDesign) documentation.
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Accessing STEP System Information

The simplest way to access system information about your STEP installation is by clicking the About STEP icon
on the Start Page.

About STEP

STEP system information is useful for system troubleshooting and new project planning, as well as helping users
ensure compliance with their contracted license terms.

Though system information is also obtainable through the Admin Portal install.log or by running a Stibo Patch
Operations Tool (SPOT) command on the application server, clicking About STEP is the most straightforward way
to obtain this information. For more information on the install.log, see the Logs topic in the Administration Portal
documentation. For information on the SPOT command, system administrators may contact Stibo Systems.

‘About STEP' Page

When the About STEP icon is clicked, a new page is opened (e.g., http://[yoursystem]/about/step) that is
password protected to ensure that only STEP users have access to the information.

This 'about’ page displays the following information:

« System name

« STEP version, in a string that identifies the system by its baseline version that includes the major release
version number (e.g., 8); minor release number (e.g., .2); the maintenance patch version, if applicable (e.g.,
mp1); and the baseline creation date.

« Number of user accounts and the number of allowed user accounts. Standard STEP users that do not count

against the number of licensed users—such as DBA, STEPSYS, SERVICE, and SWADMIN—are not
included in the user count.

« The approximate number of products, classifications, assets, and entities. Object counts are approximate
because changes could be going on in the background while the page is being viewed. Also, for time purposes,
the quick approximation number is preferable to an exact count, which could potentially tie up system
resources for a prolonged time.

« The number of contexts, dimensions, and languages
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STEP*

Trailblazer by StiboSystems

+ System name: doc-dev
+ STEP version: step-trailblazer-8.2-2017-06-21-11-08-05

+ Detailed version information

+ Number of user accounts: 56

+ Allowed number of user accounts: 300

+ Number of products (approx.): 1000

+ MNumber of classifications (approx.): 200000
+ Number of assets (approx.): 400

+ Number of entities (approx.): 10000

+ Number of contexts: 13

* Number of dimensions: 2

+ Number of languages: 13

The full version information of this system is available via snapshot spr file,
please submit this file along with any support requests.

If you are having any problems with the STEP system, please produce a
diagnostics package instead. This can be done via the Administration page.

Detailed Version Information

A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g. http://
[yoursystem]/about/version) where you can access information about the add-on components, customizations,
and hotfixes applied to your system. If your system contains none of these, only the current baseline version of the
systemis displayed.
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STEP* =

Trailblazer by StiboSystems

+ Baseline version: step-trailblazer-8.2-2017-06-21-11-08-05
+ Add-on components: toolbox-db-7.0.29

user-businessrule-api-1.0.0

Back

System Snapshot and Diagnostics Package Links

Below the bullet list, additional information is provided to assist users who need to access more complete system
information for support purposes.

Provided is a snapshot.spr link where you can download a snapshot file that contains full system information,
including installed bundles, metrics, and differences to previous snapshots. This file is intended to be submitted to
Stibo Systems along with support requests. For more information on snapshots and their contents, see the Tools
topic in the Administration Portal documentation.

Also included is a link to the Administration Portal page, in case you need to produce a diagnostics package. This
package is generated and uploaded to Stibo Systems from the 'Send Diagnostics' tab. For more information, see
the Send Diagnostics topic in the Administration Portal documentation
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STEP Workbench Ul

The screenshot below shows a basic view of the STEP Workbench. Though system customizations and variable
access permissions may result in a slightly different view, the basic elements in this view of the workbench's Main
Window will be present for most users. The key elements of workbench Ul are numbered and defined below.

Important: A one-time install of the STEP Workbench Launcher needs to be done on each client workstation
before opening workbench. STEP Workbench users do not need Java installed separately on their computers.
After installation, the workbench will launch via conventional means. For details and directions, click on the
Workbench Launchers icon, accessible on the Start Page.

b#4 Context |English US

[#-{ ]| Assets
r_=| Configurations

{12y Index Words

@ Publications

r_=| Primary Product Hierarchy
@ Collections

--- eCatalogs

Search

e Mo Object is Selected

C @ @ O

[ STEF Workflow " Bookmarks [ Syskem Setup " BG Processes ]

D @i
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Note: The STEP Workbench is a Java client. STEP's backend is AdoptOpenJDK.

10.

11.

12.

. The Menu Bar contains a collection of various tools for users to perform actions in the workbench. For more

information, see the Menu Items topic in this documentation.

The Toolbar contains actions that help with the view and navigation of the workbench. For more information,
see the Toolbar topic in this documentation.

The Tree tab navigates users to the object tree in the workbench. For more information, see the Tree Tab topic
in this documentation.

The Search tab provides access to the advanced search functionality of the workbench where users can filter
results, save these results as a collection, export these results for external use, or perform bulk updates on
these results. For more information, see the Search Tab topic in this documentation.

The BG Processes tab contains all of the background processes occurring in the STEP instance. For more
information, see the Background Process Tab topic in this documenta tion.

The System Setup tab contains all of the administrative actions to set up the workbench to maintain data. For
more information, see the System Setup Tab topic in this documentation.

The Bookmarks tab contains all of the bookmarks that are saved by the user. For more information, see the
Bookmarks Tab topic in this documentation.

The STEP Workflow tab contains all of the workflows currently associated with STEP. The toggles can be
flipped to show the states associated with each workflow. For more information, see the STEP Workflow topic
of this documentation.

Selecting an object in the workbench populates the Object Editor pane with fields and actions based on
associated permissions and validity for the selected object. For more information, including the hide (E4) and

show () buttons, see the Object Editor topic in this documentation.

System Information. At the very top of the STEP window, important information about the user's STEP
system is listed. The first element displayed is the name of the STEP system, then the user ID, followed by the
URL of the STEP system being accessed.

Thumbtack - The default is unpinned (&), but allows users to pin (f£) the right-hand side of the window.

Once pinned, a user may navigate to other items in the Tree while the information in the right side of the screen
remain unchanged. One such use case can be seen with adding objects to the Flatplanner basket. To see this
example, see the Adding Objects Manually to the Basket topic in the Flatplanner documentation.

STEP connection status displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

« Reading. STEP is requesting information from the database.
« Lost Connection to. STEP has lost connection to the server.

« Reconnected to. STEP has reconnected to the server after a lost connection. May alternate with the Lost
Connection to status if the connection to the internet is lost for a significant period of time.
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13. Connection strength is a small graph illustrating the connection strength between the user and the server,
also know as the 'Network Latency.' If a user hovers their cursor over the graph, a hover-over display will
appear showing how fast data is traveling between the server and the user as measured in milliseconds.
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Background Processes Tab

The Background Processes tab shows all active and non-active processes in STEP. Each time there is any activity
such as imports, exports, bulk-update, creating collections, etc, there is a background processes, BGP, which
generates the logs and lets the users know if the process was successful. In the event of an unsuccessful
background process, an error message is displayed showing the reason for failure.
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565 [100703, en-US > German, Tue Jul 05 13:53:00 +0530 2016]
é:% M_Level1180971, enJ5 = fr, Tue Jul 05 15:26:00 +0530 2016

100703, en-US > German, Tue Jul 05 101

'? Properties

(-& Translation
% Queued Processes Praperty » Value
E}--% Active Processes
' . |started by USER1
%:% M_Item 180937, en-US = Danish, Tue Jul 05 12:44:23 +0530 20,
48 M_Item 180570, en-US > fr, Tue Jul 05 12:52:36 0530 2015 |Id BGP_130963
%‘:’% M_Level2130569, en-US = Hebrew, Tue Jul 05 13:06:52 +0530 | Description 100703, enUS > German, Tue Jul 05 13:53:00 +0530 2016

Execution Server

doc-dev

4% 130247, UK Engish > fr, Tue Jun 28 19:05:08 40530 2015 | rodress [ ] 0%
-4 180247, UK English > German, Tue Jun 28 19:09:09 40530 201¢| Status failed
%ﬁé 180247, UK English = fr, Tue Jun 28 20:37:10 +0530 2015 Created Tue Jul 05 04:23:01 EDT 2016
%:% 100703, en-Us5 > Danish, Wed Jun 29 09:44:09 +0530 2016 - |
485 100703, en-US > Hebrew, Wed Jun 29 09:44:11 40530 2016 [P0t e e
-485 100703, enJS > German, Wed Jun 29 03:44:11 40530 2016 | Finished Tue Jul 05 04:23:17 EDT 2016
-4 100703, enJ5 > fr, Wed Jun 28 09:44:10 +0530 2015 Processing Time Om32s
é:% 100703, en-U5 = UK English, Wed Jun 29 09:44: 11 +0530 2016 )

) Time in Queus Om14s
%ﬁ% List,xlsx, en-US = fr, Wed Jun 29 09:50:57 +0530 2014
48 List.xisx, en-US » Hebrew, Wed Jun 29 09:50:58 +0530 2016 | # of warnings 0
%ﬁé List.xlsx, en-US = German, Wed Jun 29 03:50:57 40530 2016 |/# of errors ]

%:% 180246, en-Us > German, Wed Jun 29 10:13:54 +0530 2016

Execution Report
%:% 180551, en-Us » fr, Wed Jun 29 10:42:23 +0530 2016 i
%t:% M_Item 180570, en-US 3 German, Wed Jun 29 13:17:21 +0530 | Analyse
%l:i? 180575, en-Us > fr, Wed Jun 29 13:30:18 +0530 2016 Logged on

s M_Ttem 180570, en-US > fr, Wed Jun 29 14:27:31 +0530 2016
%ﬁ% 18202, en-J5 = fr, Wed Jun 29 16:46:00 EOT 2016

%ﬁ% Product hierarchy root, en-J5 > German, Wed Jun 29 16:51:00
%ﬁé Product hierarchy root, en-J3 > Hebrew, Wed Jun 29 16:51:00
48 M_Ttem 180570, en-US > fr, Thu Jun 30 14:09:42 40530 2016
% M_Item 180570, en-US = German, Thu Jun 30 14:32:17 +0530 2
%t:% 100703, en-U5 = Danish, Thu Jun 30 19:00:20 +0530 2016
%ﬁé 100703, en-U5 = Danish, Thu Jun 30 19:03:06 +0530 2016
s M_Ttem 180571, en-US > fr, Fri Jul 0109:40:21 +0530 2016
46 M_Ttem 180571, en-US > fr, Fri Jul 01 09:48:39 +0530 2016
4 M Ttem180571, endls > GE",”E”‘ F,r' JulB1 10:15:55 40530 201 Xml for translation: exceltranslation BGP_180963.zip
%ﬁé M_Item180571, en-US = Danish, Fri Jul 01 10:24:04 +0530 201¢

48 M_Ttem 180570, en-US > UK Englsh, Fri Jul 01 10:37:47 #0530~ |reneiaion Export Completed
48 M_Item 180571, en-US > Hebrew, Fri Jul 01 11:59:36 +0530 20: |1+ Export failed with exception: Optimistic locking errors were detected wta

% M_Item 180571, en-US = Danish, Fri Jul 01 12:12:27 +0530 201¢ [ 1% Caught OptimisticVerificationException at Tue Jul 05 04:23:17 EDT 2y er

Analyzing translation request

Analysis selected 1 out of 1 nodes for translation

Leaving query service

Root node was specified. Will wait for user to accept analysis result
Parsed translation configuration

Logged on

LIpdating translation status

1 nodes will be exported for translation

Registering pending translation file “100703-100703.x15x¢

The Background Process tab contains:

« Properties describes who has started the Background Process, unique identifier (BGP ID — Auto generated),
describes what kind of BGP was performed, such as export or import or bulk update etc., statuses of the BGP
such as 'Succeeded' or 'Failed,' BGP creation date and time, BGP start dated and time, BGP end dated and
time, the amount of time taken to process the request, number of warnings, and number of error messages.
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« Execution Report is a detailed user-friendly BGP information report. If the process failed, then it displays a
short message about why this is failed.

' Execution Re

H 4l 1-9ofs [k e SEVE... Truncate

« Save - Itis possible to download the execution report. Click on the 'Save' button, 'Save File' window appears.
Browse to where you want to download the file and give it a file name.

Savein: | [Z| Documents A ? t ,

< >
File name: exported. xls
Files of type: | All Files e Cancel

« Truncate - This button will be available only on 'Ended Processes' section of the BGP.

This action is used when there are lot of logs or lines under the execution report, and if a user wants to view any
particular information, such as an error or warning. The user can truncate the logs accordingly by setting the
parameters in the 'Truncate execution report' dialog.

32 Truncate execution report

Mumber of lines to retain |19

Execution report entry types to delete

[]Errar
Info
Warning

Ok Cancel

For example, if the execution report has 50 lines, and a user wants to see only 19 lines among the report that are
error related.

Number of lines to retain: 19
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Execution report entry types to delete: Enable check box for 'Info' & 'Warning'
Click on 'OK" button

Result: This will truncate the execution report and retain only the first 19 error lines.

Note: Once the lines are removed, they cannot be recovered again.

Based on the type of activity being generated, there are many different kinds of background processes. A few are
mentioned below:

Approve recursively
Bulk Update

Create Collection
Download Report
Export Manager Pipeline
Import Manager Pipeline
Purge Revisions

Revive Recursively

© © N o gk~ 0 DN =

Translation

—_—
e

Translation Import

Background Process View Options

In the Background process tab, there are two option for viewing BGPs. A user logged in can choose to see only
the BGPs that they have initiated, or the user could choose to see all the BGPs run by everyone. These two
options can be selected by clicking on either the 'One Man and Gear' button or the 'Two Men and Gear' button.

BG Processes

[+-£55) AddItemsToCollection -
‘1'.':5_7 Analyze Change-Padkage

[F-455 Approve Recursively

[+]-£ Asset Integrity check

-4 AssetDelivery

[H-£:5 Autopage Batch Service

-4 BGPTest

f.r?'_—l Bulk Update

-5 Category Profile Batch Processes

- =

m

BG Processes

One Man and Gear: Thisicon, , will display the background process run by the user who has logged into the
STEP system.
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Two Men and Gear: This icon, , will display the background process run by all users of the STEP system. To
have this privilege available, the 'View Background Processes of Other Users' setup action must be added for the
users who need access to this feature. For information on privileges, see the Setup Actions topicin the System
Setup / Super User Guide documentation.

Background Process States

Fore each background process started, there are four states that it could enter. Below each state is described in
detail:

Active Process

This shows the list of processes which are currently being executed. If there are any processes which failed, then
those processes will still be in the active process node, but highlighted in Red color.

BG Processes {18202, en-US > fr, Wed Jun 29 16:46:00 EDT 2016 - Background Process -

Background Process |WeNEICR0I
E’:B;h Translation §' Properties
% Queued Processes Property » |Value 4
1+ Active Processes Started by USER]
500 180246, en-US = fr, Tue Jun 21 15:57:37 +0530 201€
A 19024, ends > , Tue - 1 RGP_180588
% 180247, en-US = UK English, Wed Jun 22 14:35:10 +
% 180247, UK English » German, Wed Jun 22 14:33:49 - Description 18202, enJ5 > ﬁ'; Wed Jun 29 16:46:00 EDT 2016
% 179762, UK English = fr, Man Jun 27 15:42:43 +0530 | Execution Server doc-dev
%E% 179808, UK English = fr, Mon Jun 27 19:36:19 40530 Progress i 0%
% 180247, UK English = fr, Tue Jun 28 19:05:08 +0530 =
Statu
4% 100703, en-US » German, Tue Jul 05 13:53:00 +0530 | i
-0k M_Level 1180971, en-US > fr, Tue Jul 05 15:26:00 +0! | Created Wed Jun 29 16:46:00 EDT 2016
%i% 100703, en-US = DanishI Wed Jun 29 09:44:09 +053( Started Wed Jun 29 16:46:05 EDT 2016
% 100703, en-US = Hebrew, Wed Jun 29 09:44: 11 +052 —— e ———
4% 100703, en-US > German, Wed Jun 29 08:44:11 4053 | £ &= Tt
-4 100703, en-US > fr, Wed Jun 29 09:44:10 40530 201 |Processing Time Om0s
%E% 100703, enUS = LK English, Wed Jun 29 09:44:11 +{ |T|me in Queue Om5s
% List, xlsx, en-US = fr, Wed Jun 29 09:50:57 +0530 20: || i
# of warnings 0
%:'% List, xlsx, en-US = Hebrew, Wed Jun 29 09:50:58 +05
48 List.xlsx, en-US > German, Wed Jun 29 09:50:57 405 |# of errors 0

%:% 180248, en-UJS = German, Wed Jun 29 10:13:54 +05: & Execution Report
%E% 180561, en-US = fr, Wed Jun 29 10:42:23 +0530 201
468 M_Ttem 180570, en-US » German, Wed Jun 29 13:17:;| ' Analyse

% 180575, en-US = fr, Wed Jun 29 13:30:18 +0530 201 Logged on

%E% M_Item 180570, en-US = fr, Wed Jun 29 14:27:31 40 Analyzing translation request

45 [18202, en U3 > r, Wed Jun 23 16:46:00 EDT 2016] Analysis selected 1 out of 36 nodes for franslation
%:'% Product hierarchy root, en-US » German, Wed Jun 29 Leaving query senice

4 Productierarchy root, en-15 > Hebrew, Wed Jn 29 Root node was specified. Will wait for user to accept analysis result
%:% M_Item180570, en-U5 = fr, Thu Jun 30 14:09:42 405

% M_Item180570, en-U5 = German, Thu Jun 30 14:32:1
1| ) i | } H 4 | 16ofs b [ Save.., Truncate
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This shows the list of processes which are in queue. Once the active processes are complete, the queued process

moves to the active process.

p#4 Context |English US

BG Processes

8 | [] 8

]

i MultipleRevive

T

'

'

| g O ey ey S o |

7_“' PageDone

[1]

-
—

F| J":, ModeListToCollection
H :5 POF of planned page
|
-1

e Scheduled Processes

E}% Queued Processes
. L.48% scheduled Bulk Update (every mon at 11:04, star

!

BG Processes

Completed with Errors

@ Active Processes
% Ended Processes

This shows a list of processes which are completed, but with a few errors. The minor errors are displayed with the

details, but the one’s which can be processed will eventually complete.

Note: 'Completed with Errors' option is only available for Import manager pipeline, Smartsheet Import, Stateflow

dead line, and Match code process.

p#4 Context |English US

BG Processes

s | [3] 8
.l

+]- &l ISOStrict

[l]i?:l Impart Manager Fipeline

Active Processes

-
[}
mlo % Queued Processes
[Fal

BG Processes

ﬂ% Importing

EI% Completed with Errors

5
)
g

>
&

é:'% Web UL simple data import
..425 Web UI simple data import

Setup

--@ Ended Processes

Ready
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Ended Process

This displays a full list of all the processes which have been processed without any errors.

BG Processes Activating: Key 4 - Background Process

__% Ackive Progesses Execution Server doc-dev
- Ended Processes Progress
[—]% Unigue Key Processes Status succeeded
% Queued Processes Created Tue Jul 19 08:31:32 EDT 2016
% Active Processes
E}% Ended Processes Started Tue Jul 19 08:31:32 EOT 2016
éﬁé Activating: Key 4 Finished Tue Jul 19 08:31:32 EOT 2016
¢ Deactivating: Key 4 Processing Time Om0s
=14 Unlink Object Type :
% Queued Processes Time in Queue OmOs
% Active Processes # of warnings 0
% Ended Processes # of errors 0
EI--% lUpdate actual page from plan :
% Queued Processes  Execution Report
% Active Processes Start calculating keys for activating unigue key with ID Key 4. (Tue Jul 19 08:31:32 EDT 201
{5 Ended Processes For 0 objects in object types: (Tue Jul 19 08:31:32 EDT 2016)
EI--% UploadDTPDocument . -
Using template "null”. {Tue Jul 18 08:31:32 EDT 2016)
% Queued Processes ) o ] s
% Active Processes Synchronized. Activation continues. (Tue Jul 19 08:31:32 EDT 2016)
% Ended Processes Waiting to enter single-update-mode to activate unigue key. (Tue Jul 19 08:31:32 EDT 201
[_]% Web UI Asset Pipeline Download Got single-update-mode - looking for duplicates. (Tue Jul 19 08:31:32 EDT 2016)
% Queued Processes Mo duplicates - activating unigue key with 1D Key 4. (Tue Jul 19 08:31:32 EDT 2016)
Pollg. . .- - - P - . . - . . e e—m - - - .. . —_ e -

For information on Background Process Queues, see the Background Processes and Queues topicin the
System Setup / Super User Guide documentation.
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Bookmarks Tab

The Bookmarks tab allows users to set bookmarks for any objects in the Tree and allows users to easily access
these objects without having to search or navigate the Tree.

A bookmark is a Uniform Resource Identifier (URI) that is stored to provide the user with a quick method of
retrieving the data at any time. Bookmarks may be accessed either by the menu selection Navigation >
Bookmarks or by the Bookmark tab.

File Edit View Mavigate Format Maintain Window Help

@ Search Ctrl+F
Search Below -
> Goto Ctrl+G
Goto Mext Ctrl+E
4 Back
< Forward
"]
- Bocokmarks 5 ﬂ
g
= 0 Find Similar Product

Bookmarks

21 Brand Logos (BrandLogos)

&4 Endcap Displays (22177)

5 Copy Writing State (100400}

(21 Export Configurations (stibo. EMConfigFolder)

W[ Syskem Setup ” Bi5 Processes ” Search " Tree
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Note:
« Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from a
different computer.

« Bookmarks allow the setting of bookmarks specific to individual users —just as in a web browser. This means
that one user will not be able to view the bookmarks created by another user.

To know more about the Bookmarks and maintaining Bookmarks, see the Bookmarks topic in the Navigation
and Searches documentation.
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Adding a Bookmark

Standard navigation Bookmarks are used to quickly access specific nodes in the Tree and System Setup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or System

Setup hierarchies can be added with the usage of Bookmarks functionality.

To save an object as a Standard Navigation Bookmark:

1. InTree, select the item to be bookmarked.

Tree

(2] ” Search ]

B5 Processes

2. Onthe Navigate menu, select Bookmark > Add Bookmark.

-] Assets

r_=| Configurations
r_=| Index Words

r_=| Merchandising Hierarchy

r_=| suppliers

[-[7) Web Sites

+I-Jjiij Entity Root

E Publications

E|r_=| Primary Product Hierarchy
; E}Fj Products

= 0 opare]
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File Edit 9 Mavigate Format Maintain Window Help
=

@ Search Ctrl+F e g 6

[ Ass > Goto Ctrl+G m sub Proc

r_=| Conl Goto Mext Ctrl+E % Description

Conte

| E-ES eck
'.C% r_=| e € Back Name
b "EI Inde < Forward » D
— " T % hlama
% -- Bookmarks :[¥ Add Bookmark Ctrl+D |
g r_=| = o A Add Search Bookmark i
& E-0 Ad Find Similar Product i
@ [0 Customer Root * |Approved
T -0 Customers » [Translation
=] 1
2 (O] Entity Root s bath
‘Y| &) GDsN
= ﬁ Publications » Default InDesign ter
A E|1'_=| Primary Product Hierarchy » Completeness Score
~— | &7 Products -
i) Ij 2 Category Spedfic At
= EI r_=| Apparel o
E' . [ Upper Body Wear Attribute Group
2 [+-[[T) Head Wear - Display

Note: Notice that the existing bookmarks are displayed on the menu.

3. The new bookmark is displayed on the Bookmarks tab.

Bookmarks

(51 Brand Logos (BrandLogos)
&¢ Endcap Displays (22177)
= Copy Writing State (100100}

() Export Confiqurations (stibo. EMConfigFalder)

Note: The Standard Navigation Bookmark is saved under the Bookmark Tab. The bookmark is represented with
the product icon and automatically labeled with the product name and ID in parenthesis.

4. Click the new bookmark.
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21 Brand Logos (BrandLogaos)

&2 Endcap Displays (22177)

= Copy Writing State (100100}

[0 Export Configurations (stibo. EMConfigFolder)
@ Apparel (18200) i———

5. Navigate to the Bookmarks main tab, and go to the Product subtask on an object to view the bookmark data.

Bookmarks Apparel rev.0.3 - Product

g (5 Brand Logos (BrandLogos) Tables || Category Profile || Status || State Log || Tasks

F1|d Endcap Displays (22177) Product [ Sub Products ” References " Referenced By ” Images & Documents }

~— [ Caopy Writing State (100100} 9

§ (31 Export Configurations (stibo. EMConfigFolder)

| Apparel (13200) Name >(> value >

—] > D 13200

=)

o > MName Apparep

i ¥ Object Type Levell

[¥]

E, » Revision 0.3 Last edited by USER on Thu Jul 30 11:...

& * {Approved x Last Approved on Thu May 21 14:58:...

: » Translation Mot Translated

3

* » Path Primary Product Hierarchy Products /&pparel

E )

% » City ahe

1 * Country abe

n » Efate abe

=

9 » Bireet abe

E

= .
-3 12

g : :
® SolesltemMarketng Descrptors

z Mame ¥ ¥ |Value ¥

% * Description, Long abe

=

2 @ MwbuteGow

A Name ¥ ¥ Walue »
> bz #

Bookmarks can also be created using a shortcut. Select the object and press Ctrl+D. The bookmark is created
automatically.
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Removing a Bookmark

After saving a Bookmark, it may no longer be needed eventually. There is a right-click menu option that can
remove a selected bookmark.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click Remove Bookmark.

21 Brand Logos (BrandLogos)
21 Export Configurations (stibo. EMConfigFolder)
8 Copy Writing MH0n400

ia Apparel (182 Edit Bookmark

| Remove Bookmark |

Copy To Clipboard

2. The selected bookmark is removed.

Bookmarks

21 Brand Logos (BrandLogos)
21 Export Configurations (stibo. EMConfigFolder)
= Copy Writing State (100100)

Note:

« No confirmation window before removing will be displayed.

« Bookmarks can only be removed and not deleted. If user deletes a bookmark (Maintain menu > Delete), then
the object will be deleted. However, the deleted object could be found in Recycle bin.
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Editing a Bookmark

Both Standard Navigation (the link to specific objects) and Search Bookmarks may be edited in the
Bookmarks tab. To edit a bookmark:

1. Onthe Bookmarks tab, right-click the bookmark to be modified and click 'Edit Bookmark.'

Bookmarks
S Brane _— -
31 Expo Edit Bookmark ronfigFolder)
@ Copy Remove Bookmark
© Appa Copy To Clipboard

2. Ifdesired, change the name of the Bookmark then select 'OK.'

3! Edit Bookmark

Mame |Primary Brand Logos (BrandLogos)
URL  |step: //dassification?editor =Classification&versionid=111511&cont

] Edit URL

QK Cancel

3. The name will be updated in the Bookmarks tab.

Bookmarks

& rand Logos (BrandLogos)

kg Endcap Displays (22177)

=5 Copy Writing State (100100

£ Export Configurations (stibo. EMCaonfigFalder)

4. The object URL can be edited only if the Edit URL checkbox is activated. In the below screenshot, the Product
URL has been modified which points to a new Product URL —
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3! Edit Bookmark

Mame | Apparel (18200)

Edit URL

Ok

URL  |step: /fproduct?editor =Product&versionid=111511&contextid=Con

Cancel

StiboSystems
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Similarly, 'Search Bookmark' can be edited by editing the 'Search URL,' if the 'Edit URL' checkbox is edited.

5. Click the 'OK' button to save any changes to this bookmark.
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Copying a Bookmark to the Clipboard

Bookmarks are direct addresses to a specific object, such as a product, entity, or publication, in STEP. These
bookmarks can be shared to other users by copying the bookmark to the clipboard, and then pasting this
bookmark to a shareable medium.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click 'Copy to Clipboard.'

Bookmarks

21 Brand Logos (BrandLogos)
3 Export Configurations (stibo. EMConfigFolder)

'J Copy Writing St Edit Bookmark
&d Apparel (18200

Rermove Bookmark

I Copy To Clipboard I

2. Paste the copied URL of the bookmark (using Ctrl + V on Windows).

B Untitled - Motepad

File Edit Format View Help
step://collection?editor=NodeCollectionfversionid=111511&contextid=Context1&id=1001808&workspaceid=Main

The copied URL can be pasted in the URL Field of STEP Workbench, and the user can search the respective
objects.

g 6 c URL |step://collection?editor =ModeCollection&versionid=11151 1&contextid=Context1&id= E ﬂ E

Note: You may send the copied URL to other STEP users so that they can navigate to the object or to the search
criteria.
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Menu ltems

The STEP Workbench menu bar provides access to many aspects of STEP's functionality. Some of the options in
these menus are also available via a right-click menu accessible elsewhere in STEP. For instance, users may add
a product to a product family by selecting the product family, and then selecting Maintain > Insert > Product in the
menu bar, but they may also perform the same action by right-clicking on the product family in the Tree. However,
some options, like changing the view target, are only available in the menu bar dropdown menus. Each of the
menu bar sections are detailed on subsequent topics.

Note: Many menu options can be used with a keyboard shortcut. For a list of the keyboard shortcuts, see the
STEP Workbench Keyboard Shortcuts topic in the Getting Started documentation.

32 doc-dev - usere@http://doc-dev:80 - STEPworkbench
File Edit View Mavigate Format Maintain Window Help

« File— The File menu provides access to import and export actions as well as general STEP Workbench tasks,
such as, running bulk updates, changing passwords, and emptying the Recycle Bin. For more information, see
the File Menu topic.

« Edit — In addition to administration actions like copying and pasting, the Edit menu also provides access to
tasks like spelling checks, managing assets, and editing unique keys. For more information, see the Edit Menu
topic.

« View — The View menu contains options that change how data is displayed in the workbench. For more
information, see the View Menu topic.

» Navigate — The Navigate menu contains searching options and the ability to find similar objects. For more
information, see the Navigate Menu topic.

« Format — The Format menu allows for setting styles such as bold or italics and inserting character tags. For
more information, see the Format Menu topic.

« Maintain — The actions available on the Maintain menu pertain to data maintenance at the object level. Data
such as LOVs and attribute values can be merged. Data can also be forcefully deleted, duplicated, or
approved. Links and new objects can be created in this menu. For more information, see the Maintain Menu
topic.

« Window — The Window menu provides actions for changing the presentation of the STEP Workbench. For
more information, see the Window Menu topic.

« Help — The primary function of this menu is to link users to the online documentation. For more information,
see Help Menu topic.
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File Menu

The file menu contains actions that are related to maintaining the workbench from a performance level, such as
cleaning the recycle bin, purging old revisions, scheduling bulk updates, as well as defining imports and exports.

Translate *

Irnport k

Export r
7 Reports

Bulk Update r

Schedule Category Profiling

D

Save Ctrl+Alt+5
Change Password

Ernpty Recycle Bin

¢ &

Empty Recycle Bin Before...

Purge old revisions

Check integrity of external assets...
Migrate assets/DTP documents to file system...

Pre-generate Thumbnail Cache...

Close Window

Exit STEPwarkbench

Each of the options on the File menu are defined below.

Translate

The Translate menu allows users to translate products, classifications, and names of images and documents,
product values, index words, LOVs (List of Values), units, attribute names, free text cells in tables in the
workbench, and to import translations.

File Edit View Mavigate Format Maintain Window Help

Translate : Data Objects...

Import ; Setup Objects...

Export ; Manual Excel Translation Export
# Reports @] Import Translation...

Bulk Update : Change Translation
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By selecting 'Data Objects' or 'Setup Objects,' the Request Translation wizard will display. This process results
in the creation of a translation file that will include either data objects (objects that contain usable customer
data) or setup objects (objects that help organize the data objects). See the Structured XML Translation
topic for data object translations and Structured Translation for Setup Objects in the Translations
documentation for more information.

The 'Manual Excel Translation Export' is best used for a specific set of use cases, namely when there is not
much content to translate, the translator does not have access to STEP, or the objects to be translated are

setup objects. For more information on performing a manual Excel translation, see the Starting a Manual

Excel Translation Export topic in the Translations documentation.

The 'Import Translation' allows users to select an external translation file.

The 'Change Translation' allows users to change configurations.

For more information on the translate functionality, see the Translations documentation.

Import

The Import menu contains actions for bringing data into STEP.

File Edit View Mavigate Forrnat Maintain Window Help

Translate ]

Import ; @] Data...

Export 1 eCl@ss...

Reports a Images & Documents..,
Bulk Update -]

The 'Data..." option loads the Import Manager. For more information, see the Import Manager topic in the
Data Exchange documentation.

The 'eCl@ss' option launches the eCl@ss Classification import wizard. eCl@ss is used to group materials,
products, and services. For information on how to best use eCl@ss and its importer, see the eCl@ss Format
topic and the eCl@ss Classification Import topic in the Data Exchange documentation.

The 'Images & Documents..." option, while on a Tree node that contains assets (images and documents), will
load the Import Images and Document wizard. For more information, see the Import Images and Document
Wizard topic in the Digital Assets documentation.

Export

The Export menu contains actions for getting data out of STEP for external management.
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File Edit View Mavigate Format Maintain Window Help

Translate #
Import ]
Export : l@] Data...
# Reports F@] Schedule Data Export...
Bulk Update e Images & Documents...

Schedule Category Profiling Compare System Setup Exports

« The'Data..." option loads the Export Manager. For more information, see the Export Manager topic of the
Data Exchange documentation.

« The'Schedule Data Export..." allows you to create a data export that executes at a specific time or repeatedly.
This option starts the Schedule Data Export wizard. For more information, see the Scheduling a Data
Export topic in the Data Exchange documentation.

« The'lmages & Documents..." option, while on a Tree node that contains assets (images and documents), loads
the Export Images and Document wizard. For more information, see the Export Images and Documents
Wizard topic in the Digital Assets documentation.

« The'Compare System Setup Exports' option enables you to migrate systems, and allows users to determine
which items should not be added to the new system. This option will compare two STEP XML files that are
exported from two STEP systems, such as a production system being compared with a development system.
For an example of comparing GDSN systems, see the Moving a GDSN Setup to a New System topicin the
GDSN Receiver documentation.

Reports

Selecting 'Reports' option will load the Reports wizard.

Translate ¥
Import
Export
7 Reports - | STEPS Report Settings
Bulk Update 1. Report Settings Report Group
Schedule Category Profiling 2. Parameters Assets v
3. Advanced Settings Report Mame
Assets Either Linked or Mot Linked to Products in PIM
Assets Lists
Report Description
Back Mext Finish Cancel
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For more information on the reports wizard, see the Reporter documentation.

Bulk Update

Bulk updates allow you to perform one or more actions on multiple objects at the same time.

File Edit View Mavigate Format Maintain Window Help

Translate #
Import ]
Export b
# Reports
Bulk Update ! %] RunBulk Update
Schedule Category Profiling Schedule Bulk Update

« The'Run Bulk Update' option will start the Bulk Update wizard.

« The 'Schedule Bulk Update' option will allow users to create repeatable bulk updates.

For more information, see the Creating a Bulk Update topic and the Scheduling Bulk Updates for
Collections topicin the Bulk Updates documentation.

Schedule Category Profiling

Category profiles (also called data profiles) are used to take a snapshot of data that would be displayed in the
category profile tab. This snapshot does not update as new changes are made. With this action, the 'Schedule
Category Profiling' wizard will display and users may schedule the updates of existing profiles and the ability to
copy profiles as well. For more information, see Generating, Updating, and Scheduling a Data Profile topicin
the Data Profiling documentation.

Save

While saving in STEP Workbench is automatic, the Save option allows users to force a save without leaving a
field.

Change Password

During any session, any user may change their own password. Simply enter your current password in the 'Old
Password' field, then enter the new password twice in the 'New Password' and 'Retype Password' parameters.
Click 'Save' to complete the update or 'Cancel' to leave the password unchanged.

$2 Change Current User Passw...

Old Password
Mew Password

Retype Password

Save Cancel
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Empty Recycle Bin
This action purges the 'Not In Use' objects in the Tree Recycle Bin. For more information, see the In Use and Not
In Use Objects section in the Approval of Objects topic of this guide.

Select the 'Empty Recycle Bin' option to display the Confirm Purge dialog. The number of items that will be
removed is displayed. Click 'Purge’ to permanently delete the items, or 'Cancel' to leave the Recycle Bin
unchanged.

Save

Change Password
z‘ﬁ,} Empty Recycle Bin
34;,3 Empty Recycle Bin Before...

Purge old revisions

32 Confirm Purge

Are you sure you want to permanently delete these objects:

Products: &

Skip Analysis Cancel

This action is also available via by right-clicking on the recycle bin.

LS8 TN IL MIUES
"r} Recyde Bin

Search in recycle bin

g"i,h Empty Recycle Bin
z‘;} Empty Recycle Bin Before...
Approve Deletion Recursively

Empty Recycle Bin Before
This action allows users to purge the recycle bin of anything created before a specified date.
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33 Ermpty Recycle Bin Options

Only purge objects deleted before: |2017-07-21 14:27:18 | ...

Cancel

This action is also available via right-clicking on the recycle bin.

Iﬂm LTINS TL MIOUEES
°’_"} Recyde Bin
Search in recycle bin
z‘;} Ermpty Recycle Bin
gﬁg} Empty Recycle Bin Before...

Approve Deletion Recursively

Purge Old Revisions

This is a global purge of revisions contained within a specified workspace. A further description of this functionality
is available in the Revisions section of the System Setup / Super User Guide documentation.

Check integrity of external assets...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself. This
can reduce the size of the database significantly, and for DTP tools depending on having the referenced high-
resolution images directly available on the file system, replication from DB to file system of these images can be
avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File
Structure topic of the Digital Assets documentation.

The 'Check integrity of external assets..." option is enabled on systems set up to store images in a file system and
not in the STEP database. If a Classification is selected, the user can click this menu item to see if allimages in the
selected classification have been successfully migrated from the database to the file system.

The integrity of the file system for storing digital assets can be double-checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu. This starts a background
process reporting if any assets are missing or have been changed against expectations.

When errors are found, the assets with wrong or missing content are added to a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A check of approximately 10,000 asset files on standard hardware can complete after one minute. Thus, expect
that the integrity check might take some time on systems with many assets.
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Migrate assets to file system...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself. This
can reduce the size of the database significantly, and for DTP tools depending on having the referenced high-
resolution images directly available on the file system, replication from DB to file system of these images can be
avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File
Structure topic of the Digital Assets documentation.

This option is enabled on systems set up to store images in file system and not in the STEP database. Ifa
Classification is selected, the user can click this menu item to migrate images stored in the database to the file
system location.

The migration of assets of the file system can be done by selecting one or more classifications and then selecting
'Migrate assets to file system' in the File menu. This will start a background process.

Pre-generate Thumbnail Cache...

This option will generate thumbnail cache of images and documents manually. This action allows any selected
image or images in a classification folder to display as thumbnails without having to wait for them to generate.

For example, on the Image and Documents tab of a classification folder, if the image thumbnails are delayed in
displaying, then Pre-generate Thumbnail Cache from File menu can be run to generate them in a background
process.

For more information, see the Image Cache Processing Plugin Parameters and Triggers topicin the
System Setup / Super User Guide documentation.

This option is disabled by default. To enable it, ask an authorized user (one with the Setup Action = Maintain
System) to perform the following steps.

Note: Although this automates the loading process, there will be delays during upload.

Under 'System Setup' tab, navigate to 'Users & Groups.'
Select 'System Settings' tab.

Go to 'Image & Document Settings' flipper.

A wbd -

Set 'Pre-generate thumbnail cache on upload' = Yes. On upload of image or document, the thumbnail will be
generated automatically.

For more information, see the 'Pre-generate Thumbnail cache on upload' section of the Images and Documents
Settings topic in the System Setup / Super User Guide documentation.

Close Window
This option closes the active workbench window.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 66



StiboSystems

MASTER DATA MANAGEMENT

Exit STEPworkbench

This will exit the STEP Workbench completely by closing all active windows.
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Edit Menu

The Edit menu allows for typical text editing actions, asset editing actions, unique key editing, and spell check.

5 Undo Ctrl+Z

(@ Redo Ctrl+Shift+Z

3 Cut Ctrl+X

Copy Ctrl+C

[ Paste Ctrl+V

[B Paste and Match Style  Ctrl+Shift+V
Paste Link Ctrl+L
Select All Ctrl+ &
Spelling ]
Asset ¥

Edit Unique Key Values

Remove Row(s) Ctrl+Minus
Insert Row Ctrl+Plus
Undo

This action reverses the last action of the user.

Note: It does NOT restore character-by-character changes in text editors.

Redo
Once an action is undone by selecting 'Undo’, a user can then select 'Redo’ to repeat the action.

Cut

Standard 'cut' operation to remove the selected characters.

Copy

Standard 'copy' operation to duplicate the selected characters.

Note: If a folder is copied, the subfolders will NOT be copied.
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Paste
Standard 'paste' operation to insert the copied characters at the selected point.

Paste and Match Style

Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. For more
information, see the Style tag section of the Tags topic of the System Setup / Super User Guide
documentation.

Paste Link
Allows the copied object to be linked into another object (e.g., linking an attribute into a second attribute group).
Creates a new instance of the same object (not a copy), just in a different location.

For example, if a user has an image for a product line that will live under multiple parents, the Paste Link action can
be used. The user selects the asset, and then selects another location that will serve as a parent object. The paste
link option can be used to create a link, giving this object two parents. This action will not work on products as
products can only have one parent.

Some considerations with this action are:

« an attribute must exist in at least one attribute group,
« ifthe data must be shown in the Web Ul, then an attribute for display purposes should be created

Note: The Paste option is available based on the selected node. For example, when selecting a product node and
placing it into a classification folder, only the 'Paste Link' option is available. However, if a product is to be moved
to another product family, when selecting the target family after cutting the original product, 'Paste Link' is
disabled.

Select All
Standard 'select all' operation to mark all visible objects for another action, like copying or deleting.

Spelling

Allows a user to check the spelling of available text.
Spelling : Automatic Spell Check
Asset ; Spell Check

Edit Unique Key Values )
Mo Suggestions

When the 'Automatic Spell Check' option is selected, as users type, incorrectly spelled words are displayed in red
text.
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* Family Description

abe I'I'his itmezis svalabls in multi coolors

* Brand Name
* Product Name

abe Hanes
abe Hanes Beefy-T Short-Sleve T-Shirt

If the 'Automatic Spell Check' is disabled, then selecting the 'Spell Check' action while in a field checks that field's
spelling. If a user selects one of the incorrectly spelled words and navigates back to the Spelling menu, STEP will

offer possible spelling corrections.

Spelling
Asset
Edit Unique Key Values

Remove Row(s) Ctrl+Minus
Insert Row Ctrl+Plus
Asset

Automatic Spell Check

Spell Check

Mame »| ¥ |Value »
available > Family Description  |abe [This itmes is avalsble in multi coolors |
avalanche » Brand Mame abe Hanes
availably * Product Mame abe Hanes Beefy-T Short-Sleve T-Shirt
salable
assailable

When an asset is selected in Tree, the 'Asset’ menu shows various options to manage and change assets.

Asset
Edit Unique Key Values

Remove Row(s)

Insert Row

Edit Asset
External Viewer

Replace Asset Content

Ctrl+Minus

Create Local Content of fsset

Ctrl+Plus

Update Systern Properties

Delete Local Content of Asset

Note: If no object is selected or a non-asset node is selected, all of the 'Asset' menu options are disabled.

« The'Edit Asset' action will open the asset in the program that is associated with the selected file type, like

Adobe Acrobat for PDFs.

« The 'External Viewer' will open the asset in a program on the user's local computer.

« The 'Replace Asset Content' action will allow users to replace the asset with local assets.

« The'Create Local Content of Asset' option initiates an asset push and downloads the asset.

« The'Update System Properties' action refreshes the asset's system properties in the 'Images & Documents'

tab of the asset.
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« After selecting the 'Create Local Content of Asset' action, the 'Delete Local Content of Asset' option is enabled
and allows a user to delete that downloaded asset.

Edit Unique Key Values

Unique Keys provide a special way of designating objects for identification outside of STEP. Selecting the 'Edit
Unique Key Values' action on an object with active unique keys will display the 'Edit Unique Key Values' dialog,
allowing users to edit any unique key related attributes on the object.

32 Edit Unigue Key Values

Attributes
Mame | > |Value >
» Receiver Product TM abe (1901247451231
* GTIM G4
» Receiver Product GLM GLH
* Supplier Part Mo, 122 PA1-23211
o

If there are no active unique keys for the selected object, then the following message displays.

32 Edit Unique Key Values

Mo unigue key attributes to edit

Cancel

For more information, see the Unique Keys topic of the System Setup / Super User Guide documentation.

Remove / Insert / Add Options

At the bottom of the Edit menu are two options that will change based on the selected node or current view. The
following are a sampling of what may appear:

On attribute references

Remowve Attribute Group  Ctrl+Minus

Add Attribute Group Ctrl+Plus

On the sub-products tab of a Product object
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Remove Row(s) Ctrl+Minus

Add Product Ctrl+Plus

On Lookup tables

Remove Row(s) Ctrl+Minus

Add Row Ctrl+Plus

The options will allow users to add or remove to the selected node as desired.
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View Menu

The View Menu's purpose is to change the way a user views objects in the STEP system. In this menu, users may
change the viewable workspace, context, and mode, add a filter, change the primary hierarchy, and other options
to customize the view to their needs.

Note: This menu does not edit or change any of the values. For more information to edit these values, see the
Maintain Menu topic of this documentation.

Maode r
Context k
Workspace k
Target 2
Filter 3
Prirnary Hierarchy 3
Select version r
Mew View

Remaowve view 2
Product views 3

Show Source Context
Rotate Table
' Reload F5
Collapse Tree
Disable calculated values
Default Font Size
Choose User Display Sequence Attribute
Toggle Show Hidden Background Process Ternplates

Default Context L4
Logs 3
Mode

The 'Mode' sub-menu includes options that allows the user to view STEP data in a variety of ways, dependent on
the need. These options are mirrored on the toolbar. For more information, see the Toolbar topic in this
documentation.
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File View Mavigate Format Maintain Window Help
Modee ev’ Maorral
Context : )
Translation
Workspace
Workspace
Source Context
Filter ; Revision
Prirnary Hierarchy :E8 Update

« Normal mode is the view where the majority of object maintenance occurs. From the toolbar, it is represented
with the E icon.
« Translation mode shows the split view of the different contexts for objects. To use the Translation mode,

select a Source context from the View menu. From the toolbar, it is the E icon. Online Translation can be
done from this Translation Tab. Fields highlighted in green color can be translated within STEP from this
Translation Mode. For more information on translating data into other languages, see the Translations
documentation.

« Workspace mode shows a comparison of values between Main and Approved workspaces. From the toolbar,

itis the ﬂ icon. For more information on workspaces, see the Workspaces topic in the System Setup /
Super User Guide documentation.

« Context mode shows a comparison of values between different contexts. From the toolbar, it is the E icon.
For example, this will allow a user to view values for all languages or for all price versions. For more information
on contexts, see the Contexts topic in the System Setup / Super User Guide documentation.

« Revision shows a comparison of values between different revisions. From the toolbar, it is the = icon. If you
have selected any object in STEP, then switched to the revision view, it will show a comparison screen of the
two latest revisions. The latest revision is displayed in the first column and the older revision is displayed next.
These revisions are also listed under the Status tab in a product editor. For more information on managing
revisions, see the Revisions topic of the System Setup / Super User Guide documentation.

« Update shows a comparison between objects across workspaces (Approved and Main) and allows the user to
update the object in the current workspace from a source workspace.

Context

When an object is selected, 'Context' displays all available contexts in a dropdown. By selecting one of these
contexts, the viewed context for the current object and all other objects, is changed to the selected context.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 74



StiboSystems

MASTER DATA MANAGEMENT

Workspace
Vimovigate Format Maintain Window Help
Mode >
Context b
9Workspace e Main
— Approved

Workspace shows all available workspaces. It is possible to change the viewed workspace and view objects as
they appear in different workspaces. In this example, there are only two workspaces: Main and Approved.
However, more can be added as desired. For more information on setting up and using workspaces, see the
Workspaces topic in the System Setup / Super User Guide documentation.

In the toolbar next to the context selector, a toggle icon (') allows you to switch between the Main and Approved

workspaces.

Target / Source

The 'Target' and 'Source' sub-menu allows users to choose alternative dimensions to show in the Context mode.

Depending on the view chosen, this function label changes from target to source.

« Inthe Translation view, this allows the user to select the source language.

Source * UK English
All Languages
German
English
Danish
Hebrew

Spanish

« Inthe Workspace view mode, this allows the user to select the target workspace.

Target * " Approved

« Inthe Context view mode, this allows the user to select a single target as context or multiple contexts to
compare the content.
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Target > ~  Danish DK

~  French Belgium
English UK
English U5
French FR
Germany German
Global

|srael Hebrew

Other

« Inthe Revision view mode, this allows the user to select a past revision(s), provided there is a recorded
change in STEP. If the revisions are older than the current session, the 'Other' option will display a window to
select necessary revision for comparison. When the Revision view is selected, the selected object will show
the current version and the immediately previous version. By using target, users may select specific revisions
for comparison.

Target * 049 last edited by USERJ on Thu Jun 01 15:4%:09 EDT 2017
0.48 last edited by USER) on Thu Jun 01 15:4%06 EDT 2017
0.47 last edited by USER) on Thu Jun 01 15:47:33 EDT 2017

Cther

« Inthe Update view mode, this allows the user to select the source workspace.

‘ Seource * " Approved

Filter

View Mavigate Format Maintain Window Help

Mode -] ~ | 6
o Workspace ]
L E]
=l
=5 Target
= :
5 Filter Hide Empty Yalues
e Prirnary Hierarchy Show Mandatory Attributes Only
@ Select version Show Editable Attributes Only
@ ) Show Legal Attributes Only
e Mew View
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Select a view to filter out empty attribute values, show only mandatory attributes, show only editable attributes,
and/or show only legal attributes.

Primary Hierarchy

An object may be located in multiple hierarchies. When locating objects, there may be a reason that a user wants
the object's path to specify one of those hierarchies instead of all the applicable hierarchies. Changing this view
can be done by switching the primary hierarchy view used for workbench. This path is displayed in the object
details within workbench, but the path is also used when navigating to an object via a search results set.

For example, object 12345 is in a supplier hierarchy and a primary product hierarchy. When doing a search for
object 12345, upon clicking the 12345 link in the search results, User A wants the object to be displayed in the Tree
within the primary product hierarchy. User B wants to click on the 12345 link and be taken to the object within the
suppliers hierarchy. Both scenarios can be accommodated when each user sets their own view.

iew Mavigate Format Maintain Window Help

Eﬂ Mode » Vgé

Context >

]
= Workspace » . [m[mﬁ
"[ Target BN
2 LS e >| > |Value
[+~ Prirnary Hierarchy <~ Primary Product Hierarchy
E Select version ; Configurations

An objects' path can be changed based on the selected primary hierarchy. To change the display view, select
Primary Hierarchy from the View menu, and then select the desired hierarchy. For many, the Primary Product
Hierarchy will be the default selection.

In the below example, Object 0726222 is a product object type being viewed in the Primary Product Hierarchy.
This path echos the location of the object in the Tree tab.

rEIE Primary Product Hierarchy
E}Fj Products
r_=| Apparel
r_=| Footwear
-7 safety
E]r_=| Hardware
: E}Fj Tools
E|r_=| Task Lighting
5 Flashlights
=il Flashlights Items

» Path Primary Product Hierarchy Products/Hardware /Tools/Task Lighting Flashlights Flashlights Ttems/0726277 ljee—
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Examples of how objects will be displayed can be seen with the Merchandising Hierarchy selection. Notice the
changed path and the object's location in the Tree tab.

-Ll—_ITE Merchandising Hierarchy
|'_= Apparel
|'_= Automotive
|'_= Beverages
E}|’_= Footwear
[=-{ 7] Women's Footwear
E}r: Dress Shoes

» Path Classification 1 root/Merchandising Hierarchy Footwear Women's Footwear [Dress Shoes 0726227 s—m

Select Version
Allows the user to set the default publication or version used for proofing.

New View

Allows the user to create and customize a new view to hide or show attributes.

Remove View

Removes an unwanted view.

Product Views
Shows the products that are selected.

Show Source Context

Attribute names may be translated. This option allows a user to view attribute values in both a foreign language
and in the source language.

Rotate Table

This will flip the selected table so that the columns become rows and vice versa. This is most often used in a multi-
product editor.

Reload

Retrieves updated information from the database including other users’ changes.

Collapse Tree
Collapses the folders in the Tree navigator.
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Disable calculated values
Disables the automatic calculation of calculated attributes. This will make the STEP interface load faster.

If Disable calculated attributes is checked, calculated attributes can be rendered one-by-one by clicking the
Calculate button on a calculated parameter in the product editor.

= [CalculatedPrice % [Calu:ulate]

Default Font Size
Allows the user to change GUI font.

Choose User Display Sequence Attribute

Allows the user to select a user-specific Display Sequence Attribute. This option is different from the Attribute set
under Users & Groups in System Setup. For more information on using Display Sequence Attributes, see Display
Sequence Attribute topic in the System Setup / Super User Guide documentation.

33 Sclect User Display Sequence Attribute

The system default display sequence attribute: DisplaySequence

IUser Display Seguence Attribute | DisplaySeguence e

Circulation M
Completeness Score =
PrintDisplaySequence
Product Variant Priority
SmartshestMandatory
TotalMumberOfltems
TranslateltemData W

Toggle Show Hidden Background Process Template
Once selected, any previously hidden Background Process Template will display.

Default Context

Sets the default context used when logging in.

Logs
Displays Workspace and System Setup logs.
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Navigate Menu

The Navigate menu offers options for moving around the workbench.

@ Search Ctrl+F
Search Below
> Goto Ctrl+G
Goto Mext Ctrl+E
4 Back
= Forward
Bookmarks »

Find Similar Product

Search

The 'Search' action accesses the 'Search' tab, which displays along the left side of the workbench window. Using
the search functionality, users may perform a search of all of STEP objects. For more information on searching
within STEP, see the Navigating and Searching topic in this guide.

Search Below

Only after selecting an object will the 'Search Below' action become selectable. Once this option is selected, the
'Search' tab will perform populate with a 'Search Below' for that object. Click the Search button to perform this

query.

]

e v Reset Search
Show Details

| Mame

Goto

A quick way to jump to a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displays multiple hits and allows the user to select the desired object.
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Goto | ID/Mame v | T-5hirts

[[7) T-shirts (18202)

[l T-shirts Ttems (13203)

[T T-5hirts Sales Ttems (18205)
[T T-shirts (18208)

[7] T-shirts (18454)

[ T-shirts (253689)

Goto Next
When there are multiple 'Goto’ results (or typeahead results) from the 'Goto' function, the user can opt to select
'Goto Next' to continue on to the next hit/ result.

As seen with multiple items meeting the criteria for a Goto action, the 'Goto Next' action will cycle to the next object
in thatlist. This list is ordered by STEP IDs.

Goto Next will be disabled if the previous Goto command has not been used.

Back / Forward

The 'Back' and 'Forward' actions will function the same as most web browsers. 'Back’ allows userstogotoa
previously visited screen, and 'Forward' returns to the screen from which a user went back.

Bookmarks

The Bookmarks sub-menu allows a user to bookmark the currently displayed object or create and name a search
based on the selected object.

Bookmarks : EIE] Add Bookmark Ctrl+D

. . @] Add Search Bookmark
Find Similar Product

4 T-shirts (18206)

Find Similar Product

The Find Similar Product option populates a search based on the attributes and its values of the selected product.
When this option is selected, a window will appear prompting the user to check off common attributes to search
for.

Important: Attribute values from calculated attributes and inherited attribute values are not searched
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3P Pleaze Select Attributes

[] Air Transportation Restrictions
[] Base Unit of Measure
[ ] Brand Mame
[ ] Brand Owner
[ ] Category
[] Children
[ ]Cast
[ ] Dimensions_CalcTest1
Nimensinns_CalcTest] 2 hd

Select Cancel

Note: The 'Please Select Attributes' dialog shows only the attributes which have values (inherited from context,
inherited from hierarchy, local values, and calculated values).

When the attributes are selected, click the 'Select' button, and the user is redirected to Search Tab, which is
populated with the Object type and selected attributes with its values.

Object Type ™
[Db]&::tTypE Product
[Searm (BrandMame) = Hanes EW
[ earch: {ErandDwner} = HanesBrands EN
C R Reset Search
Show Details
| Mame >

After clicking the 'Search' button, the selected product(s) which match the search criteria are displayed.
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CObject Type =
[Db]edType Product

’

[Search (BrandMame) = Hanes

’

[ earch: {ErandDwner} = HanesBrands

H

Displaying 1 of 1results

Reset

Search

Show Details

Mame

>

> gl Cotton T-shirts ID = 18205

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type
Product (1) - exclude

Bl ltem Family (1) - sxclude

Results by Position in Tree Hierarchy
Results by Parent

[C]Products (3} - sxclude
Bl T-shirts ltems (1) - =xclude

Note: This search is recommended for externally maintained attributes with validation base types of Text, LOV,
and Numeric. It is not recommended for attributes with validation base types like Number, URL, Date, Condition,
Multivalued Text, or Multivalued LOV, etc.
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Format Menu

The Format menu contains items for stylizing and transforming text in the workbench.

Style r
Clear All Styles
Character Tag r

Insert Special Character Ctrl+5Shift+E

Style

This option allows setting either bold or italics. Users may create their own styles, which will show in this menu.

Forrnat Maintain Window Help

Style ] Bold
Clear All Styles I[talic
Style ; BodyRowStyle
Character Tag 4 2 &4
_ ) bold

Insert Special Character Ctrl+Shift+E
Bold_C
BoldHeader
bolditalic
BottomLeftCorner

BottomRightCorner
bullet

Other Ctrl+Y

Users can apply style formatting to selected strings of text such as bold, italics, or custom style tags. The
secondary 'Style' menu contains a list of additional styles. Selecting any will change the selected text. To add more
styles to the list of options, see the Tags topic in the System Setup / Super User Guide documentation.

Selecting 'Other’ from the extended Style menu displays a bank of all the custom styles in the STEP system.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 84



StiboSystems

MASTER DATA MANAGEMENT

*B  Bold Ctrl+B

Format o
Style

Clear All Styles I ltalic Ctrl+l
Character Tag 3 eﬂykz : bold
#  Insert Special Character Ctrl+Shift+E BodyRowstyle
Bold_C
BoldHeader
bolditalic
[ ] BodyRowStyle A BoldRed
[ ]bold BottomlLeftCorner
[Jeold_c BottomRightCorner
[] BoldHeader 9 Other CrleY
[ ] bolditalic
[ ] Boldred
[ ] BottomLeftCorner
[ ] BottomRightCorner o

Cancel

Note: Formatting is limited to free text fields.

In this example, bullets are applied to the Long Description field. The word 'flash’ is bold.

Red carpet worthy pumps in scarlet suede is sure to turn heads. Metal disk details on the size will sparkle when the cameraﬂﬂash.l
See product variations for other color ufferings.|

o

Long Item Description |ab: D

Clear All Styles

This action clears all applied styles on the selected text.

Character Tag
The 'Character Tag' action allows for the insertion of custom-made character tags.
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Forrat Maintain Window Help

Style ]

Clear All Styles

Character Tag ] LineBreak

¥ Insert Special Character Ctrl+Shift+E MoVersionPageMo

Emspace
ft
gt
It
multisep
phone
Other Ctrl+R

To learn more about editing character tags, see the Tags topic in the System Setup / Super User Guide
documentation. In the example below, a phone character tag is used, followed by a line break, and then a multi-
item separator.

[ph]

* Long Item Description |abe f—

/

Selecting 'Other’ from the character tag menu displays a bank of all the character tags in the STEP system.

Style H

Clear All Styles

Character Tag 9 : LineBreak

¥ Insert Special Character Ctrl+5Shift+E MoVersionPageMo
emspace
4 8 Insert Characte.. X ft

emspace A gt
ft It
at multisep
LineBreak
It phone
multisep
MoVersionPageMo e Other Ctrl+R
phone W
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Insert Special Character

This is an embedded character map. It shows the most recently used characters and offers a complete Unicode
character range.

Forrmat
Style L
Clear All Styles
Character Tag b
£ Insert Special Character Ctrl+Shift+E

Selecting the 'Insert Special Character' option displays a pop-up of the most recently used symbols.

| > Lung Item Description |ahc | |

el:|s

Other... Enter

Selecting the 'Other..." option on this pop-up will generate another dialog that allows for selecting all of the special
characters, as well as changing the character set to choose from.

32 Insert Special Character

Maost Recently Used Symboals
elefs| | | | | |
IUnicode Character Block: |Basic Latin e
D Al Spedal Characters
bz s % & "0
ClLY [ * + . -1
01|23 |4|5|6]|7
8 9 ol <= >]7?
@ A|B C/DEF|G|
Insert Cancel
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Maintain Menu

Maintain menu provides the user to maintain STEP data by inserting, linking, merging, deleting, approving and
others. Some options, such as CMDM Monitoring and User Anonymizer, are only available if the functionality is
activated via a license and/or add-on component. Many options have additional options and are explained below:

Insert *
Link ¥
Merge >
Delete

Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+)

Duplicate Recursively
Make Revision

Approval ]

Enable group for workflows

Revive

Revive Recursively
Truncate log...

CMDM Menitoring b

User Ancnymizer

Insert

The 'Insert’ action allows the user to create an object based on the currently selected object. The options are
disabled based on the selection.

Note: Itis also possible to create objects products, classifications, entities, publications, and assets when right-
clicking in STEP. For more information on object creation, see the Creating Objects in Tree topic of this guide.
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Insert
Link
Merge

¥ Delete
Force Delete & Purge
Unlink Object Type

Duplicate

i &

Duplicate Recursively
Make Revision

Approval

Enable group for workflows

Revive

Revive Recursively

Truncate log...

Ctrl+)

NN

¥

[

D E=R=E=R:N § N A NN

.

Product

Classification
Classification Root
Mew Entity Node
Entity Root

Mew Publication...
Mew Publication Group
Mew Publication Section...
Mew Page Template ...
Orphan Attribute

Asset

Attribute

Attribute Group

List of Values
Dirnension

Dimension Point
Workspace

Action Set

Mew lmage Conversion Configuration...

Create Transformation Lookup Table
Mew Event Queue

Mew AssetPush Event Cueue

Mew AssetPush Configuration

STEP Workflow

Background Process to Monitor Deadlines

User

Group

Mew Supplier

Create Package

Create STEP Worlflow
Mew Business Condition
Mew Business Action
Mew Business Function
Mew Business Library

Setup Group Root...

Ctrl+5Shift+P
Ctrl+5hift+C
Ctrl+5hift+ R

Ctrl+Shift+ 0
Ctrl+Shift+ A
Ctrl+Shift+T
Ctrl+Shift+]
Ctrl+Shift+L
Ctrl+Shift+D
Ctrl+Shift+ M
Ctrl+Shift+W
Ctrl+Shift+5

Ctrl+Shift+R
Ctrl+5Shift+D

Ctrl+5hift+G

Ctrl+5hift+R

The following options are available in the Insert sub-menu:
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Product — If the user is within the primary product hierarchy, this option will create a new product beneath the
selected hierarchy.

Classification — If the user selected a classification hierarchy, this option allows creation of a new
classification folder beneath the selected classification with the predefined classification object types.

Classification Root — If the user would like to have a classification root to store images or configurations or to
link products in the classifications folder, this option creates a classification root with a set of predefined
classification root object types that are listed.

New Entity Node — If the user selected an entity root, this option will create a new entity object based on one
of the predefined entity types.

Entity Root — A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root object
types.

New Publication... — Allows the user to create a new publication. If the user has already selected a publication
hierarchy, then when this option is chosen, 'Create Publication’ dialog will displayed with default object type
selected. The user must provide a name of the publication and 'Page Template,' 'Product Template,' and
'Publication Template' to create a new publication.

Note: The 'Create’ button in the ‘Create Publication’ dialog will be enabled only if the user has selected a
publication template.

New Publication Group — Allows the user to create a new publication group within the selected publication
group. If a publication group is selected, once this option is chosen, ‘Create Publication Group’ dialog will
display with the predefined set of object type.

New Publication Section... — The user will get a wizard to create 'New Publication Section.' When selecting
this option, the 'New Section' dialog will display. Complete the Section Name and select the Page Template
from the dropdown list.

New Page Template... — Allows the user to create a new page template. After selecting a 'Publication Group,'
this option will display a wizard Create New Page Template in STEP.

Orphan Attribute — This allows the user to add an attribute as an orphan attribute to a product by searching or
browsing from System Setup tab. For information, see the Orphan Attributes topic in the System Setup /
Super User Guide documentation.

Asset — Allows the user to create placeholder with ID and name for a new asset on the selected classification
folder. The user may choose an asset object type from the Create Asset dialog, then asset content can be
added.

Attribute — Allows the user to create a new attribute in the selected attribute group in System Setup.
Attribute Group — Allows the user to create a new attribute group in System Setup.

List of Values — Allows a user to create new list of values under Lists of Values Group / LOVs in System
Setup. User will be allowed to key in ID and Name in the Create LOV dialog.
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Dimension — This option will create a new dimension. A user must select the 'Contexts' node in the System
Setup for this option to be available. For more information on dimensions, see the Dimensions and
Dimension Points topic in the System Setup / Super User Guide documentation.

Dimension Point — Allows the user to create new dimension point. A user has to select a dimension under
System Setup > Contexts > Dimension (for example 'Language'). The label of this option changes dynamically
based on the selection of dimension, so the option ‘Dimension Point’ is never displayed. For example, if the
user has chosen 'Language' as Dimension, this option will be labeled as ‘New Language'.

Workspace — The user can create a workspace from this option in System Setup, while focused on an existing
workspace. For more information on workspaces, see the Workspaces topic of the System Setup / Super
User Guide documentation.

Action Set — This option creates a new setup or user action. A 'Create Action Set' dialog displays with ID and
Name to be filled when user selects the option Action Set. Creating a setup or user action is based on which
node is selected in System Setup. For more information on action sets, see the Maintaining Action Sets
topicin the System Setup / Super User Guide documentation.

New Image Conversion Configuration... — A wizard will display to create new image conversion
configuration and save it for reuse in the selected classification folder. For more information on image
conversions, see the Image Conversion Configuration topic in the Digital Assets documentation.

Create Transformation Lookup Table — Allows the user to create a transformation lookup table under the
selected classification. For more information, see the Transformation Lookup Tables topic in the Resource
Materials online help.

New Event Queue — The user can create a new event queue in System Setup. For more information, see the
Creating a New Event Queue topicin the System Setup / Super User Guide documentation.

New Asset Push Event Queue — The user can create a new asset push event queue in System Setup and it
will create a new event queue. The event queue can have any number of asset push configurations running
from it. For more on assets push events, see the Creating and Maintaining Asset Push Event Queues
topic in the Digital Assets documentation.

New Asset Push Configurations — A new asset push configuration will be created under the selected Asset
Push Event Queue. For more on assets push configurations, see the Creating and Maintaining Asset Push
Configurations topic in the Digital Assets documentation.

STEP Workflow — This will create a new workflow under System Setup > Workflows when the user first
selects '"Workflows' in 'System Setup'. The STEP Workflow designer window will display. It is also possible to
create a workflow by right clicking on the 'Workflows' folder. For more information on workflows, see the
Workflows documentation.

Background Process to Monitor Deadlines — When first selecting the System Setup > Workflows node,
this option starts a background process for checking STEP Workflow items that have exceeded their
deadlines.

User — Users are created by first selecting System Setup > Users & Groups > Group where the user will
belong. When a user selects a Group and select this option, the 'Enter New User' dialog displays. For more
information on users in STEP, see the Working with Users topic in the System Setup / Super User Guide
documentation.
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o Group —Groups are created by first selecting System Setup > Users & Groups > and selecting the necessary
node to hold the group. For more information on groups in STEP, see the Working with User Groups topicin
the System Setup / Super User Guide documentation.

« New Supplier — Supplier users are created in System Setup > Supplier Group. A new supplier can be created
by first selecting the supplier group.

« Create Package — Creates a package by first selecting System Setup > Change Package. After the user has
selected the change package option, a 'Create Change Package' dialog displays. Enter an ID and Name of the
Package. For more information on packages, see the Change Packages topic in the Configuration
Management documentation.

« New Business Condition — Creates a new business condition under Global Business Rules in System
Setup. Business Conditions can also be created under Workflows in System Setup. For more information on
business conditions, see the Business Conditions topic in the Business Rules documentation.

« New Business Action — Creates a new business action in System Setup under Global Business Rules.
Business action can also be created under Workflows in System Setup. For more information on business
actions, see the Business Actions topic in the Business Rules documentation.

« New Business Library — Creates a new business library in System Setup under Global Business Rules.
Business libraries can also be created under Workflows in System Setup. For more information on business
libraries, see the Business Libraries topic in the Business Rules documentation.

o Setup Group Root... — Creates a new setup group root under System Setup. When the user selects this
option, the 'Create Setup Group Root' dialog displays with set of object types. The user may create a new
setup group root based on the object the object type selected.

Link
The 'Link' action provides a list of object or reference types for linkable actions. This menu will only show the
relevant options as active if it is possible on the selected object.

Insert ¥
Link : Product Ctrl+5hift+Q
Merge : HAsset Ctrl+5Shift+F
Attribute to Classification  Ctrl+5Shift+3
# Delete r

Product to Classification  Ctrl+5hift+H

Force Delete & Purge
Attribute to Product Ctrl+Shift+K

Linlink Ohiect Tune

Based on the source object there are different link options available with keyboard shortcuts shown in the above
screenshot.

« When a user selects a product hierarchy and clicks on Link > Product, the product is linked to the selected
product via a product reference type dropdown.

« When a user selects a product hierarchy and clicks on Link > Asset, the asset is linked to the selected product
via an asset reference type dropdown.
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« When a user selects an attribute, it can be linked to classifications.
« When a user selects a classification, it can be linked to products.

« When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, see the Creating a Product Attribute Link topicin
the System Setup / Super User Guide documentation.

Merge

Depending on the selected object, the user can merge attributes, LOVs, and LOV values. For more information,
see the Merging Attribute Values topic, the Merging Values in an LOV topic, or the Merging LOV Values in
Bulk topic in the System Setup / Super User Guide documentation.

Merge : Attribute Values
LOVs
Values in LOV

¥ Delete

Force Nelete & Purne

Delete

In STEP, the 'Delete’ action sends items to the Tree Recycle Bin. If the selected item for deletion contains child
objects, the user will receive a warning that these items will also be deleted. For more information, see the
Recycle Bin for Tree topic of this guide.

Note: The keyboard 'Delete’ button does not delete objects in STEP Workbench.

Force Delete and Purge

If an object is selected in the workbench, and 'Force Delete and Purge' is clicked, the Confirm Force Delete and
Purge dialog is displayed. Click the 'Force Delete and Purge' button to permanently delete the object and purge it
from the recycle bin without any further opportunity to cancel.

$2 Confirm Force Delete and Purge

After force delete and purge you cannot revive these objects again.
Force deleting and purging an object will NOT cause an Approve Deletion event,
Are you sure you want to permanently force delete and purge these objects:

Entities: 1

Force Delete and Furge Skip Analysis Cancel

Unlink Object Type

When in System Setup, this option allows a user with the appropriate privileges to unlink the selected object type
from its parent.
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Duplicate

This standard 'duplicate’ operation essentially copies and pastes in one click. Users may also right-click while
selecting multiple objects and duplicate each of them. A prompt will request a new ID when an auto ID is not set,
then automatically provides a different name. The user is also allowed to indicate if duplicate references should be
created.

Duplicate Recursively
A hierarchy can be duplicated when the user selects the top node in the hierarchy and clicks 'Duplicate
Recursively.' The ID should be editable for duplicate recursively.

In the below example, the ID is auto generated so the duplicate recursively background process will ultimately give
an error.

Mame » | » |Value
* ID IconR.oot
> Mame lcons _ _

$2 Duplicate Recursively

* Dbject Type Icons
* Revision 0.1 Lasi O ID IconRoot
» oved

poor v Apr Mew Mame Imns{2}|
» Translation Mot Tral
s Path Classifid [] Duplicate references
> Wisibil

Isibiity Start Process with Description
* Purpose abe Storage

- Mame | pyplicate Icons(Z)
» Catalog Group Theme abe
Cancel

Make Revision
Allows a user to force a revision on a product and provide a comment for explanation.

Approval
The approval options allow objects to be moved to the Approved workspace.
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Approve Object Ctrl+Shift+]
Partial Approve...

Check Approve

Approve Deletion

Approve Recursively

Transfer Object To r
Update Object From r
Update Workspace From *
Update Object

Approve Object — Approves an object from the Main workspace to the Approved workspace and changes
the red X ( %) to either a green checkmark (< ) or a yellow one (< ). See the Approval of Objects section

of this guide for more information.
Partial Approval — Approve selected parts of the unapproved changes on the selected object.

Check Approve — The 'Check Approve' action allows the user to see if anything is barring successful
approval of an object. In the example below, mandatory values are missing.

32 Unable to approve product

Approve report for 18212 1L B

Unable to approve object due to missing mandatory values on attribute(s):
Feature Bullet 1

0K

Approve Deletion — For an approved object to be removed from the Recycle Bin, the object must be

Approve Deleted. If a previously approved object is deleted, in the Recycle Bin it will have a red '(in Use)'
header:

20709 rev.0.9 Deleted (in Use)

Performing an Approve Deletion changes the header to 'Not in Use' and allows the object to be deleted.

20709 rev.0.9 Deleted (Not in Use)

For more information, see the In Use and Not In Use Objects section in the Approval of Objects topic of
this guide.
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« Approve Recursively — Launches a workflow process that will approve the currently selected object and all
of its children.

« Transfer Object To — Takes selected object and moves it into the chosen workspace.

« Update Object From — Updates the object across all workspaces, including references and values for
classifications, products, and images and documents.

« Update Workspace From — Updates the current workspace from another workspace. It is possible to
update the entire workspace or only a part of the workspace. Objects that do not exist in the current
workspace will be transferred to the current workspace.

« Update Object — Updating objects across workspaces. This means that if an object exists in different
workspaces, values and references can be updated across these workspaces.

Enable Group for Workflows
This is a disabled legacy option.

Revive

Revives a deleted object, either 'In Use' or 'Not In Use', from the Recycle Bin. For more information, see the In
Use and Not In Use Objects section in the Approval of Objects topic of this guide.

Revive Recursively

Revives a deleted object as well as all of its children, either in use or not in use, from the Recycle Bin. For more
information, see the In Use and Not In Use Objects section in the Approval of Objects topic of this guide.

Truncate Log

Once selecting an Event Queue or Asset Push Queue, this option will reduce the log to the most recent entries.
For more information, see the Event Queues topic of the System Setup / Super User Guide documentation.

CMDM Monitoring

Selecting the 'Start background process for monitoring Customer Data Policies' option under CMDM Monitoring
will manually initiate any of the active data policies in the system. For more information, see the Data Policies
topicin the Data Governance documentation.

User Anonymizer

This option is available to admin users and is used to anonymize a deleted user within the object change logs,
revision logs, and workflow status logs. For more information, see the User Anonymizer topic in the System
Setup / Super User Guide documentation.
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Window Menu

The Window menu offers actions around the STEP Workbench window.

Mew PIM Window Cirl+M

Goto Window
E] Goto Dashboard

Loom Window

New PIM Window
This action will create a new instance of the STEP Workbench.

Goto Window
This is a legacy option and no longer functions.

Goto Dashboard
This option will display the STEP Workbench dashboard.
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33Ke; %

Hew ltem Creation by State Average Time in State Ohject Type Count
STEP Workflow profile is unavailable STEP Workflow profile is unavailable Profile generated Tue Jan 26 2016
15:03 in context ‘English US', workspace
'Main’

W ltem {7
N Salos ltem (68)
Item Fobdar {Z5)
M Lawed 3 {23)
W Laved 2 {Z1)
Dihar obyact typas {105)

Translation Status
Profile generated Tue Jan 26 2016
15:03 in context "English U5, workspace
'Main’

M Mot Transkated {322)

[ FexFt =~ | Awverage Ohject Completeness Number of ltems in Workflow State

Profile generated Tue Jan 26 2016 No data available for context "English STEP Workflow profile is unavailable
15:03 in context ‘English US', workspace | | US', workspace "Main’, completeness
‘Main’ metric with ID ‘Completeness Metric B

M Yas {8)
R {1

Zoom Window
This action will center the STEP Workbench on your primary display.
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Help Menu

The Help Menu has two options: 'Help' and 'About STEP"'.

&7 Help F1

57 About STEP

Help

The 'Help' option opens the STEP documentation in your default web browser.

If configured to authenticate, you will be prompted to enter a STEP username and password before online help is

displayed. To enable this functionality, the property
OnlineHelp.Documentation.Authentication.Enabled=true must be added it to the sharedconfig.properties

file. Authentication is disabled by default.

Note: The authentication option will not work with any Single Sign On (SSO) solutions other than LDAP.

Username* :

Password* :

You are here: Welcome to STEP Online Help

Welcome to the STEP Online Help

When you are done with online help, you should click the Logout button located on the far right of the online help
toolbar. Upon logging out, you will be taken back to the documentation login screen.

If authentication is disabled, the Logout button will still display. In this scenario, clicking on the button will take you
to the STEP Online Help welcome page.
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About STEP
The 'About STEP' option displays the workbench introductory window.

$2 About STEPworkbench

STEP”

Trailblazer by StiboSystems

@ 2018 All Trademarks, service marks and logos appearing are
proprietary to Stibo Systems or its licensors.
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Object Editor

When an object is selected from the left panel in STEP (e.g., Tree tab, System Setup tab, etc.), the right panel
displays details on the first tab for the selected object. The left panel can be hidden or displayed by clicking the hide

(E4) and show () toggle buttons.

The kind and number of tabs will vary depending on the selected object. However, all objects will have at least an
ID, Name, Object Type, Revision, Approved, Translation, and Path. These fields are called 'aspects.’

18207-012 rev.0.2 - Product
Commercial || Tables || Category Profile || Status || State Log || Tasks
Product [ Sub Products " References [ Referenced By ]
9 Desarpton E
Mame *| ¥ |Value

* D 18207

* Mame 15207012

* Dhject Type SalesItem

* Revision 0.2 Last edited by USER. on Mon Jul 27 15:43:10 EDT 2015

* Wpproved 3 Last Approved on Mon Jun 15 16:27:06 ECT 2015

* [Translation Mot Translated

» Path Primary Product Hierarchy Products/Apparel Upper Body WearT-shirts/T-Shirts L

* Condition [

» Parent % T-shirts

» Status
@ Sales Item Marketing Descriptions

Mame »| » |Value »
. The Hanes Beefy-T T-Shirt For over 35 years, it has set the standard for T-shirt comfort and quality.
» Description, Long abe Today it's better than ever, offering greater durability and less shrinkage than you'll get with ordinary
tees.

See the Object Maintenance in Tree topic within this guide and child topics for additional information on the
various object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the STEP
documentation (e.g., information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with aspects in the first
flipper called 'Description.' For more information about description attributes, see the Description Attributes
topic in the System Setup / Super User Guide documentation.
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Search Tab

The Search tab allows users to perform simple searches by typing directly into the default search field.

b [ Seanch ;]

=l | _

= ®= Advanced

I

m

& B [ Rezet ” Search ]
Search Result Show Details

© || Name >

i

5

ol

Users can also perform more complex searches by selecting and/or combining additional search criteria.

ﬁ Search

=i
Search

S Object T

s ject Type

]

i Search Below M

tails

Referenced fssets %l

Revised Objects Changed Since
Document Content

Search from List

Javascript search

Missing Mandatery Values
Unapproved

Product Override Search

Search in Publication Hierarchy
Referenced By

References

STEP Workflow

Sample Result

Translation Status

Unpushed or Failed Assets

[ STEP Workflow ” Bookmarks ” System Setup ” BG Processes (2] ]
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Below Search Operations can be performed on the entire search result.

-Operations on Entire Result

SIRC= TR

For more information about search operations, see Search Operations on Entire Result topic in the
Navigation and Searches documentation.

For more on searching, see the Search section of the Getting Started documentation.
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STEP Workflow Tab

STEP Workflow is STEP's native functionality for structuring and to some extent automating processes around
objects in STEP. Typical examples are Product onboarding processes and change / governance processes.

The concept of STEP Workflows differs from the general concept of a workflow, in that STEP Workflows are data-
centric, meaning that each instance of a given Workflow always will be tied to an objectin STEP. As illustrated

below, technically, a Workflow Instance is simply a relation between a STEP object and a Workflow definition that
also exists as an objectin STEP.

o i

Done

W
Marketing Reject
Done
W
Workflow Instance Approval

Accept

W
Active - Done

STEP Object

Workflow Definition

The STEP Workflow tab has 2 sub tabs (Tasks and Profile).

Tasks

The Tasks sub tab is the primary interface for working with workflows in STEP Workbench.

1. Each workflow has a flipper that can be opened to display details about the workflow.

STEP Workflow

Tasks
O Approve Recursively

CIE

Filter by Collection

Failure i
Initial 0

CES5ES ” Search II_EFE
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2. Administrators can configure which states are displayed for each workflow. The number of tasks for the state

are displayed.

Profile

T Approve Recursively
I

Filter by Collection

Search

Failure
Initial

CRSEES

3. The Refresh button updates the data displayed for number of tasks in the workflow.

STEP Workflow

Profile

i
(N

Filter by Collection

Recursively

Failure
Initial

Cesses ” Search ” Tree

4. Clicking the Show All Items button displays all tasks in all displayed states, regardless of the assignee. Only

users with the STEP Workflow Administrator privilege have access to this button.

STEP Workflow

@ Prafile
; ' Approve Recursively
5|2 P

T

Wil | (Filter by Collection

§ Failure

@ Initial

5. Clickingthe Show All Items assigned to me or any group | am a member of button displays tasks directly

assigned to the user or any group that the user is a member of.
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STEP Workflow

B Prafile
; ' Approve Recursively
o
wil | Filter by Collection
§ Failure ]
@ Initial 0

6. Clickingthe Show All Items assigned to me button displays only tasks that are directly assigned to the user.

STEP Workflow
n Profile
; Approve Recursively
|G P
o
wil | (Filter by Collection
§ Failure i
@ | Initial 0

7. Click the ellipsis button ([...)) to allow users to filter the list of displayed tasks based on a Collection. For

example, if a user wanted only to see objects in the workflow where the Color Attribute = Blue, they can first
perform an Attribute search on the Search tab, then save the result as a collection, and use that collection to
filter the objects to display only those where Color is Blue.

STEP Workflow

|

@ Profile

:;' @ Approve Recursively

5| &P

D

wil | (Filter by Collection

m Failure i
@ | Initial 0
w
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Profile
STEP Workflow {  New Item Creation Profile - By State - STEP Workflow profile i
Tasks m STEP Workflow profile
| KPI_StatusTracking fConfiguration last edited by user on 2015-07-23 13:46:21; On-demand data has not yet been generated for this profile
New Item Creation Profile - By Assignee Edit configuration Update on-demand data Copy to Clipboard ]
Hew Item c"“tf“" Profile - By Statefl} State > GTEP Warkflow > Ttems in State > Average tme in State
{ New Item Creation Profile - By Workflow > Copy Wiriting SalesItemCreation 11 31Days
» Copy Writing Cluster SalesTtemCreationMewER. 4 123 Days
» Copy Writing Cluster SalesTtemCreation 11 &1Days
» Copy Writing Ended 6 SalesTtemCreationMewER. 4 123 Days
» Digital Asset Cluster SalesTtemCreationMewER. 4 123 Days
» Digital Asset Cluster SalesTtemCreation 11 &1Days
» Digital Asset Review SalesTtemCreationMewER. 4 123 Days
» Digital Asset Review SalesTtemCreation 11 &1Days

Click a Profile link to see details of the configuration.

The Edit Configuration button allows you to modify the data being profiled.

The Update on-demand data button runs the profile and updates the data displayed.
The Copy to Clipboard button saves the data displayed to your computer's clipboard

ok N =

Once saved to the Clipboard, this data can be pasted into Excel for further analysis.

For information on how to configure workflows, see the Creating a Workflow topic.
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System Setup Tab

Schema objects are maintained from the System Setup tab. Examples of such objects are Attributes, Action Sets,
Contexts, LOVs, Object Types, Tags, Units, Users & Groups, Workspaces, Reference Types, and many more.
Most actions performed require Super User access. This is where the core components like integration endpoint,
STEP Workflow, Web Ul, business rules, etc. are created and configured.

System Setup

-3 Attribute Groups

----- (&) Attribute Transformations

f-{£=] Action Sets

EI-- Contexts

]Eﬁ Lists of Values [ LOVs

----- Gateway Endpoint

r-[55] Global Business Rules

R-[55] Inbound Integration Endpoints

----- Match Codes and Matching Algaorithms
Outbound Integration Endpoints

() | O e A |
=] ]

»]

X1
H
1

Portals

| Status Flags

1 Workflow Profiles

i Workflows

-[E] Derived Events

B3 Object Types & Structures
EEI-- Tags

[ Uniits
Eﬂ--rﬁ Users & Groups
EEI"E‘J‘ Reference Types
EEI--E + + Workspaces
-l Table

[+ {&= Keys

EEI---_H Event Queues
#-[Bg Component Models
[

-1 Recyde Bin

l STEP Workflow " Bookmarks ]W[ BG Processes ” Search ” Tree
o e
BEE B

Additional information on the System Setup objects and functions can be found throughout the online help. For
example, information on workflows is available in the Workflows guide, while information on integration endpoints
is available within the Data Exchange guide. Information for general functions that are not covered in
independent guides (e.g. attributes, references, users and groups) can be found in the System Setup / Super
User Guide.
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Toolbar

The features accessible on the STEP toolbar, (located beneath the menu bar), are geared towards navigating
between objects and viewing object data in different ways.

£+] doc-dev - USER2@http://doc-dev:80 - STEPworkbench = =R =

File Edit View Mavigate Format Maintain Window Help
BT

I3 o= C'uRL

Context |English US

r_=| Assets

[#-{ 7] Configurations

&2 ETIMS Article Groups
-{£5) ETIM Article Groups

The various features available on the STEP toolbar are described below.

Stibo Systems Logo

Clicking the Stibo Systems logo allows the user to toggle between the STEP dashboard and the STEP
Workbench. For more information regarding the dashboard see the Global Dashboard section of the Data
Profiling documentation.

Context List

Context |English US -

'Context' acts as afilter that allows a user to view object data defined by, for example, country or language.

To select the context, the user clicks the dropdown and then selects the desired context from those listed. When
working in STEP it is useful to check that the context is properly set because viewing data in the wrong context is
likely to cause significant confusion. For more information regarding contexts, see the Contexts topic in the
System Setup / Super User Guide documentation.

Workspace Toggle Button

Located to the right of 'Context', the Workspace Toggle button, = , switches the user's view of a given object
between the 'Main' and 'Approved' workspaces. In the 'Main' workspace, object information is editable. In the
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'Approved' workspace, the user will see only those values that have been approved, and may not edit them. For
more information on workspaces, see the Workspaces topic in the System Setup / Super User Guide
documentation.

Navigation Buttons

¢>c

To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, the user
can click the 'Back’, 'Forward', or 'Reload’ buttons, respectively. These buttons are located between the
'Workspace Toggle' button and the URL field. When clicked, these buttons behave in a way similar to most web
browsers' 'Back’, 'Forward', and 'Reload' functions.

Address Field

URL |sset?editor =AssetReferencedBy &contextid=Main

To maximize navigability of the STEP tool, all objects may be accessed via an in-tool URL. As with the URL bar in
a standard web browser, a product may be reached within STEP by pasting its unique URL into the URL bar. Itis
important to note that the STEP URL always begins with "step://", unlike web URLs which begin with "http://" or
"https:/I."

Viewing Mode Buttons

S|=|=qea]

STEP enables the user to view STEP data in a variety of ways, dependent on the need. When clicked, each of the
five 'View' icons that appear to the right of the URL field in the toolbar present STEP data in different ways. Below
are the five view modes described:

Normal mode

B

This is the default view of the STEP Workbench. With this view selected, users will see a listing of all relevant
attribute and metadata associated with that object.

Translation mode

=

With this mode selected, users can view all object-related data in up to two languages. The data is presentedin a
comparison display format. STEP automatically highlights in green those attributes that require translation. More
information of translations is available in the Translations documentation.
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Workspace mode

!

With the 'Workspace' view active, users can see object data as it appears in both the 'Main' and 'Approved
workspaces. This comparison view can be useful by allowing a user to view, at a glance, which values have
changed since the object was last approved. However, if the object is in 'Never been approved' status, only the
'Main' workspace will show when this view is active. For more information on workspaces, see the Workspaces
topicin the System Setup / Super User Guide documentation.

Context mode

B8]

With this view enabled users can view all of an object's data for two or more available contexts in a comparison
display format. The number of contexts viewable at one time is configurable. For more information regarding
contexts see the Contexts topic in the System Setup / Super User Guide documentation.

Revision mode

With this mode selected, users can view the current state of an object's data as well as all previous revisions in a
comparison display format. The number of revisions viewable at one time is configurable, but the current and
previous versions are shown as the default. For more information on revisions, see the Revisions topicin the
System Setup / Super User Guide documentation.

Goto Field

Goto | IDYName -

This field enables searching for specific objects. To quickly locate objects in the hierarchy by their ID, name, or key,
that data can be added into the 'Goto field' and searched on. When the desired item appears in this field, the user
can click on it, taking them directly to the object. For more information regarding the Goto field, see the Goto topic
in the Getting Started / User Guide documentation. For more information on Keys, see the Unique Keys topic
in the System Setup / Super User Guide documentation.
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Tree Tab

This section contains information about how to create and remove local overrides and information about table
dimension points.

r_=| Aszets

..r_=| Configurations
7] Index Words

..r_=| Merchandising Hierarchy
..r_=| Suppliers

(-] Web Sites

E Publications

..r_=| Primary Product Hierarchy
@ Collections

[ﬁ eCatalogs

i} Fecyde Bin

T[ BG Processes (2) ” Search ]

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.

Object Description

Products Itis used to store actual product information. Alternative name is 'Blue folder

Classifications | Itis used to store assets (Images and documents), configurations, and link products.
Alternative name is 'Yellow folders' or 'Secondary classification.'

Index Words An Index structure needs to be created in STEP, in the same way as a ‘Classification
Hierarchy,” and products are linked into this structure.

Entities Itis used to store the party, supplier data, or contact information. Alternative name is 'White
folders.'

Publications Itis used to store print (Example: InDesign) documents and print related configuration like
templates, versions, commercial data, and dtp documents. Alternative name is 'Green
folders.'
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Object Description

Collections Collections are containers for storing different sets of objects to perform bulk update or export
data.

eCatalogs Itis used to create electronic product catalogs. An electronic product catalog is a data file
containing product and price information for a specific product selection. Alternative name is
STEP sync.

Recycle Bin Deleted objects (products, assets, classifications, configurations and entities) are moved to
recycle bin from the Tree tab.

It is used to create electronic product catalogs. An electronic product catalog is a data file containing product and
price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, see the Basic STEP Concepts and
Object Maintenance in Tree topics within this guide.
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Object Maintenance in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of
maintaining objects in the workbench are the same, and are described in the All Objects section of this guide.
This includes general information on creating, editing, approving, and deleting objects.

Note: The All Objects information should be read and understood prior to focusing on any of the object type
specific information (links below), as the basic information that is common to all object types is not repeated in the
type-specific sections.

Beyond the general object maintenance topics, additional information on working with specific object types in
Tree, including details about the various editors and functionalities available on them can be found in the
subsequent topics in this guide:

o Assets

« Classifications

« Collections

« Entities

« Products

« Recycle Bin for Tree

«» Publications: Information about maintenance of objects in the green publication hierarchy is not covered in this
guide. Itis located in the Publication Hierarchy section of the STEP Publisher documentation.

Note: All actions in STEP are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information in
this guide focuses strictly on the means for carrying out the various actions, and assumes that all required
privileges are available to do so. More information on privileges is available in the Privilege Rules topicin the
System Setup / Super User documentation.

A variety of components are also available for maintaining objects in Web UI. For more information, see the Web
User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or via
imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of this
material, but additional information is available in the relevant guides throughout the STEP Online Help.
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All Objects

This section covers the basic functionality of creating, editing, and deleting objects in the Tree, as well as providing
an overview of the commonalities between the various object editors. Regardless of the particular object type or
hierarchy that you are working with, the general principles of creating and maintaining objects are the same.

Itis helpful if the Basic STEP Concepts topic in this guide has been read and understood prior to reading this
material.

A variety of components are available for creating and maintaining objects in Web Ul. For more information, see
the Web User Interfaces documentation. Additionally, objects are often created or maintained within workflows,
or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope
of this material, but additional information is available in the relevant guides throughout STEP Online Help.

Note: All actions in STEP are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values.

The information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege Rules topic
in the System Setup / Super User documentation.

See the relevant section(s) below for detailed information on working with objects in the workbench:
« Approval of Objects
o Creating Objectsin Tree

« Deleting Objectsin Tree
«» Editing Objectsin Tree
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Approval of Objects

This section introduces the user to the concept of approvals in STEP, and provides detailed information on how to
carry out approvals in the STEP Workbench. Approval of objects in the Web Ul is handled via addition of an
Approve action button to a screen.

Approval Overview

The data in STEP is logically divided into two workspaces named Main and Approved.

The Main Workspace is the editable "draft" Workspace where data is initially born and enriched. The Approved
workspace, on the other hand, holds approved data deemed ready for production.

Main Approved

=

Approval

In a typical STEP setup, data from the Approved workspace is made available to downstream systems. Data
cannot be edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation
called approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or other
operation.

The approval operation only applies to objects that are workspace revisable. These are:

« Product objects
« Classification objects
« Asset objects

« Entity objects configured to be workspace revisable

All other objects in STEP (like attributes, references, etc.) will be identical in the Main and Approved Workspaces
and changes made to these will be reflected automatically in both workspaces. These objects are known as being
'Globally revisable'.
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Detailed information on how to carry out approvals in STEP Workbench can be found in the Approving an
Object topic in this guide. This guide also contains a detailed description of the approval symbols that are visible in
the different object editors in the Approval Symbols topic in this guide.

Note: All actions in STEP are controlled via privileges. Some users may not have access to approve objects, or
may only have options to approve specific object types, hierarchies, or attribute values. The information in the
subsequent topics assumes that all required privileges are available to carry out the described actions. More
information on privileges is available in the Privilege Rules topic in the System Setup / Super User Guide
documentation.

In Use and Not In Use Objects

When an object is approved in STEP, it cannot be purged from the Tree Recycle Bin. This is restriction prevents
approved objects that show on the Approved Workspace from being removed erroneously. This prevention is
done by way of the 'In Use' and 'Not In Use' indicators on the object records in the Tree Recycle Bin. For more
information, see the Recycle Bin for Tree topic in this guide or the Recycle Bin for System Setup topicin the
System Setup / Super User Guide documentation.

'In Use' objects cannot be individually deleted nor are they included in the Purge action. A user must perform an
Approve Deletion action on each 'In Use' item.

< (160350) rev.0.8 Deleted (in Use)
-7 Light-track Ll Froof View || Status || State Log | Tasks
-] Luminaire haoist Images & Documents Commercial ” Tables |

1 -3 Mechanical accessories for luminair M[ Sub Products " References " Referenced By |
=

g -] Mumber ftext label for house numbe @ Descripti

&5 -[Z] Pictogram for emergency luminaire
— -[= Pillar for bollard Mame >| > |value

§ ~[Z] Sales Flyers * D 160350

@ -~ Suppliers Root  Mame

=]

& -] Support profile lightdine system -

* Object T Level 2

2 -[Z] Test device for emergency power | L5 s Eve
— [T (160323) * Revision 0.8 Last edited by USE

[~

2 -7 (160324) * |Approved 3 Last Approved on |

i

LE - » [Translation Master

o -7 (160363)

&l E 12-GGK79(2) * Path Primary Product Hierar
— - | 12-GGKT(2)a(2) » Default InDesign template

£ -\ 18210 MB(2) » CalculatedAtiribute £ NjA-

| 18212 L B(Z
E g {} # Child Connt i I

When an object that is not approved is deleted, it shows the 'Not In Use' indicator. This means it will be purged with
the 'Empty Recycle Bin' option and can be totally removed.
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€12-GGK79(2)a(2) rev.0.2 Deleted (Not in Use) -

7] Light-track 2 Tables || Proof View || Status || Statelog || Tasks
-] Luminaire hoist Referenced By " Images & Documents " Commercial |
| ~[Z] Mechanical accessories for lumninair [ Data Containers ” Sub Products ” References |
'.g - [Z] Mumber ftext label for house numbe © Description ~
X -] Pictogram for emergency luminaire -1 |
— [ Pillar for bollard flame Vale
i ~[[T] Sales Flyers » D 245318
E -[7] Suppliers Root * Name 12-GGKTH{Da(2)
= -[Z] Support profile lightHine system
ol (31 Support profile lig Y > Dhbject Type Item
e -[Z] Test device for emergency power |
— [T (160323) * Revision 0.2 Last edited by L
% [T (160324) > |Approved 3L Mever Been Apy
-.E -1 (160350} * Translation Mot Translated
T r_=| {180363)
S - ™ 12-GGK73(2) * Path Primary Product Hie
— - [12-GekTs(2)a(2) » Default InDesign template
[; -'lD"I‘lI'\ KA O

If an object that is approved is deleted, it will still appear in the Approved workspace until an Approve Deletion or
Approve Deletion Recursively action is performed.

The key difference with the System Setup Recycle Bin and the Tree Recycle Bin is that all of the System Setup
objects in the Recycle Bin are flagged with 'Not In Use' since nothing in the System Setup is constrained by
Approval status.

Note: When in the Approved workspace, neither recycle bin will appear.
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Approving an Object

This topic describes how to approve an object in the workbench. When an object is approved, it moves to the
Approved workspace.

Data ownership

The concept of data ownership is very important in relation to approvals. For an object to be fully approved, all data
that the object owns must also be approved. When data changes, the object that owns that data is considered
"modified" and can potentially become 'unapproved.'

The figure below shows data owned by a Product object (the largest box).

Local References
to other Products

Parent Product
Local References
to Entities

Product
< D
% MName

Local Linksto
Classifications

% Local Specification
Attribute Values

<+ Description
Attribute Values

Local References
to Assets

Local Links to
Specification Attributes

T

o A Product owns its parent link (also true for Classifications, Entities and Assets).

« The Product owns local values, but not inherited Specification Attribute values. Thus, when these are modified
at an ancestor level, this will not affect the Product’s approval status. Also, the object's local values (that is,
assigned at the product level), will be approved.

« The Product owns all local References and Links for which it is the Source. When a Link or Reference is
modified, it is the Source that is changed while the Target is unaffected. Attribute values on the Reference /
Link are likewise owned by the Source object.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 119



StiboSystems

MASTER DATA MANAGEMENT

Approve an object

To approve an object, right-click on the object and select one of the available approval options, or use the options

on the Maintain menu.
_ Maintain Window Help

% 2: Bl New Classification Ir.uert »| (¥ URL | d=1083748contextid=Context18id=As
| EIET { New Asse Cirs Shift+ A Link '
% F_=| Ind & New Product Merge ? broducts || References || Referenced By [ﬁ
;l % !:II b Import Images & Documents... ¥ Delete
% r_=| We @ Export Images & Documents... Force Delete & Purge | ake
Y| EEE & Export Data Below Unlink Object Type pssetsRoot
E' "'—J oD Map eCl@ss Attributes fissets
@ ﬁ Put , o e Duplicate Ctrl+) Msset Root
T r—=| Pri i csseator Eg Duplicate Recursively 0.1L i i i
3| @6 col .1Last edited by Stibo Systems on Fri .
ﬁ w8 e & Cu Ctrl+X Moke Revision o Approved on Fri Jan 02 00:00:00 £S
z ﬁ Re Copy Ctrl+C nt Translated
i Paste Cirl+V Approval Approve Object Ctrl+Shift+)
__!T Paste Link Cirl+L Enable group for workflows Partial Approve...
El X Delete Revive s
i e Duplicate Ctrl+) Revive Recursively e Deletmln
3 Eg Duplicate Recursively Approve Recursively
x
§| Approve Object Ctrl+5hift+]
E Partial Approve...
— Check Approve

Approve Recursively

Note: If 'approval' is a task within a workflow, then objects can alternately be approved from the task view. See
Working with Tasks in Workflows in the Workflows documentation.

Approve Obijects is available when the Main workspace is selected.

Approving objects is available for:
« Classifications
o Products

« Images & Documents
« Entities (setup to be Workspace revisable)
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The status of an object in the various workspaces can be viewed in the Status tab in the Workspaces field of the
relevant editor.

18210 M B_EN rev.0.57 - Status

Product || SubProducts || References || Referenced By || Images & Documents || Commercial [m Category Profile || Proof View m State Log [ﬁ]
* 0.4 Fri Aug 26 11:12:03 EDT 2016 Mon Aug 29 12:06:58 EDT 2016 LISER4 Auto Generated
* 0.3 Fri Aug 19 14:13:58 EOT 2016 Fri Aug 19 14:13:53 EOT 2016 LISERE Auto Generated
» 0.2 Tue Aug 02 09:15: 20 EDT 2016 Tue Aug 02 09:15: 44 EDT 2016 LJSERG Auto Generated
* 0.1 FriFeb 13 11:36:39 EST 2015 FriFeb 13 11:36:39 EST 2015 STEPSYS
@ Workspaces

D > Name > |Path »

» Main Main Main 0.57
* {Approved Approved Approved 0.53
» Werification Verification Verification 0.4

Once object editing is complete, and the object is ready for publishing, approving the object copies the current
object values into the Approved workspace.

Conditions to approve an object

Objects must be approved from the Main workspace.

An object cannot be approved if parent objects are not yet approved (approving must be done from the top
down in the hierarchy).

A Reference or Link cannot be approved if the Target does not exist in the Approved Workspace, i.e., ifa
Product / Classification is referenced with another Product / Asset / Classification, then the referenced Product
/ Asset / Classification needs to be approved first before the actual Product / Classification is approved.

If Attributes or References / Links are Mandatory, objects cannot be approved if there are no values / targets.

Externally Maintained Attributes or References / Links are not under revision control. Values / references will
automatically be reflected in the Approved Workspace and modifying the data will not affect object’s approval
status.

The user must have sufficient Approve privileges.

To easily check differences in the Main and Approved Workspaces, select Partial Approve, as discussed
below.

When approving, the object's revision number changes automatically.

An entire hierarchy can be approved using the Approve Recursively option. For more information, see
Approving Recursively below.

Partial Approve

It is possible to approve an object that has a Reference / Link to another object that does not exist in the Approved
Workspace. In this instance, the object will become “partially approved”, meaning that the object and all data that
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can be approved will be approved. However, the Reference / Link will not be approved. If the Target for the
Reference / Link is later approved, the Source will need to be approved again for the Reference Link to be updated
in the Approved Workspace.

Main

Approved

Classification only
in Main

Productsought
approved > E-

Partial approvals can also be performed deliberately - both manually and programmatically. Specific Attributes,
References, Links, and the object Name can be selected for approval. The Attributes, References, Links and
Names are sometimes referred to as “part objects”. These part objects cannot exist in the Approved Workspace
without the object to which they belong. Thus, when the first part object is approved, the object will need to be
present in the Approved Workspace.

Productwithout Link to
Classification

Usage

Partial approval of selected elements of the object is particularly helpful in situations where certain elements of the
object need to be available for usage (in the Approved Workspace) before the rest of the object or its elements can
be approved.

For example, consider that there are two users who perform changes for a product and then approve the product.
If the product is completely approved, then it can be difficult to identify which user performed specific changes. In
this case, using the Partial Approve will allow the user to approve the changes performed only by him / her and
leave the rest of the changes to be approved by the other user who made those changes.

Approve partially

1. Inthe Tree, select the object you wish to partially approve.

2. Inthe Maintain menu, click Approval > Partial Approve. Optionally, right-click the selected object and click
Partial Approve.

3. This will bring up the Partial Approve dialog box:
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33 Partial Approve

Main Approved
1 [All Elements]
=I-£ Attributes
=11 Attributes for Web UT Screensho
P DI Hazmat Yes Details...
Expand All Collapse all
Suppress Re-Translation
| Approve Selected | Checdk Cancel

4. The user has to select the required element / elements (for example, attributes) and click on ‘Approve Selected’
button.

Partial Approve Compare View Dialog
The dialog shows which elements of the selected object have been changed since the last approval of the object.

Besides Name, Parent Object, and Default DTP Template, the type of elements listed are attributes, references,
and tables. For each element the values in Main and Approved Workspaces are listed.

For detailed information about the value for an element, click the Details...link. This displays a detailed view of the
element showing the values for the Main and Approved workspace:

32 Partial Approval Compare View - Hazmat

Main Approved

Cancel

In the above example, the value for the attribute Brand Name has changed. Values only present in Main
workspace are marked with a green background color. Values only present in Approve workspace are marked
with a red background color.

Note: The detailed view differs slightly depending on the element type selected.

All elements are selected as default. To deselect all elements, click the checkbox next to the All Elements node.
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You can select the element(s) you wish to approve by clicking the check boxes next to each element. You can also
select a whole element group, i.e., Attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click the -
sign next to the element group. To expand all elements in the dialog, click the Expand All button. To collapse all
elements in the dialog, click the Collapse All button. To check if the selected elements can be successfully
approved, click the Check button. An Approve report will subsequently summarize the result of the check.

Clicking the Approve Selected button will approve the selected elements of the object and the Approve status of
the object will change accordingly. Normal Privilege rules apply to Partial Approve. For more information, see
Action Sets.

Suppress Re-translation

Normally, an approval of a translated Product in a source language will cause the Translation status of the
Product to be set to Re-translation needed. In the Partial Approval dialog this behavior can be suppressed by
clicking the Suppress Re-translation checkbox. All existing translation relations with status 'Up to Date' will
remain in status 'Up to Date'. This is especially used in cases where only minor changes are approved and no re-
translation is needed. For more information, see the Translations documentation.

Note: To get a list of language variations of the object that potentially will be affected by the approval, place the
cursor on the Suppress Re-translation label.

Check Approve

If you are unsure whether or not you are allowed to completely approve an Object, you can run a Check
Approve.

1. Inthe Tree, click the Object to be approved.
The Editor shows the Object contents in Main and Approved Workspaces.

2. Inthe Maintain menu, click Approval > Check Approve, or right-click on the object, and then select Check
Approve option.

« If you only have changed attribute values for which you have the Approve privileges, a Complete Approval
Possible dialog box appears.

3 Complete Approval Possible

The object can be be approved completely

without errors,

« Ifthe product cannot be approved due to multiple reasons, such as Mandatory values / References being
empty, then the report will provide details about the missing information, as shown below:
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$3 Unable to approve product

Approve report for 18210 M B
Unable to approve object due to missing mandatory values on attribute(s):
Manufacturer Name

Ok

Note: If you have changed attribute values for which you do not have the Approve privileges the Approval options
are unavailable.

For example, consider a Product that has multiple attributes linked and has mandatory values and references
which needs to be approved after the changes have been done. In this case, scrolling down or switching between
tabs to check if the values are entered is time consuming; Check Approve will help the user to know if the product
can be approved completely with a detailed report.

Approving Recursively

Approving Recursively is done from the Main menu by clicking Approve Recursively. Similarly, the Approve
Recursively can be done by right-clicking on the Product as well.

Approving Recursively is available when a Main Workspace is selected.

Approving Recursively is available for:

« Classifications
¢ Products
« Images & Documents

« Entities (setup to be workspace revisable)

The status of an Object in the various Workspaces can be viewed in the History tab in the Workspaces field of the
relevant Editor.

Approving Objects recursively means searching for unapproved Objects linked to (or below) a selected hierarchy
node, and approving these Objects (copying them to the Approved Workspace).

This is useful and time saving e.g., when a lot ofimages have been imported and checked and should all be
approved.

To recursively approve in the 'Main' Workspace:

1. Inthe Tree, select the hierarchy containing the Objects to be approved.

2. Inthe Maintain menu, click Approval > Approve Recursively.
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A dialog box appears, listing the Name of the selected hierarchy node, contained Objects and status of
analysis.

Note: Approve Recursively automatically performs a search for unapproved Objects. You can click the Skip
Analysis button if this is not needed.

32 Approve Recursively

Q Finding Unapproved Objects (This might be time consuming)

Ohbject » |Classifications * Products  * |Assets
18210 M B_EN 0 1 0

@ Empty mandatory links/values in Main workspace

Validator » |Classifications * Products  * [Assets
Missing mandatory values 10 2 0
Missing mandataory links 0 0 0

< >

Start Process with Description
Mame | Approve 18210 M B_EN

Skip Analysis Cancel

3. Optionally, type a name for the process.

4. Click OK button to start the approve process.

A dialog box appears displaying information on the process.
5. Click Go to process button.
The Process view opens, showing details of the process and a report of approved Objects.

The hierarchy will now have Approved status indicating that it is copied in the Approved Workspace.

Approval feedback

When clicking Approve Objector Partial Approve, you might get different types of warnings, depending on
your Approve Privileges.

Approve Object Feedback

If you have modified attribute values for which you have Approve Privileges and at the same time have modified
attribute values for which you do not have Approve Privileges, an Unable to Approve the Entire Object
dialog appears.
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$3 Unable to Approve the Entire Object

Missing approve values privilege on attributes:
Tshirt fity

Aftribute_Fnglish

Short Ttem Description

OK

If you have modified attributes values and do not have Approve Privileges, then the option 'Approve' is disabled

in the right-click menu. If you have modified attributes values for which you do not have Approve Privileges, a
Missing privileges dialog appears.

3 Missing privileges

You do not have suffident privileges to approve
any of the non-approved modifications performed

on this object

For more information about user privileges, see the User Actions topic in the System Setup / Super User
Guide documentation.

Partial Approve Feedback

If you have modified attribute values for which you have Approve Privileges, and at the same time you have
modified attribute values for which you do not have Approve Privileges, a Partial Approve dialog box appears.
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33 Partial Approve

Main Approved
71 [All Elements]
-7 Attributes
-1 Category Specific Attributes
=121 Display
=-£7 Manual Sequencing Display
i...[|T short Ttem Description | T-shirt, short sleeve, Mens M, T-shirt, short sleeve, Mens M, Details. ..

Expand All Collapse Al

[ ] Suppress Re-Translation

| Approve Selected Chedk Cancel

In the example above, the user will be able to approve all attribute values in Attribute Group Manual Sequence
and Category Specific Attributes. All attributes users do not have permissions for will not be displayed.

Approve Recursively feedback

1. InBG Processes, click Approve Recursively, open Active or Ended Processes, click the relevant process.
2. Inthe Background Process tab, open Execution Report.

§ Execution Report

Recursive approval started on "235915" in context "English US
Approved 0 classifications; 1 products; 0 assets; 0 entities..
Recursive approval of 1 objects done. 0 warnings and 0 errors.

If there are any errors, the report will provide details about the error. If the process or approval was successful,
then the report will show 0 errors and 0 warnings.

The following example shows a missing mandatory attribute value, which caused the object to not approve.
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2 Execution Report

Recursive approval started on "235915 in context "English U3
Approved 0 classifications; 1 products; 0 assets; 0 entities.; 1 errors
Approve error report for 235915-2
I LInable to approve object due to missing mandatory values on attribute(s): step:ifattribute?id=Target_Attribute
Recursive approval of 1 objects done. 0 warnings and 1 errors.

H 4l 1-50f5 [k 2 SEVE... Truncate

Approve Recursively dialog

3% Approve Recursively

Q Finding Unapproved Objects (This might be time consuming)
Ohject * |Classifications * Products  * |Assets
13210 MEB_ENM 0 1 0

2 Empty mandatory links /values in Main workspace

Validator » |Classifications * Products  * |Assets
Missing mandatory values |0 2 0
Missing mandatory links ] 0 0

£ >

Start Process with Description
Mame | Approve 18210 M B_EN

Skip Analysis Cancel

There are multiple options which are explained below:

« Finding Unapproved Objects: This will analyze the hierarchy and then provide the count of the number of
Products / Classifications / Assets / Entities which are currently in unapproved status.

« Empty Mandatory Links / values in Main Workspace: This provides the details about the number of
mandatory links / references that are missing for the Products / Classifications / Assets / Entities.

« Start Process with Description: This option is used to enter the name for the Process before starting the
background process. This option is not mandatory but is recommended as entering an identifiable name
can be useful for review purposes.

« Skip Analysis: This option can be used in cases where the number of child products is large. The analysis of
the number of unapproved or missing mandatory values / References can be time consuming but will
provide the detailed report. By clicking this option, the analysis will stop and the user can proceed with the
approving recursively.
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For example, consider there are hundreds of products in a particular parent hierarchy. Selecting each product,
one at a time, and then approving them would be time intensive. In these cases, approving recursively will help
a user to approve all the products at one time.

Context Dependent Approvals

When an object is approved, that approval always happens in a specific context and will only be applicable to
data visible in that context.

To illustrate this concept, see the figure below in which object 'P' has values for two different attributes, Color
and Width, in the Main workspace. While Width is not dimension dependent, Color is, and has different
values in two contexts: 'Blue' in the English context and 'Bleu' in the French context. If the object is approved in
the English context, only the data visible in the English context will be reflected in the Approved Workspace.
Because of this separated approval, the object must also be approved in the French context to have it become
completely approved, indicated by a green checkmark in the approval status field. Until this approval across
contexts is done, the object in the English context will have the status 'Approved in Current Context on [date +
time]', indicated by a yellow checkmark, and the object in the French context will have the status of 'Last
Approved on [date + time]' (red X).

Main Approved
Width: 20 cm Width: 20 cm
Colar (EN): Blue Color (ENJ: Blue
Color (FR): Bleu Color (FR):
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Approval Symbols

The Approved symbols are used to indicate the status of a Product, Classification, Image or Document. The
Approved symbol is viewed by clicking either a Product, Classification, Image or Document.

If you need to approve data, this is typically done in:

« Normal viewing mode - either approve a single object, or you can approve recursively.

« Approved mode - approve all Objects, or you can partial approve Objects (choose specific Values and
References to be approved).

An Object can contain revised data or not revised data.

Not revised Objects are:

« Externally maintained Attributes
o Commercial Data

« Entities, which are not set up to be Workspace revisable

Revised data are:

« Internally maintained Attributes (e.g. Description Attributes and Specification Attributes)
« References between Objects:

« Product to Image / Document Reference

« Product to Product Reference

« Product to Classification

» Product to Entity
« Classification to Classification
« Classification to Entity

« Image/Document to Entity

« Image/ Document to Classification

« Entity to Entity

« Entity to Product

« Entity to Image / Document

« Entity to Classification
« Object names (e.g. Product names, Images & Documents names and Classification names)
o STEP PIM Tables
« Linked Attributes to Product
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Note: Only the status of revised data are reflected in the Approved field (see the table below for more
information).

The Approved field contains one of three different symbols indicating the Approved status of the current Object.

Approved Status Description

Symbols

X Unapproved | Revised data on Product, Classification or Images & Documents in current
context are not approved.

Examples can be:

« An Object has never been approved.
« Revised data (e.g. Attribute Values, References, Object names or tables) have been

changed in current context without being approved.

Examples of changes to revised data could be:

« Achange in Object name.
« Achanged value on an internally maintained Attribute.
« Ifan Attribute has been linked to a Product.

« If Reference links to Objects have been made.

Note: When linking a Product to Classification and in case the Classification
Object Type owns the Product links, then the Product does not get the
Unapproved symbol. For more information, see Online Help - Object Types &
Structures.

Privileges can have an influence on the Approved symbols. See 'Users with
Different Privileges' below.

v Approved Revised data on Product, Classification or Images & Documents are approved
in all contexts.

Note: No data in current context or any contexts are to be approved.

o Partial The yellow Partial Approved symbol can appear if:

Approved . , ;
Revised data have been approved in current context but a Reference, Object

name, or Value need also to be approved for the Object to get approved in all
contexts.

If you change view to another context, then you typically see that:
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Description

« Adimension dependent Reference is not approved.
« Adimension dependent Value is not approved.

« Adimension dependent Object name is not approved.

Note: When all the dimension dependent References, Attribute values and
Object names have been approved, then the symbol will change from yellow
Partial Approved symbol to a green Approved symbol.

Privileges can have an influence on the Approved symbols. See 'Users with
Different Privileges' below.

Different Approval Status Messages in the STEP Application

1. Unapproved

In these examples, objects are shown as an unapproved status in 2 different situations.

When an object is newly created and never been approved as shown below:

Mame *| > |Value H
* 1D 1235915
¥ Mame 1235915-2
* Object Type Active Products
» Revision 0.1 Last edited by USERE on Thu Oct 12 12:04:10 EOT 2017
» |Approved x Mever Been Approved

When an object attribute / reference is modified, the status will show as “Last Approved on” along with the date

and time as shown below:

Mame *| > |Value >
* 1D 1235915
* Mame 1235915-2
» Object Type Active Products
» Revision 0.3 Last edited by USERE on Thu Oct 12 12:09:07 EOT 2017
» |Approved x Last Approved on Thu Oct 12 12:09:03 EDT 2017
2. Approved
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Mame »| * |Value >
» 1D 1235915
* Mame 1235915-2
» Object Type Ttem
» Revision 10,31 Last edited by USER4 on Mon Jan 07 17:56:10 EST 2019
* Approved « Approved on Man Jan 07 17:55:10 EST 2019

3. Partially approved

Mame » | » |value »
> D (235915
* MName 1235915-2
» Object Type Active Products
* Revision 0.5 Last edited by USERE on Thu Oct 12 12:13:20 EOT 2017
» |Approved « Approved in Current Context on Thu Oct 12 12:15: 13 EDT 2017

Users with Different Privileges

If two users have different View privileges, then they might get two different Approved symbols when looking at an
Approved Object.

Example with Attribute can be:

» User 1 has the privileges to see all Attributes
« User 2 has limited privileges and can only see some of the Attributes

If changes are made to the Attributes that only User 1 can see, then User 1 gets the Unapproved symbol, while
User 2 only gets the yellow Partial Approved symbol as no changes has been made to the Objects he can see.

If changes are made to Attributes that both User 1 and User 2 have the privileges to see, then both users get
the Unapproved symbol.
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Creating Objects in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of creating
objects in the workbench are the same, and are described below. Tree icons are set during object type creation
according to preference and may be different in your system.

Note: All actions in STEP are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on the means for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup / Super User documentation.

Objects can be manually created in the Tree via right-clicking or using the Maintain menu.

Create a new object via right-click
1. Select a parent under which the new object should be created. Note that if the new object should be created as
aroot node on the Tree tab, the Maintain menu must be used (see below).

2. Right-click on the parent and select the appropriate 'New...' option. The options will vary based on the selected
parent. For example, note the differences between the available options on a classification and an entity, as
shown below.

-] Bese™ "l assif -] Entity Root ”~

r_=| coni £2  Mew Classification [ % Customer Hierarchv
B ETIM 2 New Asset Ctrl+Shift+A | | o Key Accounts L Bl iZ

--gfrjde id  Mew Product

3. Selecting the right-click option will open a Create dialog, appropriate for the selected object super type (e.g.
Create Assets for assets and Create Entity for entities). The options available in the dialog are based on the
data model defined in System Setup. For example, the Object Type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being
created does not have autogenerated IDs applied.
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33 Create Asset X 33 Create Entity
Object Type CObject Type
@ Assets & ®) Customer
() Auto Classification Rule Set
jin] CUS 114886
() Bulk Update Configuration " :
Marme
1D
Create Cancel
Mame
Create Cancel

4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking Create
completes the creation of the new object, which is then accessible in the Tree. If a Name is not supplied, the
object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation, the object will
display in the Tree using the Name entry. For example, two new objects have been added under Customer C
in the screenshot below. The first did not have a Name supplied, while the second did.

-l Entity Root

=+ Customer Hierarchy

8 Customer A
8 Customer B

28

-4} (ADD_114888)

Henry Magnus

Create a new object via the Maintain menu

From the menu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use this method when adding a new root node to Tree. Additionally, note that the
available options differ based on the active selection when the menu is accessed. For example, the below shows
the available insert options when a classification has been selected, whereas the publication-related options would
be enabled if a publication object had been selected instead.
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File Edit View Mavigate Format Maintain Window Help
44 Context |Engish US Insert @ Product Ctrl+Shift+P
Link [0 Classification Ctrl+Shift+C
ﬂ F_=| Assets Merge 5] Classrflc?tmn Root Ctrl+5Shift+R
i ({7 Configurations % Delete MNew Entity Node
? r_=| ETIM Hierarchy ) 3 Entity Root
v B[ Index Words Force Delete & Purge A
il | [#-[ 7] Merchandising Hierarchy Unlink Object Type
— r_=| Suppliers B New Publication Group
% -] Web Sites 52 Duplicate Cirl+] | @@ Mew Publication Section...
E i Entity Root By Du plicate Recursively . New Page Template ..
&1| () GDSN _ _

o ﬁ Publications Make Revision &3 Orphan Attribute Ctrl+Shift+0
T [+ Primary Product Hierarch Accet Ctrl+Shift+A
: g Cﬂ"ec:iﬂﬂs Approval IT Attribute CtrlShift+T
-0 eCatalogs Enabl for workfl - i

el & nable group for workflows

i ﬁ Recyde Bin BT Attribute Group Ctrl+Shift+]
2l Revive Bl List of Values Ctrl+Shift+L
_!T Revive Recursively . D?r‘nen S?Dn . Lo Sh?f“ -
EI . Dirnension Point Ctrl+Shift+M

g Truncate log... Workspace Ctrl+Shift+W
m
— B Actionset Ctrl+Shift+5
3

x

(=]

=l

a8

=

uw
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Mew Image Conversion Configuration...
Create Transformation Lookup Table
Mew Event Queue

Mew AssetPush Event Queue

MNew AssetPush Configuration

B STEP Workflow Ctrl+Shift+R
- Background Process to Monitor Deadlines  Ctrl+Shift+D
& User
& Group Ctrl+Shift+G
&8 New Supplier

Create Package
- Create STEP Workflow Ctrl+5hift+R

Mew Business Condition

Mew Business Action

Mew Business Library
B Setup Group Root...
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Many of the available options will only be enabled when an appropriate selection has been made on the System

Setup tab. For example, an attribute group must be selected for the Attribute or Attribute Group options to be
enabled.
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Deleting Objects in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of deleting
objects in the workbench are the same, and are described below.

Note: All actions in STEP are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on the means for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup / Super User documentation.

Objects can be deleted from the Tree by right-clicking on the object to be deleted, or via the Maintain menu when
the object to be deleted has been selected. In both cases, the Delete option is selected from the menu, and
deletion of multiple objects is supported using Ctrl or Command to multiselect.

Convert to Product-COwerride Maintain| Window Help

i =[] Products Unlink product | ~
=8 = "% cut Ctrl+X ! Insert 4
_— =T Ur - . ,
< 2 B Copy Ctrl+C Link
o : ,
E = Paste Ctrl+V Merge
4wl ,
— Paste Link Ctrl+L . % Delete
B ¥ Delete

Selecting Delete will open a deletion confirmation window, which will vary slightly based on the object selected for
deletion. For example, a classification provides an option to unlink child products rather than delete them, while
deletion of a product will automatically delete all child objects.
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31 Delete

8 Delete

Are you sure, you want to defete tis object and its sub-objects? Are you sure, you want to delete this object and its sub-objects?

e

ame » {igsets Sub-Product Count  » Classifications »
* 7| Assets ID = AssefsRoot B9 0 71

o

Sub-Product Count
0

r5ub Products

(®) Unlink

(O Delete Delete Cancel

Delete Cancel

Clicking Delete will attempt to delete the selected object (and delete or unlink child objects as appropriate). A
confirmation window will appear detailing success or failure. Note that in order to delete an object, a number of
conditions must be met. For example, the object must not be referenced by any other object and must not be active
in any workflow. If the deletion conditions are not met, the confirmation window will display the errors, which must
be corrected prior to deletion of the object.

$2 Delete report

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below.

Mame
ﬁ 12-GGK799 1D = 100703

-Delete Objections

"12-GGK799" could not be deleted due to the reasons listed below:

step://product?id=18210 has a cross reference to the object being deleted step://product?d=100703. The
link is visible in these workspaces Approved, Main.

step:jproduct?id=18212 has a cross reference to the object being deleted step://product?id=100703. The
link is visible in warkspace Main,

-Warning! If you use force delete, the below actions will be taken,

Cross references to objects being deleted will be removed, These cross references will not be reconstructed, if the objects
are revived,

Force Delete Close
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In some cases, a Force Delete option is available, though it is recommended to correct the data whenever possible
rather than forcing deletion. Also note that updates may need to be approved in order to take effect. For example,
if an object has been referenced by another and that reference has been approved, removing the reference must
also be approved (by approving the change on the referencing object) to resolve the deletion objection.

Once an object has been deleted, it is visible in the Recycle Bin for Tree, from where it can be revived if needed. In
order to fully delete the object, the deletion must be approved and the object purged. Following a purge, the object
cannot be revived.

Tree .

El T} Recyde Bin
~[—] Smart Sheet Configurations .3. B
J GOSN l;] g
- [ Japan
- [ Mexico .
- () MyCICs M
- (O] MyRegistrations * M
m (111507 * C
m (11484 7 Purge
- (11485 Approve Deletion

L
E Eiﬁ’z Approve Deletion Recursively
E {abcde Revive
g 12119 Revive Recursively
[ TS -

For more information on the Recycle Bin for Tree and the available actions, see the Recycle Bin for Tree topic
within this guide.

Alternatively, an object can be deleted and purged in one go using the 'Force Delete & Purge' option in the
Maintain menu. Choosing this option will bypass the Recycle Bin and is equivalent to completing a deletion and
purge all in one action. However, this option does NOT cause an approve deletion event in the system, so if
deletion events need to be recorded for output to downstream systems, this option should not be used.
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Editing Objects in Tree

Objects can be easily edited within Tree, and general principles for editing are the same, regardless of the type of
object. The available tabs will vary based on the object type selected, as well as other considerations such as data
model and licenses. Some tabs are common across the various object super types, while others appear only on
specific object types or subsets of object types. Additionally, some editors appear on more than one super type,
but have differing functionality based on the type of object that has been selected.

This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

Note: All actions in STEP are controlled via privileges. Some users may not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on the means for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in the Privilege Rules topic in the System
Setup / Super User documentation.

When an object is selected, the main portion of the screen displays a corresponding editor. The main editor for the
object is the first tab, which is Classification in the below example.

Tree
B Assets EEATET M | Sub Products || References || Referenced By || Images & Documents || Tables || Stabus || Statelog || Tasks
® Desaript

o
- [ Tustrations Name 13 Walge
- [ Installation Manuals
» 1D IconFoot
[+ 7] Logos
[ 7] MSDS Sheets » Mame lcons
-] Owners Manuals > Object Type Tcons
g zr';d“d Images > Revision 0.1Last edited by Stibo Systems on Fri Jan 02 00:00:00 EST 1870
-7 Videos
Fi-{ ) Configurations » Approved o Approved on Fri Jan 02 00:00:00 EST 1970
{7 Index Words » Translation Mot Translated
[]E E“_b"mﬁ;”: e » Path Classification 1 root/Assets/Icons
|- Primary Product Hierarchy
:E Products > Visbilty
i Discontinued Products | || * Purpose ate Storage for icons

All objects will have an ID, Name, Object Type, Revision, and Path field. Objects that are subject to approval
(known as 'workspace revisable') will also have an Approved field. ID cannot be changed once an object has
been created, so the field appears yellow, meaning it is not editable. Revision and Approved data is auto-
populated by the system, so these fields are also not editable. Conversely, object Name and Object Type can be
edited (assuming the user has privileges to do so), so those fields appear white.
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Note: Any number of attributes may be added to objects under the Description flipper. However, not all data
shown in the Description section is an editable attribute. Fields such as ID, Revision, Approved, Translation, and
Path are aspects of the object (not attributes), and are not editable. Name and Object Type are also aspects of the
object, though these may be edited.

Some object types only support Description attributes, meaning all object data is accessed under the Description
flipper. For object types that support Specification attributes, data is organized by attribute group, and clicking the
magnification icon (indicated by a 1 in the screenshot below) will collapse or expand each group, allowing users to
focus on the relevant data. All attributes have a validation base type applied that determines the allowable data
that can be entered, and is indicated by the icon to the right of the attribute name below (2). Detailed information
on attribute validations is available in the Validation Rules topic in the System Setup / Super User guide.

To edit data, simply click in any editable field. Text attributes can be edited by typing directly into the field, while
LOV attributes will provide a dropdown from which users can select a value, as shown below (3).

Tree

m Sub Products || References || Referenced By || Images & Documents

=[] Products -~
EI r_=| Apparel 0 o —
. [T Upper Body Wear =
=8 r_=| T-shirts ' Manufacturer Information
E - T-shirts Items Mame >| > |Value
- | 12-GeK799 » Manufacturer's Part Number |abe 0090828842
. -l Cotton T-shirts » Manufacturer Name abe Hats-R-Us
| New Shirt > Country of Origin ANTIGUA AND BARBUDA
; =1l Polo T-shirt » Product Name (be
[#-[[T] T-Shirts Sales Ttems @ Category Specific Attributes
¢ [0 Head Wear Name -
: g ::::;ear » Material |ab¢ Cotton/Polyester
r_=| Hardware ’ C:.?ulur E
r_=| Displays > F‘rlm.aryuI Fulur |ah
1—_:I Furniture » T-shirt Size
r_=| Automotive %
r_=| Building Products N
r_=| Electrical & Electronics 5 Atf‘
i o
E LFET and Beverage 9 3 af}ﬂ_
dy %S
WHL
‘l L

Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2
opens the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, see the
STEP Workbench Keyboard Shortcuts topic within this guide. The data fields available for editing will depend
entirely on the data model and will vary for each implementation.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 143



StiboSystems

MASTER DATA MANAGEMENT

Note: Data edited in the workbench is auto-saved, with the change / save being applied as soon as the user exits
any field. Therefore, no explicit save action is ever required by the user.

If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will change the
approval status (if the object had been previously approved). See the Approval of Objects topic within this guide
for more information on approvals.

Multi-Editors

Objects can be multi-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally, objects
of the products and classification super types have a Sub Products tab that can be used for multi-editing.
Functionality for editing objects is comparable, regardless of how the multi-editor interface is accessed.

Right-clicking in any row header will expose the Rotate Table option which can be used to access the preferred
orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active selection.). Editing
in this manner allows for easy copy / paste of values between objects using Ctrl + C and Ctrl + V.

Tree 14 Products
= Key Accounts A m References || Referenced By

(-0 GDSN

[]...ﬁ Publications View: Show all =

(=[] Primary Product Hierarchy

EE Products Hame » |12-GGKT99 » Mew Shirt >
ED_ Apparel Name + Nama 12-GGKT99 New Shirt
Dlgiuj”p;i‘”: Wear Ohject Type iz Item Item
. ir
& g it Tems Revision Aol s 0.13 Last edited by USER7 on W... 0.1 Last edited by USERE on Tue ...
E 12-GGK799 Path Rotate Table Primary Product Hierarchy/Produ... Primary Product Hierarchy Produ. .,
E Cotton T-shirts Approved > Approved | Rotates the current table |red on FriOct 23 ... |3 Never Been Approved
- Palo T-shirt Translation > Translation Mot Translated Mot Translated
r_=| T-Shirts Sales tem | ||Default InDesign template  * Default InDesign template
[#-[7] Head Wear Default Quark template > Default Quark template
[+ 7] Footwear UFC s PG
-] Safety EAN > EAN
[+ ] Hardware GTIN > GTIN
t£-{I] Displays v ||[Provider GLN > Provider GLN
£ D » Completeness Score » Completeness Score

Right clicking in any data cell will expose the Hide Equal and Mark Different options, which are especially useful
when working across multiple objects as they will hide all equal values, or highlight all different values,
respectively.
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Cut

Copy
Paste
Paste Link

Rotate Table
Hide Equal
Mark Different

* R

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+L
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Additional options for viewing data are available using the View menu located in the upper left corner of the multi-

editors.

Product |F‘|'uduct 'ENEG | Sub Producks

=

View: Show all

Mew View
Edit view

Remove view

Product views *

>

¥

The default view option is to Show all which displays all data on the object, similar to what would be available in a
single-object editor. Additional options can be configured using the New View option. Clicking this opens a dialog
for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the user can

select the attributes to be included in the view.
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33 Edit Filter
{Legal Atiributes '-|| (®) Show only (") Do not show
i ~ Add i ~
Name Name
Object Type Remove Object Type
Revision Revision
Fath Add Al Fath
Aoaroved Aoaroved
Transizfion RemoveAll Transizfion
InDesign Template InDesign Template
Annual Sales Forecast, Maximum Annual Sales Forecast, Maximum
Annual Sales Forecast, Minimum Annual Sales Forecast, Minimum
Category Category
Colar Colar
Completeness Score Completeness Score
Description, Long Description, Long
Description, Web v Description, Web v
= LNt O all=d 4 = LNt O all=d 4

Update table setting

Save Cancel

The dialog defaults to having only "legal" attributes shown, meaning those attributes that are valid for the object, as
well as standard aspects of the object such as ID and Name. Note that object aspects are italicized, while
attributes are shown in standard text. By default, all available attributes and aspects are shown in both the left and
right panels. The dropdown in the upper left corner also has options to expose standard attribute search / browse
functionality, though typically the Legal Attributes selection is used as this prevents a user from defining an invalid
view. The 'Show only' and 'Do not show' radio buttons are applicable to the right panel, where the data for the view
is defined. The Add button is used when an attribute or aspect has been selected in the left panel and should be
added to the view (the right panel). The Remove button is used when an attribute or aspect has been selected in
the right panel that should be removed the view. The Add All and Remove All buttons are used to add or remove
all attributes and aspects from the view. Clicking Save stores the new view.

Once one or more views have been created, they are available for selection from the View menu under Product
views.

View: Show all

Productviews : ~  Streamlined View
Mew View Show all
Edit view ¥ * Name

W

Remove view -] Objec
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An existing view can be edited using the Edit view option, and a view that is no longer needed can be removed
with the Remove view option.

Note: Views are user-specific and machine-specific, so a view created by one user will always be available for
that user when using the machine on which they created the view, but will not be available for any other user or for
the same user working from a different machine. Workbench views are stored in an XML file on the user's local
machine at C:\Users\[user\STEPUserViews[UserID].xml. If the file is deleted, the configured views will no longer
be available.

Right-Click Editing Options

Additional editing options are available by right-clicking within the various editors. These include standard cut/
copy / paste options, as well as more exotic options which are briefly described below.

Note: Not all options are available and/or enabled at all times. Some options are available only for particular
attribute validation types, and others are available only on specific editors and/or object types. Menus also change
based on whether the right-click takes place on the column or row header, or within the active editable value field,
as well as when a single object/ column / row has been selected vs. when multiples are selected.

« Character Tag: Used as a quick option to add tags to attribute values without having to enter the Rich Text
Editor. Character tags that have been defined for the system will be available as sub-options to the Character
Tag selection. For more information, see the Tags topic in the System Setup / Super User guide.

« Edit: Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell
check, special characters, etc.

« Filter: Used tofilter the displayed data under any flipper, by values, and is exposed by clicking the column
header. This can be especially useful when working with attribute groups with a large number of attributes in
them as it allows users to filter based on empty / populated, greater than / less than, etc.

« Footnote (Insert / Edit): Used to add an additional piece of information (e.g., a footnote) to an attribute value.
Footnotes are added / edited within the Rich Text Editor so using these options will open that dialog. Note that
footnotes are only supported for use in conjunction with STEP tables. Using footnotes within attribute values
that will output in something other than a table will not yield the expected results. For more information on
footnotes, see the Tags topic in the System Setup / Super User guide.

« Hide: Used to hide a particular row or column from view, and a hidden row or column is exposed by clicking on
the row indicator or column header.

« Hyperlink (Insert / Edit, Follow, End): Used for adding hyperlinks to attribute values. Highlight text within
the attribute value and select the insert option to provide a hyperlink to be assigned to the selected text. After
inserting, and with the cursor at the end of the hyperlinked text, use the end option. This ends the hyperlink so
that subsequent text does not become part of it. Use the edit option to edit a previously inserted hyperlink.
Select the follow option while the cursor is within the hyperlinked text to follow the hyperlink. For more
information, see the Tags topic in the System Setup / Super User guide.

« Inline Reference (Insert / Edit, Copy as): Used to add inline references to attribute values. Inline references
are used to re-use values present within another attribute, object Name, or ID. This avoids duplication of data
by maintaining the data only once, and re-using it from that source as needed. For example, a description

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 147



StiboSystems

MASTER DATA MANAGEMENT

attribute may need to dynamically include the object Name, e.g., '[Name] is a great product!'. Detailed
information on working with inline references is available in the Inline References in Attribute Values topic
within this guide.

Insert Special Character: Used as a quick option to add special characters to attribute values without having
to enter the Rich Text Editor. Opens an editor allowing for selection of the most recently used special
characters, with an option to access a full Unicode character menu. For more information, see the Tags topic in
the System Setup / Super User guide.

Override: Used to manually populate a local value to override a calculated (derived) value. This option is only
enabled on calculated attributes. For more information, see the Calculated Attributes topic in the System Setup
/ Super User guide.

Recalculate: Used for on-demand display of calculated attribute values in the editor if they have previously
been disabled via the 'Disable calculated values' option in the View menu. For more information, see the
Calculated Attributes topicin the System Setup / Super User guide.

Rotate Table: Used to rotate the data display. As a right-click option, it is only enabled from row / column
headers when multiple objects are selected. For a single object, it can be used to rotate the data under a flipper
only via keyboard shortcut (Alt + F11).

Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows /
columns.

Sort: Used to sort data based on attribute value rather than attribute name or display sequence. This option is
exposed when a column header is selected, and requires a sort selection (Ascending, Descending, or None).

Style: Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter the
Rich Text Editor. Styles that have been defined for the system will be available as sub-options to the Style
selection. For more information, see the Tags topicin the System Setup / Super User guide.

Additional Information

In addition to the main editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functions within them vary based on the
selected object. Therefore, they are described in the context of the type of object being edited, in the subsequent
sections of this guide:

Assets
Classifications
Collections
Entities
Products

Recycle Bin for Tree

Publications: The publication hierarchy and its associated objects are detailed in the Publication Hierarchy
section of the STEP Publisher documentation.
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Inline References in Attribute Values

Inline references can be embedded in attribute values for attributes that have text and numeric text validation
base types. An inline reference use case follows:

You are working with product objects whose model number is the same as their STEP ID (for example,
'12345'). On these objects there is an attribute called 'Product Description' that needs to dynamically reference
the object's model number within the text of the attribute. For a Product Description such as 'Acme lawn
mower, model number 12345, the inline reference to the STEP ID would populate '12345." Using an inline
reference in this instance helps to avoid duplication of effort—since the product's model number already exists
in STEP asits ID, there is no need for users to manually enter it a second time into the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system resources.
For example, it may be easier for users to use an inline reference to pullin a STEP ID than to create a calculated
attribute using the formula 'StepID()'".

One attribute value can include several inline references. An inline reference can reference either a single attribute
or an attribute group.

Inserting an Inline Reference using Workbench
1. Select the relevant node. The corresponding editor appears.

2. Click on the leftmost tab within the editor, which is different depending on the object type (for example,
'Product’, 'Classification’, 'Images & Documents', 'Publication,' and so forth).

3. Activate the Value field of the relevant attribute where you want to create or edit the inline reference. Or,
highlight the field, right-click, and select Edit to launch the larger value editor.

Note: Pressing Alt + F2 will also open the value editor.

4. Place the cursor at the position in the Value field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

5. Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference to
edit an existing inline reference.
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Spelling

Tables || Category Profile || Proof Vie 5 Undo change value of 'Bas
Product l Sub Products l {(f® Redo change value of 'Cou
Mame >| » |Value
» Manufacturer's Part Mumber |abe % Cut
» Manufacturer Name abs: Copy
* Country of Origin B paste
* Product Mame |ah: Cosmic Party Hat .
[E  Paste and Match Style
= Category Spedfic Attributes
= Attribute Group Style
@ Display Character Tag
Pame >| > |Value #.  Insert Special Character
» Basic Manufacturer Information ab:
* Long Item Description abt 5ui1ﬁm Insert Inline Reference
: b . .
» Manufacturer's Part Mumber a Edit Inline Reference
* Country of Origin

6. The Inline Reference dialog displays.

Object Selection
Object

(@) Resolve To Object ID

() Resolve To Object Name

() Resolve To Attribute Value andjor Unit

Attribute Selection
Attribute

Attribute Name(s)
Indude

Separator | =
Attribute Value(s)

Aspect
Atfribute Separator

Values(s) and Unit{s)

Cancel
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If you do not wish to return the name or ID of the current object and instead want to return a value or values
from another object in STEP, click the ellipsis button (E]) to the right of the Object field. Ignore this field if you

plan to return value(s) from the current object instead.
. Click the ellipsis button ([...) to display the 'Select Object' dialog, search for or browse to the object that holds

the value(s) that you would like to return, then click Select to choose the object.
Select Resolve To Object ID to return the value of the STEP ID of the chosen or current object.

Select Resolve To Object Name to return the value of the STEP Name of the chosen or current object.

Select Resolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion of
the Inline Reference dialog.

Click the ellipsis button ((...]) to the right of the Attribute field to open the 'Select Attribute or Attribute Group'
dialog.
Search for or browse to the relevant attribute or attribute group for the inline reference, and then click Select.

For Attribute Name(s), check the Include box if the name of the attribute(s) should be included in the inline
reference.

In the Separator field, type a separator to be used between the name and value of the attribute. The default is
the equals sign (=). Note that the Separator field is not activated unless the Include box has been checked.

For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:

Inline Reference

Ohject Selection
Object

() Resolve To Object ID
(") Resalve To Object Name

(®) Resolve To Attribute Value and/or Unit

Attribute Selection

Attribute | Manufacturer Name ? Display

. Mame | > |Value
Attribute Name(s)

Incdude
Separator | =

» Basic Manufacturer Information |abe Manufacturer Name=~Acme Party Supplies

Attribute Value(s)

Aspect Values(s) and Unit(s) -
Attribute Separator

K Cancel
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15. Under Attribute Value(s), select the relevant Aspect from the dropdown list. Available options are 'Value(s)
and Unit(s),' 'Unit(s),' and 'Value(s).'

16. Inthe Attribute Separator field—which is only valid when an attribute group has been chosen for the
Attribute selection—type in one or more characters to specify how the attribute values should be separated.
The default is the semicolon character without a following space (;).

The following screenshot shows:

1) An attribute group called 'Manufacturer Information' selected for Attribute

3) An attribute separator of ; placed between each attribute within the group

(1)

« (2) A separator of = placed between the attribute name and attribute value
(3)
(4)

4) How the attributes and attribute values resolve in the inline reference.

Inline Reference

Object Selection
Object
() Resolve To Object ID
(") Resalve To Object Name
3 Manufacturer Information
{®) Resolve To Attribute Value and/or Unit A | '> Vil
ame alue
Attribute Selection » Manufacturer's Part Number |abe (121177
. Acme Party Supplies
Atiribute : » Manufacturer Name abe
Manfacturer Informaton > [Country of Origin HONG KONG
Attribute Name(s) » Product Name |ahEr Cosmic Party Hat
Indude
Separator e
& Display 0
Attribute Value(s) MName » |Value v 3
Aspect Values(s) and Unit{s) » Basic Manufacturer Informatilab Country of Origin=HONG KONG;Manufacturer Name=Acme Party
d asic Flantaciurer Srormatia o oplies: Manufacturer's Part Number=121177:Product Name=Cosmic Party Hat
Attribute Separator e
oK Cancel

17. Click OK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes

The Attribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued
attributes. Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag
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(multisep). The multisep tag is a Character Tag in System Setup and comes standard with STEP systems.
STEP stores the values of multi-valued attributes with the multisep tag between them, and this tag typically

renders as a forward slash (/).
multisep/ - Character Tag

System Setup

E% Tags [haracter Tag
% Style Tags @ Character Tag Definition
U] Spedial Characters Name »| > |Value
E}--% Character Tags * Name multisep
----- E BeforeLastDigitinNumerator > Edited By
----- ol EndFracﬁun > \Character Tan Liltisep
----- [o] FractionBar > Rendering /
..... E ft + ahow Character [ag T es
""" % Qt » Keyboard Shortout
..... |r| -
¢ Output Formatting
..... E IntegerToFractionSe, r F t i t
----- E LineBreak orme iy
..... E It * InDesign <0x000D =
..... ol | > | Add Formatting

If a multivalued attribute is used in an inline reference, the rendering setup for the multisep tag will be shown
between each of the values. In the below example, the 'Country of Origin' attribute has four values. When
rendered in the inline reference, these four values are separated by the forward slash (/) character.

¥ Display
MName »| ¥ |Value
| [N EON | _mlﬂ omxmrmmmummamhwm
* Country of Crigin T NAM e ThTOr it e Name=Acme Party Manu =121177;Product
EXICO Mame=Cosmic Party Hat

For more information on STEP character tags, see the Tags topic in the System Setup / Super User Guide
documentation.

Copying Attribute Values as Inline References

An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then paste it
into the value editor of another attribute as an inline reference. This inline reference can then be edited like any
other inline reference.

1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor field.

2. Right-click and select Copy as inline reference.
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¢ Display
MName *| » |Value

* Basic Manufacturer Information |abe % Cut CirleX
* Long Item Description abe Product information: .

» Mangufach..lrer's F‘part Mumber abe 121177 : Copy CtrC
* Country of Origin HOMNG KDNG‘/ Copy as inline reference  Ctrl+]
» Manufacturer Name at-::' Acme Party Supplies Pacte Ctrl+\f
* Product Name abe Cosmic Party Hat Paste Link Ctrl+ L

3. Navigate to the 'destination’ attribute value and select the value editor field.

4. Right-click and select Paste.

§ Display

Mame » | * [Value
» Basic Manufacturer Informatijabe % Cut Ctrl+X
* Long Item Description abe: Prodyct ir S Ctrl+C

* Manufacturer's Part Number |abe 1211 _ o
» Country of Origin HOMG Copy as inline reference  Ctrl+I
» Manufacturer Name abe JAcme Par Paste ChrleV

-
% Pradicd Blaeme “he Crernie D3

5. The value appears in the destination field as an inline reference.

7 Display

Mame » | Value
» Basic Manufacturer Informaﬁlahl Acme Party Supplies
» Long Item Description abe Froduct informaton: , par

» Manufacturer's Part Number [abe 121177
* Country of Origin HOMNG KOMG

Note: The copied 'source' attribute value is connected to the 'source’ object, meaning that any time an attribute
value is coped as an inline reference and pasted elsewhere, the inline reference will never pick up the attribute
value from the current object but only from the 'source’ object. Also, STEP IDs and STEP names cannot be
copied as inline references.
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Christmas Party Hat rev.0.11 - Product

Tables || Category Profile || Proaf 'u'iewl Status || State Log || Tasks

* Manufacturer's Part Mumber |abe

» Manufacturer Name abe

* Country of Origin

* Product Name |ahE=r Christmas Party Hat
- Category Spedfic Attributes
- Atiribute Group
¥ Display

Mame » | » |Value I

» Basic Manufacturer Informatiabe Party Supplies ¥

» Long Item Description abe Celebrate the holidays w

Product [ sub Products Refere
> Status I
» LRL ™ Ohiject Selection
» Malue 1 am; Object | | Cosmic Party Hat
' Manufacturer Information I Resolve To Object ID
Hame >| > |Value () Resolve To Object Name

(®) Resolve To Attribute Value and/or Unit

Attribute Selection
Attribute | Manufacturer Name

Attribute Name(s)
] Indude

Separator

Attribute Value(s)

Inserting an Inline Reference using Web Ul

Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted into an
attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference in Web Ul is similar to adding one in the workbench. For instructions, see the Rich Text
Editor section of the Web User Interfaces documentation.
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Assets

This topic covers information specific to the asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

An asset is any product-related electronic file, such as images (liff, eps, jpeg, etc.), Word docs, Excel files, PDFs,
PowerPoint files, text files, etc. Images are a common asset so they will be the focus of this section. In most cases,
the terms “asset” and “image” are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality check
be performed by users with graphic arts knowledge. Ideally, this check occurs prior to importinto STEP so that
only approved images are available in the system.

Classification of Assets

Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated from
other classification hierarchies (e.g., those used for alternate structuring of products, import / export configuration
storage, etc).

The recommendation is to have one classification object type and instance for each asset object type. For
example:

System Setup

EI% Object Types & Structures [ Assets

|‘_?| Alternate Classifications |__=| Icans

(=42 Assets rj Iustrations
"',?J Assets |j Installation Manuals
----- ik | Icon [T Logos
-5 Tustration [4-[ =] MSDS Sheets
- ----- E Installation Manual r_=| Owners Manual
- ----- Ingd Logo rj Product Images
= | MsDS [T Product Videos
o E Owniers Manual
- ----- ﬂ Product Image
----- Q Product Video

Within the individual type-based classifications, additional levels can be modeled if necessary. A common option is
to work with a 2-level folder structure based on the first characters of the asset file name. For example:
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=H[ ) Product Images
E{91
#7110
0 11
B 12
HT) 13
=3 14
) 15
B[] 16
=517
Wl 1713
-l 1714
- | 1719

{1+

#

With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets. Instead,
assets are typically located via references from other objects and/or via searches. Note that STEP does not
require that the image hierarchy have multiple levels. Assets can be stored in a single folder (e.g., a flat structure).
However, this is not typically recommended as it can be impractical to navigate the hierarchy as the number of
assets increases.

Notice that the same asset object can exist below multiple different classifications. However, this functionality is
typically only used for cases where suppliers upload assets. These assets will initially go into supplier-specific
classifications and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation

New asset object types are defined in STEP the same way any other object types are, via the System Setup tab.
One key difference between asset object types and other object types, such as products or classifications, is that
there are no parent-child relations between assets, as asset instances live in classification hierarchies.

Asset object types are defined in STEP Workbench System Setup under 'Object Types & Structures.' Apart from
the built-in generic type 'Assets', it will be a flat list of the different asset object types required for the setup. For
example:
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System Setup
=-{#¥ Object Types & Structures
|'_= Alternate Classifications
E}‘-.!_:?J Assets
-7 Assets
..... & | Ioon
- =] Tlustration
----- E Installation Manual
..... 224 Logo

. ..... & msDs

----- ﬁ Owners Manual
- ----- | Product Image
- Product Video

On older STEP installations you will often see asset object types that are file type specific. For example: JPG
Image, Word Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather than the
file type. This is done for clarity as it is often more important to understand the purpose of the asset. For example,
an asset is not just a PDF file, instead it is an Installation Manual, a Product Brochure or an Owner's Manual. One
advantage of the purpose-based setup is that it is possible to restrict reference types to point to the specific types
of assets and not just to generic file types.

With the move away from file type specific asset object types, asset object types cannot be applied automatically
when digital media files are imported into STEP as there is no 1:1 relationship between file types and asset object
types. Itis possible to have object types automatically applied upon import when a file-based approach is used, but
this functionality generally does not weigh up to the disadvantages of the approach.

Asset Objects and Digital Media Files

A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and digital
media files in STEP. Thus, it is possible to work with asset objects that do not have "content", i.e., are not tied to
any digital media files. Furthermore, the content can be dimension-dependent so that an asset is tied to different
files in different contexts. Finally, an asset can have different content in different historical revisions.
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Product Object

Asset Reference "Primary Product Image”

Asset Object

IPG File

As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects (not to
the actual media files) that relations are modeled (using references).

Image Variants and Handling

Different publishing projects impose various requirements on the use of images. For example, a high resolution
image in STEP may be a TIFF. However, for the web, a jpeg is needed. Or, if the high resolution image is an EPS,
a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines. When using an image conversion, the images
in STEP must be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configuration topic in the Digital

Assets guide.

More Information

For specific details about working with assets in the workbench, see the Maintaining Assets and Linking
Assets to Products topics within this guide.

For information on working with assets in Web Ul, see the Asset Handling in Web Ul topic in the Web User
Interfaces guide.

For information on importing, exporting, and managing assets, see the Digital Assets guide.
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Maintaining Assets

This topic covers information specific to the Asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

Creating Assets

The basic methods for creating an asset are the same as any other object type, as described in the Creating
Objects in Tree topic within this guide. However, there are a few considerations that are specific to assets that
users should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated. When assets are
created in STEP via import of a digital media file, this association happens automatically. However, when assets
are created using standard object creation methods in Tree (e.g. right-clicking on a classification folder and
selecting 'New Asset'), it is only the placeholder that is created. An asset created in this manner will initially have
no system properties and no content. For example:

Chihuahua rev.0.1 - Images & Documents

[ Assets A || BINELERR KT 8 | References || Referenced By || Status || Stabe Log || Tasks

-] Ieons
[ ] Tlustrations Name s> Walue | hsset has
[#[ ] Installation Manuals
& lj Logos s D 115308 no content.
[#-[ 7] MSD5 Sheets » Mame Chihuahua
[ Owners Manual » Ohject Type Product Image
=8 E Product Images

g ot » Revision 0.1Last edited by USERS on Sun Jan 29 10:58: 10 EST 2017

=N |-_=| 12 » pproved 3 Never Been Approved
| 123456 » Translation Not Translated

a2 j @I » Path Classification 1 root/Assets/Product Images/1/12/Chihuahua

B4 » ProductsGaloreAtiribute b

E-[36 § System Properties:

B9 No System Properties

A user can right-click on the asset and select Replace Asset Content to open a dialog where a digital media file
can be selected from the local machine. STEP will automatically read and populate the properties of the asset, and
a thumbnail of the digital media file will display. For example:
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(=[] Assets

[T lcons

-] Hustrations

#-[ 7] Installation Manuals
[~ Logos

[ ] M5DS3 Sheets

rh-[ ] Owners Manual

=} |j Product Images
=1

B

@) 123456

1B~ -

i) 2
i) 4
i) &
H-7]9
T A
H-{7]B
7 C
H-T]D
H-[]E
H-[F
d-7] G
H-[JH
H-]1
L
H-TM
H{7]0
H-[ )P

H R
L
LW
d-] Y

----- Chrysanthemum
-] Product Videos
[#-{ 7] Configurations
[+)-{ "~ ETIM Hierarchy

i O O e OO o O s Y IO e O U e O IO s O o Y o O OO e O g U o O e O - OO e O o |

Chihuahua rev.1.0 - Images & Documents
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| ED [T B | References || Referenced By || Status || Statelog || Tasks

Mame > Value »
> ID 115308
> Name Chihuahua
» Object Type Product Image
> Revision 1.0 Last edited by USER® on Sun Jan 29 10:59:56 EST 2017
> pproved 3€ Never Been Approved
» [Translation Mot Translated
» Path Classification 1 rootfAssets/Product Images/1/12/Chihuahua
> ProductsGaloreAttribute  |abe
§ System Properties:
Mame » Value >
» Clazs abe True color
» Colorspace abe LGB
* Compression abe JPEG
» Depth il 8 (bits/sample)
» Extension abe jpg
» Filename abe |136.JPG
> Format abe JPEG (Joint Photographic Experts Group JFIF image)
» Height 123 (115146 (mm)
> MIME Type abe imagefjpeg
» Pixel Height 01:: 3264 (pixels)
» Pixel Width i1 2448 (pixels)
» Profile abe Custom EXIF, Custom XMP
» Gamples il 3 (samples pixel)
» Gize abe 2,270,283
» Upload Time abe | 2017-01-29 10:59:56
> Width 123 863.59 (mm)
» Horizontal DPI 122 (72 (dpi)
» Nertical DPI 123 (72 (dpi)

To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols for an
initial implementation). More information on importing assets is available in the Importing Assets section of the

Digital Assets guide.

Asset Editor

General information about editing objects in STEP is available in the Editing Objects in Tree topic within this
guide and is not repeated in this section. However, assets have some additional editing options specific to working
with digital media files, which are described.
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The Images & Documents tab is the primary workbench interface for assets. It has three sections, described
below.
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[ References ” Referenced By ” Skatus ” Skate Log ” Tasks ]

ame » |Value
* 1D 115305
* Mame Chihuahuz
» Object Type Froduct Image
» Rewvision 1.0 Last edited by USERG on Sun Jan 29 10:59:56 EST 2017
* |Approved x Mever Been Approved
* [Translation Mot Translated
Classification 1 rootfAssets/Product Images/1/12/Chihuahua

Edit Asset
External Viewer
Save to disk

Image Viewer

» Path
Properties:
me >

> |Value >
» Class abe True color
* Colorspace abe RGE
* Compression abe JPEG
» Depth 23 & (bits/zample)
* Extension abe fpg
* Filename abe (136.1PG
» Format abe JPEG (Joint Photographic Experts Group JFIF image)
* Height 122 |1151. 46 (mm)
» MIME Type abe jmage fipeg
* Pixel Height 23 3264 (pixels)
» Pixel Width 23 2443 (pixels)
* Profile abe Custom EXIF, Custom XMP
» Bamples % |3 (samplesfpixel)
» Bize abe (2,270,288
* Upload Time abe 2017-01-29 10:59:56
» Width 123 563.59 (mm)
» Harizontal DPI 123 72 (dpi)
* Mertical DPI 122 72 (dpi)

The Description flipper contains the same basic information as other object types. Additional Description
attributes can be made valid for assets to support data such as keywords or asset descriptions. Specification
attributes cannot be made valid for assets.

The System Properties flipper displays data that is read automatically from the digital media file. This
information cannot be edited.

The asset thumbnail has a number of options available for editing assets. Additional right-click options are also
available when the asset itself is right-clicked from the Tree. All of the options that are specific to assets only
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(accessible from right-click on the thumbnail or the asset) are described below.

« Create Local Content of Asset: Creates a local version of the asset specific to the current context. See
the Asset Dimension Dependencies section below for more information.

« Delete Local Content of Asset: Deletes the content of an asset that is not dimension dependent. Deletes
the local (context-specific) content of the asset if the asset is dimension dependent. See the Asset
Dimension Dependencies section below for more information.

« Edit Asset: Opens the digital media file for editing in an external program, in addition to an Edit Asset
dialog in STEP. Upon completion of editing in the external program, click save within the program to store
the edited asset to a temporary directory. Then click OK in the Edit Asset dialog in STEP to have STEP
retrieve the edited file from the temporary directory and store this in the asset. Note that the media file will
open in the application associated with the file type. For example, for files ending with .xls, Excel will
automatically be launched. This may be different from computer to computer. One user’s computer may
open up EPS images in Photoshop, while another user’s computer may open the same file types in
lllustrator.

- Export Images & Documents: Opens the Export Images and Documents wizard to make selections to
export the currently selected asset(s). See the Export Images and Documents Wizard topic in the Digital
Assets guide for more information.

« External Viewer: Opens an external viewer for viewing the asset. This is comparable to the Edit Asset
function in that the program that is utilized is specific to the file type and the user's computer settings. It
differs in that any changes made to the asset in the external program are not saved back to STEP.

- Image Viewer: Opens an image viewer within STEP for the user to examine the actual asset (as opposed
to just the thumbnail).

« Push Asset(s): Initiates asset push for the selected asset(s). See the Asset Push section of the Digital
Assets guide for more information.

« Replace Asset Content: Opens a dialog for the user to select a digital media file for the asset. See the
'Creating Assets' section above for more information.

« Save to disk: Opens a standard save dialog allowing the user to select a location on their local machine to
save the digital media file to.

« Unlink asset: Only enabled if the asset has been linked directly into a publication, in which case it unlinks
the asset from the publication. See the Publication Hierarchy section of the STEP Publisher (InDesign)
guide for more information.

References

The References tab displays the classifications that the selected asset is linked to, and allows for linking to
additional classifications using the Link to Classification link. Each asset must be linked to at least one
classification, but may be linked to many. Links can be removed by right-clicking on the row indicator and selecting
'Remove Link to Classification'. The Name of each classification displayed is hyperlinked for easy navigation, and
revision, approval, and translation statuses are also displayed.
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EHT] Assets
B[] Icons
-] Hustrations

[#-[7] Logos

4[] MSDS Sheets
- -7 Owners Manual
E} E Product Images
et
B[R

Referenced By

E Installation Manuals

Chihuahua rev.2.0 -

A 1|| Images & Documents Referenced By || Status || State Log || Tasks
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References

3 Classifications

D » |Mame » |Object Type  * Revision » |Approved » [Translation
> 8735 12 Assetlevel 2 0.3 Last edited by USERG ... x Last Approved on Thu... Not Translated
| |Link to Classification

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). The
display of the Referenced By tab on an asset will vary slightly from system to system, based on the data model.

Tree
A1|| Images & Documents || References (LGN | Status | State Log || Tasks

B[] Assets
7] Teons
7] Hustrations

7] Installation Manuals
7] Logos

f#[ 7] M3DS Sheets

f#h[ ] Owiners Manual
=[] Product Images
Bt

E} 12

------ "

------ ! ] %ua
B2
w4
w6
w9

12’45b rev.3.1 - Referenced By

Reference Type

Source

o

Thumbnail

» Image Display Sequence »

Caption 1

» |Caption 2

W

Primary Product Image  + n

» |Product Images + HP 18210MB é
{ ¥
Ungrouped Referenced by Products, Classifications or Entities
‘Reference Type H ‘Source >| >‘
@ Used on Page
‘Publicaﬁon » "u'ersion » ‘Page » ‘Area Used » |Page Type »

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User guide.
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2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the STEP Publisher section of the online help.

Status

The Status tab provides general information about objects, including revisions, translation status, and approval
status. For more information on these basic settings, see the Status Tab topic in the Products section of this guide.
For assets specifically, this tab also includes an Asset Push Status section that describes the status of assets for
the various asset push configurations on the system. For more information, see the Monitoring Asset Push topicin
the Digital Assets guide.

State Log

The State Log tab allows users to view the recent history of the object across all workflows in which it has been
entered. See the State Log Tab topic in the Workflows documentation for more information.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More
information on the Tasks tab is available in the 'Moving Tasks through a Workflow in Workbench' topic in the
Workflows guide.

Asset Dimension Dependencies

Individual asset object types can be made dimension dependent using the Dimension Dependencies parameter
on the object type. This configuration will only affect the STEP Name of assets, meaning that it allows for individual
assets to have a different name based on the indicated dimension dependencies (e.g., 'Red Hat' in English and
'Chapeau Rouge' in French when the dependency is Language).
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Icon - Object Type

Object Type References || Log
® Descript

Mame * | » |Value
> D Tcon
> Mame Icon

> Last edited by

2017-01-29 12:07:47 by USERG

* Mame Pattern

> [ID Pattern [id]
* [con E
application/postscript
» MIME Types mage ftif
mage/tiff

» Dimension Dependendies Language;

» Reference Target Lock Policy Strict

It is also possible to make the content of assets dimension dependent so that an assetin STEP can be tied to
different digital media files in different Contexts. This is configured using the Image & Document Settings >
Dimension Dependencies parameter in System Settings.

-5 Web Uls

(5] workflow Profiles
5 workflows
Derived Events

o Ohject Types & Structures
% Tags

-+ Uniits

@B
B\h Reference Types
++ Workspaces
@ Table

{E. Keys

Ii Event Queues
Component Models
-9 Recyde Bin

-

System Setup L 4 System Settings
[system settings [JR)

2= Classification Hierarchy Settings
% Image & Document Settings

» Dimension Dependencies

» Store assets and DTP documents in

Language;

Database

* DTP asset source

Asset Push

* Pregenerate thumbnail cache on upload

Mo

» Disable auto-deanup of thumbnail cache

Mo

» Transformation Lookup Tables follow asset dimension d...

M

» \izset Import Compatibility Mode

Simple

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on asset
dimension dependencies, this should be avoided. As mentioned, the setting is global, meaning that special
procedures must be implemented for creating assets that are to have the same content in all contexts. Thus, if you
import a digital media file (and via this create an asset instance) in a context that does not use the top level
dimension point for the dimension on which asset content depends, the content will be created only in the
dimension point the current context uses.
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Custom Asset Metadata

When importing assets into STEP, System Properties attributes can be automatically created in STEP on the
asset, and then populated with the image metadata detected on the incoming assets. The image metadata must
be formatted as either XMP (Extensible Metadata Platform) or EXIF (Exchange Image File). Determination of
which metadata attributes should be housed in STEP is configured manually.

In an image file, image metadata is stored as plain text in XML format. Based on the configuration file and import
shown below, the Creator, Subject, and Description metadata will be written to STEP. In the following sample,
some rows have been removed for brevity, as indicated by '...".

1H <x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 5.3-c887 1.136881, 2010/06/16-18:11:35 ">
2F  <rdf:RDF xmlns:rdf="http://ww.w3.org/1999/82/22 -rdf-syntax-ns#">

3 <rdf:Description

- rdf:about=""

5 xmlns: xmpMM="http://ns.adobe.com/xap/1.8/mm/"

“E <doicreator: fm—
= <rdf:5eq»
g <rdf:11>0KL Photo:RM Style:RM</rdf:1i>»
18 - </rdf:5eq>
11 + </dc:creator:
LZE <de:subject) m—

= <rdf:Bag>»
14 <rdf:lizlucite</rdf:1is
15 <rdf:lirbox</rdf:1i>
16 <rdf:1lirchest</rdf:1i>»
17 <rdf:lirtrunk</rdf:1i>
18 - </rdf:Bag>
19 - </dc:subject>
ZCE <dc:description) <

21 <rdf:Alt>

22 <rdf:11 xml:lang="x-default">Lucite trunk</rdf:1is
23 - </rdf:Alt>

24 - </dc:description»

</rdf:Description>
7 </rdf:RDF>
28 ¢fw:xmpmeta>

ra
o
T

P2
I
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Prerequisites

The user should have a basic understanding of XML, the XML structure of image metadata, and XPath before
proceeding with configuration. The configuration file uses XML to define attribute names and the XPath query to
retrieve metadata. For more information, search the web.

XMP Configuration File

The custom asset metadata configuration file uses the instruction "XmpConfiguration' to define the name of the
system attributes being created in STEP and the XPath that defines how to retrieve the image metadata.

XPath is an XML query language STEP uses to search the XML within an image file and identify the desired
metadata. The XMP configuration file defines the XPath queries to be run against an image file being imported.

The following sample configuration file defines three metadata attributes (Creator, Description, and Subject), and
the XPath query required to find the corresponding metadata.

LE <XnpConfigurationy
12 <kmpProperties allow="true"s

<KnpProperty
name="Creator” unit=""
xpath="/*[nane(. )="x:xnpneta’ ]/* [nane(.)=" rdf:ROF" ]/*[nane(. )=" rdf :Description’ ]/*[nane(. )="dc:creator | /* nane(. ="rdf:Seq" ]/*[nane(.)="rdf:11°]"/>

<KnpProperty
name="Description” unit=""
xpath="/*[name(. )="x:xmpmeta’ |/* [name(. )="rdf :ROF" ] /* [name(. )= " rdf :Description' ]/*[name(.)="dc:description’ ]/*[name(. )="rdf :ALE" ] /* [name(. )="rdf:11"]"/>

<KnpProperty
name="Subject” unit=""
xpaths"/¥[name(.)="x:xmpmeta’ ) /¥ [name(.)="rdf:RDF ] /# name(.)=" rdf:Description’ | /#[name(.)="dc:subject' | /*[name(. )="rdf:Bag' ] /* [name( )= rdf: 11" ]"/>

- <[XmpPropertiesy
17 = ¢ /XmpConfiguration)

In the above example, the 'creator’ attribute is defined by the text:

name="History" unit=""

The XPath to find the creator metadata is defined by the text:

xpath="/*\[name (.)="x:xmpmeta'\]/*\ [name (.)="rdf :RDF'\]/*\ [name
(.)="rdf:Description'\]/*\ [name(.)="dc:creator'\]1/*\[name (.)="rdf:Seq'\]/*\
[name (.)="rdf:11i'\]1"/>

Using an XMP Configuration File

1. Create and save a custom asset metadata configuration file using XmpConfiguration instruction as shown
above, that defines:
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« the image metadata attribute name(s)

« the appropriate XPath to the required metadata on the image

2. Save the configuration file to the STEP server in the same directory as the sharedconfig.properties file.

3. Edit the sharedconfig.properties file and include the case-sensitive XMP.ConfigFile property as follows,

N o o &

where 'customxmpconfiguration.xml' is the name of the configuration file created above.

XMP.ConfigFile = customxmpconfiguration.xml

Save the sharedconfig.properties file.
Restart the STEP server to apply changes to both configuration files.
Import an image that includes the metadata attributes defined in the XMP configuration file.

Navigate to the imported asset to view the metadata assets on the System Properties flipper.

Custom attributes are identified in the STEP asset editor by the text 'asset.' which is prepended to the attribute
name (for example, 'asset.Creator').

. =] Owners Manual
= [T Product Images

Images & Documents References || Referenced By [_

E|r_=| 1

B[O '? S',rsl:an Froperties:

'E Product_SDTlﬂﬂlﬂ_lmage_l| Mame *| * |Value >
T2 » fasset.Creator 1za OKL Photo:RM Style:RM

BT 4 » lasset.Description  |12a Lucite trunk

--r_=|6 » fasset.Subject 12a ludite;box;chest;trunk

B 9 > lsset.Title fza SOT10010

r_=| A * Class abe True color

Important: Custom coding by Stibo Systems can be used to allow attributes to be displayed in workbench
with names other than 'asset.[attribute name]'. For more information, contact your Stibo Systems
representative.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 169



StiboSystems

MASTER DATA MANAGEMENT

Linking Assets to Products

If the asset’s name can be matched to the product, then this function can be performed when the asset is imported.
If not linked at this time, there are two ways that the interface allows the link to be made: a) from the product or b)
from the asset.

There are three ways to link images to products:
o From the product
« Fromthe asset

o Fromimport

Linking Assets to Products (From Products)

1. Select the product and then select the References tab.

l Product ” Sub Products }[ Referenced By ” Images & Documents ” Commercial ” Tables ” Category Profile ” Proof View " Skatus ” State Log ” Tasks l

2. Navigate to the Image References section of the References tab. Click on the + symbol to link the image to the
correct area. For this example 'Primary Product' will be used as it is the most common reference type made.

2 Image References

Reference Type w| * [Target ¥ [Thumbnail
» |Brand Name Loge =+ |B
* | Hlustration + H
* |Primary Pruduct...l + 1
* |Product Image + n
> |Video + (i

3. Asearch window will appear.
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E] Select Asset (Reference Type = Primary Product Image)

rows- |

[#-{ 7] Assets

r_= Configurations

r_= Merchandising Hierarchy
1'_= Suppliers

(- 7] Web Sites

r_=| Primary Product Hierarchy

== Details

Cancel

4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of the

image will appear when the product is selected.
' Image References

Reference Type w| » [Target ¥ [Thumbnail
> |Brand Name Loge =+ B \
* | Hlustration + m
* |Primary Product Image E !| 20805 -
* |Product Image + n
> |Video + (i

Note: When assets are linked to products, you must designate what type of reference is being made. For
example, is it an image that represents the product? Is it an accessory to the product? Or a related document?
This reference type denotes that the image being linked to the product is a direct representation of that
product. When you make such a reference, a thumbnail of the image is attached to the product. The thumbnail
will only appear for this reference type. It is possible to link more than one image to the reference type if the

reference type is set to allow multiple references 'yes.'

Linking Assets to Products (From Assets)

1. Select the image in the Assets folder in the Tree. Then, select the References by tab.

[ Images & Documents " References ][ Skakus ” State Log ” Tasks ]

2. Ifitis not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary

Product Image' to link the image to the product.
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[ Images & Documents ” References ][ Stakus " Stake Log ” Tasks ]

|-¢

Reference Type w| * |Source * [Thumbnail
> |Primary Product ... | + |52
* |Product Image + m
7
Reference Type w| * |Source » »
7
Publication * |Version * |Page * |Area Used

3. Navigate to the Product in the pop up window, and select it.

rE] Select Object (Reference Type = Primary Product Image) |, 2 J1
Corowse [T

(-7 Assets ol
[+-{ ] Configurations

7] Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
-] Web Sites
Eli Primary Product Hierarchy
E}i Products
Eli Apparel
[+-[[T] Head Wear
Eli Upper Body Wear
=[5 T-shirts
=gl T-shirts Items
: E]‘ Hanes T-shirts
i E 18210 MB
™ 182121 B
-\ 18213M 0 -

®Dewls

[ sekct || Concel ]
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4. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a thumbnail

of the image will appear when the product is selected as illustrated in the below image.
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20701 rev.1.4 - Referenced By

Eifl Assets Images & Documents || References |PUAEIEERENHY | Status || State Log | Tasks
-] (QAIcon)
Image References

l ] Tcons ¢
. [ Tustrations Reference Type v| » |Source s Mhumbnail N
|j Installation Manuals » |cal Green + [
- [ Logos
-] MSDS Sheets
= = == > |Primary Entity Image ~ + %]
B[] Owners Manual P
=} Product Images

H B 119613

B

B2 -

E}- g » |Primary Product Imaage | + m- Jinch heels
% || Red and Gold heels

Linking Assets to Products using the Import Manager

This method is best used for large amounts of products / assets linking. Ideally, you should already have a file in
Excel that has the products and desired Image ID set up according to how you want them to be after import.

Note: If you only need to link a few assets to products, then it is more efficient to link them via the interface.

1. Goto File and select Import, then Data. An 'Import Manager' window will appear. On 'Select Data Sources',
click the ellipsis button ([...]) next to 'Filename' and select your file.

E] Import Manager u
Steps Select Data Source
1. Select Configuration Data Source :File -
2. Select Data Source _
q . £ Retrieves contents from files reachable from your local computer.,
4, Map Data Filename | qrputFile. bet
5. Identify Objects

&. Identify Destination
7. Select Business Rules
8. Advanced Settings

2. Proceed to the 'Map Data' step. Select a source column and click the Map button. Map the column holding IDs
to'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the 'Asset
Reference' radio button, select the 'Primary Image' radio button. For more information on mapping, see
Inbound Map Data - Map in the Data Exchange documentation.
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rE] Map <Mame> to ﬁ1

1D
() Name
() Attribute
() Product Classification Link

i) Product Reference

i@ Asset Reference () Brand Name Logo

(™) Hustration

(7 Classification Reference ) Installation Manual

() Entity Reference (Z) M5D5

(7 Owners Manual

(71 Reference Meta-Data i .

i i@ Primary Product Image
() Parent (7 Product Image

i 1 Video
i) Object Type i
(") Variable
i) Multivalued Variable
(7 Overrides product
(7 Add child to override

[] Mandatory
Ok
b -

3. Click OK to close the Map To dialog.

4. Ifthe image IDs were not found or the import file data was not done correctly, then columns will appear in red.
For information on input files, see Asset Reference - Map Inbound in the Data Exchange documentation.

Note: If the image IDs were not found or the import was not done correctly, then columns will appear in red.
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s 5
E]Impnrt Manager | 28 |
Steps Map Data
1. Select Configuration Source:
2. Select Data Source 2l »* |<Mame = »
3. Select Format 13210 18710 MB
4. Map Data 13212 18212 LB
5. Identify Objects — g
6. Identify Destination
7. Select Business Rules
8. Advanced Settings
4 | m P
Result: Map to: :Asset v:
ID=<IDz « rimaryProductimage AssetReference=<Name> @
18210
18212
18213
Auto Map ] ’ Map ] [ Generate Profile ]
| Back || Mext || Fsh || Cancel |

STEPXML Import

It is also possible to link the images to product via STEPXML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">

<Products>
<Product ID="18210" UserTypelID="Item" ParentID="18209">
<Name>18210 M B</Name>
<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>
</Product>
</Products>

</STEP-ProductInformation>
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Classifications

This topic covers information specific to the Classification super type that is important to know when working with
classifications. For general object maintenance information (applicable to all object types rather than specific to
classifications), see the All Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings. For
example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate subfolders
under the 'Assets' classification folder. Product objects could also be linked into classifications to provide
alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor

The primary editor for classification objects is the Classification tab.

T-shirts and Sweatshirts rev.0.3 - Classification

1j Assets A | BEEEERLTN | Sub Products || References || Referenced By || Images & Documents || Tables || Status || Statelog || Tasks
(-] Configurations —
1j ETIM Hierarchy ¥ |
H d|#
(-] Index Words Name Value
f#-[] Merchandsing Hierarchy »ID 22586
[#-[ ] Suppliers > Name T-shirts and Sweatshirts
-7 Web Site
D EEE Ac:ﬂ:ReEil Web Ste ebLeve 3
EHj Apparel » Revision 0.3 Last edited by USERY on Mon Dec 26 07:24: 26 EST 2016
Elﬁ Mens Casual > Wpproved 3 Last Approved on Mon Aug 08 10:59:21 EDT 2016
ij Caps » Translation Not Translated
=1 7] [T-shirts and Sweatshirts
L) B0701 » Path Classification 1 root/Web Sites/Acme Retail Web Site/ApparelMens Casual/T-shirts and Sweatshirts
| 214012 > Visbity
w 18215012 » Landing Page Copy ahe
| 1827012
o 18217054
~[2] Women's Apparel

This tab will display all description attributes that are valid for the classification. Note that only description attributes
are available on classifications (as opposed to products, which can also have specification attributes). More
information on description attributes is available in the Description Attributes topic of the System Setup /
Super User Guide.
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When on a classification, the Sub Products tab is used to display objects of the product super type that are linked
into the classification via Product to Classification links. When the selected classification does not have product
children (e.g., classifications used to house assets or configurations), the Sub Products tab does not provide any

meaningful information.

Tree
----- [ Product Videos
H-{ 7 Configurations
o[ 7 ETIM Hierarchy
o[ Index Words
H-{ T Merchandising Hierarchy
[ Suppiers
=[] Weh Sites
[ Ace Retal Web Ste
Dij Apparel
B[ Mens Casul
1j Caps
3 Tt and Sweatshits
- 182079012
| 18214012
- 18215012
-\ 821702
L 18217054
[ Women's Apparel
[ Automotive
{4 Buiding znd Electrcal Products
- [ Entity Root
i) GDSN
]ﬁ Publications
o [5) Primary Product Higrarchy
f-(3 Collctions
- eCatalogs
7%} Recyde Bin

o - =} [ {F}-- [F1-- 5}

e T = W = T == N = O = W = |

T-shirts and Sweatshirts rev.0.3 - Sub Pl:}dw ts

Classification |BELULGIREN | References || Referenced By | Images & Documents || Tables || Status || Statelog | Tasks
View: Showall =
| 18207-012 > 18214012 > 18215012 > 18217012 > 18217-054
‘ID » (18207 18214 18215 18217 100305 A
Mame »|18207-012 18214012 18215012 18217012 18217054
Ohect Type » Gales Ttem Bales Item Sales Item Sales Item Sales Item
Revigon » 10,2 Last edited by USER 0.., 0,3 Last edited by USERL ... 0.4 Last edited by USERL ... 0.3 Last edited by USERL .., 0,22 Last edited
Path » Primary Product Hierarchy... Primary Product Herarchy... Primary Product Hierarchy... Primary Product Hierarchy. .. Primary Product
Approved » |3 Last Approved on Mo... 3§ Last Approved on Mo. .. | € Last Approved on Mo... € Last Approved on Mo... |/ Approved or
Translation » Not Tranglated Not Translated ot Tranglated ot Translated Not Translated
Completengss Score »
Classification 1root |Web Classification 1root |Web  Classification 1root |Web  Classification 1root | Web  Classification 1n
Sites | Aane Retail Web Site Sites | Acme Retal Web Site Sites | Aae Retail Web Site Sites | Acme Retail Web Site Sites | Aame Ret
Category » || Apparel | Mens Casual | || Apparel | Mens Casual | | Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens
T-shirts and Sweatshirts | T-shirts and Sweatshirts | T-shirts and Sweatshirts | T-shirts and Sweatshirts | [T-shirts and Swe
18207012 18214012 18215012 18217012 18217054
Ohect Type » Gales Ttem Bales Item Sales Item Sales Item Sales Item
Parent » T-ghirts T-shirts T-shirts T-shirts T-shirts
Product Variant Priority »
Released by »
Status H
LRL H v
{ >
|Add Product

Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly into
any editable field. Standard editing capabilities are available within this interface (as described in the Editing
Objects in Tree topic within this guide), including copy / paste functionality using Crtl + C and Crtl + V. Right-
clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and Mark
Different selections - all of which are self-explanatory and can be especially useful when editing multiple objects.
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18207-012 * 18214012
T-shirts | T-Shirts Sales T-shirts | T-5hirts Sales
Itemns | T-shirts Items | T-shirts
a8 Ccut Ctrl+X
Copy Ctrl+C
[B Paste Ctrl+V
8.97
$ Paste Link Ctrl+L
5000 Rotate Table
2000 Hide Equal
Mark Different
The Hane:
For over 2 Hide/Show Attributes
the stand:
comfort ar :
¥ hetior Filter
offerin
vt I
Cherride
Recalculate
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Note that two views are available using the Rotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including options
to add and remove products.

Classification |REEIGITLEN | References |ReFerenced

View: Show all -

[

D
Mame > [0
18207-012 > |18207
18214-012 > [18214
18215-012 Hide

18217012 Show All Rows

18217-054 Rotate Table
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Selecting Remove Product deletes the product to classification link between the objects, but does not delete the
product itself. Selecting Add Product opens a dialog allowing the user to browse hierarchies to select a product
to link, as well as specifying the link type to be applied.

$2 Select Classification Preduct Link

Search

E}Fj pper Body Wear s
=[5 T-shirts
-l T-shirts Items
£ T-Shirts Sales Items
E|r_=| T-shirts
-l 18217-054
| 18207-012
-] 18214012
|l 18215012
-\ 18217012
-[T] Head Wear
B-[[T] Footwear W

- Details

Link Type |iijiehsite Link s

Select Cancel

Note that the same functionality is available using the Add Product link at the bottom of the Sub Products editor.

References

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has privileges applied, has objects visible in
other contexts, or has any linked attributes, that information can be viewed (and in some cases edited) on this tab.

The display of the References tab on a classification will vary slightly from system to system, based on the data
model. If the selected object has classification reference types for which the object is a valid source, those will
appear on this tab, in addition to the default flipper options.
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B Assets Classification || Sub Products Referenced By || Images & Documents || Tables || Status || Statelog || Tasks
|j Confiqurations & Display
|j ETIM Hierarchy Reference Type v| » Target »| 3
B 7] Index Words —
B[] Merchandising Herarchy ! GessfiatonReference+ 1)
#{) Suppliers © Ungrouped Classification References
Eij Web Sites e Reference Type v| > [Target ¥
EE Aeme Retal Vied e » |Related Web Classification  + \ﬁ.,l [ ] Mens Tops r
{7 Apparel '
B[] Mens Casual § Applied Privileges
1j Caps e Applies to » |Action Set » \Attribute Group » [Object Type > |Group » Language ¥|Country 3
1j Mens Tops » [ T-shirts and Sweatshir tClassify Products Merchandiser Managers < ANY » <ANY >
= [ Tesfrts and Sweatshirts Add Privilege
| 18214012 § Visible Objects in Other Contexts
- 18215012 No Visible Objects in Other Contexts
|| 18217012 9 Attributes
l— 18217054 D » [Name » |Attribute Groups » Mandatory » Inherited from »
[ 7] Women's Appare]
{7 Automotive ¥ Calor Color Apparel
- 7, Buiding and Electrical Products > Hize fize [
i [ Entity Root ? | Link to Attribute
Reference Flippers: References can be placed in attribute groups for display purposes. All references for

1.

which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created to the object selected in the dialog from the currently selected object that you are
standing on (e.g., current object = source, dialog selection = target). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User Guide.

Ungrouped Classification References: The functionality is identical to what is described for the Reference
Flippers section above. The only difference is that this area displays references that have not been placed in
attribute groups for display purposes. If all references that are valid for the selected object have been placed in
attribute groups, the Ungrouped Classification References flipper will not be present.

The Applied Privileges flipper allows users to apply privileges to the selected classification. Detailed
information on creating and editing privileges is available in the Privilege Rules section of the System Setup /
Super User Guide.

The Visible Objects in Other Contexts flipper displays subproducts that are visible in another context, which
is only applicable if classification hierarchies have been set to be dimension-dependent in System Settings.
See the Classification Hierarchy Settings topic in the System Setup / Super User Guide for detailed
information.
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5. The Attributes flipper allows the user to view attributes linked to the classification, as well as to add new links

using the Link to Attribute link. When attributes are linked to a classification, they are available to be
populated on any objects of the product super type that reference the classification (assuming the attributes are
also made valid on the applicable product object type). The exact columns available will depend on the data
model and the attributes that have been made valid on the attribute links. Whether or not the various attributes
are editable will also depend on the setup of the data model. However, an ID and Name field are always
shown, with the attribute name being a hyperlink that can be used to navigate directly to the attribute. An
Attribute Groups column is also present, displaying the attribute group(s) that the attribute is in. A Mandatory
column is present and if checked, product objects that reference the classification cannot be approved until a
value has been provided for the attribute. Note that mandatory settings on the attribute itself apply globally,
while mandatory settings on the attribute link apply only to product objects that reference the classification at
which the attribute is linked (or reference a classification that is inheriting the link). More information on
mandatory settings is available in the Mandatory Attributes topic in the System Setup / Super User Guide.

If the attribute link is inherited (indicated by a green down arrow, =, in the row indicator), the ‘Inherited from'
column will display the parental node where the attribute has been linked, which is hyperlinked for easy
navigation. More information on linked attributes is available in the Inheritance in the Product Hierarchy topic
within this guide and in the Attribute Links topic in the System Setup / Super User Guide.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by a match code or is used by any publication, that information can be viewed on this

tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

Tree
£-[7] Acme Retail Web Site
= E Apparel

T-shirts and Sweatshirts rev.0.5 - Referenced By

Classification || Sub Products || References |BAEEEIMSIEM | Images & Documents || Tables || Status || Statelog || Tasks

=8 E Mens Casual P Deply
: Reference Type v| » |Source 2
[ 7] Caps
r_‘= Mens Tops » |Classification Reference  + \t.-l
& EH' tsand Sweatshits | | @ \jngrouped Referenced by Products, Classifications or Entities
""" l— 18215012 Reference Type v| ¥ |Source > >
] 8215012
----- || 1827012 § Used by Match Code Objects
----- v 18217-054 D » IName ’
~[Z] Women's Apparel © Used on Page
-7 Automoti
B u, .mo " ] Publication > |Version > |Page > |Areg Used > |Page Type
f#H-{ 7] Building and Electrical Products

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
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screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User Guide.

2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:

System Setup L 4 Find Similar - Match Code =pmi

Ell’i‘-] Match Codes and Matching Algorithms &, Match Code Values | Shatiskics [m
Y § Definition
i e Find Similar
[iﬂ] Outbound Integration Endpaints MName >| > |Value
-7 Web Uls » D FindSimilar
rin-l Workflow Profiles > Mame Find Similar
E‘ Workflows > Last edited by 2017-01-24 12:34:34 by USERG
i-+|=] Derived Events
(& Object Types & Structures » ICategory T-shirts and Sweatshirts (22588)
f:_l/i Tags * Match Code Window Size 1
E|r_=| T-shirts and Sweatshirts | ' Used by Match Code Objects
ol 18214012 ID > Name > [Edited by >
-\fa] 18215012 > FindSimilar Find Similar  [2017-01-24 12:34:34 by USER6

More information on match codes is available in the Matching, Linking, and Merging guide.

4. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the Publication Hierarchy section of the STEP Publisher guide.

Images & Documents

The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets that are
housed within that classification). Note that assets can be tied to classifications in two ways: as child products, or
via image and document references. Assets are typically referenced to classifications only when the classification
contains non-asset children for which the asset is relevant. In any case, assets referenced to classifications are not
visible on the Images & Documents tab. This is in contrast to how the same tab functions for products, where the
tab displays all assets referenced to the selected product. However, for the displayed assets (those that are child
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to the classification), the functionality available for interacting with the assets is the same as what is available for
referenced assets on a product, which is described in the Images and Documents Tab topic in the Products
section of this guide.

Tables

The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information, see
the Tables guide.

Status

The Status tab provides information about the status of the object, including revision history, translation status, and
approval status. Products and classifications share a common Status tab, which is described in the Status Tab
topicin the Products section of this guide.

State Log

The State Log tab displays the history of the selected object across all workflows. If the object has ever beenina
workflow, a flipper is displayed per workflow and the history of transitions of the object within that workflow can be
viewed. Detailed information on the State Log tab is available in the State Log Tab topic in the Workflows guide.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More
information on the Tasks tab is available in the Moving Tasks through a Workflow in Workbench topic in the
Workflows guide.
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Collections

Collections provide a valuable tool for data maintenance tasks. Collections are containers for storing sets of
objects from Tree and System Setup, independently of their placement in the hierarchies. A collection can be
created via a search or import, and all objects in a collection can be updated at the same time. Collections and
collection groups are found in the Collections hierarchy on the Tree tab.

When multiple collections need to be grouped together, they can be put into a 'collection group'. Collection groups
can also hold other collection groups. See Creating Collections or Creating Collection Groups in this
documentation for more information on each topic.

Tree
r_=| Primary Product Hierarchy

-5 Collections
[+ [5] All PPH

=8

()

- [5] Copy Writing State
}@ Temporary Collections
—}-@ Tshirt Group
E@ Men's Tshirts

- B[ Size Medium

-5

For more on data maintenance of collections and collection groups, see the Maintaining Collections topic.

Dimension Dependency and Collections

Collections and search results are dimension dependent. A search in one context can display different objects
than the same search in another context.

The following example illustrates how creating a collection from search results can return different objects, based
on the dimension dependent values in the context being searched.

This search is performed in the 'English US' context for the value 'red' in the 'Color (Color)' attribute. The search
finds four objects with the value.
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v | € —» CurL [sid3=1739288conte>

<
m References || Referenced E'grl

[Search
|Cnlur (Color) = Red |
& Advanced
D * Color »
9F | Reset || Search | |iame > ID Color
Displaying 4 of 4 results Show Details | ||12-GGKE0 » (1832922 Red
ame » || ||[Mens T PBG * (179916 Red
Mens T POY * MT 18404 Red
Womens TPOY w Class  » 179923 Red

One of those objects has a translated value of 'rojo' for the language dimension pointin the 'US Spanish' context.
the other objects have no value for the attribute.

€ 12-GGKB8O0 rev.0.9 - Compare Contexts | |

Compare Contexts References || Referenced By
* |English U5 * |English Canada  * |English LK »JUs Spanish >
* ID 152922 132922 182922 182922
* Mame 12-GGKE0 12-GGKE0 12-GGK30 12-GGK30
* Color Red Fed Red Fojo

Performing the search again in the 'US Spanish' context returns no records since the value of 'red' does not exist
for any of the records in the searched context.

El ] 2 |E [ coto [1oame

Search Result Profiling

[Search |

[Color (Color) = Red ||| search Result Profiling
&= advanced

0 hit{s)

I | Reset | | Search |
Displaying 0 of 0 results Show Details
[ Name |
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Creating Collections

In workbench, collections can be created in two ways:

1. Using the Search tab, perform a search, and create a collection of the results
2. Using an import file, create a collection of the contents

Regardless of how they are created, if a collection contains less than 10,000 objects, these can be inspected in the
Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat structure
regardless of any parent-child relations that may exist between the objects, and regardless of which parents /
children the objects have when viewed elsewhere in STEP.

Note: While this topic and the Collections section do not address Web Ul functionality, it is important to note that
the Web Ul Collection Content Screen also has the same 10,000 object restriction to allow for the best
performance.

In Web Ul, objects can be manually added to and removed from a collection. This functionality is not available in
the workbench.

Creating a Collection from Search

The most common way to create a collection is through creating a search. To do so, follow the steps below.

1. Navigate to the Search tab, enter in the needed search criteria, and click Search to verify the results. For more
on how to search, see the Navigation and Searches topic in the Getting Started / User Guide
documentation.

2. Click the 'Save as Collection' button.
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Search Below
’VFIashIights Items (20359) ﬂ
5~
Displaying & of & results Show Details
Mame

I Blue and Purple Flashlight /D = 174557
W flashlight case [0 = 129555

I Flashlight C Batteries [D = 170582

jil Flashlights Items 1D = 20555

¥® pink Flashlight 1D = 19133

¥™ Red flashlight 1D = 174554

-Operations on Entire Result
5l GERL

| Save as Collection |
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3. Next select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a

collections group folder), enter a collection name (the ID is autogenerated), and click OK.

$2 Save as Collection in Background Process

Search

Collection ID 157532

Collection Mame |Flashlights

Cancel

El@ Collections ~
: > {7 Addresses
- [ AlPPH
- [F Backplate v
- Details

4. A background process runs, and the new collection is created and saved under the specified folder.
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Tree

1'_=| Primary Product Hierarchy
EI@ Collections
- (5] AllPPH
& 7] Bottled Water
>89

-4 Blue and Purple Flashlight
- | flashlight case
- |8 Flashlight C Batteries
- i Flashlight Items
- {f# Pink Flashlight
m Red flashlight

5. Right-click the collection, and run any needed bulk update, or export the objects.

Note: The initial search criteria used to locate the included objects is stored on the collection, which allows for
later updates of the collection. To learn more about editing searches to update collections see the Maintaining

Collections topic.

Creating a Collection from File Import

Collections can be created from a text or CSV import file containing STEP IDs of products, assets, or
classifications. Objects in the import file must already exist in STEP as the import will not create or update objects,
only place them in a collection.

Important: If the import file includes only attribute values or unique keys of the products, assets, or classifications
to be added to the collection (and does not include the STEP ID), you must use the above steps for Creating a
Collection from Search.

To create a collection from a file:

1. Inthe Tree, right-click the Collections top node or a collection group to determine where the new collection will
be saved, and select Create Collection From File....
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2.

r_=| Merchandising Hierarchy
r_=| Suppliers

-] Web Sites

- i Entity Root

-0 GDSN

ﬁ Publications

1‘_=| Primary Product Hierarchy

-5 Collection=
(-0 eCatalos Create Collection Group...
@ Recyde Create Collection From File...

Delete

Search Below

In the Create Collection From File dialog, locate the file to be imported.

31 Create Collection From File

Look in: Imports e ? ¥ '

,i""? D Product IDs

Recent Items

Desktop

Documents

2

This PC

@ File name: Product IDs. bxt

Metwork: Files of type: | Al Files e

Collection ID 112706

Collection Mame |Mew Products

File Contains Products e

Classifications

Assets

The Collection ID is autogenerated
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3. Forthe Collection Name parameter, add a Name for the new collection.
4. Forthe File Contains parameter, select if the import file contains IDs of products, classifications, or assets.

5. Click OK to start a background process which will create the new collection.
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Creating Collection Groups

Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.
Creating a Collection Group

1. Depending on where you want the collection group to live, either right-click the top-level Collections node or an
existing collection group in Tree. Then select Create Collection Group....

[#-[ 7] Assets

r_=| Configurations

r_=| ETIM Hierarchy

r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

- 7] Web Sites

- i Entity Root

[#-(0) GDSN

ﬁ Publications

r_=| Primary Product Hierarchy

% 'S
[ﬁ eCatal Create Collection Group...
a'_"} Recyd Create Collection From File...

” System Setup ” BG Processes ” Search ]

Delete

Search Below

okmarks

2. Inthe'Create Collection Group' dialog enter a Name (ID is autogenerated) for the new group.
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[#-[ 7] Assets
r_=| Configurations

r_=| ETIM Hierarchy

r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

(- 7] Web Sites

- i) Entity Root

[#-[0) GDSN

ﬁ Publications

r_=| Primary Product Hierarchy
(5] Collections
-5 eCatalogs
'ﬁ Recyde Bin

3% Create Collection Group

D 112700

” System Setup ” BG Processes ” Search ]

Mame |Mew_Products

Bookmarks

Collection Group

® Desript

Mame

» D

* Mame

Cancel

3. Click OK

StiboSystems

MASTER DATA MANAGEMENT

Once created, collection groups can be selected to hold new collections, or more collection groups can be created
under them. For more on how to create collections, see Creating Collections in this documentation.

Tree
r_=| Primary Product Hierarchy

EI@ Collections
#- [ AlPPH

=8

- EVN-06

(|

- 5] Copy Writing State

-5 Temporary Collections

=g Tshirt Group

=45 Men's Tshirts

B 5] Size Medium
- 12-GGKT3

- 12-GGKB0

{8 18210 M B

-5
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Maintaining Collections

Collections can be a valuable tool for data maintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects with
data anomalies could be grouped in a collection via search criteria. Once the data is corrected, the objects with
updated information no longer meet the search criteria. Thus updating the collection automatically removes any
updated / fixed objects from the collection. In this way, only the objects that still need to be fixed are displayed in the
collection.

This topic addresses the various ways users can interact with and maintain collections.

o Delete

« Edit Search Criteria
« Export Data Below
« Refresh Data

o RunBulk Update
« Republish

« Search Below

Delete

Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
They will still reside under their original nodes in Tree and System Setup. All collections and collection groups
below a collection group must be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placementin STEP as well. In this case, it would be best to just updated the collection through proper
maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and select Delete.
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-3 Collections
G- [ Assets made with Search
[ [ Copy Writing State

= [ Cotton T-shi| oz
'ﬁ 19710 M & Fun Bulk Update
E 15712 i Export Data Below
- 18213 M Republish...
E 18218 Refrech
E InDesign

- 8 Digital Asset Edit Search Criteria...

[ [ Flashlight C

- [ Group2 #_Delete

.. (=1 Darte Habe

< Search Below
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Additionally collections and collection groups can also be deleted from the Maintain menu, Delete option.

File Edit View Mavigate Forrmat Maintain Window Help

44 Context |English US

" - w]l||[® O FTroCUCTs
r_=| Electrical & Electr
r_=| Food and Bevera
r_=| Kitchen

r_=| Party Supplies
G-I Discontinued Product
T Product Qverrides
G-l Packaging
G-l GOSN Products
-3 Collections

- [ Assets made with Sez
[ [ Copy Writing State
= ] Cotton T-shirts
- 18210 M B

Tree

----- & 321218

- 18213M 0

----- | 21510

” System Setup " BG Processes (2] ” Search ]

[ [7] Digital Asset Review
+1- [5] Flashlight Callection
- (5 Group2

Bookmarks

Insert
Link
Merge

Delete

i i

(s

F Delep-—=
orce De I|D

|}
elete a selection

Unlink Object Type

Duplicate

Duplicate Recursively
Make Revision

Approval

Enable group for workflows

Revive

Revive Recursively
Truncate log...

Migrate Attribute Values

Ctrl+]

For more on creating searches, see the Navigation and Searches documentation.

For more on how to use bulk updates, see the Bulk Updates documentation.
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Edit Search Criteria

Collections created from searches can be edited if needed to reflect the needed objects in the collection.

1. Todo so, right-click on the collection and select Edit Search Criteria.

Tree

-3 Collections
[+ [ Assets made with Search
G- [ Copy Writing State

E 182 @ Run Bulk Update
-E 182 ik Export Data Below
ﬁ 182 Republish...

E 182 Refresh

" 9 Flashig Edit Search Critena...
G- [ Group2

.. 8 Party H . Delete

- [3 PetHats

[ [ Product

Search Below

2. Once selected, the user will be brought to the Search tab where they can see the original search criteria, and
modify the search criteria if necessary.

Search Below ¥
IVSE.arch Below = Cotton T-shirts
Object Type ™
’V— COhject Type = Item Family
oa v Save Reset Search
Show Details
| Mame ¥
-Operations on Entire Result
e
0 @ &

Alternatively, if a collection was created using a search criteria, the 'Search URL' will appear in the collection's
Description flipper under the Search URL field. The user just needs to copy and paste this information into a
browser, and they will be brought to the Search tab with the original search criteria on it where they can make
adjustments if needed.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 195



Tree Cotton T-shirts - Collection
(+-[[3] Product Overrides A M Data Profile
i Packaging
-l GDSN Products
) Mame » |Value
=-(35 Collections
- [J Assets made with Search * D 112803
. {3 Copy Writing State * Mame Cotton T-shirts
T-shirts

E 8 R * Estimated Amount of Obje...| |5
; B 13010 M B

E 18212 LB » Bearch URL step: /fsearch?args0, 0=topnodetype %e3dproduct®e2ctopnodeid %630

™ 18213M0 > Last edited By 2017-08-17 16:48:25 by USERL

- 18216L 0

y. -
W
£ > £ >
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For more information on searches, see the Navigation and Search topic in the Getting Started / User Guide

documentation.

Export Data Below

The Export Manager wizard allows a user to export data on demand and to create or modify an export

configuration.

1. Ifauser wishes to export all objects in the selected collection based on the selected format and the mapped
data, they can right-click on the collection and select Export Data Below.

-5 Collections

- [ Assets made with Search
& [3 Copy Writing State

= [E]{hthmT-dit
----- - 18210 M

1 Run Bulk Update
[y p

™ 1821218

ik Export Data Below

----- - 18213M (
----- - 13216 L O
- [5] Digital Asset R
- [5] Flashlight Coll
- [5] Group2
- (5] Party Hats
- [7] PetHats

| ey I ey O ey A e

Republish...
Refresh

Edit Search Critena...

> Delete

Search Below

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as needed.
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33 Export Manager

Steps Select Format
1. Select Configuration Excel o
2. Select Objects
3. Salect Format Exports data in Excel format,
4. Map Data Excel version |Eyca 573603 P
5. Advanced
6. Select Delivery Method

Back Mext Finish Cancel

For more information on exporting, see the Creating a Data Export topic in the Data Exchange documentation.

Refresh Data

Collections created from search results can be updated for the most up-to-date information and object groupings,
as objects in a collection that no longer meet the search criteria will be removed from the collection.

« Tostart arefresh in workbench, right-click on the collection and select Refresh.

Tree

E1-5 Collections

- [ Assets made with Search

& [ Copy Writing State

=n | Cotton T-shirts

4™ 1321 T} Run Bulk Update

ﬁ 1821 Export Data Below
ﬁ 1821

_____ E 18211 Republish...

G- (5 Digital ASI Refresh
- [ Flashlight
- [ Group2 Edit Search Criteria...
B [J PartyHal X Delete
- |7 PetHats
- 5 Products Search Below

Note: The 'Refresh’ option is Only available if the collection is created from a search.

« Tostartarefresh in Web Ul, go to the collection content screen, select the desired collection, and click the
Refresh collection action.
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Collection Detall

Clear all EP Export % Refresh collection

Name - Object Type . Fath

Primary Product
Hierarchy,/Produc
Root/Apparel
/Mpper Body
Wear/T-shirts,/T-
shirts Items/Polo
T-shirt/18210 M
B_EN

18210 M B_EN ltem

Note: For more on how to setup arefresh in Web Ul, see the Scheduling a Collection Refresh in Web Ul
topic in the Bulk Updates documentation.

Run Bulk Update

This option allows the user to interact with the objects in the collection in a number of ways. To name a few, the
objects could be submitted into a workflow, assigned to a user group, or have an attribute updated.

1. Right-click the desired collection and select Run Bulk Updates.

=1 Collections
B [0 Assets made with Search
G- [J Copy Writing State

- 5 Cotton T-shy=
4™ 1520 ®] Run Bulk Update
ﬁ 182121 & Export Data Below
BN

& [ Digital Asset Refresh
[#- [3] Flashlight Ca

- 5 Group2

G- [0 PartyHats | #% Delete
- |7 PetHats

Edit Search Criteria...

Search Below

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 198



StiboSystems

MASTER DATA MANAGEMENT

2. Complete the steps in the Bulk Update wizard to make the same updates to all objects in the collection.

32 Bulk Update

Steps Configuration

1. Configuration
2, Operations

3. Parameters

4. Preview

5. Advanced

() Use Existing Configuratiors

(®) Create New Configuration

Back Mext Finish Cancel

For more on how to use the bulk update wizard, and the various operations that can be applied to collections or a
group of collections, see the Bulk Update documentation.

For information on how to schedule bulk updates for collections in Web Ul, see the Scheduling a Collection
Refresh in Web Ul topic in the Bulk Updates documentation.

Republish

The Republish action generates events on products, classifications, or assets in the collection. Common setup is
to use this option for on-demand creation of a republished event. For example, to generate events for all objects in
a collection that has never been published by an event queue.

For more information on events, see the Events topic in the System Setup / Super User Guide documentation.

1. Torepublish an event, right-click on the desired collection and select Republish....

=[5 Collections

[+ 1) Assets made with Search

B (3 Copy Writing State

= BEUT;;?;: %1 RunBulk Update
™ 18212068 & Export Data Below

E 18213M ™ Republish.., |
18216L 0
[+ [5] Digital AssetR Refresh
B [ Flashiight Colle Edit Search Criteria...
= 5 Group2
B PartyHats | 7. Delete

- [3] PetHats

Search Below
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Note: Users must have the privilege to maintain event queues in order to use this action.

2. Clicking the action launches a wizard where users can choose the appropriate event queue from the dropdown

menu.

32 Republish collection

Republish to event queue:

Process Description:

BSSSAdVSTERKML o
BSSSADVSTEPKML
ESSSGenerickML

Downstream Data
weelClassification

Republish collection: Cotton T-shirts

Republish Cancel

3. Users can also enter in a Process Description to give a name to the background process, which can be
monitored in the 'Republish Node'.

BG Processes

i

{5 Republish nodes
% Queued Processes

- Active Processes
E}--% Ended Processes

Search Below

If a certain attribute on some of the items in the selected collection needed to be changed, a user could use this to

locate the items.

When a user right-clicks on a collection and selects Search Below, it allows the user to search only the items in

that particular collection.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

200



StiboSystems

MASTER DATA MANAGEMENT

-3 Collections
G- [ Assets made with Search
[ [ Copy Writing State

B 8 ﬁ 182T1-[Jd: %} Run Bulk Update
- 18213 M Republish...
E 18218 Refresh
E InDesigr

[ [ Digital Asset Edit Search Criteria...

- 5 Flashlight Cq % Delete

#- 5 Group2 '

B @ Party Hats Search Below

. (51 Pet Hate

See the Search Below topic in the Getting Started / User Guide documentation.
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Collection Properties and Statistics

Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can
provide a quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab

The Description and Statistics flippers provide information about the selected collection. Below are the flippers
described in more detail.

1. Description: This displays the Collection properties

2. Statistics: This displays the Collection Statistics

Products with Assets - Collection

£
M Data Profile [E]
3 Description

----- B 114413
ﬁ 20803 Mame »| » Value
a 080303 » D 114506
E 20805 > Mame Products with Assets
..... 444443
g . > Estimated Amount of Obje...| 28
_____ W 44a4445 » Gearch URL step: /fsearch?args0. 0 =topnodetype %:3dattributegroup®e2ctopnodeid S 3dA tiributeGrou
----- G 444445 > Last edited By 2016-12-05 09:36:43 by USERL
-] Hats and Caps Items o

..... £ (AttributeGroup)

----- [T (attributen) .
..... T (attsize) Collection Content

..... I]I {Attl’TfShirtSiZE} 28 object(s)
""" DI (AttwithLangDeplOY  patice: Objects in Collection may be hidden in Tree due to Context\Workspace visibility andfor privilege checks
----- DI {Color, Interior)

..... |]I {Hazmat) Content by' O*Ct Type
----- I (Hazmatmy Product (10)
----- [T Marketing Descriptia
----- [T (Referenceattribute %:}emfg}
..... em
..... I Releasedsy) (& ttems (1)
13 (selingprice) G ltem2 (1)
..... i {S!ﬁippingF‘.EStl’il:ﬁDl‘lEl G Item3 (1)
..... H% E.zle} ) Il 'tem Folder (1)
..... alue
_____ T (e Attribute (17)
s | soeciatopesto
- (3] Sample Search Collection l%’ Attribute Group (1)
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Description Flipper
The fields described below provide information about the collection:

< Party Hats - Collection a
m Data Profile || Log

® Descript
Mame *| » |Value >
* D 111807
* Mame Party Hats
» Estimated Amount of Obje... 4
» Gearch URL step: /fsearch?args0.0=topnodetype % 3dproduct %e2ctopnodeid %e3d 1211898search0. 0 =BelowCriteria
» Last edited By 2016-08-22 11:53:40 by USERS

« ID: Shows the collection ID, which is auto generated.
« Name: Shows the name of the collection.

. Estimated Amount of Objects: Displays the total number of objects in the collection based on the latest
'Refresh’ of the collection. The count is not filtered according to Context / Workspace visibility, privilege checks,
or object types.

« Search URL: Displays only on collections created from a search result. A user can copy the URL, paste itinto
the URL field, press ENTER, and see the search in the Search tab. It is possible to edit the search if needed.
For more on searching see the Navigation and Searches topics in the Getting Started / User Guide
documentation.

« Last edited By: Displays the date and time and user who last worked on the collection.

Statistics Flipper
The Statistics flipper gives an overview of which type of objects are included in the selected collection.
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Products with Assets - Collection

<
E}Ej Data Profile || Log
qj D - l.

----- Wl 114413
ﬁ 20801 Mame »| » [Value
-\ 20803 > ID 114506
™ 2080303
ﬁ 20805 » Mame Products with Assets
..... G 494443 * Estimated Amount of Obje...| |28
""" i M » Search URL atep: jfeearch?args0. 0 =topnodetype % 3dattributegroup¥: 2ctopnodeid % 3dAtributeGrou
----- 4444446
g : » Last edited By 2016-12-05 09:36:43 by USERL

il Hats and Caps Iter| ¥ Stafistics
----- (51 (AttributeGroup)
..... 1T (attributen) Collection Content
..... 1T (atirsize)

..... I (atrTshirtsize)
----- T (attwithLangDepL

----- 13 (color, Interior) Content by Object Type

28 object(s)
Motice: Objects in Collection may be hidden in Tree due to ContextWWorkspace visibility and/ar privilege checks

----- 13 (Hazmat)

..... I (Hazmatyn) Product (10}

----- 13 Marketing Deserip % ltem (4)

----- 13 (Referenceattribut ltemd (2}

----- I Releasedsy) (& ttems (1)

----- 13 (selingprice) [ ttem2 (1)

----- [T (shippingRestrictio (A ttem3 (1)

_____ IF 5ze) I tem Folder (1)
----- 13 valuez) Attribute (17)

----- 13 value3)

----- 13 condition Attribute{ Special types (1)

""" 13 valuet (& Attribute Group (1)

In addition to breaking down the objects by type, it will also display the exact number of objects in the entire
collection based on the latest 'Refresh’ of the collection.

Note: While actually viewing the collection in Tree, it may appear that there are fewer objects in the collection
then what is reported by the Estimated Amount of Objects field under the Description flipper or the total objects
reported under the Statistics flipper. Examples of why this may happen could be because some objects are not
approved for the workspace the user is currently in, and thus do not show, or it could be due to privileges.

Data Profile Tab

The Data Profile tab can display a dashboard to provide a graphical representation of the objects that are in the
collection. This can be modified based on the user's requirement.
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Tree < Data Profile
7] Primary Product Hierarchy Collection |REGNEL (=M | Log
(5 Collections
__ 5 AlPPH Generated: Mon Mov 28 2016 14:24 Update Profile
- ) Backplate (®) Dashboard () Value Details () Reference Details
[ [5 Baskets
= 1 Bottled Water Object Count Translation Status
- EWN-06
- EWN-06
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- [J Commbatalist Least Complete Attributes Approval Status
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- |21 Copy Writing State IHarmunizaﬁnn v | 0% ~
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- |5 Data Quality Collection | JProduct Name 0% e mnmmema e
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| |
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=

If a profile has never been created, a user can click on the Generate Profile link to create the collection's
Dashboard.

Collection [ Log ]

Generate Profie

Diashboard Value Details Reference Details

If it has already been created, it is recommended to update the profile when viewing if it has not been updated
recently.

Collection [ Log ]

Generated: Mon Mov 28 2016 14:24]Update Profile

(@) Dashboard () Value Details () Reference Details

For more information on how dashboards and data profiling work, see the Data Profiling documentation.
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Log Tab

The Log displays details about the creation and modification of the collection, details about which user performed
what actions, and the number of objects in a collection when a collection is refreshed.

Tree 4 Bottled Water - Log
Fj Primary Product Hierarchy | | collection || Data Profile m
El@ Collections Showing page 1of 1
(- @ AIPPH 2016-09-15 15:14:45 'USERJ: Created
[+ [J Backplate 2016-09-15 15;14:45 'USERT': Mame modified from ‘null
- ] Baskets 2015-09-15 15:14:45 'USERT": Collection refreshed, number of objects: 4
E | Bottled Water 2016-11-23 15:25: 24 'USERL" Collection refreshed, number of objects: 4
e
- EVN-06
- | EVN-12
| EVN-24
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Entities

This topic covers information specific to the Entity super type that is important to know when working with entities.
For general object maintenance information (applicable to all object types rather than specific to entities), see the
All Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used to model customer-related
data, such as contacts, addresses, markets, or customers, though they can be used for any number of data
modeling scenarios, including modeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only utilize description attributes, the application of category-
specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type validity and all
entity instances of a particular object type will have the same attributes available for population. Additionally,
entities cannot be published in printed form (e.g. as part of print publishing solutions), nor can you translate entities
using a background process.

Entities may or may not be subject to approval, dependent upon the revisability settings (globally revisable entities
are the same in the Main and Approved workspaces, while workspace revisable entities adhere to standard
approval concepts). This provides a great deal of freedom in determining how entities are handled, specifically in
terms of how events are generated and processed. For more information, see the Revisability on Entity Object
Types section of the Getting Started / User Guide documentation or the Events section of the System Setup
ISuper User Guide documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination of a
hierarchical display (with source displayed as child to target, or vice versa). In effect, this makes classifications
unnecessary for use with entities as entities can be classified via entities. Additional information on this is available
in the Entity Reference Types section of the System Setup /Super User Guide documentation.

However, entities do retain the standard data modeling capabilities and provide even more configurability. The
Revisability parameter allows you to define an entity object type that does not have to be approved and also
determines how events are processed.

Entity Hierarchy

Any number of entity hierarchies can be added to any system. For example, you may set up address hierarchies,
customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as part of the
implementation process and will likely differ on each system. The following is an example of an entity hierarchy.
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=il Entity Root
E}% Customer Hierarchy
=8 Customer A

----- % Axel Kiers Vej 11

Jesper Jensen

= 2 Customer B

o Key Accounts

For more information on hierarchy setup, see the Object Types and Structures section of the System Setup
ISuper User Guide documentation.

Entity Editor

Once the entity hierarchy is created and description attributes are applied to the entity object types, the next logical
step is to start entering values.

Note: Only description attributes can be applied to an entity object types and will appear in the entity editor.
Specification attributes are not allowed on entities.

=

-] Assets References || Referenced By || Status || StateLog m}
Q D . l.

[+ 7] Configurations

U

U

=
(| ~[Z)Index Words Name >| > Value

Y| [ 7| Merchandising Hierarch

0 rj ) ° g » D ADD_101571

wil| B[] Suppliers
= B[ Web Sites » Name Axel Klers Vej 11
2| B[ Entity Root » Dbject Type Address

w i .

& E% Customer Hierardhy > Revision 0.1Last edited by USER on Fri Aug 14 10:59:02 EDT 2015
o Eg Customer A

El ,/J} Ael Kiers Viej 11 » Path Entity hierarchy root/Entity Root/Customer Higrarchy/Customer A/Axel Kiers Vej 11
B |2 Jesper Jensen > City abe Hojbjerg
— Elg Customer B > Country abe Denmark

1 4% 3550 George Busbee Pkwy

n ' > Gtate abe

1A John Smith

E; ..... 8 Customer C 5 Bfrest abe Bl Kiers Ve 11
= 4 Key Accounts > 7p 22 DK-8270
| E-[2 Publications

For example, the image above shows an entity modeled as an address. The entity object has several description
attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute can be modified
and maintained. Since this entity object type has been modeled to be globally revisable, approval is not applicable.
Therefore, the Approval Status field is not shown.
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Entity References, Referenced By, and Status Tabs

Every entity editor includes a References, Referenced By, and Status tab. The labels on these three tabs remains
constant, while the label of the first tab differs based on the object type. Each is defined below.

References Tab

You can view associated references of an Entity object by selecting the References Tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an Entity Object will list valid References. In this tab it is possible to maintain
references from the selected entity to other objects.

See Reference Types topicin the System Setup / Super User Guide documentation for more information.

An entity can reference a number of different objects. It is possible to create:

« Entity-to-Entity references

« Entity-to-Product references

« Entity-to-Classification references
« Entity-to-Asset references

In the example below, one Entity-to-Entity reference type is valid on the selected entity object. Clicking the plus
sign (+) will open a large editor where you can select objects to be referenced. Alternatively, you can type the
name of an object in one of the white target fields and press 'Enter.’

-] Assets | Customear Referenced By || Status | Skate Log

-] Configurations § Ungrouped Entity References

r_=| Index Wu.rqs _ Reference Type w| » [Target | 3
g :f;;::::mg Hierarchy Affiliate Of + [*3)| & customer C &<
[+ =] Web Sites
=il Entity Root
: E}% Customer Hierarchy

. =2 Customer A
: 4 Axel Kiers Vej 11

L

« Targets can be unlinked by clicking the delete button .

« Metadata attributes can be linked on to the target reference in References Tab.
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« The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

For the meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.

Reference Type |IR'E(f=13001 RNl

P
> 1D
* Mame Contact to Contact
» Last edited by 2016-07-26 15:26:27.0 by USER
» Externally Maintained Mo
* Dimension Dependencies
» |Allowe multiple references fes
» Mandatory Mo
» Parent/Child relation Mone
» [Inheritance Mone
* Completeness Score 1 K
* Purpose E
?
Component * |Marme * |Description
P
D * |Name >
* | Add Attribute Group
9 vddatrbutes |

D * [Mame
> ContactMame Contact Mame
* PhoneMumber Phone Mumber

Completeness Score Completeness Score

Add Attribute

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

210



StiboSystems

MASTER DATA MANAGEMENT

Referenced By Tab
Selecting the Referenced By tab on an entity will list valid Reference Types. In this tab, you can maintain
references from other objects to current entities.

See Reference Types in the System Setup / Super User Guide documentation for more information.

An Entity Object can reference a number of difference objects. Itis possible to create:

« Product-to-Entity reference

« Entity-to-Entity reference

« Asset-to-Entity reference

« Classification-to-Entity reference

In the example below, one Entity-to-Entity reference type is valid from an Entity to the current selected Entity
Object. Clicking the plus sign (+) will open a large editor where you can select objects from where a reference to
the current selected Entity Object should be made. In the example, a reference from an entity named 'Customer A'
is made to the current selected Entity Object.

[ ) Assets [ Customer ” References ] Referenced By [ Status " State Log ]
r_= Configurations @ Unigue Identifiers

[ Index Words Reference Type w| > |Source >

[#-{7] Merchandising Hierarchy :

F- [ Suppliers 2 Referenced by Objects

1—_= Wweb Sites Reference Type w| * |Source >| 3
=I-jjili Entity Root » |Affiliate OF + 3|8 customer A &

-4 Customer Hierarchy

=8 Customer A

4 Axel Kiers Vej 11

&l Jesper Jensen

[—]8 Customer B

‘j} 3550 George Busbee Phkwy
&I John Smith

----- 5 EEE|

D Used by Match Code Objects
D > [Mame >

« Metadata attributes can be linked on to the target reference in Referenced By Tab.

7 Referenced by Objects

Reference Type v| * |Source |

> | affiiate Of + 1)

« The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

« For the meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.
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@ Desgptn

Component

Mame *| » |Value
> [D ConfirmedDuplicate Contact
* Mame Confirmed Duplicate Contact
* Last edited by 2016-08-31 13:38:24.0 by USERA
» Externally Maintained Mo
* Dimension Dependendes
* WAllow multiple references Yes
* Mandatory Mo
» Parent/Child relation Mone
* Inheritance MNone
* Completeness Score 1
* Purpose abe
?

> |Mame * |Description

Status Tab

one Number

A record of all the changes that have been made to a currently selected entity will be displayed. This record will
allow you to see the user that made the change and when the change was made.

Tre
[ Assets
i #-{—] Configurations
----- 7] Index Words
- {7 Merchandising Hierarchy
r_=| Suppliers
-] Web Sites
=il Entity Root
E} % Customer Hierarchy

£ & [Pustomer Al

(=]
m

Customer A rev.0.1 - Status

Cuskomer |ReFerences Referenced By @ Skate Log || Tasks

Revision * |Created » [Edited ¥ Major > |Jser
* 0.1 Thu Jul 30 14:53:26 EDT 2015 Fri Aug 14 10:58:36 EDT 2015 USER.

®Disgnostis
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You can purge past revisions or revert the old revisions. There will be no Workspace, Translation, or Approval
Status flipper as Entities can be created as globally revisable, meaning they are the same in both the Main and
Approved workspaces.

However, Workspace, Translation, and Approval Status flipper will be displayed if we create entity object type as
'Workspace Revisable' as illustrated in below images.

Example of object type definition

[T v || 109
@ Desaipton

Mame *| * |Value
> ID Account
* Mame Account
» Last edited by 2017-10-15 16:25:44 by USERE
* Mame Pattern
> [0 Pattern
* Enable Profiling Mo
* Icon
> Dimension Dependencies
Revisability orkspace Revisable

* |Description

D * |Mame »
|> |Add Attribute

Example status tab for workspace revisable object

Account Group 1 rev.0.1 - Status

] Assets Account || References || Referenced By State Log

i 7] Classifications

[ Confuraions *
'"[fl eClass 10 Revision Create Edite Major |Iser Comment
[~ ETIM Hierarchy * 0.1 Mon Oct 16 16:28:55EDT 2017 Mon Oct 16 16:28:55 EDT 2017 USERE

--@ Index Words
r_=| Merchandising Hierarchy Jip]
-7 Offers

r_=| Suppliers
-] Web Sites
- (0] Customer Roat
i -[0) Customers

EI @ Entity Root

1) Becaunt Group 1

w

Name ¥ [Path » ¥

stem Setup ” BG Processes ” Search ]
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Products

This topic covers information specific to the Product super type that is important to know when working with
products. For general object maintenance information (applicable to all object types rather than specific to
products), see the Object Maintenance in Tree topic within this guide.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product
number, etc. In other words, any item that a company sells that can be ordered.

Product Hierarchy

The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy. The
product hierarchy consists solely of objects of the product super type. The product hierarchy is an organized
hierarchy where all products in the workbench are stored. This is also where products and product attributes are
linked. Although configurable, the product hierarchy is usually a multi-level hierarchy—each level controlled by its
own unique object type. Super users can control the naming convention(s) used to categorize the products at their
different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually
designed to take advantage of this capability, with objects classified according to similar characteristics. More
information on inheritance is available in the Inheritance in the Product Hierarchy topic in this guide.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete objects
are represented by cubes.
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[#-{ 7] Assets
1'_= Configurations
r_= Index Waords
r_= Merchandising Hierarchy
r_= Suppliers
[-[7) Web Sites
E Publications
E|r_=| Primary Product Hierarchy
E}Fj Products
=-[I5) Apparel
E}Fj Head Wear
[+-[[T] Hats and Caps
E}|__=| Upper Body Wear
=I5 T-shirts
=gl T-shirts Items
E}- =) T-Shirts Sales Ttems
E|1__=| T-shirts

|l 18214012
-\ 18215012
-l 18217012
‘- |a] Red Shirt

All objects of the product super type must exist in the product hierarchy, and may exist only once (e.g., each object
can have only a single parent). The primary purpose of the product hierarchy is proper attribution of products. That
is, in the product hierarchy, products should be grouped according to their similar properties so that inheritance of
attributes, attribute values, and references can best be used. Based on this, it is evident that the Product Hierarchy
is not intended to be used for modeling website hierarchies or other taxonomies (e.g., merchandising hierarchy,
sales hierarchy, etc.) where an object can be represented multiple times. When a product needs to "live" in more
than one location, that can be accomplished using classification hierarchies. In this case, the product continues to
exist in the product hierarchy (and this is considered its true place of residence). It is then linked into one or more
classification hierarchies using references.

Product Editor

The Product Editor is displayed when an object of the product super type is selected in Tree.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 215



Tree
]ﬁ Fublications
=[] Primary Product Hierarchy

20808-013 rev.0.7 - Product

Category Profile || Proof View || Status || StateLog || Tasks

StiboSystems

MASTER DATA MANAGEMENT

Sub Products ”

References ” Referenced By

I

£ Products
=) Apparel
E}i Upper Body Wear Vale
- B[R Tshits > 101567
B[] Head Wear > Name 20808013
=-[7 Hats and Caps
- » ChjectT Gales Ite
(+ [ Hats and Caps Item LS aes em
EI‘ Hats and Caps Sale * Revision 0.7 Last edited by USERG on Wed Jan 18 08:38:58 EST 2017 E
| [20808013] > Approved € Last Approved on Mon Aug 10 09:47:21 EDT 2015
m 280304 » Mranslation Mot Translated
| 20808-08
m 20808-09 » Path Primary Product HierarchyProducts fApparelHead WearHats and Caps/Ha...
m 011l > Categor £ Primary Product Hierarchy | Products | Apparel | Head Wear | Hats and Caps
m A - | Hats and Caps Sales Items | 20808-013 | 20808-013
- t120t » Parent # Hats and Caps Sales Items
m ]
|l 1111111 A
f- 17 Footwear Mame ¥ 3 Value H]
[ 7] Safety » Manufacturer Name abe
[T Hardware » Product Width 123
i) Displays > Product Height 123
[+-[7] Furniture —
-] Automotive * Beling Price 1231299 § 6
[+-[7] Building Products * Product Depth 122
[#}-[7) Electrical & Electronics > |Annua| Sales Forecast, Maxin123 250
-7 Food and Beverage —
A1 ) Kichen H L\nnual Sales Forecast, Minim|123 {100
i) Party Supples ,[100% Cotton, Unstructured, Soft Crown, Low-Fitting, 6-panel cap, Seamed Front Panel without
= » Description, Long abe Buckram, & Rows Stitching on Visor, Matching Fabric Undervisor, Matching Fabric Adjustable Hook
) {3 Discontinued Products and Loop Closure, One size fits most,

The Product tab (known as the Product Editor) is the primary interface for working with product objects in the

workbench.

The Description flipper displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in Tree topic within this guide. Note that some information
displayed is common for all implementations, while other information is specific to the data model and
configuration of each system.

If the object has a primary image referenced, a thumbnail version of it will display. The reference type to be
used for the thumbnail display is controlled in System Settings (on the Users & Groups node), and additional
information on this is available in the Primary Image Type topic in the System Setup / Super User guide.
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Additional information on references in general is available in the Reference and Link Types topic in that same
guide.

Specification attributes are displayed in flippers, with the flipper name matching the attribute group. Flippers
can be expanded / collapsed by clicking the magnification icon. Note that when attribute groups have sub-
groups, configuration determines whether the parent group or the child sub-group is displayed as the flipper
name. This is set via the 'Product Editor, Group attributes by top group' parameter in System Settings (on the
Users & Groups node), and additional information on this is available in the Product Information Manager
Default Settings topic in the System Setup / Super User guide. More information on attributes in general is
available in the Attributes section in that same guide.

Attribute values can be edited by clicking into any editable field. Additional information on the various editing
options is available in the Editing Objects in Tree topic within this guide. By default, attributes are displayed in
alphabetical order within each flipper. However, if an attribute display sequence has been configured, this will
override the alphabetical sorting. More information on attribute display sequence is available in the Attribute
Display Sequence topicin the System Setup / Super User guide.

Additional Editors

See the additional topics listed below for information on the other editors available on products.

Category Profile: Allows users to configure and view profiling data and dashboards for the objects under the
selected node. See the Data Profiles topic in the Data Profiling documentation for more information.

Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists are
often used to store pricing information. See the Commercial Data section of the STEP Publisher (InDesign)
guide for more information.

Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from
parental objects). See the Images & Documents Tab topic within this guide for more information.

Product Variants: Allows the user to generate and manage a family of products, which are basically the
same, only varying on the values of a small sub-set of their attributes. For example, clothing and shoes both
offer good use cases for product variants as shoes or clothing items may come in multiple sizes and colors, but
are otherwise identical. The product family holds all data for the item, e.g., a particular shoe, while the variants
would hold only the various combinations of the color and size varieties (e.g., size 7 red, size 8 blue, etc). The
Product Variants tab is only present if the system has been configured to support variants. For more
information on this, see the Product Variants documentation in the System Setup / Super User guide.

Proof View: Allows users to preview a close representation of how a product will look when mounted onto an
InDesign page based on a selected publication version and product template. For more information, see the
Generating Proof Views topic in the STEP Publisher (InDesign) documentation.

Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit these
references. See the Referenced By Tab topic within this guide.

References: Allows users to view all objects that the current object references, and add / remove / edit these
references. See the References Tab topic within this guide.
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State Log: Allows users to view the recent history of the object across all workflows in which it has been
entered. See the State Log Tab topic in the Workflows documentation for more information.

Status: Allows users to view basic information about the object, including revision history, translation status,
and approval status. See the Status Tab topic within this guide for more information.

Sub Products: Allows users to view and edit all child objects of the selected object in a table form. See the
Sub Products Tab topic within this guide for more information.

Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information,
see the Tables guide.

Tasks: Displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow.
More information on the Tasks tab is available in the Moving Tasks through a Workflow in Workbench
topicin the Workflows guide.
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Inheritance in the Product Hierarchy

Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the child
products that exist under the parent product can inherit the value - meaning that the value is present on the child,
as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the value can be locally
edited on the child (e.g., a different value supplied so the child no longer inherits the value from the parent). Note
that value inheritance also applies to references, meaning that if a reference is populated on a parent, it is also
available on the child in the same way as an attribute value. However, references must be explicitly configured for
inheritance to be in place, while attribute values will automatically inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. This means that
attributes can be linked to specific nodes / categories so they only appear for those categories and their children.
For example, consider a company that manages data for both batteries and clothing. Size might be applicable to
both categories of objects since both batteries and apparel have sizes assigned. However, sleeve length and
voltage are characteristics applicable for clothing and batteries, respectively, and it could be confusing to see a
'Voltage' attribute on a clothing item. To avoid this, the '"Voltage' attribute could be linked to the 'Batteries' category,
while the 'Sleeve Length' attribute could be linked to an 'Upper Body Apparel' category.

Inheritance perpetuates throughout the hierarchy, no matter how many levels are present (e.g., inherited
attributes and values appear on children, grandchildren, etc.). When attributes are considered applicable to all
products, regardless of category, they are called 'global attributes'. For example, attributes such as Price,
Description, and Manufacturer Name. Thus, these attributes are linked to the top level in the product hierarchy and
are inherited down to all products beneath, no matter how many levels there are.

Attribute inheritance only means that the attributes are available for all of the products beneath where they are
linked. The process of linking attributes to different levels does not have anything to do with the actual values that
will go into the attributes for any particular product. In the 'Voltage' example, when linking that attribute, you are
only concerned with making that attribute available to all the battery products—not with the actual voltage for any
given product. However, if many batteries under a parent shared the same value, the value could be populated on
the parent to inherit down to the children. Any children varying from the parent value could then be edited
individually, while those having the same value as the parent do not need to be updated further. Note that attribute
inheritance within the product hierarchy is only available with specification attributes, and is not available with
description attributes. Further note that this topic focuses on inheritance solely within the product hierarchy.
However, it is important to be aware that attribute inheritance can also be used within classification hierarchies
that are used to organize product objects. Attributes can be linked to a classification, making them available for all
products linked into that classification (or a child classification). More information on attribute inheritance with
classifications is available in the Classifications topic within this guide, and within the Attribute Links topic in the
System Setup guide.

Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a level too
high in the hierarchy. With such a setup, a single change could mean that thousands or millions of products would
have to be updated in downstream systems and many systems are not geared to handle massive feeds like that.
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When working with products and/or creating new products, users should be mindful of inheritance, considering
both the inheritance of the available attributes, as well as their specific values or references. It may be helpful to
consider the following:

« Isthe hierarchy granular enough to allow products within the category to be grouped so that all products only
have the relevant attributes, or are additional category levels required to obtain this granularity?

« Which attributes are required for the products in the category and/or subcategories?

« If product variants are used, which attributes should be maintained at the family level and which ones should be
maintained at the variant level?

Note: Data can also inherit from dimensions (e.g., language or country). More information on this is available in
the Dimension Dependent Data section of the Contexts topic in the System Setup / Super User Guide.

Linking Attributes to Products

To make attributes valid for products, they must be linked to the appropriate tree nodes in the product hierarchy.
Some attributes will be global attributes (applicable to all objects in the product hierarchy) and are linked to the
“Product Hierarchy” root node. These global attributes are then valid for all products. Other attributes apply only to
specific categories of objects, and are then linked directly to those categories, making them available for all objects
within that category (if also set as valid for those object types). Attributes should not be linked to individual leaf
objects, as each one would have to have the link individually applied. Instead, attributes should be linked to some
parental folder in the hierarchy above the objects needing to use the attribute.

Before proceeding, be aware of the following:

« Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes are made available for the children "under" the node at which they are linked
(being mindful that "under" means "actual children" in the product hierarchy, whereas it means "objects with a
reference to" when dealing with classifications).

« Linked attributes apply only to objects of the product super type. For example, linking attributes to a
classification object that holds assets does not make those attributes available on the child assets.

« Only Specification attributes can be linked to products or classifications. Description attributes cannot be linked
attributes.

Linking Attributes

1. Select the product group or classification and click the References tab.

2. Expand the appropriate flipper (Linked Attributes from Product Hierarchyon product objects or
Attributes on classification objects), then click Link to Attribute.
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Classification || Sub Products Referenced By

1D > Name
¥ WirTransportationRestrictions Air Transportation Restrictions
¥ AnnualSalesForecastMaximum Annual Sales Forecast, Maximum
¥ AnnualSalesForecast, Minimum Annual Sales Forecast, Minimum
¥ WvailabilityEnd Availability End
¥ AvailabilityStart Availability Start
¥ BaselnitOfMeasure Base Unit of Measure
¥ BrandMame Brand Name
¥ BrandOwner Brand Owner
¥ Color Color
¥ Cost Cost
¥ CostEffectiveDate Cost Effective Date
¥ CostExpirationDate Cost Expiration Date
¥ CountryOfCrigin Country of Origin
¥ DescriptionLong Description, Long
¥ TaxClassification Tax Classification
¥ Tshirtsize T-shirt Size
* JLink to Aftribute |
3.

Reference Type w| » [Target |2

W

Related Web Cla... + Tf;_

4

Applies to * |Action Set

Add Priviege

» [Attribute G... > |Object Type »

&
¢

Completeness Score

» Color

| Link to Attribute

In the standard search / browse window that displays, locate the appropriate attribute(s) and click Select.

Localizing an Attribute Link
Local attribute links can be created to override inherited attribute links.

1. Select any existing inherited attribute link and right-click on the row indicator.
2. Selectthe Create Local Link option.
9 Linked Attributes from Product Hi
DisplaySequence ¥ [Con
Hide
Show All Columns
Rotate Table
Link to Attribute

Remove Link to Attribute
Create Local Link
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This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the same way as inherited links, though removing a local link simply re-applies the inherited link.

Unlinking a Linked Attribute

Unlinking an attribute does not delete the attribute from STEP; it simply removes the link so the attribute is no
longer available for population on the selected node (and child nodes, if applicable). Note that attribute links must
be removed from the same node to which they were added. In other words, trying to remove an inherited attribute
link is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it must be
removed on the parental object that holds the link. However, care should be taken in doing this as it will remove the
link for all child groups, and will need to be re-linked at those lower child levels if it is still needed there.

1. Onthe References tab of the object, expand the appropriate flipper (Linked Attributes from Product
Hierarchy on product objects or Attributes on classification objects).

2. Right-click on the row indicator and select Remove Link to Attribute from the context menu (or use Ctrl +

-”). Multiple attributes can be unlinked simultaneously by multi-selecting.

Note: If an attribute has been linked locally, removing the link only removes the local link, and the inherited link
will again take effect.

[ Praoduct ” Sub Products ][ Referenced By ” Images & Docur

= Discontinued Product Maintenance
2= Image References

2= Sales [tem References, Classification
2= Sales Item References, Product

= Index Words
= publications
@ Linked Attributes from Product Hierarchy
Completeness Score > |ID >
. = 5
3 Hide t
4 Show &All Columns Jnit
¥ lelnit
3 Rotate Table peen
3 Link to Attribute Ctrl+Plus
3 Remove Link to Attribute Ctrl+Minus  PESCription
¥ o o urersPartMumber
3 Create Local Link LrerMame

Additional methods for maintaining attributes links

Attribute links can be added and removed in a number of ways, in addition to what has been described above.
These include:

« References tab of the attribute itself

« Maintain > Link menu when a product or classification is selected
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« Edit> Link to Attribute / Remove Link to Attribute menu when a product or classification is selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values

There are many advantages to setting common values:

« When an update is needed, the value is only entered once in the product group instead of — potentially —
separately, across hundreds of products.

« When new products are added to the group, they automatically inherit the product group’s values.

« The translation of product group values only need to be performed once, as opposed to translating the same
value every time for individual products.

As mentioned above, it is possible to set attribute values for an individual product, but consider a situation where all
products within a product group share common attribute values. For example, a set of hats that share a common
description and features.

There are two ways to approach this: 1) keep all common values with the individual product or 2) set the common
value at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the attribute value is
inherited down to all products beneath.

Tree

20808-013 rev.0.7 - Product

qij Primary Product Hierarchy A Commercial || Tables || Category Profile || Proof View || Status || State Log m
E}D Products Product [ Sub Produicts ” References ” Referenced By
21T Apparel .
|j Upper Body Wear ? Disay
EHj Head Wear Name > ¥ |Value )
Eij Hats and Caps > Manufacturer Mame b

i)l Hats and Caps Trems > Product Width i

E}[j Hats and Caps Sales Ttems ||| 5 broduct Helght i
-2 > Sellng Price 12 12.99 §
- 2080304 :
| 2080808 > Product Depth 1
L 2080809 > nnual Sales Forecast, Maxin 122 250
Al 20111 .
~— » \Annual Sales Forecast, Minimit23 (100
121 N 0% Cpttgn, Unstructured, Slo& Crouyn, Low-Flithng, G-palnel mp,ﬁeamed Front Panel without Buckram, &

» Description, Long ahe: Rows Stitching on Visor, Matching Fabric Undervisor, Matching Fabric Adjustable Hook and Loop Closure, One

|| 20808012 ize fits most,
A B > Description, Table b
| € » Description, Web abe
Al D > Feature Bullet 1 ahe: JLiltin sweatband wicks away sweat to keep you cool & dry
|l 1111111 > Feature Bullet 2 I ﬂlitretm construction provides a comfortable fit

The image above shows three inherited values, which are designated by a green down arrow ().

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products beneath
will inherit the same value.
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Itis possible to override an inherited value by setting a different value at any subordinate level, e.g., the product
level. This is called a localized value. However, this requires that the attribute be valid for the child object type (as
is the case for the inherited values shown in the screenshot above). Attributes that display as inherited (indicated
by the green arrow) but not editable (e.g., value field is yellow rather than white) are not valid for the object, so they
can only have a common value with all sibling products, which is inherited from a parent higher in the hierarchy.
Detailed information on setting validity of attributes is available in the Validity on Specification Attributes topic
in the System Setup / Super User Guide.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental value.
Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object has the null
value).

For information on working with and/or setting up inherited reference values, see the Inheritance Example for a
Reference section of the System Setup / Super User Guide.
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Images & Documents Tab

When working with products, the Images & Documents tab displays thumbnails of all assets that are referenced by
the selected product, or inherited from a parental object referencing the asset. When working with classifications,
this tab displays all assets that are child to the selected classification. The functionality for working with the
displayed assets is the same, regardless of whether a product or classification has been selected.

Blue Hat rev.0.16 - Images & Documents

(120170) (120170) “ || Commercial || Tables || Category Profile || Proof View || Status || State Log
ﬁ (120666) (120666) | Product H Sub Products H References ” Referenced By l Images & Documents

- (179653) (179653)

- (179864) (179864)

- (179866) (179366)

M (179868) (179868)

M 109308 (109308)

ﬁ Baseball Hat (20805) =

-\ GrayHat (114503)

M Industrial Hard Hat (208C

M Industrial Hard Hat (1811

ﬁ 5ki Hat (179857) purple cap Yelow cap

M ski Helmet (179858) 300 x 215 px 283 x 178 px

[#-[[] Hats and Caps Salesltems (2 - 5KB 3ZKB

] I | b Primary Product Image Product Image

<< Previous Filter 1-2of2 Mext ==

If more than 50 assets are present, the Next / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially useful
when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size, file
size, and reference type used to link the asset to the selected object.

Interacting with Assets

From the Images & Documents tab, several actions can be taken with the displayed assets.

Edit asset

By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image to a
disk or local PC, and view the image on a larger scale.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 225



StiboSystems

MASTER DATA MANAGEMENT

Referenced By ] Images & Documents
1-2of2 Mext ==
Edit Asset
- External Viewer
Save to disk
velow Image Viewer
283 x 175PX
32KB
Product Image

Edit reference type

The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdown will be disabled (grayed out) if there is only one valid reference between the object type
and asset type. If multiple valid reference types are available, selection of the reference type is enabled and can be
edited from this location. More information on references is available in the Reference and Link Types topicin
the System Setup / Super User Guide.

Filter the displayed assets

A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays
assets that have the entered value as part of the asset name, as shown below.

Note: The filter automatically applies wildcard functionality so explicit entry of wildcards (*) is not needed.
Entering an asterisk will cause the system to search for assets with an asterisk in their name.
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SubProducts | Commercial || Tables || Category Profile State Log
| Rodit | Refaences | Refrencedey | Images & Documents
<< Previous Filter 1-250f 25 Next >3
&
Industrial Hard Hat rev.0.33 - Images & Documents
ateqory Profile | Proof View || Status || Statelog | Tasks
Ub Products ” References ” Referenced By ‘ Images & Documents | I GIoE]
,__‘_5 .
S << Previous Fiter ap| 1-40f4(25 total) Next 5>
orange cap Orange latex gloves purple cap
188x 153 px 544 580 px 300 x 215 px
104KB J45KB 5KB
Product Image Product Image Primary Product Image
B u [ [
| orange cap purple cap purple cap Yellow cap
: 188 x 153 px 300 % 215 px 300 % 215px B3x 178 px
. [ 104KB 5KB S5KB 32KB
e cp wire spoal Yelow & Fink Hat L Product Image Primary Product Image Product Image Product Image
300% 215 px H1x32px 1229 x 1888 px
5K brlc B77K8
i

To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset

The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates

directly to the asset in the classification structure.
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Product Overrides

Product overrides are alternate versions of products and product families that may have differing values,
references, links, and structures. Attributes and values applied to the product family are inherited to the product
override and can be replaced with local values and references on the product override. Product overrides allow
product objects to exist in multiple locations in the product hierarchy and are the primary building blocks for many
print product presentations. A product override allows for the creation of 'pseudo’ product families that are flexible
to ever-changing print presentations. They can be thought of as a workaround for when an existing product family
does not contain the exact products needed for a publication layout and/or its accompanying STEP table(s).

A product override folder can include products from various "standard" (e.g. non-override) product families.
Similarly, a product override leaf object can live under a different product folder (override or standard) than the
folder in which its corresponding standard object resides.

Tree 101609 — SKU 00001 rev.0.1 - Product
7] Assets m Sub Products || References || Referenced By || Images & Documents || Commercial || Tables || Stab
rj Configurations
[ Index Words Name s> Walue
rj Merchandising Hierarchy
L . > ID 101609
7] Suppliers
[+ 7] Web Sites > Name 101609
i Entity Root » Dhject Type Product-override
[T Publications — :
Elr_:l Primary Product Hierarchy > Revision 0.1Last edited by USER on Tue Aug 04 11:18: 17 EDT 2015
E Products » Wpproved € Never Been Approved
[ [l Discontinued Products » Mranslation Not Translated
Product Cverrid
0 E} ES Lu | :Em = » Path Primary Product Hierarchy Product Qverrides/Level 1/Level 2/101609 — SKU 00001
gve
‘ E Level 2 » Dverridden Product 5K 00001 (SKU 00001)
| [101608 — SKU 00001 || |> Product Variant Priarity

. i Packaging > | Compare this with Overridden product

e 7] Regional Products Attribute G
-3 Collections . »1> Ml
-3 eCatalogs Iame ° U.E
[EI---&) Recyde Bin > Gize abe Medium

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from
standard products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and
references of a product / product family. This is useful in order to publish a limited version of a product family
without modifying the object itself.
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Example

E}r_: Product Overrides
E||'j Level 1
E}|’_= Level 2
= | [104061 — Ski Jacket Pro]
@ SKU 00001
L. g SKU 00002
-l Packaging
=T Regional Products
E|r_=| Apparel
=) Winter
[=-{I5) Winter Coats
=[[T) Ski Jacket Pro

In this example a product family Ski Jacket Pro has three products. A product override 104061 is created and
based on the product family Ski Jacket Pro. Attributes, values, and references are inherited from the product
family Ski Jacket Pro to the product override folder and can be replaced with local values and references on the
product override.

Two products from the product family Ski Jacket Pro are linked into the product override folder (SKU 00001 and
SKU 00002). The product override only contains a subset of the products included in the original product family
Ski Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked into the
product override. These products will have their values inherited from their original structure instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow icon (Jate 1), if an

attribute or reference is inherited from an overridden product. Inherited values and references can be replaced
with local versions, assuming the relevant attribute and/or reference is valid on the relevant product override object

type.

Creating a Product Override
1. InTree, select an object for which an override should be created.
2. Right-Click and select New Product-Override
3. Inthe Create Product-Override dialog,
« Clickan Object Type

« KeyinID and Name
. Optional: Click the ellipsis button ([...)) to select a product family to adapt values, references, and links from.

The product-override will inherit all values, references, and links from the selected product family.
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« Optional: Click 'Adopt Children' if the product-override should also include all products from the overridden
product family.

4. Press Create to create the product-override.

Linking Products into a Product Override

1. InTree, select the product override
2. Right-click the product override and select Add Children to Override

3. Search or Browse for the products to be linked into the product override

Removing Products from the Product Override

1. InTree, select the product override
2. Expand the product override and select the product to be removed

3. Right-click and select Remove Child from Override

Creating a Subordinate Product Override
1. InTree, select the product override
2. Selecta product linked into the product override

3. Right-click the product and click Convert to Product-Override

The product will be converted into a product override. Values, references, and links will get inherited from the
overridden product.
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Referenced By Tab

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by product overrides, has a match code acting on it, or is used by any publication, that
information can be viewed on this tab. Finally, privileges assigned to the product can be added and edited from this
location, and subproducts that are present only in other contexts can be viewed (if the object is of a dimension-
dependent object type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

114613 rev.0.3 - Referenced By

Product || SubProducts || References |BREEEMENEM | Images & Documents || Commercial || Tables || Category Profile || Proof View

-] Primary Product Hierarchy
£ Products

[ Apparel
Eli Footear Reference Type
Ei Shoes > |Bil of Materials + Y
=5 Pumps > [Suppler Replacement Iem  + @
=+ i} Pumps Ttems

E ‘ 2inch heels

E ‘ Finch heels

s Packaging ik
-\ 115122
sz |9
| 2685 3 » Name » Path 3
Bam o
[—]- Pumps Sales Items - s Bath s
[T 3inch heels
| 20m9401z IY
| 2738012 ID >
[ Translation | 9
[ B 6 Publication » Version » Page » Area Used » Page Type H
B[] Safety
[T Hardware It
[ 7] Displays T Appliesto  * |ActionSet  » |Attribute G... » |Object Type * |Group *language ¥ [Country  *
i Furniture Add Priviege
7 Pussomacaceenes
[#}-[[7] Building Products v

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
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screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User guide.

. Referenced by Products, Classifications or Entities: The functionality is identical to what is described for
the Reference Flippers section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes.

. Used By Product Overrides: Displays product override objects that are based on the selected object. More
information on product overrides is available in the Product Overrides topic in this guide.

. Linked into Product Overrides: Displays product override objects that have the selected object as a child.
More information on product overrides is available in the Product Overrides topic in this guide.

. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:

System Setup Find Similar - Match Code

(+-(5] Global Business Rules A || BBl T | Match Code Values | Skatistics

: Inbound Integration Ent?points . & Definition

Match Codes and Matching Algorithms I

: > >

= ﬁ Eind Simil Mame Value

.. .~ Find Similar * D FindSimilar

| Outbound Integration Endpoints > Mame Find Similar

] Web UI
Pl WEb LS > Last edited by 2017-01-19 13:55:37 by USERS
-5 Workflow Profiles
: Workflaws » Category Shoes (20689)
--[Z] Derived Events * Match Code Window Size 1
mf?ﬁ' MNhicrt Tunae & Strorhirae

Tree Shoes rev.0.2 - Referenced By

Er_=| Primary Product Hierarchy A || Tables || Category Profile || Proof View State Log || Tasks
£+ Products | Product " Sub Products ” References | REfEI‘EﬂEEd By [ Images & Documents H Commercial ]

-] Apparel

EI g Fontuear = Referenced by Products, Classifications or Entities
B Ifl Ehpes &= Used By Product Overrides
2} [l Pumps Items § UUsed by Match Code Objects
[+-[[T] Pumps Sales Items Iib] * [Name > [Edited by »
[ Boots > FindSimilar Find Similar 2017-01-13 13:58:41 by USERS

More information on match codes is available in the Matching, Linking, and Merging guide.
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6. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the STEP Publisher (InDesign) documentation.

7. Applied Privileges: Displays the privileges that have been applied to the selected node. Privileges can be
added using the Add Privilege link, and can be removed by clicking on the row indicator and selecting 'Remove
Privilege'. Existing privileges cannot be edited from this interface. Detailed information on creating and editing
privileges is available in the Privilege Rules section of the System Setup / Super User guide.

8. Visible Sub-Products in Other Contexts: Displays subproducts that are visible in another context, which is
only applicable if the object type is dimension-dependent. Note that it is not recommended to make product
object types dimension-dependent; instead, it should only be data on objects (e.g., attributes and references)
that are dimension-dependent. As a result, this flipper is rarely used.
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References Tab

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has associated index words, is used by any
publication, or has any linked attributes, that information can be viewed and edited on this tab.

The display of the References tab on a product will vary slightly from system to system, based on the data model.
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‘ Product || Sub Products Referenced By || Images & Documents || Commercial || Tables

) Assets
r_=| Configurations
r_=| ETIM Hierarchy
r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
{7 Web Sites
- ffij Entity Root
(¥} () GDSN
ﬁ Publications
Eli Primary Product Hierarchy
EHT] Products ’
Eli Apparel
EI‘ Upper Body Wear
-5 T-shirts
=}l T-shirts Items
-ﬁ 1266799 e’* Ungrouped Classficaton tinks
?

[+I-Jjjj Cotton T-shirts’

Reference Type v

-

Bill of Materials +

Supplier Replace... +

E MNew Shirt Reference Type v| » [Target >
[l Polo T-shirt » |Packaging Link + 'y
[+-[7] T-Shirts Sales Item -

5] Head Wear E’L_
-7 Footwear Inherited From » [Index > |Level 1 b
{7 Safety » Locally defined Indexdoc_Test Index Words/Indexdoc_Test/consequati
g= ;ﬁware » Locally defined Indexdoc_Test Index Words/Indexdoc_Test/doluptatus
[ ays
- Furniture * Locally defined Indexdoc_Test Index Words/Indexdoc_Test/polyester
(-7 Automotive | > | Add Index Word
{3 Bulding Products el_
[+-{{7] Electrical & Electronics n 3 |Name b
[+{{7] Food and Beverage - )

¥
- Kitchen 105494 Autopage Publications/Acme Wholesale Clothing/Caps and Hats
-7 Party Supplies > 111845 Autopage Publications/acme Wholesale Clothing/Shirts
[+-[IF| Discontinued Products » 111512 Autopage Publications/Beta Tools/Power Tools
t¥}- [ Product Overrides > | Link to Pubiication or Section
£

: I Packaging O lnied Atsiutes fom Product Herarchy
[+ GOSN Products

. ©-Linked Attrbutes from Classification Herarchy
-3 Collections

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the currently selected object to the object selected in the dialog (e.g., current
object = source, dialog selection = target). If any attributes are available on the reference and editable, they can
be edited within this interface. References can be removed by clicking the (X) on any existing reference.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 235



StiboSystems

MASTER DATA MANAGEMENT

Additional information on configuring and working with references is available in the Reference and Link Types
topicin the System Setup / Super User guide.

. Ungrouped References: The functionality is identical to what is described for the Reference Flippers section
above. The only difference is that this area displays references that have not been placed in attribute groups for
display purposes. If all references that are valid for the selected object have been placed in attribute groups, the
Ungrouped Classification Links and Ungrouped Product References flippers will not be present.

. Index Words: Allows users to view index words linked to the currently selected object, and to link index words
using the Add Index Words link. Index words are maintained in a dedicated hierarchy where it is possible to
maintain the word itself along with a sort word. More information is available in the Creating an Index Words
Structure topic in the STEP'n'design documentation.

. Publications: Publications that the currently selected product is linked to are displayed, and new links can be
created using the Link to Publication or Section link. Additional information about working with publications
is available in the STEP Publisher (InDesign) documentation.

. Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental node
in the hierarchy display under the Linked Attributes from Product Hierarchy flipper. The exact columns
available will depend on the data model and the attributes that have been made valid on product attribute links.
Whether or not the various attributes are editable will also depend on the setup of the data model. However, an
ID and Name field are always shown, with the attribute name being a hyperlink that can be used to navigate
directly to the attribute. An Attribute Groups column is also present, displaying the attribute group(s) that the
attribute is in. A Mandatory column is present and if checked, the object cannot be approved until a value has
been provided for the attribute. Note that mandatory settings on the attribute itself apply globally, while
mandatory settings on the attribute link apply only to objects that are child of the node at which the attribute is
linked. More information on mandatory settings is available in the Mandatory Attributes topic in the System
Setup / Super User guide. If the attribute link is inherited (indicated by a green down arrow, =, in the row
indicator), the 'Inherited from' column will display the parental node where the attribute has been linked, which
is hyperlinked for easy navigation. More information on linked attributes is available in the Inheritance in the
Product Hierarchy topic within this guide and in the Attribute Links topic in the System Setup / Super User
guide.

The Linked Attributes from Classification Hierarchy flipper is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is a member of
(e.g. has areference to), rather than attributes that are linked to a parental product. The same considerations
apply in that the exact columns available will vary based on the data model, with ID, Name, Attribute Groups,
and Mandatory columns always being present and functioning in the same way as for product attribute links.
Note that objects shown in the 'Inherited from' column in this case are parental objects not of the selected
object itself, but instead of a classification that is parent to the classification that the selected object references.
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Status Tab

The Status Tab provides general information about objects, including revisions, translation status, and approval
status. For products and classifications, the Status tab displays the same information, regardless of the object
type. Publications, entities, and assets have slightly different information available, though much of it is common to
what is described below.

[ Product ” Sub Produicts ” References ” Referenced By ” Images & Documents ” Commercial ” Tables ” Cateqary Profile ” Proof View }[ State Log ” Tasks ‘

9

_Reuision ¥ |Created » |Edited » [Major ¥ User » |Comment ¥
+ 04 FriOct 23 10:4%:50EDT 2015 Tue Jan 13 15::42:51E5T 2016 L3ER futo Generated

03 FriOct 16 09:3%:06 EDT 2015 FriOct 16 09:39:06 EOT 2015 LJSER Complete approval

02 Tue Sep 22 14:1402E0T 2015 Tue Sep 22 14:14:02 EDT 2015 LSER. futo Generated

01 FriFeb 1311:36:40EST 2015 FriFeb 13 11:36:40 5T 2015 STEPSYS

Context » |Approval Status ¥
» Danish DK xLastAmouedonFﬂDctlﬁﬂs:SS:UﬁE]TZtJlS
> English UK € Last Approved on Fri Oct 16 09:39:06 EDT 2015
> English US x Last Approved on Fri Oct 16 09:39:06 EOT 2015
» French Belgium x Last Approved on Fri Oct 16 09:39:06 EDT 2015
» French Canada 3¢ Last Approved on Fri Oct 16 09:33:06 EDT 2015
» French FR x Last Approved on Fri Oct 16 09:3%:06 EDT 2015
# [zermany German x Last Approved on Fri Oct 16 09:39:06 EOT 2015
} |Israel Hebrew 3 Last Approved on Fri Oct 16 09:39:06 EDT 2015
Attribute > Vigible in workspaces 3 |Visible in dimensions > Value
* Long Item Description )ﬂwoued, Main Country=AlCountries, Lanquage=en-J3 Red carpet warthy pumps in scarlet suede is sure
» Packaging Type )ﬂmoued, Main Country=AllCountries, Lanquage=std.lang.al Box
> Suppler Name )»woued,ram Country=AlCauntres Products Galore

No problems found
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. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a
historical "snapshot” of an object. The Revisions flipper provides a record of the revisions that have been made
to the currently selected object, including when changes to the object were made and who made them. Via
right-click, users are able to purge old revisions or revert to previous revisions. For more information on
revisions, including how they are generated and how they should be managed, see the Revisions topic in the
System Setup / Super User Guide.

. Workspaces: All the workspaces that the selected products are in will display, as well as the revision number
that exists in that workspace. Generally speaking, if the object has been edited since it was approved, the Main
and Approved workspaces will hold different revisions. However, it should be noted that not all changes to an
object generate a revision. More information on this is available in the Revisions topic in the System Setup /
Super User Guide. For more information on workspaces in general, see the Workspaces topic in the
System Setup / Super User Guide.

. Translation: Translation relations (sources and targets) and status (e.g. Up to date, Re-translation needed,
etc) of the translations display. For more information, see the Translations documentation.

. Approval status in all contexts: Displays the approval status of the object in each context on the system.
More information on approvals is available in the Approval of Objects topic in the Getting Started / User
guide. More information on contexts is available in the Contexts topic in the System Setup / Super User
Guide.

. Hidden values: Displays hidden inherited values on the object. Hidden values are those that are inherited
from another dimension (e.g. language or country) rather than from a parental object. More information on this
is available in the Dimension Dependent Data section of the Contexts topic in the System Setup / Super
User Guide.

. Diagnostics: Displays any issues with the object found by system diagnostics. If a problem has been found,
the information can be copied by clicking the file link.

% Diagnostics
||F‘rn:n|:nlems found. Press button to copy information to dipboard. Please supply this information to Stibo System.
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Sub Products Tab

When the Sub Products tab is accessed on an object of the product super type, all direct children of the selected
node are displayed. If privileges allow, data can be edited on the displayed objects by clicking directly into any
editable field. Standard editing capabilities are available within this interface (as described in the Editing Objects
in Tree topic within this guide) including copy / paste functionality using Ctrl + C and Ctrl + V.
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T-shirts rev.0

Product || Product Variants |RENUHLCLIEM | References || Referenced By || Images & Documents || Commercial || Tables || Cateqory Profile

View: Show gl =

18217054 » (18207012 » (18214012 H
D > 100305 18207 18214
Mame > 18217054 18207-012 18214012
”DbjettType » Gales Ttem Sales Ttem Sales Ttem
”Revision » 00,23 Last edited by USERG on Thu Ja... 0.4 Last edited by USERG on Man ...0.5 Last edited by USERG on Thu Ja...
Path » Primary Product Hierarchy/Products/... Primary Product Hierarchy/Produc. .. Primary Product HierarchyProducts...
Approved > x Last Approved on Fri Sep 16 10:... x Last Approved on Mon Jun 15... x Last Approved on Mon Jun 15 1...
Translation > Nat Translated Mot Translated Mot Translated
Classification 1root | Web Sites | Acme Classification 1root | Merchandising Classification 1 root | Web Sites | Acme
Catedor X Retail Web Site | Apparel | Mens CasualHierarchy | Apparel | Sportswear | Retail Web Site | Apparel | Mens
gy | T-shirts and Sweatshirts | 18217-054 [T-shirts | 18207-012 Casual | T-shirts and Sweatshirts |
18214012
Parent > T-shirts T-shirts T-shirts
Seling Price > 8,578 8578
Annual Sales Forecast, Maximum - » 5000 5000
Annual Sales Forecast, Minimum > 2000 2000

The best-seling T-Shirt For over 33
years, it has set the standard for
X T-shirt comfort and quality. Today it's

The best-seling T-hirt For over 35
vears, it has set the standard for
T-shirt comfort and quality. Today

The best-seling T-hirt For over 35
vears, it has set the standard for
T-shirt comfort and quality. Today it's

Desaripton, Long better than ever, offering qreater s better than ever, offering better than ever, offering greater
durability and less shrinkage than you'l greater durability and less shrinkage durability and less shrinkage than you'l
et with ordinary tees, than you'l get with ordinary tees,  get with ordinary tees,

Description, Table >

eature Bulet 1 X Fiber Content; Fabric: 100% Ring-spun Filber Content: Fabric; 100% Fiber Content; Fabric: 100% Ring-spun
Cotton Ring-spun Cotton Cotton

Feature Bulet 2 X Ultra-saft premium cotton feels great  Ultra-soft premium cotton feels — Ultra-saft premium cotton feels great
against your skin. ENG value test areat against your skin, against your skin,

Feature Bulet 3 X Eon-d'lafe fabric taping reinforces neck Non-chafe fabric taping reinforces Eon-dﬂafe fabric taping reinforces neck

nd shoulders, neck and shoulders, nd shoulders,

Feature Bulit 4 X Lay Flat collar keeps its shape wash Ly Flat collar keeps its shape wash Lay Flat collar keeps its shape wash

fter wash, after wash, fter wash,

Feature Bulet 5 X Eurable double stitching trims sleeves  Durable double stitching trims Eurable double stitching trims sleeves

nd bottom hem, sleeves and bottom hem, nd bottom hem,

Primary Color H Blue Orange

Sales Item Shart Destription > T-shirt, Blue, M, cotton T-shirt, Orange, L, cotton

Seling Price LIOM > EA EA

Size > Medium

Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and
Mark Different selections - all of which are self-explanatory and can be especially useful when editing multiple

objects.
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Note that two views are available using the Rotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including an

option to add a product.

- .~ 0000000000000
Product || Product Variants [BERUNZOGTEN | Referances
View: Show all -

Ohject Type » |Revision > P
18217054 » Sales Ttem 0,23 Last edited by USER... P
Hide
Show All Rows
15207 ted by USERG ... P
Rotate Table

Add Product Ctrl+Plus

Rermowve Row(s) Ctrl+Minus

Selecting Add Product opens a Create Product dialog allowing the user to input data to create a new object,
which will be added as a child to the currently selected node. The options available in the dialog are based on the
data model defined in System Setup. For example, the object type selection will vary based on the allowable object
types under the selected parent, and ID will only be available for population if the object type being created does

not have autogenerated IDs applied.

32 Create Product

Object Type

ID 115206

Mame

Create Cancel

Note that the same functionality is available using the Add Product link at the bottom of the Sub Products editor.
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Recycle Bin for Tree

This topic describes the functionality available for objects within the Tree Recycle Bin. For information on the
System Setup Recycle Bin, see the Recycle Bin for System Setup topic in the System Setup / Super User
Guide. For information on deleting objects from Tree, see the Deleting Objects in Tree topic within this Getting
Started / User Guide.

Note: Objects in the Recycle Bin are not searched when a user performs a search in workbench and Web Ul.
This limitation also applies to searches done using the workbench Goto functionality. Additionally, attribute values
of objects in the Recycle Bin cannot be edited. If editing is required, the object needs to be revived.

When an object is deleted from Tree, it is moved to the Recycle Bin located on the Tree tab. To revive or
permanently delete an object, right-click on it in the Recycle Bin and choose one of the options described below.

- ! Recyde Bin

m {11150~

m {1148 o Purge

- (11481 Approve Deletion

E (1148 Approve Deletion Recursively
{1143 )

E (abede Revive

-~ g@ 12119 Revive Recursively

- 1821750

« Purge: Permanently deletes the object, with no subsequent option for revival. It is recommended to approve
deletions prior to purging them, though it is not required. However, purging an object without first approving the
deletion will NOT result in a deletion event being captured. Therefore, if deletion events need to be recorded for
sending to downstream systems, the deletion should always be approved prior to the purge action being
carried out. For more information on events, see Events in the System Setup / Super User Guide.

« Approve Deletion: Deletes the selected object from the Approved workspace, and passes a deletion event
for that object. This option is only enabled on objects that are workspace revisable.

« Approve Deletion Recursively: Deletes the selected object and all of its children from the Approved
workspace, and passes a deletion event for allimpacted objects. This option is only enabled on objects that are
workspace revisable.

« Revive: Revives the selected object, returning it to the location in Tree from which it was deleted. Note that
object revival has some dependencies and objects may not always be revived exactly as they were prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those references will not be present upon revival.
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« Revive Recursively: Revives the selected object and all child objects to their previous location in Tree. Note
that object revival has some dependencies and objects may not always be revived exactly as they were prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those references will not be present upon revival.
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Navigating and Searching

This section describes the many different ways you can access specific data in the workbench. STEP Workbench
offers rich functionality for finding both System Setup and Tree objects based on various criteria. Whether it be by
standard navigation, Bookmarks, searches using basic, advanced, or drill-down functionality, STEP provides

many ways to locate the required data.

This section will allow users to:

« Navigate hierarchies

« Find data quickly using the Goto function

« Find data using basic and advanced searches

« Perform drill-down searches using the Search Result Profiling page

o Use standard and Search Bookmarks

Note: Objects within the Recycle Bin are not searched and will not display in search results.

For information on search functionality in the Web Ul, see the Homepage Widgets topic and the Advanced
Search topicin the Web User Interfaces / Web Ul Setup and User Guide documentation.
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Navigation

You can navigate the STEP tree structures in the same manner as you navigate Windows folder structures. Basic
desktop computer skills are prerequisites for all users of the STEP system.

Expanding a Folder
Use one of the following methods to display the contents of a folder:

« Click the plus sign (+) to the left of a folder
« Double-click a collapsed folder

Collapsing a Folder

Use one of the following methods to hide the contents of a folder:

« Click the minus sign (-) to the left of a folder

« Double-click on an expanded folder

Collapse Tree

When folders in the Tree hierarchy are expanded, all can be collapsed by using the 'Collapse Tree' option from the
'View' menu.

EEETTT - ©

Elrj Assets Mode ? F-{ 7] Assets
r—=| I;:l:clns Context » r_=| Configurations
g llustrations :
% Installation Manuals Workspace ¥ g ;Iiiﬂsiit?army
L !
iy [ toges #-I= Index Words
[T Owners Manual Target :
: . [#-{ 7] Merchandising Hierarchy
rj Product Images Filter > r_=| Offers
r_=| Product Videos Primary Hierarchy 5 r_=| Suppliers
Transformation Lookup Table . : )
. Select version »| H-{T] Web Sites
[#-{ "] Configurations ---_J Addresses
Erjﬁ ;Mdedb sites Mew View [0 Customer Root
- resses :
- [O Customers Remove view "'_J Customers
) . [+ [T Entity Root
[ (0) Entity Root Product views _J -
+--{&0 Publications : o
(=-{IT] Primary Product Hierarchy Show Source Context @ P“_bl'ﬁh"”s _
E}-[5) Products [H-{IT] Primary Product Hierarchy
! r_=| o Rotate Table @ Collections
r_=| Footwear ' Reload F5 % ECE?::QQS.
-3 Hardware en Collapse Tree (-1 Recyde Bin
i -3 Tools T L e
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Note: Folders too many sub nodes display an (x) and cannot be expanded in the hierarchy. To view objects
beneath such folders, use the search or Goto functionality. For more information, see the Goto topic.

Navigating and expanding folders and sub folders can be done in any tab. However, when in the Workflow tab,
first open a flipper to display the processes.

= ?
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1]

L]

wil |Fi|1:er by Collection ||Z|
@ | Start 1
ﬁ Update

(%)

=]

&1 End

o | o

— &

g

E =

s | &=

z

) o

e

g &

% | @

e

®

| &

.== 0'

= o3

-

S b

& o

~ Rog

7]

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 246



StiboSystems

MASTER DATA MANAGEMENT

Goto

The Goto functionality allows the user to locate an object in STEP in a quick and efficient manner. There are two
'Goto' features:

« Goto - A quick way to jump to a particular object in the database based on the name and/or ID. If there are

multiple hits, it displays the first one. Press 'Ctrl+G' to move the cursor to the Goto parameter.

« Goto Next - When there are multiple hits from the 'Goto' function, the user can opt to select Goto Next to
continue on to the next hit. Press 'Ctrl+E' to display the next Goto Next item.

Type in the Name or ID of an object in the Goto field, press Enter or click the Goto next object button to the right
of the field, and the system will take you to the object without displaying a list of search results.

Once you start typing in the Goto field, the system will suggest objects matching the typed-in text (case insensitive)
and display them on a dropdown menu as shown below.

Goto | ID/Name vla I

B 2.
[T] A (8783)

i

(1T asset.dass (asset.dass)

[IT asset.colors (asset.colors)

JI asset, colorspace (asset.colorspace)
JI asset. compression (asset. compression)
(1T asset.creator (asset.creator)

JI asset,depth (asset.depth) -

When typing in the 'Goto’ field all objects are searched not just products. This includes but is not limited to
classifications, assets, attributes, user names, etc.

It is important to keep in mind that:

« Object IDs and Names are both searched.
o Object IDs are searched case-sensitive.
« Object Names are searched case-insensitive.

« Wild Cards are not allowed

Items can be selected from the menu using either the mouse or the keyboard up arrow and down arrow keys. A
maximum of 20 items will be displayed.

Another way to find the Goto and Goto Next options is in the Navigate menu.
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Mavigate Format Maintain Window
@ Search Ctrl+F
Search Below

Goto Ctrl+G
Goto Mext Ctrl+E

Back

2 "'T\ %’V

Forward
Bookmarks »

Find Similar Product

Keys in the Goto function dropdown
The ID/Name dropdown list in Goto function will have any created keys as part of the dropdown list.

Goto | IDYMame w |Red
IDYName

Supplier Part Mumber

Note: Only activated keys can be seen in the Goto function dropdown list. See the Creating and Deleting Keys
topic in the Data Quality documentation.

Selecting a key from this dropdown can be used to identify and delete objects, parents, referenced objects, and
assets. The system will take the user to the product that has the unique key value stored on that object.

Setting the Primary Hierarchy for 'Goto' searches

A user can set the Primary Hierarchy to be either a Primary Product Hierarchy, Classification folder, Asset Folder,
etc, through the View > Primary Hierarchy Menu. Once the primary hierarchy is selected and an object is
searched, first priority is given to the folder that is selected and then the other folders will be searched.
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Mode
Context
Workspace

Target
Filter
Prirnary Hierarchy

Select versinn
Primary Hierarchy

Mew View
Remove view

Product views

Show Source Context
Rotate Table
Reload

Crollance Tree

Help

F5

| v | € > O urL [editor

¥

?Huet || sub Products

tribute Group
- iteqory Spedfic Attributes

f% Ascets
; Classifications
Configurations

Index Words
Merchandising Hierarchy
Suppliers

Web Sites US

Prirnary Product Hierarchy

Cther
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For example, if the View > Primary Hierarchy is set to Assets, the product will first be searched under Assets.
Then when clicked on Search again, the user will be shown in the actual hierarchy where the product was initially
created. In normal circumstances, the product will by default be searched in the actual hierarchy where it was
initially created.

Important: Objects within the Recycle Bin are not searched as part of the Goto functionality.
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Bookmarks

Bookmarks in STEP are placeholders created by the user that serves as a shortcut for previously viewed Objects.

In the STEP system, there are two different types of Bookmarks:

1. Standard Navigation Bookmarks

2. Search Bookmarks.

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from a
different computer.

Standard Navigation Bookmarks

Standard navigation Bookmarks are used for quickly accessing specific nodes in the Tree and System Setup
hierarchies.

You can add a standard navigation Bookmark by selecting a node in the hierarchy and clicking Add Bookmark
in the Navigate: Bookmarks menu or alternately by using the Ctrl+D keyboard shortcut. The Bookmark will
afterward be accessible in the left side Bookmarks tab.

Search Bookmarks
Search Bookmarks are used for storing specific searches that can then easily be re-run.

Steps to add a Search Bookmark:

1. Create a search criteria in the Search tab.

|Search: T-shirts =]

Object Type ™
’753|ES Ttem ‘ﬂ

o=
-
2 BEEA Reset Search

Displaying 3 of 3 results Show Details
Mame >
> T-shirts 1D = 15454
T-shirts 1D = 15205
> T-shirts 1D = 1520

L

BG Processes

2. Goto Navigate > Bookmarks
3. Select'Add Search Bookmark'
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Search Below

Back

A A =W

Forward
Displaying 3
Mame Bookmarks

» T-sh

|_=|T'5|4 Find Similar Product

Processes
W

@ Search Ctrl+F

Goto Ctrl+G
Goto Mext Ctrl+E

Search Result Profiling

3 hit(s)
Click links to narrow down search

v |

C¥ Add Bookmark

|@ Add Search Bookmark

4. A dialog will be displayed to type in the Bookmark Name.

Enter Bookmark Mame

Enter the bookmark name
Search #1

5. Click on OK button.

Accessing the Saved Search Bookmark

When you click on a stored Search Bookmark, the search parameters will be populated. Select Search to rerun

the search.

u Search *
= IVSear::h: T-shirts
Object Typa ™

ﬁ IVDbjectType = Sales Item

]

(]

il R Reset Search

@ Show Details
;ﬁ [ Mame >
Note:

Ctrl+D

Search Bookmarks are saved under the Bookmarks tab with a search icon labeled with the bookmark name

provided by the user.
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Bookmarks

w (C7 Brand Logos (BrandLogos)

1|0 Export Configurations (stibo. EMCaonfigFol
= Copy Writing State (100100)

3% Search #1

Saved Bookmarks can also be found in the under the Navigate > Bookmarks.

Mavigate Format Maintain Window Help

@ Search Ctrl+F o g 6
[} Goto Ctrl+G
Goto Mext Ctrl+E
€< Back
= Forward
Bookmarks : [112] Add Bookmark Ctrl+D

. o @ Add Search Bookmark
Find Similar Product

[ Brand Logos (BrandLogos)
O Export Configurations (stibo.EMConfigFolder)
E  Copy Writing State (100100)

Editing a Bookmark

Both standard navigation and Search Bookmarks can be edited in the Bookmarks tab by right-clicking the
Bookmark and selecting Edit Bookmark in the context menu. Itis possible to edit the Name of the Bookmark
and also the object / search URL if the Edit URL checkbox is activated.

Removing a Bookmark

Both standard navigation and Search Bookmarks can be removed from the Bookmarks tab by right-clicking the
Bookmark in the tab and selecting Remove Bookmark on the context menu.
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Search

The Search tab, in combination with the Search Result Profiling page, offers extensive methods for locating
objects in STEP quickly and efficiently.

Generally, there are two approaches to performing searches:

1. If you know specific details about the object you wish to find, use the Search tab. For example, all products
where the value for the attribute 'Weight' is less than '5 kg', the object is located below the product folder 'Office
Chairs' and is not of the object type 'ltem’.

2. If you do not know details, start with a broad search and then narrow it down using the Search Result
Profiling.

Note: Objects in the Recycle Bin are not searched and will not display in search results.

Search Elements

The elements on the Search tab work together to create and refine a search for objects in STEP. The numbered
elements in the following image are described below.
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Search Result Profiling

Search Result Profiling

127 hit(s)
Click links to narrow down search

Motice: Profile is not filtered according to context visibility / privilege check

-Operations on

B A &

Results by Object Type
Product (1071 - exclude
ﬁltem (41) - exclude

|l Salesitem (18) - excluge
I_CSSE (10} - excluge
[ClLevel2 (7) - exclude
[CILevel3 (6) - sxclude

Wl ltemFolder (B) - sxcluce

[T SalesltemFolder (6) - sxclude
.F'E”etl'd-" - exclude
ELEUEH (3} - exclude
[CiLeveld (3) - exclude

[Tl SalesltemFamily (2 - exclude
Wl temFamily (1) - =xcluge
l_F'EIEk (1) - exclude

Classification (20} - exclude

[ClAssetlevel 2(T) - exclude
[ClAssetlevel 1(4) - sxclude
[C1Department (3} - sxclude

[ MerchandisingClass (3) - sxcluge
[C1SubDepartment (3} - =xclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 mast commaon)

|'_=|F‘rﬂducts I’EQ:' - exclude

Bl Buy Side Packaging (15) - exclude
EPFGGUHS (11) - exclude

[l Crinking Items (8) - exclude
[C1T-shirts and Sweatshirs (4) - sxcluds
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m

1. Search criteria type selector - Click the text to display a list of available search criteria options. See the Search

Functionality topic for more information.

2. Add criteria / operator button - Click the green plus button () to add a new search criterion or hover the

mouse over and hold down the green plus button () to display a sub menu and choose an OR operator or an

Exclude operator. See the Search Functionality topic for more information.
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Remove search criteria button - The X button clears an individual criteria from the search. Click the Search
button to refresh the Results Area.

4. Resetbutton - Clears all results and search criteria from the Search panel and Search Result Profiling page.

5. Search button - Runs the defined search.

6. Search result counts - The number of items currently displayed and total number of items found by the search.

10.

11.

12.

If the search finds objects not visible in the current context or objects that you are not privileged to see, a
message is displayed and the objects are not displayed in the search result.

Show Details / Hide Details toggle - Hyperlink shows or hides search result details. The details view displays
asset thumbnails. The asset thumbnail is displayed when the search is under a classification folder and there
are assets. Similarly, if the search is for the products and the product is linked to an asset, the thumbnail is
displayed. If noimage is linked, 'No Primary Image' is displayed.

Search results list - When a search has been executed, the results are shown in a list below the search box.
Clicking one of the results will open the object editor for that particular object in the Search Results Profiling
pane, while continuing to display the search results list. It is also possible multi-selection from this listand a
maximum of 100 results are displayed. The complete result set can be viewed, exported, or updated using the
'Operations on Entire Result' options below.

Note: The maximum results displayed can be adjusted via the case-sensitive 'DrillDownSearch.Maxresults'
property in the sharedconfig.properties file. However, it is not advisable to adjust the number more than 100+
as this will diminish system performance as the number increases.

Save as Collection button - Click to open the 'Save as Collection' dialog and save the entire result setas a
collection. Collections are available on the Tree. See the Search Operations on Entire Result topic for more
information.

Export button - Click to open the Export Manager wizard and export the entire result set to a specified file type.
See the Search Operations on Entire Result topic for more information.

Bulk Update button - Click to open the Bulk Update wizard and modify a variety of elements on each item for
the entire result set. See the Search Operations on Entire Result topic for more information.

Search Result Profiling - Panel displays profiling information about the search including categories and
provides a convenient way to further refine the search. See the Search Result Profiling topic for more
information.

Search Options

The Search tab dropdown includes a number of options. Each is described in greater detail in the topics that
follow.

Soarch =
&= advanced T
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Search Below

Referenced Assets

Revised Objects Changed Since
Data Containers

Search from List

JavaScript Search

Missing Mandatory Values
Unapproved

Product Override Search
Search in Publication Hierarchy
References

Referenced By

STEP Workflows

Sample Result
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Translation Status - see the Searching for Translation Status topic in the Translations documentation

Unpushed or Failed Assets
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Search Functionality

This section describes the different types of search criteria available in the STEP system as well as some basic
search functions.

Important: Calculated attribute values are generated on-the-fly. Searching for the value of a calculated attribute
is not allowed since generating all possible calculations would cause substantial performance issues.

Standard Search Criteria

The standard search criteria named 'Search' allows you to find objects based on name, ID, attributes and their
values.

A text string entered in the search field will search for object names, IDs, or attribute values where the text occurs.

Search ;]
Hats!
& Advanced
EEE [ Reset ” Search ]
Show Details
Marne >

If you enter a text string and click the Search button, search finds objects with an ID, and/or a name and/or an
attribute and/or their values matching the entered string. You can further refine standard searches as shown
below.

Note: By default, standard searches are case insensitive for name and attribute value searches, but are case
sensitive for ID searches. You can make name and attribute value searches case sensitive using the Advanced
option 'Match Case on Names and Values.' For more information on the options available under advanced, see
the Search: Advanced Options topic.

Search Field Typeahead

Once you start typing in the standard search criteria text field, the system suggests possible entries matching the
typed in text (case insensitive), and displays them on a dropdown menu as shown below.
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Search

[Search
Haﬂ

|- Hat123 (110150)

[T Hats and Caps (20435)

[l Hats and Caps Items (20438)

[T Hats and Caps Salesltems (20433)
[T Hat Size (HatSize)

Hat Workflow (Hat Warkflow)

 — |I—EI

In the typeahead menu, objects are displayed with their relevant icon, then name, and then ID in brackets.
Attribute values are shown as text.

Items can be selected from the menu using either the mouse or the keyboard 'arrow up' and 'arrow down' keys. A
maximum of 100 items will be displayed.

Note: Using sharedconfig.properties entries, it is possible for a system administrator to control the behavior of the
typeahead. E.g., after how many entered characters should suggestions be shown, etc. Search for the
'"TypeAhead' section on the Configuration tab. For more information, see the Configuration topicin the
Administration Portal documentation.

Limiting Results to Matches on IDs

You can limit standard searches to match on ID only by entering 'ID =" at the beginning of the text field as shown
below.

= ]

ID = 1|

[ 1 = 108205
[ ID = 108206
1P = 108251
ID = 108252
FE D = 108255
= D = 108256
ID = 108286
ID = 108287 -

] »

|l

'id"and 'ld" will also work, as the spaces on each side of the equals sign are optional.
Limiting Results to Matches on Name

You can limit standard searches to match only on name by entering "Name =" at the beginning of the text field as
shown below.
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Search
]

Mame = hat]

|| Mame = Hat123

[T Mame = Hats and Caps

[l Mame = Hats and Caps Items

[[C] Mame = Hats and Caps SalesItems
DI Mame = Hat Size

Mame = Hat Waorkflow

 —

"name" and "NAME" will also work since the spaces on each side of the equals sign are optional.

Attribute Value Searches

Using a standard search, you can limit the result to only match on values for specific Attributes.

Important: Calculated attribute values cannot be searched since they are generated only when viewed or
processed.

There are at least three ways to construct an attribute search query:

1. Start entering an attribute name or ID, then select the relevant attribute from the typeahead menu, after which
"Attribute Name (Attribute ID)" is inserted in the text field, then enter a search operator or enter a SPACE and
select an operator from the typeahead menu and enter the value to search for.

Search

Search ™
g 123 (110190)

TR Hat123 (110190)
[T Hats and Caps (20435)

[l Hats and Caps Items (20438) l
[T Hats and Caps Salesltems (20438) ;
DI Hat Size (HatSize) |

Hat Workflow (Hat Workflow)

2. Enter the attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator from
the typeahead menu, then enter the value to search for.
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Search
]

Hat123 (110190) |

Hat123 (110190) !

| IHat123 (110190) !
Hat123 (110190) <
Hat123 (110190) <=
Hat123 (110190) =
Hat123 (110190) >
Hat123 (110190) >=

 —

3. Enter the attribute name (case insensitive), enter a search operator or enter a SPACE and select an operator
from the typeahead menu, then enter the value to search for.

[Search =
SalesTtem = |
Salesltern = 120-Volt Portable Tire Inflator, Campbell Hausfe
|_|SalesItern = 120-Volt Portable Tire Inflator, Husky |;J
Salesltem = Battery, All purpose, A4, 2 pk
“|SalesTtem = Bed, Expresso, Comfy, Queen
Salesltem = Bottled Water, Evian, 8 oz 12-pk
Salesltem = Bottled Water, Evian, 8 oz 24-pk
Salesltem = Bottled Water, Evian, 8 oz 6-pk
Salesltem = Cap, Orange, One Size, Cotton 7

 — ||—EI

Note: As shown on the screenshot above, if you have the required privileges you will get typeahead suggestions
on existing values after having specified a search operator.

Attribute Value Search Operators

The following search operators that can be used when performing attribute value and reference metadata
attribute value searches.

Operator Description

< Less than operator. Only works for number validated attributes (Validation Base Type = number,
integer or fraction)

<= Less than or equal to operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)
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Operator Description

= Equal to operator.

> Greater than operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)

>= Greater than or equal to operator. Only works for number validated attributes (VValidation Base
Type = number, integer or fraction)

! Operator used for finding objects where the specified attribute does not have values in current
context. Note that the search does not check whether the attribute is valid for a given object. Also,
if the specified attribute has an inherited value (not a local value), then the object will be listed in the
results set even though the value field is not empty.

! Operator used for finding objects where the specified attribute does not have local values in any
context. Note that the search does not check whether the attribute is valid for a given object. Also,
if the specified attribute has an inherited value (not a local value), then the object will be listed in the
results set even though the value field is not empty.

Wildcards in Searches

Two following two wildcards are available for performing searches on partial text strings:

« *(asterisk ), multi-character, represents any number of characters in a string

« ?(question mark), single character, represents exactly one character

Wildcards can be used anywhere in the text string.

Note: Searches starting with a wildcard should be avoided since they are significantly slower than other
searches.
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Searches in 'Full Text Indexable' Attribute Values

Searches in values for attributes configured with the 'Full Text Indexable' parameter set to 'Yes' do not work in the
same manner as searches in other attribute values. Apart from common English words like 'in' and 'as,' each word
is indexed as a separate element. For more information about the words that are not indexed, search the Oracle
website for the 'English Default Stoplist.'

For example, consider an attribute named 'Description’ that has the following value on a given product:

Black powder coated die-cast aluminum enclosure. Textured surface. Bulk version: Enclosures may possibly
have flaws in the finish such as scratches, dents, discoloration, etc.

« Ifthe'Full Text Indexable' parameter is set to 'Yes' for the attribute, a search for 'Description = aluminum'’
returns the product.

« Ifthe 'Full Text Indexable' parameter is set to 'No' for the attribute, a search to find this product would require
a wildcard on both sides of the "aluminum' text like this: 'Description = *aluminum®.

Note: Searches starting with a wildcard (as shown above) are significantly slower than other searches.

By default, if you have not specified an attribute, typeahead for Full Text Indexed attribute value entries is turned
off. If you have specified an attribute, you will first get typeahead suggestions after having entered three (3)
characters of the value entry. See the 'Search Field Typeahead' section above.

Numeric Value Searches for Attributes with Units

Values for numeric searches with no units are assumed supplied in the default unit for the attribute. For example, if
kg is the default unit for the 'Weight' attribute, 'Weight = 1' willmatch '1 kg' and '1000 ¢'. If no default unitis
configured, the search 'Weight = 1' will only match the value '1' with no unit.

ISO Date Searches

If an attribute with the validation type of 'ISO Date,' where the date populated in the field is in the YYYY-MM-DD
format, a search on the populated attribute on objects can be performed using the following key words in the
Search tab: now, today, tomorrow, yesterday.

While it does not matter if the 'ISO Date' is set to 'Strict Validation' or not, it does matter that the date is written in
the YYYY-MM-DD format. Any other format, including using slashes '/ ' instead of dashes '-' will not work since
searches work by matching only values conforming to the ISO standard (with dashes). For this reason, itis
recommended that 'Strict Validation' be set to Yes, otherwise, the stored values are not guaranteed to be
searchable.

In the example below, a user searched for an object that has a particular date. The user typed in the name of the
date attribute 'ISO Date', and then used an 'attribute value search operation’ followed by the keyword 'tomorrow.'
Then they narrowed their search even further to just under one particular node, giving them the desired results.
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Coarch

I50Date (ISCDate) = tomorrow T
& pdvanced

[Search Below = Flashlights Ttems =]

[
Displaying 1 of 1 results
Mame

> | flashlight case I = 129565

Search
Show Detailz

Reset

Search Result Profiling

1 hit{s)
Click links to narrow down search

Results by Object Type
Product (1}
Eltem (1) - exclude

- exclude

Results by Position in Tree Hierarchy
Results below child nodes of Flashlights ltems

E®flashlight case (1) - =xclude

Results by Parent
Bl Flashlights ltems (1) - sxclude

Combining Search Criteria

You can combine different search criteria to create advanced searches. Except for cases where one or more 'OR'
operators are used, the sequence of the criteria does not matter.

The search shown below:

|Search: Name = Hat123

E‘

| Search Below = Apparel

[Object Type =
’VPmduct

o ¥

| Reset |f

Displaying 1 of 1results

Show Details

Mame

>

v

w Hatl23 I = 1101590

...will generate the same results as:
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Search

|5eard'| Below = Apparel
| Object Type = Product

[Search

Mame = Hat1l23
&= Advanced

BE | Reset |f _
Displaying 1 of 1 results Show Details
Mame ¥

|.. Hat123 1D = 110150

W

When not using 'OR' operators or 'Exclude' search criteria, all criteria are combined with an implicit
'AND' operator.

Click the add criteria button (5 ) to construct a query that includes more than one criteria. By default, the criteria
will be 'AND," meaning that all criteria will be met for the results.

As an example, the search shown below will find objects that have the value 'Black’ for the 'Color" attribute AND
that are present below an 'Audio Visual Equipment' hierarchy node. The order of criteria does not impact the
results.

|Search: Color (Color) = Bladk (Bladk) E‘

Search Below ™
’VEIech'iEI & Electronics (3302) Eﬂ

2 v Reset Search
Search Result Show Details
[ Mame > |
-Operations on Entire Result

g
o @

For information on constructing your search using 'Exclude’ search criteria and 'OR' operators, see below.

Using 'Exclude’ Search Criteria

Itis possible to negate all the different types of search criteria using the 'Exclude' search criteria functionality.

You can add 'Exclude' search criteria to search either by clicking and holding the add criteria button (5= =), then

selecting 'Add Exclude' from the menu that displays (shown below). Criteria can also be excluded by clicking an
'exclude' link on the generated 'Search Result Profiling' panel.
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Search

| Search Below = Apparel =1
|Obiject Type = Product =]
|Search: Name = Hat123 =1

Add Criteria | Reset || search |

Add OR Show Detallf

Add Exclude 10190

'Exclude’ search criteria appear with a red minus icon on the left side of the criteria panel (shown below).

Search
| Search Below = Apparel

|Db_'iEL‘tT‘y'|:IE = Product
|Search: Name = Hat123

| E L E|EE

Search ;]
= |Color = Gray
& Advanced
EEE [ Reset ” Search ]
Displaying 1 of 1 results Show Details
Marme >

W

w Hatld3 i = 110790

When no 'OR' operators are used, the sequence of 'Exclude’ search criteria does not affect the results.

Continuing with the example above, the search finds objects where all the 'positive’ criteria are met, minus objects
where the attribute 'Color' is 'Gray.'

Note: Use as many 'Exclude’ search criteria as needed. Keep in mind that the 'Exclude’ criteria are subtracted
from the 'positive' search results, so a search containing only an 'Exclude’ search criteria without an 'Include’
criteria as point of departure will not generate any results.

Using the 'OR' Operator

Add an'OR' operator to search by clicking and holding the add criteria button (=& ~), then selecting 'Add OR'
from the menu that displays (shown below).

! i Reset Search
Add Criteria Show D'Etﬂilsl
*
Add OR
Add Exclude
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When using 'OR' operators, search is divided into separate parts containing one or more criteria. Each part s, in
effect, executed separately and the results are then added before presenting the final result.

As itis not possible to work with parenthesis, when working with 'OR' operators it is often necessary to configure
the same criterion on both sides of an 'OR' operator. As an example, the search shown below will return all objects
where the name starts with the text 'Hat123' and the color is 'Black,’ plus all objects where the name starts with the
text 'Hat123' and the color is 'Gray.'

Search

|Search: Name = Hat123 =
| Search: Color = Black &
OR
|Search: Name = Hat123 =

[Search

Color = Gray

&= Advanced T
EEE [ Reset ] [ Search ]

Show Details

[ Mame ¥
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Search Result Profiling

The Search Result Profiling page appears when you have run your search. The page displays statistics about
the search grouped under the headers Results by Object Type, Results by Position in Tree Hierarchy and
Results by Value. Apart from giving you information about the results of your search, you can use the page to
further refine your search. Thus, if you start by running a broad search, you can refine it by clicking the links
'Exclude’ in the profile - thereby adding additional criteria to your search. See the example below:

Search Result Profiling

87 hits
Click links to narrow down search

Results by Object Type
Product (78) - =:clude

G Product (781 - exclude

Asset (B) - =xcluds

TIFF Image (71 - exclude
JPG Image (1) - exclude

Attribute (1) - =xclude

When exclude option is clicked, an additional search criteria called 'Add Exclude' is added as shown below:

| Search Below = Primary Product Hierarchy =1
| = Search: Object Type (getChiectType) |51
Search =
= |Excellence (I-Excellence)
& pdvanced T

C R Reset ||f

Displaying 100 of 1232 results Show Details
Mame
> | 7130-03-FR ID = 5554 -

W

w 7132-06 [0 = 8095
|.. 7133-12 D = 8081

L
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For all types of searches, the Search Result Profiling page will display the results sorted by Object Type. The
screenshot above shows the Results by Object Type. The search result includes 78 Products of the Object
Type "Product”, 8 Assets (where 7 are of the Object Type "TIFF Image" and 1 is of the Object Type "JPG
Image") and finally 1 Attribute.

If you click TIFF Image, an Object Type Search Criteria is added to the search. The search runs again, finding
only objects with the Object Type "TIFF Image."

If you click exclude next to TIFF Image, an Object Type Search Criteria is added to the search, but this time as
an Exclude Criteria. Hence, all objects of the Object Type "TIFF Image" will be excluded from the search result.
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Search: Advanced Options

Additional options for narrowing a search can be accessed under the Advanced flipper in Search.

Each of the following advanced options is described in the following sections:

Match Case on Names and Values
Include Inherited Values
Exclude Values

Regular Expression

o 0N =

Include Data Containers

| Search - =]

¢ Advanced
[ ] Match Case on Mames and Values

[ ] Indude Inherited Values
[] Exdude values

[ ] Regular Expression

[ ] Indude Data Containers

g Reset Search

Show Details
| Name »|

1. Match Case on Names and Values - When selected, Name and Attribute value searches are not case
sensitive.

For example, this is a basic search with search criteria of 'Search = T-Shirt.'

Search ™
T-shirt j

& Advanced

| g Reset Search |
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The search results are displayed with all the objects in STEP that match the search criteria, in this case 'T-
shirt.'

STEP objects in the search result includes:
« Classification / Asset/ Product/ Entity objects

« Special Types objects
« System Setup Tab objects

Cearch =
t-shirts j Search Result Profiling
@ Advanced 3 hit(s)
ﬂ Reset Search Click links to narrow down search
Displaying 3of 3results  Show Detailz
Mame > Results by Object Type

> T-shirts I = 18459
Product (2] - exclude
> T-shirts D = 18205

% T-shirts I = 18705 IjLE".I'E' 3(1) - exclude
[Tl Sales ltem Family (1) - exclude

Classification {1} - exclude
[C1MerchandisingClass (1) - sxclude

Results by Position in Tree Hierarchy
Results by Parent

[C1T-Shits Sales ltems (1) - sxclude
[C] Sportswear (1) - sxclude

[C1 Upper Body Wear (1) - exclude
[C1T-shirts {1} - =sxclude

Results by Value

Hame matching "t-shirts"

Mame (3] - exclude

Now, on the search, select the Advanced option 'Match Case on Names and Values.'
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Search
M| Search w =]
t-shirts
@ advanced
Match Case on Names and Values
[] Indude Inherited Values
[ ] Exclude values
] Regular Expression
[] Indude Data Containers
g5 v Reset Search
Show Details
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With this option selected, the search result will only include attribute values and all the object names in STEP
that match the search criteria in the correct case. Since the previous search results were all a different case,
this search will return no results.

Search

M| Gearch =
t-shirts

@ advanced

[ ] Exclude values

[ ] Regular Expression

Match Case on Mames and Values

[] Indude Inherited Values

[] Indude Data Containers

B

Displaying 0 of 0 results

Reset

Show Detailz

[ Mame

>

EIL WL

-Operations on Entire Result

< Search Result Profiling -

Search Result Profiling
0 hit(s)

Note: ID searches are always case sensitive.

Include Inherited Values -When selected, attribute value search results will show objects where the match
includes inherited values as well as objects where the match includes locally defined values.
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Attribute values with hierarchical inheritance (values with green triangle) will only be included in the search
result when Include Inherited Values option is selected.

23 B2 b

=y

» Product Weight

Dimension dependent Attributes — Specification or Description attribute values inheriting from other contexts
(values with a red triangle) will also be displayed in the search result even when the user does not select the
option Include Inherited values.

» Ewclusive?
* Mew Product

. Exclude Values - When selected, attribute values are not searched for the entered search term. If unchecked,
attribute values are searched for the entered term and objects with the search term populated as an attribute
value are included in the search results.

The Exclude values in advanced search are useful for neglecting objects which are having search content as a
value init.

For example, assume there are attributes which has value 'Red' in few objects and there are objects which has
Object Name/ID as 'Red.’

If a normal search is performed, the results for 'Red' are shown below.
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Search < Search Result Profiling .
Search =
Red Search Result Profiling
- ad d
reneE 11 hit(s)
dh - Reset Click links to narrow down search
Displaying 11 of 11 results Show Details
Name /|| Results by Object Type
182121 B ID = 18721
= Product {(11) - exclude
BB723-12 I = 100974
VA D = 12745001 B Active Products (7) - excluce

N _ N ‘ lterm Family (2} - exclude
I Cosmic Party Hat - Gold and Red D' = 134422 Lo Sales ltem (1) - xcluce

i:] Cosmic Party Hat - Green [D = 134414 Bl ltem Folder (1) - sxclude
e Mens T PBO 2 1D = MT 18400
I Pink & Blue Giraffe Party Hat 1D = 121185 Results by Position in Tree Hierarchy
¥™ Red Baseball Cap I = 20505

jil Red Cotton T-Shirts 1D = 18205
I Rustic Bed Frame ID = 132495
ji T-shirts Items [ = 18203

Results by Parent
(Displaying the 5 most common)

[C1Products (3} - sxclude

Bl T-shirts ltems (2) - sxclude

Bl Children's Hats (2} - sxclude
- Red Cotton T-Shirts (2) - sxcluds
|'_=|HEltS (1) - exclude

Results by Value

Values matching "Red"
(Values are displayed in lowercase)

red (11} - exclude

Attributes with values matching "Red"

1T secondary Color (7} - exclude
I]i Color(2) - exclude

[T Available Colors (1) - sxclude
[IT attribute B (1) - =xciude

-Operations on Entire Result

B <&

If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and
Names matching the search are turned.
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Red
@ advanced

[] Indude Inherited Values
Exclude values
] Regular Expression

[] Indude Data Containers

[ ] Match Case on Names and Values

B

Displaying 2 of 2 results

Show Details

Mame

>

» Red D = 20805
* Red ID = 15205

-Qperations on Entire Result

B A &

Search Result Profiling

Search Result Profiling

2 hit(s)
Click links to narrow down search

Results by Object Type
Product (2] - exclude

™ Active Products (1) - =xclude
Bl ltem Family (1) - sxclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

r_=|F’fCIC|LICTS (2] - exclude

1181167 —Hats and Caps Items (1) - exclude

StiboSystems

MASTER DATA MANAGEMENT

[ Hats (1) - exclude
Il Hats and Caps ltems (1) - sxclude

Bl T-shirts ltems (1) - zxclude

Results by Value

Hame matching "Red"

Mame (2] - exclude

4. Regular Expression - When selected, attribute values are searched using the regular expression entered in
the Search text box. Although establishing an attribute with Validation Base Type of Regular Expression allows
more than 2000 characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only returns
results for matches within the first 2000 characters. For more information, see the Regular Expression topic
in Resource Materials online help.

5.

Include Data Containers - Include any search terms contained inside data containers.
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Search Operations on Entire Result

There are three operations that can be found at the bottom of the Search Tab.

Mame
| .. Hat123 [D = 110190

W

1| 1] [ r

-Operations on Entire Result

Exporting a Search Result

After conducting a search it is possible to export the search result by clicking the Export Search Result button at
the bottom of the Search tab.

When clicking the Export Search Result button, STEP will attempt to use all the objects in the result as root
objects for the Export Manager (equaling selecting the objects on the Product Selection step of the Export
Manager). Which objects are exported is thus determined by the selected Export format and the selections made
in the Export Manger. For more information using the Export Manager, see the Export Manager topicin the
Data Exchange documentation.

82 Export Manager

Steps Select Objects
1. Select Configuration Product selection made by search URL,
2. Select Objects
3. Select Format
=4 Data
Map Only export selected objects
5. Advanced
6.5 Delivery Me Only export leaf objects Export: | Product v
Indude object types <Al object types>
Back Mext Finish Cancel

Saving a Search Result as a Collection
After conducting a search it is possible to save the entire search result as a Collection.
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When clicking the Save as Collection button, a dialog is opened where it is possible to specify the ID, Name, and
location of the new Collection. For more information on collections, see the Collection topic in the Getting
Started documentation.

$2 Save as Collection in Background Process

Search |

-5 Collections
-5 eCatalogs

2= Details
Collection ID 124174

Collection Mame

0K Cancel

Bulk Updating a Search Result
When having conducted a search it is possible to Bulk Update the entire search result.

When the Bulk Update Search Result button is clicked, the Bulk Update wizard appears with the search result
selected as the dataset. For more information on bulk updates, see the Bulk Updates documentation.

32 Bulk Update

Steps Configuration

1. Configuration
2, Operations

3. Parameters

4. Preview

|Ise Existing Configuration
5, Advanced O

(®) Create New Configuration

Back Mext Finish Cancel

Note: If you only wish to Bulk Update some of the objects in the result, you can select or multi select in the
search result and then select the Run Bulk Update option on the File menu
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Search: Data Containers

The Data Containers search criterion allows users to limit search results to only objects for which data containers
exist for the specific data container types, or those objects for which specific attributes are linked via data
containers.

Searching for objects with information in data containers is available using the standard search criterion and also
using the specific Data Containers criterion. Each method is defined below.

For more information on data containers and the terminology used in this topic, see the Data Containers topic of
the System Setup / Super User Guide documentation.

Standard Search Including Data Containers

This option searches data containers and other identified objects for the defined values. For more information, see
the Examples section below.

1. Clickthe Search tab, and select Search from the dropdown.

Cearch ¥
& Advanced T

T v Reset Search

saarch Result Show Details
[Name

Tree

2. Open the 'Advanced' flipper and check the 'Include Data Containers' option.

| Gearch - ]

@ Advanced
[ ] Match Case on Mames and Yalues

[ ] Indude Inherited Yalues
[] Exclude values

[ ] Regular Expression

I Indude Data Containers |
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3. Ifneeded, click the green plus button () to add additional search criteria.

4. Click on Search to run the search and view results.

Data Containers Only Search

This method requires that the searched data exist in a data container. Matching data outside of data containers is
not displayed. For more information, see the Examples section below.

1. Click the Search tab, and click the Search dropdown.

2 Advanced T

oa - Reset Search

earch Result Show Details

2. Inthe Search Criteria Type Selector, select the 'Data Containers' search criterion.

Search

Search

Object Type

Search

Search Below
Referenced Assets

Revised Objects Changed Since
Data Containers

Document Content

Search from List
Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

[ Systemn Setup ” BG Processes (2) ]

Search in Publication Hierarchy

3. Supply the Data Container Type parameter and the additional text input parameter as needed:

« Continue to the next step without populating either parameter to return all objects for which any data
container of any data container type that has been added.
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. Click the ellipsis button ([...)) for the Data Container Type parameter to limit the search results to only those

objects for the selected data container type. Click Select and then click Search. The search returns a list of
objects for which the data container type has been added, even when no attribute values exist in the data
container. For more information, see the Examples section below.

Search

Datz Contsiners =

32 Data Container Type

Data Container Type

@ Advanced

=5 Attribute Groups Py
(#-(0 Attribute Group
=#-[E0 Data Containers

o '| Reset Search ' ---- El contacts
Search Resuft Show Details - ~El Emai
[ Name - [E] Main Address
~[E] Phone
--[E] [Ghipping Address|
e E Vitals
-3 ETIM Attributes .
' B
& Details
Select Cancel

« If necessary, narrow the search using additional search terms in the text input parameter. Type the selected
‘Data Container’ attribute to display typeahead suggestions. Once selected, the available operators =, <, >,
<=,>=1 llare displayed. If the selected attribute has a value in the ‘Data Container’ tab, the values display
as a dropdown. However, the search result will be displayed only for the attribute value which is present for
the attribute in the Data Container tab. For more information, see the Examples section below.

D=tz Contziners W
Data Container Type | shipping Address (ShippingAddress)

Country Code (CountryCode) =

Country Code (CountryCode) = AMGUILLA (AI) -~
| _|Country Code (CountryCode) = ANTIGUA AND BARBUDA (AG]
{Country Code (CountryCode) = ARGENTIMA (AR)
rlCountry Code (CountryCode) = ARLIBA [AW)
Country Code (CountryCode) = AUSTRALIA (AL
(Country Code (CountryCode) = ALISTRIA (AT)
Country Code (CountryCode) = BAHAMAS (BS) |
Country Code (CountryCode) = BARBADOS (BE)

Search

Datz Containers W
Data Container Type  |shipping Address (ShippingAddress)

Country Code (CountryCode) = BAHAMAS (BS)

& Advanced

-Operations on Entire Result

o) @

=

Displaying 1 of 1results Show Details
Mame ¥

2 Customer B ID = CLS_107855

L

-Operations on Entire Result

J @ E
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4. If necessary, open the Data Containers Advanced flipper and set the following parameters:

| Data Contsiners ™ =]
Data Container TYpe  |Shipping Address 2 (211423) | ...

@ Advanced

Instance count | > | |1

[] Match Case on Values

|:| Regular Expression

g5 v Reset Search

« Instance count - specify a number of data container instances an object must have.
« Match Case on Values - makes the search case sensitive.

« Regular Expression - search data containers using a regular expression. For more information, see the
Regular Expression topic in Resource Materials online help.

5. If needed, click the green plus button () to add additional search criteria.

6. Click on Search to run the search and view results.

Examples

The following examples show a variety of searches for values in data containers.
Standard Search for Product Data Container Value

The dataset includes an object with a Flat Crush Test value of '10 kN'. This value is in a product data container.

Corrugated Box rev.0.1 - Data Container:

--r_‘=| Apparel ~ | Product |BEELEREIETZES [ Sub Products | References || Referenc
£ Hardware & Industry Standard A

[+[[T] Tools

i Industry Standard B

([T Doors and Doorknobs ¢

r_=| Hardware Kit » |ID > |Attribute Name | > Value >

El|j Packaging Supplies IndustryStandardB_27183%  Edge Crush 12a 4347

- .| IndustryStandardB_271883  Flat Crush t2a |10 kN

[+-[IZ) Displays IndustryStandardB_271882  Pin Adhesion 123 11.05
[-£5) Furniture IndustryStandardB_271882  Scuff and Abrasion  |12a [JON

Searching for the value 10 kN' with the standard Search criterion returns 0 results.
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Search w
10 kM

&= advanced

[~
Displaying 0 of 0 results
| Mame

T

Show Details
a

Reset
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Search Result Profiling -

Search Result Profiling
0 hit(s)

Checking the Advanced option to 'Include Data Containers', and searching again, displays the object as a result.

Search Result Profiling -

Search

M| Gearch =
10 kM

9 Advanced
[ ] Match Case on Mames and Values

[] Incude Inherited Values
[ ] Exdude values
|:| Regular Expression

Indude Data Containers

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type

Product {1} - exclude

ﬁltem (1) - exclude

Reset

156~

Displaying 1 of 1 results

Show Details

Results by Position in Tree
Hierarchy

Results per Parent

Mame

>

> ™ (245934) 1D = 245935

O Tools (1) - exclude

Standard Search for Entity Data Container Value

In this example, a user searches for all instances of the value 'BAHAMAS' in STEP. Select the standard 'Search'’
from the dropdown, add 'BAHAMAS' into the text input parameter, open the advanced flipper and check the
'Include Data Containers' option, and click Search. The results includes Customer A and Customer B entity
objects where 'BAHAMAS' occurs inside a data container, and also includes the 'BAHAMAS' values that appear

outside of data containers.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

281
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BAHAMAS

9 Advanced

[] Include Inherited Values
[ ] Exclude values
|:| Regular Expression

Include Data Containers

[ ] Match Case on Mames and Values

E

E=

Displaying 5 of 5 results

Reset

Show Details

Mame

>

> ™ 18210 M B_EN ID = 15210

> |y Axel Kiers Vej 11 ID = ADD_101571

+ 8 Customer A 1D = COLE 101595

* |2 Customer B I = CLS_107835

> ™ InDesign modified ID = 123216

-Operations on Entire Result

9 @ &

Data Container search for Entity Data Container Type

StiboSystems
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In the example below, a user searches for a data container type called 'Shipping Address' without refining the
search any further. If the user selects 'Shipping Address' as the Data Container Type and clicks Search, a list of
entities for which a data container has been added to an entity under the data container type 'Shipping Address'

will display. In this instance, four entities are listed.
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& pAdvanced

Data Container Type E‘%hipping Address (ShippingAddress)

[

Displaying 4 of 4 results

Reset

Show Details

Mame

W

B Customer A ID = (LS 101545

W

2 Customer B ID = (U/S_107835

W

2 Customer D D

= LS 114565

v

2 Customer E D = CUS_114565
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The entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of'ARGENTIAN' in the
Contact tab, but with the value of ' BAHAMAS' on the Data Containers tab.

i (18212)
- [H] Account Group 1

= 2 allen

[—}--% Customer Hierarchy
Elg Customer A
S Axel Kiers Vej 11

Jesper Jensen

=1+ 2 Customer B

John Smith

B B Customer C
o Key Accounts

il GOSN
<

><@' 3550 George Busbee Pk

>

]

Referenced By || Status || State Log || Tasks

Customer B rev.0.4 - Customer

o ==

Customer Data Containers

@ Description

Mame | » |Value »
> D CUS_107835
* Mame Customer B
» Dbject Type Customer
* Rewision 0.4 Last edited by USER.J on Tue Sep 26 17:1...
» Path Entity hierarchy root/Entity Root/Customer Hi...
* Completeness Score 1 i
* vailable Sizes A

Country Code | ARGEMTIMA

B 2 allen

[—}-% Customer Hierarchy
E|8 Customer A

=| John Smith

-4 3550 George Busbe

A

£y Axel Kiers Vej 11

Jesper Jensen

L
>

€ Customer B rev.0.4 - Data Containers

o
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When a search is performed on the ‘Shipping Address' data container and the attribute 'Country Code' is selected,
all of the values are displayed. The search result will display the entity ‘Customer B’ only if the value is
‘BAHAMAS.’ The search result will return ‘0’ if the value selected is ‘ARGENTINA’

Search

Datz Contziners W
Data Container Type | shipping Address (Shippingaddress)

Country Code (CountryCode) =

Country Code (CountryCode) = ANGUILLA (AI)
| |Country Code (CountryCode) = ANTIGUA AND BAREBUDA (AG,
{Country Code (CountryCode) = ARGEMTIMA (AR)
~{Country Code (CountryCode) = ARLBA (AW)
Country Code (CountryCode) = AUSTRALIA (AL
Country Code (CountryCode) = ALISTRIA [AT)
Country Code (CountryCode) = BAHAMAS (BS) |
Country Code (CountryCode) = BAREADOS (BE)

[

Search

Diatz Contsiners
Data Container Type

Shipping Address (ShippingAddress)

Country Code (CountryCode) = BAHAMAS (BS)

& Advanced

=

Displaying 1 of 1 results

Show Details

Marne

>

W

8 Customer B I

=L 107835

0 E

-Operations on Entire Result

9 4@ %

-Operations on Entire Result

Data Container search for Entity Data Container Type and Value

To continue the previous example, if the user refines the search for entities with a 'Country Code' data container
type to only include those data containers containing the value 'BAHAMAS', the user would enter' BAHAMAS' in
the input field. In this example, results returned from the search show two of the original four entities. This means
that a 'Shipping Address' data container has been added to these two entities, and an attribute within those data

containers also contains the value 'BAHAMAS'.

]

| Data Contziners

Data Container Type | shipping Address (ShippingAddress)

BAHAMAS

[E

Displaying 2 of 2 results

Show Details

L

Mame

>

W

2 Customer A I = CLIS_101545

W

2 Customer B ID = CLS_107535

-Operations on Entire Result

g @
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Search: Document Content

With the Document Content search criteria you can search for a specified word / text string in text documents
stored as Assets in STEP.

1. Click the Search tab.
2. Click the Search dropdown and select Document Content.

Search

Search

Search

Search
|7'3" Advanced T

EEE | Search

Search Result Show Details
[ Mame

Tree

Object Type

Search

Search Below
Referenced fssets
Revised Objects Changed Since

Data Containers
Document Content
Search from List

[ BG El'uc%es (41} l

Important: A prerequisite to searching in documents is that they are indexed. Document Content displays as a
search option only in systems that have full text indexable functionality enabled and are not running In-Memory.

3. Enter the word / text string into the text field that appears.

| Dooument Content |
’VFind 9

EI-: [ Reset ] Search
Displaying 0 of O results Hide Details

[ Mame *|

4. Click the green plus sign () to add additional search criteria. (Optional)

5. Clickon'Search' to run the search and view results.
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Search: JavaScript Search

The JavaScript search criteria searches through all JavaScript in STEP. It can match items according to
Business Rules, Match Algorithms, Decision Tables or any other structure programmed through JavaScript.

Follow the steps below to set up a JavaScript Search:

1. Click the Search tab and click the Search dropdown.

& pAdvanced

T v Reset Search

aarch Result Show Details

2. SelectJavaScript search.

Search

Jawasoipt search
Find |5

[] Match case

[] Match whale word only

| Reset ||

Displaying 59 of 59 results Show Details

Mame
> |=ﬁ (acn-88fdd33c-fceb-4754-a118-a9103b7 59 I
» ## (acn-b35434c0-5c7a-4413-ad89-ecad7e6cd3 |

JavaScript Checkbox Options

Search Result Profiling

54 hit(s)
Click links to narrow down search

Results by Object Type
Special types (55)

_JBusiness Action (47) - exclude
_1Business Condition (8 - =sclude

These checkbox options are available with JavaScript search criteria:

« Match Case: If you select this, the search will only return results that match the upper or lower case letters that

are in the search criteria.
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Find |a

Match case
[ Match whale word only

¥ ==
Displaying 38 of 38 results Show Details

Mame
> W (acn-88fdd33c-fceb-4754-a118-a9103b75%e =

> ¢ (acn-b35434c0-5c7a-4413-ad89-ecad7e6cad |

« Match whole word only: will return only results that are the exact criteria that were put in that standalone. An
example would be if the letter 'a’' were typed into a search, and only results that had 'a' in it that standalone
somewhere in the JavaScript were returned.

Javasdipt search
Find |p

[] Match case

Match whole word only

EE | Reset || .

Displaying 1 of 1 results Show Details
Mame

> ({) BSSSPackagingLibrary (final) ID = BSsSPackagingl.
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The Missing Mandatory Values search criteria is used for finding Product objects that have valid Mandatory
Specification attributes without values.

To set a criteria as a Missing Mandatory Values search:

1.

2. Select Missing Mandatory Values from the dropdown.

Click on the Search tab and click the Search dropdown.

& pAdvanced

T v Reset Search

aarch Result Show Details

[ Missing Mandatory Vakes =
|-Missing Mandatory Values “"'"i E1
ERE [ Reset ][ Search ]
Show Details
[ Mame »|
Use Cases

1.

Product object which has specification and description attribute as mandatory with empty values.

The 'Product Name' attribute is set as mandatory for Iltem Object Types. For Object 22200, the attribute value
is left empty. In the Search tab, Missing Mandatory Values search criteria is used with Object Type

‘ProductsRoot’ search criteria. 22200 is included in the search results.
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: ub Products eferences eferenced By
Products (ProductsRoot) . Sub Products || Ref Ref d B
Missing Mandatory Values = E1 2 Description
Missing Mandatory Values Mame s> Walue
L i Reset Search > D 22200
Displaying 100 of 194 results Show Details * Mame 22200
Name > Object Type Item
il 3 inch heels ID' = 20594 L]
12-GG D = 100705 » Revision 0.1 Last edited by STEPSY:
m 2 K799 = -
050-42151 D = 7975 * |Approved x Mever Been Approved
, O - -
M 555-22346 ID = 6506 # [Translation Mot Translated
PH18213 M 0 ID = 18213 » Path Primary Product Hierarchy/
N 20883 D = 20555 @ Manufacturer Information
bel 20888 AAA Batteries ID = 109005 MName s | |Value
m 20888 AAA Batteries RECHG D = 109007 s Manufacturer's Part Mumber 33 TRO&EY
21873 (box of 5 pair multi-color) ID = 21875 » Manufacturer Name abe
I 21882 (sellable case of 20 boxes of 5 pair oranc > Country of Qrigin ScHINA
) 22126 (box of 20 pair orange) ID = 22125 » Product Name £
22200 ID = 22200 > abe
W= 0262119 11 = 27507 » Supplier Part Number abe (448291

2. Description attribute is mandatory and is left blank on entity object.

In this example, the 'Available Sizes' description attribute is set to mandatory. On the address entity ADD _
107837, the 'Available Sizes' attribute is empty. A search is performed that has a 'Missing Mandatory Values'
search criteria with Object Type ‘Entity root’ search criteria. The ADD_ 107837 object is returned as a result.

References || Referenced By || Status || Skate Log || Tasks
P Description

| Entity hierarchy root (Entity hierarchy root) 1
Missing Mandatory Vakes
|-Missir1g Mandatory Values E1 Mame s | ® Value
T~ o=t || search |II? 2 ADD_107837
Displaying 100 of 10049 results Show Details ||| > Mame 3550 George Busbee Plwy
Mame » DObject Type Address
-00000 ID = 3 A
> | ) 64TH MED DET (VS) D =D&5116545 » Revision 0.1 Last edited by USER. on Fri Aug 14 16:32;
i 250 South Hampton De [0 = 400, 114355
» Path Entity hierarchy root/Entity Root/Customer H
* @mmmm ID =ADD 107837
— HET - . | * Completeness Score i::
% @ 114333_ 3550 Gm‘gﬂ Bushee » Available Sizes E‘ﬂ‘
»|0J ABC.UN |D= ADD_107837 511655, Uity Tor T
i AR D W'II:CI'I'F i TN - NeRTiaESs % Mamtzrt Blama ahe
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The search criteria requires no data input or selections to be made. However, it is encouraged to use in
conjunction with another search criteria (by clicking the green + sign) to help further refine the search.

Note: As the Missing Mandatory Values search criteria only works on Product objects, using it in combination
with other search criteria will limit the search result to such objects.

The Missing Mandatory Values search criteria can also be set to exclude Product objects with missing Mandatory
values. This functionality is described in Using Exclude Search Criteria within the Search Functionality topic.
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Search: Object Type

With the Object Type search criteria you can limit your search result to items of a specific Object Type. These

objects are maintained in the workbench System Setup > Object Types & Structures folder.

1.

Click on the Search tab and click the Search dropdown.

€ pAdvanced

CRI Reset

aarch Result

Search

Show Details

2. Select Object Type from the dropdown.

3.

Search

" Object Type ™

Product

-]

I3 |

Reset Search
Show Details

[ Mame

StiboSystems
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In the dropdown that displays 'Product' by default, select an object type. See the System Setup Object
Types section below for more information.

« Hover on an object type to display a sub menu when available.

« When an Other... option is available, click it to display a selection dialog. Use the Browse or Search tab to

select the object type. Click Select to confirm.
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‘| Object Type ™ 5
Product
Product : Product
Aszet :
Sales [tem
Classification :
Product Folder
Attribute
Ditern
List of Values )
External ltem Enricl
Unit

Publication Group
Publication
Publication Section

Entity
Special types

Discontinued Prod
Buy Side
Level 1

MewObj
Product

I Other...

33 Please Choose Object Type

StiboSystems
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[=-{IZ] Primary Product Classification
[+ i) Discontinued Products
-3 External Products
-l GDSN Products
i Packaging Hierarchy
rj Primary Product Classificatic

[ Product Folder
E Product Overrides
’ rj Products

2= Details

Select Cancel

4. If needed, click the green plus button () to add additional search criteria. For example, return only products

with the text'ACME".

Search

|Object Type = Level 1

Search
ACME i —
@ Advanced

Ex|

Search Result

Reset Search

o al

[ Mame

Note: Without the additional search criterion shown above, the results will be a list of all objects of the

specified type.

5. Click Search to run the search and view results.
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s [

|DbjectType = Product

E‘

Cearch ™
ACME

&= Advanced

=3

(o -

Displaying & of & results

Show Details

Mame

>

e 21933 [0 = 21955

N 27244 ID = 27294

¥ Comfy Bed 1D = 22155

¥ Comfy Footboard ID = 22155

I Comfy Headboard D = 22787

¥ Comfy Side Rail ID = 221565

System Setup Object Types

Search Result Profiling

6 hit(s)
Click links to narrow down search

Results by Object Type
Product {6
EHEH"I (6) - exclude

- exclude

Results by Position in Tree Hierarchy
Results by Parent

-BEUS ltems (4) - exclude
[C]Products (1} - =xclude

Il Refrigeration Items (1) - =xclude
[C]Products (1} - sxclude

Bl Crinking Items (1) - sxclude

Results by Value

Values matching "ACME"
MWalues are displayed in lowercase)

acme (7) - excluds

Attributes with values matching "ACME"

[T Brand Name (5) - sxclude
(I Manufacturer Name (1) - exclude
[T supplier Mame (1) - exclude

The following object type selections require further information.
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"| Object Type ™ =
Attribute
Product ]
Asset >
Classification b
Attribute
List of Walues
Unit
Publication Group >
Publication b
Publication Section ]
Entity *
Special types >

Attributes, Lists of Values, and Units

The Attribute, List of Values, and Unit object type categories do not include sub selections. All of the selected
object types available will be searched for each of these categories.

Special Types

Special Types includes Table Type, Business Rule, Business Library, Business Condition, Business Action, and
Business Function object types.
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Search: Product Override Search

With the Product Override search criteria you can locate and identify any product overrides present in your
system. You can simply search for all overrides in STEP or you can narrow your search to overrides of a specific
product. If more concise results are required, you can specify sub-products.

1. Click on the Search tab and click the Search dropdown.

Search

2 Advanced T

oa - Reset Search

earch Result Show Details

- Owverridden Product

() Find Al

(@) Find by Overridden Product

COwerridden Product

-5ub Products
(] Exact Match an Child Products

|5u|:| Product > |
> | Add Child Product

oa v Reset Search

Show Details
[ Mame

3. Inthe Overridden Product group, select a radio button :

« Find All - Searches for all product overrides.

« Find by Overridden Product - Searches for the specified product, as shown in this image. In the text box,
either type the product's name, or click the ellipsis button ([...]) to browse or search for a product.
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- Overridden Product

() Find Al
(®) Find by Overridden Product

Overridden Product | Batteries {20878)

- Sub Products

[[] Exact Match on Child Products

|5L|I:| Product

> | Add Child Product

32 Overridden Product

StiboSystems
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Vi

Reset

Ex

Search
Show Detailz

[ Mame

[=-{IZ) Primary Product Hierarchy
[+ Discontinued Products
i External Products
[+ il Packaging
E Product Overrides
EI|__=| Products
--1'_'=| Displays
EH'_‘=| Electrical and Electronics
E}Fj Electronic Accessories
: E|r_=| Power

- o )

= Details

----- Il Tvre 5 Contactors and Starters "

Cancel

In the Sub Products group, set the following options as needed:

« Exact Match on Child Products - WWhen checked, search results must have every sub-product specified.

« Add Child Product - Click the link to select sub products that will narrow the search further by requiring
search results to have exactly the specified sub-products linked to them.

Click the arrow button (> ) on one or a group of rows to display the following menu and perform the action:

Sub Products
(] Exact Match an Child Products
ub Product 3
Hide

— Show All Rows
? Rotate Table Search
Displa Add Child Product  Ctrl+Plus Zhow Details
E Remowve sub product  Ctrl+Minus :l

« Hide - Hides an added child product from list.

« Show All Rows - Show all hidden child products.

« Add Child Product - Does the same operation as the ‘Add Child Product' link as stated above.

« Remove sub product - Removes the selected child product.
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5. If needed, click the green plus button () to add additional search criteria.

6. Click on Search to run the search and view results.

This image shows products with the specified child product, but others child products could exist as well.

- search ] SearchResultProfiing -

| Product Owemride Search E
-Overridden Product Search Result Profiling
() Find Al 2 hit(s)

® Find by Overridden Product Click links to narrow down search
Ind oy LvVerrdaden Frodu

Overridden Product | Batteries (20878) Results by DM Type
rSub Products Product (2} - exclude
[] Exact Match on Child Products &l Product-override (2) - exclude
Sub Product * T
» Batteries Rechargeable ITtemFolder Results by Position in Tree
» Batteries Items Hierarchy
> | Add Child Product

Results per Parent

ELE'I.-'E| 2(2) - exclude

C Reset

Displaying 2 of 2 results Show Details
Mame >
> Batteries Override 1 — Batteries [0 = 124055
> Batteries Override 2 — Batteries [0 = 170577

This image shows there are no overridden products with only this exact sub product.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 297



StiboSystems

MASTER DATA MANAGEMENT

Search € Search Result Profiling .

| Product Ovemide Gearch =
-Overridden Product Search Result Profiling

() Find Al 0 hit(s)
(®) Find by Overridden Product

Overridden Product | Batteries (20878)

-Sub Products
Exact Match on Child Products

Sub Product ]
» Batteries Rechargeable ItemFolder

> | Add Child Product

Ha Reset Search

Displaying 0 of 0 results Show Details
[ Mame > |

This image shows overrides regardless of sub products.

Search € Search Result Profiling na

| Product Oweride Search E
-Overridden Product Search Result Profiling

() Find Al 3 hit(s)
® Click links to narrow down search
Find by Owverridden Product

Overridden Product | Batteries (20873) Results by DM Tym.
-Sub Products Product (3} - e=clude
[] Exact Match on Child Products el Product-override (3) - sxclude
|Sub Product >]
* | &dd Child Product == =
2| 1o Fred Results by Position in Tree
Hierarchy
om Reset Search
Displaying 3 of 3 results Show Details Results per Parent
Mame > CCiLevel 2 (3) - exclude

¥ Batteries Owverride 1 — Batteries [0 = 174055
> Batteries Owverride 2 — Batteries D = 170577
¥ Batteries Owverride 3 — Batteries ID' = 179555
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Search: Referenced Assets

The Referenced Assets search criteria is used for finding product objects which has referenced assets to the

specified product.

By default, all local referenced assets for the specified product are displayed.

To set up Referenced Assets search criteria:

1. Click on the Search tab and click the Search dropdown.

Search

& Advanced

T

g v Reset Search

aarch Result Show Details

Reset

Search
Show Details

]

Referenced Assets
Search

E Object Type

A Search Below

@ Referenced Assets

@ Revised Objects Changed Since
EI Data Containers

& Search from List

StiboSystems

MASTER DATA MANAGEMENT

3. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By
running a basic search, it will return results of all referenced assets of the product specified.
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Search Result Profiling

Referemcad Assets ™
Product Mame

Indude Inherited Assets ]

Match Case on Mames ]

Dress Shoes

Search Result Profiling

3 hit(s)
Click links to narrow down search

[ |

Displaying 3 of 3 results

Results by Object Type

Asset (3} - exclude

Reset | i
Show Details

Mame

>

W

| 20695 back I = 20700

'E Product Image (3} - exclude

W

'wm| 20695 main 1D = 20701

W

' 20695 side D = 2070z

Results by Parent
r_=|2|:| 3k - exclude

Results by Position in Tree Hierarchy

Note: Ifthe product ID and name are the same, or if the product name has numbers as part of its name, the
search result will still display all the local referenced assets of the product specified.

Checkboxes for Referenced Assets Search

When performing a search, there are two search checkbox options that can be selected.

« Include Inherited Assets - This option is used when the inherited referenced assets on the specified product
are to be included in the search resuilt.

Tree

E Fashion Board
- GOSN Products
i Packaging
E Product Overrides
E}E Products
Erj Apparel
E||j Upper Body Wear
El1j T-shirts

=i T-shirts Items
-l 2358141
M assas2
- i 3872312
-l Cotton T-Ghirts
- S0 Many T-shirts
[+-[[7] T-5hirts Sales Items
[+H{IT) Head Wear
[+-{I7] Electronics
(-7 Footwear

A

235914-1 rev.0.3 - References

Category Profile || Proof View || Status || State Log || Tasks

Referenced By
Product ”

Images & Documents

Product Variants

" Commercial Tables
Sub Products l References

@ Category Spedfic Attributes

@ Discontinued Product Maintenance
CF Document References

o Image References

A

W

Reference Type v| * [Target Thumbnail

W

ImagePrior

W

Brand Mame Logo  +

W

Tlustration +

W

Primary Product Image E Blue cap

W

Product Images +

* |Video +

Y | FY | P Y| 0
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« Match Case on Names - This ensures that the specified product name is searched matching the case (case
sensitive) and all local referenced assets are displayed in the search result.

I L]

33‘ External Products
...\ Fashion Board
-l GDSN Products
Eli Packaging
E}E Product Overrides
EIFj Products
EI|j Apparel
E}E Upper Body Wear
. Elr_=| T-shirts
1 [l T-shirts Items
S 2359141
| 23se152
- il 8872312

Referenced Asssts ;1

Product Name T-shirts Items
Include Inherited Assets ]

Match Case on Mames
gp v Reset

Show Detailz

Displaying 1 of 1 results
Mame
> | Blue cap ID = 107625
£ >

-Operations on Entire Result

B &

L4 Search Result Profiling

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type

Asset “] - exclude

E Product image (1) - exclude

Results by Position in Tree Hierarchy
Results by Parent
A1) - exclude
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Search: References and Referenced By

The References and Referenced By criteria work similarly.

To navigate to either of these searches:

1. Click on the Search tab and click the Search dropdown.

Search

- Advanced T

g v Reset Search

aarch Result Show Details

2. Select References or Referenced By from the dropdown.

Search

&= Advanced

CR
Search Result
| Mame

Search

Object Type

Search Below

Referenced Assets

Revised Objects Changed Since
Data Containers

Search from List
Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

Search in Publication Hierarchy

Referenced By

References

StiboSystems
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Both options require a reference type selection to begin. Reference types are setup in STEP Workbench System
Setup tab in the Reference Types folder, and the Web Ul Advanced Search allows you to pick from image and
document reference types, classification reference types, and product reference types.
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Once a reference type is entered, no additional options need to be filled in to start a search. Use the information at
a high level or fill in the other values to drill down further (e.g., multi-supplier item references). Select a reference
source under Referenced By and a target under the References. Plus enter specific attributes and values to
search reference metadata.

References

For References, there are two boxes that can be checked: Include Inherited References and Finding Missing
References.

Include Inherited References: When this is selected, it will show items that have the particular search criteria
passed down to them from a parent folder or level.

T

References = B =
RE'FEFEFICE Type Jwners Manua| {DW”EFSME”UE'} E] S'EE rCh RESU" Frﬂ'ﬁling
I Incude Inherited References I 4 hit(s)

Click links to narrow down search

m

[ Find Missing References

Reference Target Results by Object Type
rm L T ||} Product(4) - exclude
Product fZ} - exclude
=
Advanced g tem (2] - exclude
I — .
T = Results by Position in Tree Hierarchy
] Results by Parent
Reset :

58 [ Ese ] é d (Displaying the 5 most commaon)

Displaying 4 of 4 results Show Details
MName > Il Tire Care ltems (2) - =xeclude

> i 20-68204 1D = 2058:= |_=_| SkiJacket Light (1) - sxclude

~ I 104061 — Ski Jacket Xtreme (1) - exclude
N 555-22346 ID = 5605 [ Products (1) - exclude

> | 4@ SKU 00001 ID = SKU 00001 51 Ski Jacket Xireme (1) - sxclude
> | g SKU 00011 ID = 5K 00011

Finding Missing References: When the reference type is selected, and this box is checked, the populated
results will show all items that have that particular missing reference.
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| References ;]
Reference Type | video {Videa)

[] Indude Inherited References

Find Missing References

Rewget

EX

(-]

e
Reference Metadata
o
EE | Reset || _
Displaying 98 of 98 results Show Details
Mame

| 355-22346 1D = 6806

> | 6642 1D = 6642

> ). 7130-03 ID = 5854

v

w F133-12 ID =58081

Reference Target

Search Result Profiling

a3 hit(s)
Click links to narrow down search

Results by Object Type
Product {98) -

EHEH"I (46} - exclude

|| Salesitem (43) - =xclude

[l SalestemFamily (5) - sxclude
Bl temFamily (4) - =seclude

exclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most common)

[T Products (21} - exclude

[ Products (8) - exclude

[T/ Hats and Caps Salesltems (7} - sxclude
Il Crinking ltems (5) - sxclude

Bl Hanes T-shirts (5) - seclude

The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button. This
will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’ search

field.

In this example, the ‘Reference Type’ field is empty. Hence the result is irrespective of the reference type.
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[ | Refersnces W =
Reference Type Search Result Profiling

18 hit(s)

Indude Inherited Refe
[] tndlude fnher mIErEnces Click links to narrow down search

] Find Missing References

Reference Target Results b}f Dbiect Type
Seanch W Product {17} - exclude
imagej
ge/ipeg ltemn Family (9) - sxciuge
©- Advanced tem (6) - sxclude
- |- Sales ltem (1) - =sclude
[Tl Sales ltem Family (1h - exclude
Reference Metadata Entity (1} - exclude
3 customer (1) - sxclude
Results by Position in Tree Hierarchy
dh v Reset || il| Results by Parent
Displaying 18 of 18 resulis Show Detais N (Displaying the 5 most common)
Mame >

Bl Pull-Down/Pull-Out Kitchen Faucets (B) - =xclude
r_=|F'fCIE|LICTS (4) - exclude

[C1Tire Accessories (1) - excluds

Bl T-Shirts Family (1) - =xclude

[T Tire Care Salesltems (1) - =xclude

W

w B225 I =5275
Na 123857 G I = 123857
N 0726222 1D = 111204
& Acme Automatic Drip Coffee Maker D = 22795

The search result will differ when we specify the ‘Reference Type'.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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| References = = A
Reference Type  |product Images (Productimage) | ... Search Result Profiling
[] Indude Inherited References 7 hit(z)
Click links to narrow down search
[] Find Missing References
Reference Target Results by Object Type
533"’; =l Product (7) - exclude
image fipeq
&= Eltem (6) - exclude
Advanced B lterm Family (1) - ecluce
ap
Results by Position in Tree Hierarchy
Reference Metadata
v Results by Parent
(Displaying the 5 most commaon)
_i} '| Reset Search_ | r_=| Products (4) - exclude
Displaying 7 of 7 results Show Details (] Flashlights Item Qverride — Flashlights ltems (1) - =xclude
Name > ["1Dress Shoes (1) - exclude
W 123857 G D = 123857 Il T-Shirts Family (1) - excluge
2 Acme Automatic Drip Coffee Maker ID = 22195
ll Cotton T-shirts D = 1870¢
I Dog Party Hats Assortment 1D = 115306
Dog Party Hats Assortment /I = 127190
| m Yellow & Pink Party Hat D = 12717%¢

If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and select
the appropriate option. For more details on the advanced options, see the Search: Advanced Options topic.

[Search = £

image fjpeg
2 Advanced
[ ] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exdude values

[ ] Regular Expression

[] Indude Data Containers
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The user has to type the ID / Name of the source wish to search. It will list the items which have been used as a

source.

r [Referenced By ™|
Reference Type

Reference Source

]

Search Below
’VF'rimary-I Product Hierarchy (Product hierarchy root)

Reference Metadata

C R Reset

Show Details

Displaying 100 of 615 results
Mame
> I_ 120-Volh Tire Inflators (case of 10) 1D =651 ~

W

| 120-Volt Tire Inflators (case of 4) ID = 6515

W

| 120-Volt Tire Inflators (pack of 2) ID = 18515

> g1 555-2033_M D = 8801

* N 7130-03-FR 1D = 5854

Search Result Prn

615 hit{s)
Click links to narrow dom
Matice: Profile is not filte

Results by Objec

Product (456} - excluc

W External Ilter
External lter
Active Prod

|.. Sales ltem

| Case (20}

| Pack(s) -

em Family

. Open Item

W Pallet (2) -

[ClLevel 3 (1)

[Tl Sales ltem

W External lter

[l SalesltemF

Asset [1 Eﬂ'} - exclude

Click the ellipsis button ([...]) to browse for a reference type for search either type in the reference type ID / Name

for more restricted search.
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- [ Referenced By | =
Reference Type |product Images (Productimage) Search Result Profiling
83 hit(s)
Reference Source Click links to narrow down search
Search Below ™
’VF‘rimar}-I Product Hierarchy (Product hierarchy root) E1 .
Results by Object Type
E:} Asset (53] - exclude
Reference Metadata 'w| Productimage (53) - =
= Results by Position in Tree
Results by Parent
dh v Reset . (Displaying the 5 most commaon)
Displaying 53 of 53 results Show Details r_=| 15 (14} - exclude
Mame » CCJAC(8) - exclude
» '] 1st Birthday_Category Image 1D = 187524 ~ % g? 5§t5 (4) - exclude
(4) - exclude
> ] 1st Birthday Boy Blue Cupcake Kit 1D = 187520 L1203 - —:;:;L:E
> [m] 1st Birthday Boy Cupcake Kit ID = 157515

If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open the
Advanced flipper and select the appropriate. For more details on the advanced options, see the Search:
Advanced Options topic.

- [Referenced By ™| B3

Reference Type  |product Images (Productimage)

Reference Source

[Search | )

@ Advanced
[ ] Match Case on Mames and Values

[] Indude Inherited Values
[] Excude values

[] regular Expression

[] Indude Data Containers
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References and Referenced By Metadata Attribute Value Searches

Values for metadata attributes may be searched by using the References or Referenced By search options.
Users may indicate any value to search all metadata attributes for a matching value. The following pictures will
demonstrate with References, but know that the same holds true for Referenced By.

I===X B
Reference Type | alternative (Alternative) E]
[7] Indude Inherited References

Search

[] Find Missing References

Reference Target

Reference Metadata

Upsell

[ 4 |
[i] [ Reset ” Search ]

[ System Setup ” BG Processes ]

Alternatively, users may enter an attribute /D or name, operator, and value for a more restricted search.

[ References ;] =]
=
Reference Type E]
=
E [] Indude Inherited References
w
Wl

[] Find Missing References

Reference Target

Reference Metadata

Mumber == 5

m Setup ” BG Processes (1) ]

Note: Itis not possible to perform searches on missing metadata values.
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Search: Revised Objects Changed Since

With the Revised Objects Changed Since search criteria you can find recently edited objects in the workbench.
To narrow your search, enter an exact date / time to determine how old the changes can be, or you use intervals of
days, hours, or minutes. Revised Objects Changed Since criteria can be combined with any other search criteria.

1. Click on the Search tab and click the Search dropdown.

Search

2 Advanced T

oa - Reset Search

earch Result Show Details

2. Select Revised Objects Changed Since from the dropdown.

Search
Revised Objects Changed Since ™
Date LT

2013-07-02 09: 3424

g5 v Reset Search

Search Result Show Details

[ Mame > |

3. Adropdown appears with the following options:
« Date
« Interval of Days
« Interval of Hours

« Intervals of Minutes

Note: Only number values are accepted as input for the options Interval in days, Interval in hours,
Interval in minutes. When Days/day, hour/Hours/H, or minutes/Min/M is suffixed along with number, the
number value is considered.
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For the purpose of this example, 'Date’ will be used for the 'Revised Objects Changed Since' search field. The
Date option will provide a data picker, allowing for the selection of the data and time.

[ Revised Cbjerts Changed Since ™|

®
2015-08-06 09:03:39
EE | Reset |
Show Details
[ Mame ¥

25—

Month:  Day:

E] Date Picker

015 v aug v |06 ¥

Hours: Minutes: Seconds:

09 03 39

[ oK H Cancel

3. Click the ellipsis button ([...)) and determine the date / time of the oldest objects you wish to search. Click OK.

4. If necessary, click the green plus button ( ) to define additional search criteria.

5. Click on Search to run the search and view results.

[Revised Objects Changed Since |
DEtE il

2015-03-05 09:08:39

Er
Displaying 8 of & results
Marne

(% Buysidesellside_Internal ID = SuySidesalSide_Interm
I_Gluvewﬂrks case (Bx of 5 pair orange) I = 2i575
&4 SKU 00001 D = SKU/ 00001

2 SKU 00011 I = 5K/ 00011

I Test11189 D = 100705

» 5| Test docl ID = 107275

> (7 Test docl D = 10727

> | T Test document Ip = 107257

[ Reset ] _
Show Details

W

W

b

W
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Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Product {4} -

exclude

Product () - exclude
ltem (1) - exclude
I_CEISE! (1) - exclude
Asset (3) -

exclude

37| Owners Manual (2) - exclude
Assets (1) - esxclude

Special types (1)
| Poral Configuration Type (1) - exclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

CCIMA(3) - exclude

[Tl Products (1) - exclude

[T SkiJacket Pro (1) - exclude

[0 Ski Jacket Light (1) - =xclude

B Buy Side Packaging (1) - sxclude
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« Interval in days — Specify the number value in the field.

[ Revised Objects Changed Since |

Interval in days v

3

|Search: ACME =]
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The search result is displayed as shown below with objects which are revised since last 3 days.

[ Revised Objects Changed Since

- Interval in days e

S HE

@

N | Search: ACME =]

5 -

Displaying 13 of 13 results Show Details
Mame »
iE 21933 ID = 21935
* | . Black Lamp D = 122907
I Black Lamp ID = 208553
I Black Lamp by Mell ID = 122906
I Black Lamp with dimmer by Mell [0 = 12291;
I Blue Lamp by Mell ID = 122915
¥ Comfy Bed D = 22155
¥ comfy Footboard ID = 22165
¥® Comfy Headboard ID = 22167
¥ Comfy Side Rail ID = 22155
5 Purple Lamp by Mell ID = 122015
¥ Red Baseball Cap D = 20805
B Yellow Lamp by Mell ID = 122914

[ STEP Workflow ” Bookmarks ” System Setup " BG Processes ]
W

Search Result Profiling

13 hit(s)
Click links to narrow down search

Results by Object Type
Product (13] - exclude

« Interval in hours —Specify the number value in the field.
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EHEH"I (12) - exclude
| Sales item (1) - exclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

[C1Desklamp ltems (7} - excluds
Bl Beds ltems (4] - =xclude
[C15ASProducts (1) - sxcludes

(5 Acme Baseball Cap (1) - sxclude
3 arcimento (1) - exclude

Results by Value

Values matching "ACME"
MWalues are displayed in lowercase)

acme (14) - excluds

Attributes with values matching "ACME"

[T Manufacturer Name (7) - sxclude
[If Brand Name (6) - =xclude
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[ Revised Objects Changed Since

Interval in hours e

a0

The search result is displayed as shown below with objects which are revised since last 60 hours.

[ Revised Objects Changed Since |
Interval in hours v Search Result Profiling

a0 4 hit(s)
Click links to narrow down search

|Search: ACME
gp v Reset | || Results by Object Type
Di ing 4 of 4 Itz i
isplaying 4 of 4 resu show Detalls || broduct (4) - exclude
MName >

¥ Black Lamp ID = 208555 Bitem (4) - sxclude
¥® comfy Bed ID = 22155
¥= Purple Lamp by Mell ID = 122915 Results by Position in Tree Hierarchy
I Yellow Lamp by Mell ID = 122014 Results by Parent

[CiDesklamp tems (3) - =xcluds
Bl Beds ltems (1) - =xclude
[C]S8ASProducts (1) - excludes

« Interval in minutes — Specify the number value in the field.

| Revised Objects Changed Since |

Interval in minutes e

30

The search result is displayed as shown below with objects which are revised since last 30 minutes.
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| Interval in minutes

130

5 ]

Displaying 3 of 3 results Show Details

Mame

>

> |5} Asset Push 1 Queue D = Assetfushi

‘) DTP Queue ID = DTPConfiguration

>
>

AP NSUAssetpush 1D = NSII4ssetpush
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Search Result Profiling ~pm

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Special types (3)
[ )Asset Push Event Queue (3} - zxclude
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Search: Sample Result

The Sample Result Search Criterion allows users to refine the search results to only those specified numbers.
When the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a user
enters a random number and clicks on Search, the search result will be zero. Hence, this search should always be
appended to an existing search and entering a numeric value for 'Sample Results Size' will further refine the
search result based on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has 16
products. To do so they go to the Search tab > Search Below option in the Search dropdown > and choose what
node to search below. For more on how to search below, see the Search: Search Below topic.

Search L 4 Search Result Profiling o
Seanch Below = Ll
’VFu:u:u:I and Beverage (3303) 1 Search Result Proﬂ"ng
3 - Reset 16 hit(s)
: - . Click links to narrow down search
Displaying 16 of 16 results Show Details
Marme >
* N 7133-12 ID = 8081 Results by Object Type

W

el 7134-24 [0 = 5094
> Beverage D =53i5

Product (16) - exclude

» |44 Evian Water, Single ID = 8082 Egﬂflﬂ f‘il;f - f‘igx}ﬂ'ﬂ%

. . m odlBS |TEM - exclude
* Ml Evian Water Family ID = 5105 id Open Sales ltem (2) - exclude
* T Evian Water Family 1D =810 I3 Level 1 (1) - exclude

PR EVN-06 D = 110001 EoLevel 2 (1) - exclude
. EVH'DE' m =3{;|Sj I__=| LE".I'E' 3 [’1‘:‘ - exclude

N - Bl ltem Folder (1) - =xclude
QI EVI-12 1D = 5108 [T Sales ttem Folder (1) - =xclude
> EBEVN-24 ID = 20574 Bl ltem Family (1) - =xclude
» 7| Food and Beverage 1D = 8303 [T Sales tem Family (1) - exclude
* | Maive water_7132-06 D = 8055
» 7| Packaged Water D = 5715 Results by Position in Tree Hierarchy
> I Packaged Water Items [ = 5055 Results below child nodes of Food and Beverage
» Packaged Water Sales Items 1D = 8071 5 15
everage - exclude
> i:i Spring Water, Case of 24 1D = 107807 Ij ge (19) z

-Operations on Entire Result
Results by Parent

A
5] @] @l (Displaying the 5 maost comman) W

Now, the user wants to append the results with the ‘Sample Result’ search criteria. To do this they will keep their
original search, but select the plus sign > Sample Results > and enter a number. In this example ‘10’ is used to
define the Sample Results Size. The search result will give random results.
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| Search Below = Food and Beverage

Sample Resuk =
’V Sample Result Size  |1g

C R Reset

Displaying & of 3 results Show Details

Mame >
w 7133-12 D = 85081

N F134-24 D = 5074

iz Evian Water, Single D = §08:
> Evian Water Family 1D = 8105

Tg Evian Water Family [0 = 8110

> ™ EVN-24 1D = 20575

> Packaged Water [0 = 8315

Packaged Water Sales Items [0 = 8071

W

W

W

-Jperations on Entire Result

9 @ &

Notice that the results will display and not go above the specified sample results size number. If this Search button
is clicked multiple times, the sample search results will change each time, though always staying below the
specified sample number.
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Search: Search Below

The Search Below Search Criteria allows you to limit your search result to objects below a specified node in the
System Setup or Tree tab hierarchy.

Note: The search below option can be applied to the following object types only: attribute, classification,
collection, entity, product, and publication.

1. Click on the Search tab and click the Search dropdown.

Search

B Advanced T

op v Reset Search

aarch Result Show Details

Primary Product Hierarchy (Product hierarchy root) Eﬂ

B | Reset || search |

Show Detailzs
| Mame *|

3. Click the ellipsis button ([...]) to display the Search Below... dialog. By default the Primary Product Hierarchy is
selected as search criteria.

Search Below
IVF-‘rimEIry-I Product Hierarchy (Product hierarchy root) @

E] Search Below...

[oron-- TN

r_=| Classification 1root
_J Entity hierarchy root
+/ [ Primary Product Hierarchy
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4. Select anode in the hierarchy and click the Select button.

Search Below ;]
Primary Product Hierarchy (Product hierarchy root) Eﬂ

E] Search Below... uw
(rouse [[ET]

[#-[7] Classification 1root it
@ Entity hierarchy root
Elr_=| Primary Product Hierarchy
E]|__=| Products

E|r_=| Apparel
E]|j Head Wear
[=1-{T] Hats and Caps

m

- Details

I[ Select ]I[ Cancel

5. Click the Search button

’VHats and Caps Items (20436)

Ei Reset

Show Detailz

[ Mame ¥

The Results displayed includes only items at or below the selected node. Additionally, the selected node for the
search below criteria will also be included in the search results. In the example shown below, Hats and Caps
Itemsis also included in the search result
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Tree

i Search Below
’VHats and Caps Items (20436)

GE | Reset || _
Displaying 3 of 3 results Show Details
Mame

g 20803 D = 205035
B 20805 [ = 20505
il Hats and Caps Items [ = 20475

Search

(8)

Processes
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Search: Search from List

With the Search from List search criteria you can search using a list of data. This data can be manually entered
into the user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet. Users may
specify whether the entered data should be used to search for object IDs, names, key values, attributes values
(with specification of the particular attribute), or other criteria. This makes Search from List an efficient and easy
way to find large numbers of objects in STEP and, in combination with other available search option, suitable for
highly complex and extensive searches.

1. Click on the Search tab and click the Search dropdown.

Search =

Tree

€ pAdvanced

=

saarch Resule

Reset

Search

Show Details

—Y Name

2. Select Search from List from the dropdown to display a text field and dropdown with a number of options
based on your system.

I | Search from List =

[

Mumber of entries: 0

In this example, we choose Search from List: ID, which allows specifying the data list in the text field and

searching by 'ID' (selected from the dropdown).
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3. Use one of the following methods to enter the data list you wish to search in the text box:

r [Search from List ™ =

17739
23345
12323

Mumber of entries; 1

D -
EEE [ Resst ]
Displaying 0 of 0 results Hide Details

Mame >

« Manually use the Enter key to create a line break between each value.

« Copy data from Excel or any other application where line breaks or tabs are included to separate the values.
Each value must be listed on a line or be separated by a tab delimiter, without any characters (including
bullet indicators and spaces) around it. See the Using a Data List from an External Application section
below.

4. Ifneeded, click the green plus button () to add additional search criteria.

5. Click on Search to run the search and view results.
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| Seanch from List [#]

17739

20803

101557

Mumber of entries: 3
D -
G | Reset ||
Displaying 4 of 4 results Hide Details
Marme >

[C155

>
17739
.. 20670-012

>
17739
.. 20808-012

>
20803
IL 20808-013

>
1015567

StiboSystems
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< Search Result Profiling -
Search Result Profiling
4 hit(s)

Click links to narrow down search

Results by Object Type
Product (3

- exclude

|2 Salesitem (3) - esclude

Classification {1} - exclude
[ClAssetlevel 2 (1) - excluds

Results by Position in Tree Hierarchy

Results by Parent

[C|Hats and Caps Salesltems (3) - sxclude
r_=|5 1) - exclude

Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID

Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example

above.

Search from List: Name

Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.

I | Search from List ;1

=

Mumber of entries; 0

Marne

Enter the values to search into the text field. Click Search to run the search and view results.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

322



StiboSystems

MASTER DATA MANAGEMENT

The search results display with the name of the objects specified in the data list.

Search {Search Result Profili... -k
I | Search from List ;|
ey Search Result Profiling
T-Shirts Family 2 hit(s)
Click links to narrow down
search
Mumber of entries: 2
Name v Results by Object Type
dh Reset Product {2} - exclude
Displaying 2 of 2 results Show Details E Item (1) - exclude
Mame Il ltem Family
> i polo A ID = 113702 () - exclude
* il T-Shirts Family [0 = 123853 - i
Results by Position in

Tree Hierarchy
Results by Parent

r_=||:|ﬁE!FS (1) - exclude
[Tl SAProducts
1) - exclude
< > Il Eolo T-shirt

- Operations on Entire Result ——M - sxclude
Bl T-shirts ltems

5] @ @ 1) - exclude W

Search from List: Key
Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the data
list.
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~ [Seanch from List ™| = o~
555-21333
173911

Mumber of entries; 2

Ha v Reset

Search Result
Profiling
2 hit(s)

Click links to narrow down
search

Dizplaying 2 of 2 results 5.|-;.;|-.-.- [:.Etﬂus- ¥ESI.I"‘S by Obpc"
Mame ype
> W™ 179915 ID = 179915 Product (2] - exclude
> ¥ Item >1 ID = 15215 B e
@ - exclude
Results by Position
in Tree Hierarchy
Results by Parent
Il Cotton T-shirts
@ - exclude
< > [T BA Products
-Operations on Entire Result % r; Engﬂ": |
5 yens L.asua
= @] & Website

]

Itis important to keep in mind that:

« Only active keys will be available as an option in the dropdown list.

« Active Keys that have values in products can be searched.

StiboSystems
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« Searching for active keys with empty values in a data list field will NOT return search results.

For more on keys and how to activate them, see the Unique Keys documentation.

Search from List: Attributes

Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute’ from the

dropdown.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

324



StiboSystems

MASTER DATA MANAGEMENT

Search
r [ Seanch from List = [#]

Mumber of entries: 0

Attribute... e

Processes (1)

33 Pleasze Select Attribute

=3 Attribute Groups -
[+-[23 00_Source_Context

#1231 Address Atiribute Group

--Ifl Attribute Group

----- £ Blacklisted Attributes

-3 Business Conditions

[0 Business Rules

31 Calculated Attributes
[1-[251 Category Specific Attributes
--Ifl Color Atiributes

#1231 Compliance

--Ifl Customer Data

[#-[231 D&B Integration

--Ifl Data Containers for Entities
-3 Dates

--Ifl Diescription Attributes

-5 Dimensions

--Ifl Display W

@ Details

Select Cancel

Note: Description attributes are displayed under the product hierarchy node in the folders for which they are valid.
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3P Pleaze Select Attribute

Search

L—‘_}Fj Products

r_=| Apparel

r_=| Automotive

i +1-[17] Building Products
EI r_=| Displays

: |__=| Displays

l r_=| Electrical & Electronics

- {IZ] Food and Beverage

r_=| Footwear

r_=| Furniture

r_=| Hardware

Elr_=| Kitchen

: |j Major Appliances
|j Small Appliances

@ Details

Select

Cancel
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The search results display with the attributes specified, in this case it is the attribute 'Color' which holds values of

'Orange.’
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Search

| Gearch from List = =

lorange

Mumber of entries: 1

Primary Color e
Fe e
Displaying 1 of 1 results Show Details
Mame

ﬁ 18213 M O ID = 18215

£ >

-Jperations on Entire Result

9 @ &

£ Search Result Profil... -

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type

Product (1] - exclude

Results by Position in
Tree Hierarchy

Results by Parent

Il Cotton T-shirts
1) - exclude

Itis important to keep in mind that:
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« Only one attribute can be selected from the Attribute Group browse / search window to be used as search

criteria.

« Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes the
object that contains the searched value as a local value. While this object may not match an object type
restriction, it points to the origination of the searched text.

« Attribute values inheriting from other contexts can be specified in the data list.

« Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be
displayed with any search result. (This restriction is not limited to the Search from List functionality.)

Using a Data List from an External Application

Copied data can come from Excel or any other application as long as line breaks or tabs are included to separate
the values. To copy data in, each value must be listed on its own line or separated by a tab delimiter, (tab key from

keyboard) without any characters (including bullet indicators and spaces) around it.

In the example below, IDs have been copied over from an external file. Data can be horizontal or vertical as long
as the appropriate line breaks or tabs are in between the values.
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Search

r [ Search from List ™|

124143 13213

124145
15213

Mumber of entries: 2

Mumber of entries: 2

D . D
o Reset || il | e "'| Reset ||
Displaying 2 of 2 results Show Details | |Displaying 2 of 2 results Show Details
Mame » Mame >

* 18213 M O 1D = 124145
* N 1B213 MO [0 = 15215

-Operations on Entire Result

9 @ &

"N 18213 MO ID = 124145
18213 MO D = 18235

-Operations on Entire Result

g @
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Search: Search in Publication Hierarchy

Objects below a specific publication hierarchy can be searched, and the status or a specific result can be
determined, by using the ‘Search in Publication Hierarchy.’

Keep in mind that this search is not used to search for different templates (such as products, publications, or page
templates) or to search number of objects / links placed in product template. It is only used to search the objects
below a specific publication hierarchy.

Note: To use 'search in publication hierarchy' in the Search tab, it is recommended to have prior knowledge of
STEP Publisher and the publication hierarchy. For more information, see the Publication Hierarchy section of
the STEP Publisher (In Design) documentation.

To search in a publication hierarchy:

1. Click on the Search tab and click the Search dropdown.

Search

- Advanced T

g v Reset Search

aarch Result Show Details

2. Select Search in Publication Hierarchy from the dropdown.

Search in Publication Hierarchy
Search below: Publications
Search for: Objects linked to Publication [ Section o
oa Reset Search
Show Detailz
[ Mame >

Note: The search criteria requires no data input. However, it is helpful to further refine the search by pressing
the plus sign button (), and entering in information to limit the search results.
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3. Supply information for the following parameters:

Search in Publication Hieranchy E|

Search below: Publications

Search for: Dbijects linked to Publication [ Section

g Reset Search

Search Result Show Details

[ Mame ¥

« Search below: Used for choosing a node. Select either the publication group or publication. The search result
will display all matched product objects which are under the selected publication group or publication.

« Search for: Specifies what object is being searched.

Search for
The available options in the dropdown are:

Search
Search in Publication Hierarchy w1
Search below: Publications

Search for: Objects linked to Publication [ Section
Objects linked to Publication [ Section
aA ¥ Chijects in Assortment Lists
Search Result Chijects in Baskets
ame Chijects on actual pages
Chiects on planned pages

1. Obijects linked to Publication / Section: When this option is selected, products and assets linked to a
publication will be displayed in the result.
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_______ seach | SearchResult Profilng

Search in Publication Hierarchy W

Search below: Electronics Sale Poster
Search for: Objects linked to Publication / Section ~
op = Reset |
Displaying 7 of 7 results Show Details
Mame

s 21933 /D = 21955

RN 22196 I = 221595

] 22200 1D = 22200

P Chardonnay Glasses - 4 JD = 8055

¥® comfy Bed ID = 22155

I Comfy Footboard ID = 22165

Luigi Bormioli Chardonnay Glass - 1 1D = 8053

< >

-Operations on Entire Result

SN

Search Result Profiling

7 hit(s)
Click links to narrow down search

Results by Object Type

Product (7] - exclude

tem (6] - exclude
Open ltem (1) - esxclude

Results by Position in Tree
Hierarchy

Results by Parent
(Displaying the 5 most commaon)

r_=|F'FUI:|LIE'tS (3 - exclude
|__=|E|Ed5 fg} - exclude
er'FﬂdLlE’tS (2) - exclude
Bl Irons ltems (17 - exclude

Il Coffee Maker ltems
1) - exclude

]

2. Objects in Assortment Lists: This is a legacy component.

3. Objects in Baskets: The products saved in a Basket will be displayed in the results.
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-] GDSN Receiver

@ Merge_Golden_Root

-] Promations

=1l Publications

[l Templates

@ Standard Publications

-5l AutoPage Publications

@ Flatplanner Publications

=+ (i pring Wedding Catalog
EI@ Commercial Data
EIE Party Favors

[T 2 -Pages 243

(5] 4-Pages 485

(iR 6 -Pages 6 &7

-- OTP Documents
B Glassware

-- OTP Documents
= E Cards & Stationery

o ER [zuazzs}

l'"|.||l'\ﬂ'nl'\

Page Inspectaor || Skatus || State Log || Tasks

Spring Wedding Catalog - Plan

StiboSystems
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..'-|

AutoPage Publication Planner

Pagination Rules

Basket maintained locally

[
Publication m[ Wersion H Pages H Publication Planner " Plan Motes " Financial Summary |

Colurnn View: |De1'ault - Public w | View Options
D * Mame * PrimaryProductimage
4]
121183 N Pink & Blue Giraffe Party Hat
121218 F Pink & Blue Owl Party Hat
L
) }

Flatplanner

B[O B B |l [ s s

Search

| Saarch in Publication Hisrarchy ™|

Search below: . Spring Wedding Catalog I

Searchfor:  |objects in Baskets vl
&~ Reset ff search |
Displaying 25 of 25 results I Show Details

ame
e 18210 M B [0 = 18210

/

Pink & Blue Giraffe Party Hat [D = 1211585
Pink & Blue Owl Party Hat D = 121218
Politics Party Hats [D = 12119:

4. Object on actual pages: the product and asset are used on actual pages (DTP documents) and will display

the results field.
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E

#-[@l Christmas Catalog
E] Acme Party Supplies
-- Commercial Data
=[5 Party Hats

=[5 Party Favors

m Planned Page || Plan Motes || References || Skatus || Skate Log Tasksl
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Galley Page - Plan

(PRt

Flatplanner

BN R

|E|-|x\

i |'-."'.": H: |'u'iew Preview w

ﬁ 4 - Galley Page

H- EJJ CTP Documents

{55 4 - Confetti
ﬁ & - Mapkins
ﬁ 8 - Streamers

ﬁ 10 - Moisemakers_linked dass

Galley

, .
“| [Pink & Green Party Hat fy

8 &
D::ug Party Hats F\ssu:urtm#r
f f wud

f-F=0 TP Nocments

[ Search in Publication Hierarchy |

Page

[5a}

Search below: Flatplanner Publications
Search for: Objects on actual pages
£
oE v Reset Search
Displaying 100 of 110 results Show Det

ne
Pink & Green Party Hat ID = 127171 #

Pink & Green Party Hat_2 D = 1359:

W

W

5. Object on planned pages: The products and assets used on planned pages will be displayed in the result.
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I | Search in Publication Hierarchy
Search below: Flatplanner Publications
Search for: Objects on planned pages v
oa v Reset Search
Displaying 28 of 28 results Show Details
~
W
>
-Operations on Entire Result
3
5| A3 &

Tree

ﬁ Autopage Publications 2
[+ [ Standard Publications

Pages 2 & 3

| Skatus || Skate Log | Tasks

Flanned Page ” Flan Motes

=+ &) Flatplanner Publications
=@ Spring Party Catalog
% Commerdial Data

- [ Party Favors

AT )2-Pages2&3
{715 4 -Pages 455

5253 1 ~

|t

(i 6 -Pagess &7

=] OTP Documents

|Christmas Party Hat

]
|Purple & White Party Ha

[+-[E8 Cards & Stationery

[+ B8 Glassware

[+ [l Spring Wedding Catalog

(- India Test

E}--ﬁ Publication Group

=1HIT) Primary Product Hierarchy

E}Fj Products

r_=| Apparel v

T <
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Search: STEP Workflow

With the STEP Workflow search criteria you can search for and monitor STEP workflows. Selecting a specific
workflow from the dropdown list will show all items associated with the workflow. You can also specify the
workflow state to narrow your search.

1. Click on the Search tab and click the Search dropdown.

Search

2 Advanced T

oa - Reset Search

earch Result Show Details

2. Select STEP Workflow from the dropdown to display two additional dropdowns with options based on
availability in your system.

STEP Workflows ;|
STEP Warkflow |Sales Item Creation [ e
State ~
g Reset Search
Show Details
[ MName ¥

In this example, 'Sales ltem Creation' will be used for the STEP Workflow search field.

3. Forthe State dropdown, specify the state you wish to search within.

« Select a state defined in the workflow to search only items currently in the state.

« Select [any State] to search the entire workflow, as shown in this example.
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STEP Workfiow |

STEP Workflow | Sales Item Creation

State Jany State]

] v| [not in STEP Workflow]
Displaying 0 of 0 {Copy Writing
Digital Asset Review
Mew Digital Asset
Sales Item Review
W/eb Categorize

ame

"] @

StiboSystems

MASTER DATA MANAGEMENT

« Select[notin STEP workflow] to search objects which are not present in the selected workflow.

STEP Workflow ;'

STEP Workflow | Sales Item Creation
State [notin STEP Warkflow]

o v| Reset

Displaying 0 of 0 results Show Details

[ Mame

>

4. If needed, click the green plus button () to add additional search criteria.

5. Click Search to run the search and view results.
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Search Result Profiling

5 hit(s)
Click links to narrow down search

Results by Object Type
Product (5] - exclude

STEP Workflow

STEP Workflow _Sales Item Creation

State [any State]

&~ [reset [ seman ]

Displaying 5 of 5 results Hide Detailz
Mame >

|..18207-012

>
13207
|..18214-012

&
153214
|..18215-012

&>
13215
|..18217-012

*
13217
l.101164

>
101164

| Salesitem (5) - exclude

Results by Position in Tree Hierarchy
Results by Parent

ro—EhiI’TS (4) - exclude
[C1T-shirts and Sweatshirts (4] - =sxciude
[T Tire Care Salesltems (1) - =xcludes
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Search: Unapproved

This criteria is used to identify objects that are not currently approved. These include classifications, products,
images and documents, and entities setup to be Workspace revisable.

1. Click on the Search tab and click the Search dropdown.

€ pAdvanced

HE v Reset Search

aarch Result Show Details

2. Select Unapproved from the dropdown.

Search
I [ Unapproved ]
i@ Mever Approved or Modified in Main

(7 Mever Approved
(7 Modified in Main

Status in Current Context

(Ep [ Reset “ Search ]
Show Details

[ Mame ¥

3. Select the appropriate radio button and set the checkbox:

« Never Approved or Modified in Main: All objects that have 'Never been approved' and have been
'Modified in main'.

« Never Approved: Objects (products, classifications, assets & documents, or entities) that are workspace
revisable and that have never been approved.
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Product

Black Lamp rev.0.1 - Product

Images & Documents || Commercial || Tables |§ategnrv Profile || Proof View || Status || Skate Log || Tasks

Sub Products References

§ Desaipton

Mame »| > |Value
» D BP208553-2
* Mame Black Lamp
* Ohject Type Wrctive Products
> Pevision 0.1 Last edited by USERM on Wed Jul 26 08:48:51 EDT 2017
Wpproved x Mever Been Approved
* [Translation Mot Translated
* Path Primary Product Hierarchy ProductsHardware Tools/Task Lighting/Desk Lamps/Desk L:

« Modified in Maintenance: Objects that are modified after the approval or added to in the maintenance

workspace.
§ Desaipton

Mame > |alue »

* D 120223

» Mame 120223

* Ohbject Type Open Item

* Revision 0.6 Last edited by USER] on Wed May 31 08:42: 19 EOT 2017

* \Approved x Last Approved on Mon Mov 02 10:37:35 EST 2015

* [Translation Master

* Path Primary Product Hierarchy/Products /Electrical and Electronics/\Wire & Cable/Cable/Cable Ite...

« Status in Current Context: When this box is checked, only the current context is searched. If unchecked, all

objects in all contexts are searched.
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b & Context | English US
(@ Mever Approved or Modified in Main

= _

¢ () Never Approved

m

u

@l | ) Modified in Main

o I Status in Current Context I

o R [ Reset ] [ Search ]

&l Show Details

@B | [ Name a

If needed, click the green plus button () to add additional search criteria.

. Click Search to run the search and view results.
340
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Search: Unpushed or Failed Assets

The Unpushed for Failed Assets search criteria allow you to identify assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Error.'

2!] 3 M rev.1.0 - Status

Images&[}ucuments References || Referenced State Log || Tasks

Configuration » |Asset Push Status * [Relative Path * [Waorkspace * |Visibility »
* \Asset Push Configuration 1B | Downloaded IE AssetPushConfiglB/88/01/8801.jpg  |Main
* raw-main Never been handled Main
* |Asset Push Configuration 1 A Asset not in workspace Approved

1. Click on the Search tab and click the Search dropdown.

ﬂ

Show Details

[ Unpushed or Failed Assets ] |Eﬂ

Configuration: |

3. Click the ellipsis button ((-..]) to display the Select Asset Push Configuration dialog.
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Configuration:

" Unpushed or Failed Assets =

e | Browse |EETETGY

El--ﬂ Event Queues
ol Addresses
E}[ﬁ] Asset Push 1 Queue
o Y AssetPush 4 A

= Details

Select

----- ‘ﬁ Asset Push Configuration 1 A
----- ﬁ Asset Push Configuration 1B

Cancel

W

4. Select a configuration and click the Select button.

$2 Select Asset Push Configuration

| Search

EI--[ﬂ Event Queues
gl Addresses
o] Asset Push 1 Queus
b %) AssetPush 4 A
%] [psset Push Configuration 1A
----- %) Asset Push Configuration 1B

- Details

Select Cancel

W

5. Click the Search button to display the Search Results List and Profiling information.
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Search

"[lenmshadaFailad Assets. |
C

onfiguration: | asset push Configuration 1 A (AssetPushConfigl)

R

Displaying 58 of 53 results
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W
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Search Result Profiling

Search Result Profiling

58 hit(s)

Click links to narrow down search

Results by Object Type
Asset (58) - exclude

'@ Product Image (40) - exclude
9% Owners Manual (§) - excluds
@ Export anager Configuration (2) - exclude

Logo (2) - exclude

lcon (2} - exclude

Installation Manual (2) - esxclude

Import Manager Configuration (2) - exclude

f Assels f1} - exclude
@] Configuration (1) - sxcluss

Results by Position in Tree Hierarchy

Results by Parent
(Digplaying the & most comman)

r_=|.‘!'.SSE!TS (17} - exclude
r_=||'.,.'|,l!a, 7] - exclude

..'1|

Note: Click an item in the list to view it, or click a profiling link to update the search results list.
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STEP Workbench Keyboard Shortcuts

Within STEP Workbench there are many shortcut key combinations that allow users to quickly navigate and make
changes through the system. The following tables list and describe the options available for Shortcut Key options.

Basic Shortcuts

Shortcut Description Shortcut
Key
Copy Creates a duplicate of the information selected that can be pasted somewhere else. Ctrl+C
Cut Takes away information that can be pasted into a different location if desired. Ctrl+ X
Duplicate | This duplicates the item selected, with the option to duplicate references as well. Ctrl+J
Goto This brings the user to the Goto field in the upper right hand corner of the workbench Ctri+ G

screen where items are looked up.

Goto Finds the next item that most closely matches what the user is looking for. The results | Ctrl+ E
Next may differ depending on what tab the user is in and working with, or what area is
selected as active.

Help When Workbench is open, it will populate another window that provides all of the F1
Online Help Documentation.

Next Shifts the focus to the next cell. Tab
Paste When information that was either cut or copied from before is placed into an alternate | Ctrl+V
area.

Previous | Shifts the focus to the previous cell. Shift +
Tab

Redo Goes to the changed sate, if the change was reversed. Ctrl +
Shift+Z

Reload Reloads the workbench and updates to any changes made. F5
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Shortcut Description Shortcut
Key
Select All | When the desired area is clicked in or is already the active area, pressing this key Ctrl+ A
combination will choose everything in this particular area.
Undo Goes back to the original state before the change was made. Ctrl+ Z

Navigate to Main Side Bar Tabs in Workbench

Shortcut Description Shortcut
Key
Background | Unless a product is being viewed, this will bring the user to the Background Alt+P
Process Processes tab. If a user is on a product, this key combination will not transpire.
Tab
Bookmarks | Brings the user to the Bookmarks side tab. Alt+M
System Brings the user to the System Setup tab. Alt+Y
Setup Tab
Search Tab | Leaves the user looking at what they were on in the main frame, but brings up the Ctri+F
Search Tab along the left hand side.
Tree Tab This will bring a user to the Tree Tab only if not viewing an item in Tree in the main Alt+T
screen, or having an item still show up in the main screen even though navigation
has been away from it.
Workflow Navigates to the STEP Workflows tab. Alt+W
Tab

Navigate to Horizontal Tabs within Main Sidebar Tabs

To navigate to the horizontal tabs within the main tabs in workbench, press Alt + (the letter underlined on the tab).

For example, if a workflow is selected within System Setup, pressing Alt + S displays the Status tab for the
workflow being viewed because 'S' is the underlined letter for the Status tab.
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System Setup L 4
- &= Advanced Seard = [ﬁ O
STEP Workflow Edito | Walidit Lo
@ Asset Update ¥ =g @
-0 critical ? Revisions
@ DANF Testl Revision * |Created
FEUI Discontinued State > 0.9 Tue Jan 12 10:46:57 EST 2016
- Error
* 0.8 Fri Jan 08 15:57:57 EST 2016
-/l FlatPlanner old but don't delete
[ ] Workiiow 6| B

Note that options for shortcut keys to horizontal tabs vary depending on what item is selected and in what main tab
auser is located (Tree, Search, Background Processes, System Setup, Bookmarks, and STEP Workflow). Not all
tabs have underlined letters for shortcut key options.

General Shortcuts Useful in Workbench

Description Shortcut

Key

Add Bookmark When on an object and this is pressed, it will add the item to the Ctrl+D
bookmark list on the Bookmark tab.

Add Element When adding various elements, pressing this key combination will often Ctrl +
(notin all cases), bring up a dialog allowing the user to add to the desired | Plus
list.

Approve Object When in Main, approves an object that was previously unapproved. Ctrl +

Shift+J

Mark Different (On In Tree, when viewing multiple products at once, or when viewing the Shift +

multi-product display) | horizontal Sub Products tab for an item, selecting this key combination F12

will mark all areas that are different green.

New Window With STEP Workbench open, this will open an additional STEP Ctrl+ N
Workbench window.

Remove Element When deleting various elements from lists or rows, pressing this key Ctrl +
combination will often remove the desired connection or item. Minus
Rotate Table (On In Tree, when viewing multiple products at once, or when viewing the F11

Multi-Product display) | horizontal Sub Products tab for an item, this rotates the table view if the
table is the active area.
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Description Shortcut

Key

Toggle attribute
values selection
between blinking
cursor and blue filter

When on afield that is editable, selecting F2 allows the user to write inthe | F2
field. When pressed again, the entire field turns blue, rendering it entered

and non-editable, unless F2 is pressed again or the field is clicked into

again.

Insert Options

Shortcut

Description Shortcut

Key

Insert Action Set

In System Setup, when in the Action Sets, pressing thiskey | Ctrl + Shift

combination will create a child Action in an Action set. +S

Insert Asset The Create Asset dialog appears whenin Tree. Ctrl + Shift
+A

Insert Attribute Displays the Create Attribute dialog in System Setup. Ctrl + Shift
+T

Insert Attribute Group In System Setup, this creates a new Attribute Group if sitting | Ctrl + Shift

on the proper level. +1

Insert Background
Process to Monitor
Deadlines/ STEP
Workflow Deadline
Monitoring

This allows a user to set up a background process to monitor | Ctrl + Shift
states with exceeded deadlines in the desired time frame. +D

Insert Character Tag

When typing in a field and this is selected, a dialog appears CtrI+R
allowing the user to select from character tags.

Insert Classification

In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+C

Insert Classification Root

In Tree, a new Classification Root or top node yellow folder | Ctrl + Shift
is created. +R

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 347



StiboSystems

MASTER DATA MANAGEMENT

Shortcut Description Shortcut
Key

Insert Dimension In System Setup, when sitting on the top node for contexts, Ctrl + Shift
clicking these keys will bring up the dialog to create a new +D
dimension.

Insert Dimension Point In System Setup, when on a dimension, selecting this will Ctrl + Shift
create the dimension point. +M

Insert Group In System Setup, when on the node that houses Usersand | Ctrl + Shift
Groups, selecting this key combination will create a new +G
group.

Insert List of Values In System Setup, when sitting on the top node for List of Ctrl + Shift
Values, pressing this will bring up the dialog to createanew | +L
List of Values.

Insert non-breaking space | Enters a non-breaking space when editing attribute values. Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute, Ctrl + Shift
which will appear in italics. +0

Insert Product When in Tree, this will create a new object under the one Ctrl + Shift
selected. +P

Insert Special Character When in a field that allows typing, selecting this brings up a Ctrl + Shift
list of characters that can be selected and inserted into the +E
field.

Insert STEP Workflow In System Setup, when on the top node for workflows, or Ctrl + Shift
when inside the node for workflows, selecting this will bring +R
up a new STEP Workflow Designer window to create a new
workflow.

Insert Workspace In System Setup, when on a workspace, selecting this key Ctrl + Shift
combination will create a different workspace. + W
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Linking Options

Shortcut Description Shortcut
(Y
Link Asset When on References or References By tab, this allows asset links or referencesto | Ctrl +
be selected and put into the appropriate folders. Note that the Reference Type can | Shift+ F
be changed from the drop-down menu in the dialog that appears.
Link Attribute | To link an Attribute to an item, select the item that needs the attribute and select Ctrl +
to this key combination. Linked attributes will appear in the References tab under the | Shift+Y
Classification | 'Attributes' flipper.
Link Attribute | When on a product, selecting this key combination links an attribute to a product. Ctrl +
to Product Shift+ K
Link This links a classification to a product. It can be seen under the Reference tab Ctrl +
Classification | under the 'Linked Attributes to Classifications Hierarchy' flipper. Shift +H
to a Product
Paste Link Creates a new reference (pointer or link) to an existing / copied object. An Ctrl+ L
example would be if the user copied a SKU from a blue folder and pasted it into the
yellow folders. Note that object types need to be compatible.
Link Product | When on References or References By tab, this allows product links or references | Ctrl +
/ Create Link | to be selected and put into the appropriate folders. Shift+ Q

Style Options

Description Shortcut
Key
Bold When typing in a filed, this activates bold text. Ctrl+B
Character Tag | Opens the Insert Character Tag dialog for adding character tags to CtrI+R
attribute values.
Italic When typing in a field, this activates italic text. Ctrl + 1
Non-breaking Enters a non-breaking space when editing attribute values. Ctrl +
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Shortcut Description Shortcut
Key
Space Enter
Special Opens a dialog showing the most recently used special characters, Ctrl +
Character as well as an option to select to see all special characters. Allows user | Shift+ E
to select a special character to insert when editing attribute values.
Style This key combination can be pressed to bring up the Style box, where | Ctrl+Y
there are a number of styles to choose from.
Rich Text Opens the Rich Text Editor in STEP Workbench when editing an Alt+ F2
Editor attribute value.
Paste and When in afield, if 'text A" is copied from one area and is going to be Ctrl +
Match Style pasted into 'text B' that is a different style, pressing this key Shift+V
combination will make it so the copied 'text A" will past into 'text B' with
the style of 'text B'.
Flatplanner Shortcuts

Shortcut

Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctri+ Alt+ S

Zoom In (In Flatplanner) This zooms in on what is beingworked on. | Ctrl + Plus

Zoom Out (In Flatplanner) | This zooms out of what is being worked on. | Ctrl + Minus
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